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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials.
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.
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Domestic Sales - (770) 662-3633                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
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ASAP 2420 Operator’s Manual Organization of the Manual
GENERAL INFORMATION

This manual provides a description of the ASAP 2420 analyzer and the menu options and 
functions available for the ASAP 2420 analysis program. 

Organization of the Manual

The manual is divided into the following chapters:

1. GENERAL INFORMATION
Provides a general description of the ASAP 2420 system as well as its specifications.

2. USER INTERFACE
Provides basic instrument and software interface.

3. OPERATING PROCEDURES
Provides step-by-step instructions for operating the ASAP 2420.

4. SOFTWARE AND SETUP MODIFICATIONS
Provides instructions for using the ASAP 2420 Setup Program.

5. FILE MENU
Provides a description of the commands on the File menu.

6. UNIT MENU
Provides a description of the commands on the Unit menu.

7. REPORTS MENU
Provides a description of the commands on the Reports menu and samples of reports.

8. OPTIONS MENU
Provides a description of the commands on the Options menu.

9. TROUBLESHOOTING AND MAINTENANCE
Provides instructions for troubleshooting hardware problems and for performing routine 
maintenance procedures.

10. ORDERING INFORMATION
Provides part numbers and descriptions of the ASAP 2420 System components and 
accessories.
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Conventions

This manual uses the symbols shown below to identify notes of importance, cautions, and 
warnings.

A.  ASAP SERIES SAMPLE DATA WORKSHEET
Contains a form to assist you in determining the sample mass.

B. ERROR MESSAGES
Lists the error messages that may be displayed in the analysis program; includes a cause 
and action for each.

C. CALCULATIONS 
Contains the calculations used by the system to produce reports.

D. TESTING THE ANALYZER FOR LEAKS
Describers the procedure for checking each valve for leaks.

E. DFT MODELS
Provides information on DFT models.

F. ETHERNET COMMUNICATION SETTINGS
Provides information on configuring an ethernet port.

Notes contain a tip or important information pertinent to the subject matter.

Cautions contain information to help you prevent actions which could damage the 
instrument.

Warnings contain information to help you prevent actions which could cause personal 
injury.
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Equipment Description

The ASAP 2420 surface area analyzer is actually two independent instruments in a single 
cabinet — one to degas samples and the other to analyze samples. A computer monitors and 
controls analyses, and reduces, reports and archives data for each sample. 

The degas system has 12 automatically-controlled sample heat/vacuum ports. Each port 
operates independently. Samples may be added to or removed from degas ports with minimal 
disturbance to the treatment of other samples.

Temperature and rate of temperature change at each degas port can be set and monitored 
individually. Indicator lights above each degas port show the current state of the port. In 
addition, the degas operation can be monitored on the computer screen with the Instrument 
Schematic and Status windows.

The analysis system has six ports. The ports can be operated independently or concurrently 
and can perform analyses of at least 50 hours without refilling the Dewars. Each port can 
accept a range of sample tube neck diameters (1/4-, 3/8-, or 1/2-in. OD). Analysis operations 
can be monitored on the computer screen with the Instrument Schematic and Status windows. 
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For very low surface area analyses, a Krypton option is available. The option consists of a 
high-vacuum pump, low pressure transducer, and software. If this option is purchased with the 
instrument, it is factory-installed. It is also available as a field upgrade. 

For analyses that require measurement and equilibration at pressures as low as 1.0m, the 
Micropore upgrade is available. When purchased with the instrument, this upgrade is factory-
installed. The upgrade can also be added to 2420 krypton units in the field. 

For micropore analyses that require better resolution at lower pressures, a 1-mmHg transducer 
is available. This transducer can also be added to 2420 krypton units in the field.

The ASAP analysis program supports four analysis modes:

• Standard
• Krypton
• High Throughput
• Micropore

In Standard mode, the system performs nitrogen, or similar gas, analyses at 77 K. All 
analyses must use the same gas. Samples can be removed and added to any of the six ports 
without disturbing the analyses being performed on other ports.

In Krypton mode, up to five Krypton analyses are started together. Port 6 is used to store 
Krypton for dosing. The data collection is done sequentially — one analysis starts and 
completes before the next is started. 

In High Throughput mode, up to six nitrogen, or similar gas, analyses are started together. 
All analyses must use the same analysis gas and the same Psat gas, which may be different 
from the analysis gas. Once a set is started, no other samples can be started until the set is 
complete. The data collection is done in parallel. This mode also supports measured freespace.

In Micropore mode, up to six analyses are started together. Once a set is started, no other 
samples can be started until the set is complete.

Each analysis port of the ASAP 2420 is equipped with an elevator that raises and lowers the 
analysis bath fluid Dewar automatically. A removable shield to enclose the Dewar is also 
included for safety purposes.

The sample saturation pressure (Psat) tube is located next to the sample analysis port. Gas inlet 
ports and cable connections are located on the side panel of the analyzer for easy access.

The ASAP 2420 system includes Micromeritics’ patented Isothermal Jackets for the sample 
tube. The Isothermal Jacket maintains a stable thermal profile along the full length of the 
sample and Psat tubes.
1-6                                                    Nov 2011



ASAP 2420 Operator’s Manual Gas Requirements
Gas Requirements

Compressed gases are required for analyses performed by the ASAP 2420 analyzer. Gas 
bottles or an outlet from a central source should be located near the analyzer. Up to five 
different non-reactive adsorptives, for example, N2, Ar, CO2, and Kr, plus helium for free 
space can be attached to the analyzer simultaneously. A separate gas inlet is provided for the 
degas system. Helium or nitrogen are typically used for degas.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are 
required. Pressure relief valves should be set to no more than 30 psig (200 kPag). Gas 
regulators are available from Micromeritics; refer to “ORDERING INFORMATION” on 
page 10-1.

Analysis Program

The ASAP 2420 analysis program is designed to operate in a Windows 2000 or Windows XP 
Professional environment. The Windows environment provides a user-friendly interface for 
performing analyses and generating reports.

The analysis program monitors and controls the analyzer. It enables you to perform automatic 
analyses with just a few key strokes, and collects and reports analysis data. You can choose 
from a variety of reports, which can be printed automatically after an analysis or stored and 
printed later.

The analysis program includes a report system which allows you to manipulate and customize 
reports. You can zoom in on portions of the graphs or shift the axes to examine fine details. 
Scalable graphs can be copied to the clipboard and pasted into other applications. Reports can 
be customized with your choice of fonts and a company logo added to the report header for an 
impressive presentation. Refer to “REPORTS MENU” on page 7-1 for the options available 
for reports.
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Specifications

The ASAP 2420 system has been designed and tested to meet the specifications provided 
below.

Characteristic Specification

—————— ELECTRICAL ——————

Voltage:

Frequency:

Power:

100/115/230 VAC (+ 10%) 

50 or 60 Hz

 800 VA, exclusive of vacuum pumps, which are 
powered separately

—————— ENVIRONMENT ——————

Temperature: 10 to 30o C operating
-10 to 55o C storage or shipping

Humidity: Up to 90% (non-condensing) for instrument

—————— CAPACITY ——————

Analysis Manifold: 6 sample ports (5 for krypton) each with a 
constantly-monitored saturation pressure port 

Degas Manifold: 12 degas ports, each with an independently-
controlled heating mantle

———— ANALYSIS MANIFOLD TEMPERATURE TRANSDUCER————

Type: Platinum resistance device (RTD)

Accuracy: + 0.10o C by keyboard entry

Stability: + 0.10o C per month 
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Characteristic Specification

—————— PRESSURE MEASUREMENT ——————

Analysis Manifold Transducer:
     Range: 0 to 950 mmHg

Resolution:

1000-mmHg Transducer 0.001 mmHg (Analysis system)
1 mmHg (Degas system)

   10-mmHg Transducer* 0.00001 mmHg

   1-mmHg Transducer**
   (optional for high stability)

0.000001 mmHg

Accuracy (Analysis system only):

   Includes nonlinearity, hysteresis, and nonrepeatability. Transducer manufacturer’s 
   specifications. 

   1000-mmHg Range
   10-mmHg Range*
   1-mmHg Range**
     

Within 0.15% of reading
Within 0.15% of reading
Within 0.12% of reading 

     Readings from the 10-mmHg transducer are actively taken only in systems with the 
krypton or micropore option. Readings from the 1-mmHg transducer are actively taken 
only in systems with the micropore option. These transducers, even when present, are 
not utilized when running samples in standard (N2, etc.) or high-throughput modes.

*High-vacuum systems
**Micropore systems.

Vacuum Transducers:
     Type: Thermocouple

     Range: 0.001 to 1 mmHg
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Characteristic Specification

—————— VACUUM SYSTEM ——————

Pumps: Nitrogen: 2 oil-based pumps: 1 analysis, 1 degas*

Krypton: 4 pumps: 2 oil-free, 2 high-vacuum

Oil-based mechanical pump: 5 x 10-3 mmHg 
ultimate vacuum.

Oil-free and high vacuum pump: ultimate 
vacuum 3.8 x 10-9 mmHg. 

Ultimate vacuum measured by pump 
manufacturer according to Pneurop Standard 
5608.

*Can also be ordered with 4 pumps: 2 oil-free 
and 2 high-vacuum.

—————— DEGAS SYSTEM ——————

Capacity: 12 degas ports

Vacuum Control: Selectable target pressure controls switchover 
from restricted to unrestricted evacuation

Evacuation: Selectable evacuation rate from 1.0 to 
50.0 mmHg/s

Temperature Range: Ambient to 450o C (Programmable)

Temperature Control: 1 ramp during evacuation phase, 5 additional 
selectable ramps during heating phase

Selection: Digitally set, 1o C increments from computer

Accuracy: Deviation less than +10o C of set point at sensing 
thermocouple embedded in the heating mantle

Backfill Gas: User-selectable at dedicated port, typically 
nitrogen or helium
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—————— PHYSICAL ——————

Height: 159 cm (62.5 in.)

Width: 103 cm (40.5 in.)

Depth: 51 cm (20.2 in.)

Weight: 160 kg (350 lb)

—————— COMPUTER——————

Minimum requirements: Intel Celeron or equivalent, 733 MHz or higher 
CPU

128 MB RAM
20GB minimum hard drive (formatted in NTFS) 

(one partition)
Video Adapter capable of 1024 × 768 minimum 

resolution
One 10BaseT Ethernet port (can be 10/100)
CD-ROM drive
Microsoft Windows XP Professional (32 bit) or
Microsoft 7 Professional (32 bit)
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USER INTERFACE

This chapter contains information to familiarize you with the hardware and software 
components of the ASAP 2420 system. It is recommended that you read this chapter before 
attempting to operate the ASAP 2420 system.

Controls, Indicators, and Connectors

This section contains a description of the controls, indicators, and connectors located on the 
front and side panels of the ASAP 2420 system.

Front Panels

The lower front panel contains the degas ports and indicator lights that show the status of each 
port. The upper front panel contains the analysis ports.

Analysis ports

Degas ports
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Lower Front Panel

The lower front portion of the unit contains 12 degas stations, and an indicator light and 
heating mantle connections for each station.

Degas Port Indicator Lights Each degas port has three indicator lights located above the 
port. The lights show the current state of the port.

Degas ports
indicator lights

Degas port 
connector

Heating mantle 
thermocouple 
receptacle

Heating mantle
power receptacle

When an indicator light is red, do not touch the sample tube, heating mantle, or mantle 
clip on the associated port. These components may be hot enough to cause burns.

A blinking indicator light means the port valve is Open. Do not remove a sample tube 
or port plug while a valve is open. Doing so could contaminate the degas manifold.

Indicator Light
Color

Description

Red Heat is being applied to the port. Do not touch the sample tube, heating 
mantle, or heating mantle clip.

Yellow Cool down is in progress. Heat is no longer being applied to the port, 
but the sample tube, heating mantle, and mantle clip may still be hot. 
Avoid touching these components.

Green The port has cooled down and is idle. A degas operation can be started.
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Upper Front Panel

The upper portion of the unit contains six analysis stations and six saturation pressure ports. 
The power indicator light is located in the left corner of the panel.

Degas port connector Allows connection of a sample tube to the degas port.

Heating mantle thermocouple 
receptacle

Allows connection of a heating mantle thermocouple (one 
for each degas port).

Heating mantle power 
receptacle

Allows connection of the heating mantle power cord (one 
for each heating mantle).

Sample port connector For installing the sample tube containing the material you 
wish to analyze.

Po port connector For installing a Po (saturation pressure) tube.

Sample port
connector

Po port 
connector

Power
indicator
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Analyzer power indicator

High-vacuum pump power 
indicator

Turns on and flashes green while the analyzer is 
attempting to communicate with the computer. Once 
communications are established, remains solid green.

These indicator lights turn on (and remain solid green) 
when power is being applied to the high-vacuum pump(s) 
and they are at full operating speed. Applies only to units 
with high-vacuum pumps installed.

    

1       2

Analyzer power indicator 

High-vacuum pump
power indicator
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Right Side Panel

Upper Right Side Panel

Gas inlet ports 
(1 through 6) 

Used to connect up to six analysis gas supplies to the 
analyzer. When measuring free space, any one of the ports 
may be used for helium. 

Degas Backfill port Allows connection of a gas to use after degassing the 
sample to backfill the sample tube with a clean dry gas.

Gas inlet ports

Degas backfill gas port
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Lower Right Side Panel

On/Off switch For turning the analyzer on and off. This switch also serves 
as the main breaker for the analyzer; it switches off 
automatically in the event of an electrical fault.

Power connector For connecting the analyzer to the power supply.

Valve circuit breaker Protects the circuitry for the valves in the event of a failure. 
If the circuit breaker trips (pops out), call your 
Micromeritics service representative.

Voltage selector switch For setting the analyzer to the correct incoming AC line 
voltage.

Ethernet connection 

Service access panel

Power panel

(to computer)

           

 Power Panel

Power connector

Voltage selector switch

Valve circuit
breaker

On/Off Switch
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Back Panel

Vacuum pump
power connectors

Vacuum pump
housing

Vacuum pump housing The vacuum pumps are located on a shelf at the bottom on 
the unit. The pumps can be accessed by removing the lower 
back panel or the lower front panel of the unit.

Vacuum pump power 
connectors

For connecting the vacuum pumps to the power supply. 
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Turning On the System

1. Place the ON/OFF switches for the computer and all peripheral devices in the ON 
position.

2. Place the analyzer ON/OFF switch in the ON position.

Turning Off the System

1. Select Close from the System Menu or Exit from the File menu.

2. If you exit the ASAP 2420 program with analyses in progress, you will be warned of the 
operation. If desired, you can continue exiting the application and the analyses will 
proceed and continue to collect data. Reports that are queued under the Print Manager will 
print. If, however, a power failure occurs and an uninterruptible power supply (UPS) is not 
attached to the computer, the data collected after exiting the ASAP 2420 System program 
are lost.

3. Place the computer, monitor, and printer ON/OFF switches in the OFF position.

4. Place the analyzer Power switch in the OFF position.

Always exit the ASAP 2420 program and/or Windows before turning off the computer. 
Failure to do so could result in loss of data.
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Using the Software

The analysis program operates in the Windows environment and requires familiarity with 
standard Windows operations such as using the mouse, menus, and dialog boxes. While this 
manual provides brief instructions for such standard operations, you may have to refer to your 
Windows documentation or to its online help system to clarify functions which are specific to 
Windows.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are 
available for certain components on the instrument schematic when in manual mode, and for 
onscreen graphs and tabular reports. These menus are accessed by selecting the item for which 
you wish to display its menu and clicking the right mouse button. For example, right-click in a 
column of an onscreen report and the following menu is displayed.

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key 
combinations (if assigned) are listed to the right of the menu item. Instead of opening the menu 
and choosing the command, simply press the key combination. For example, to open a sample 
information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an underlined 
letter by pressing Alt plus the underlined letter in the command. For example, to access the 
File menu, press Alt, then F.
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Table 2-1: Shortcut Keys

Key(s) Function

F1 Access online operator’s manual

F2 Open a sample information file

Clear the field of existing date (Select Dates dialog)

F3 Open an analysis conditions file

Insert the current date (Select Dates dialog)

F4 Open an adsorptive properties file

Display a calendar from which to choose a date (Select Dates dialog)

F5 Open a report options file

F6 Tile open windows

F7 Cascade open windows

F8 Start report

F9 Close all open reports

Alt + F4 Exit the ASAP 2420 program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F4 List adsorptive properties files

Shift + F5 List report options files

Shift + F9 Access shortcut menu of (1) selected component on instrument 
schematic, or (2) onscreen reports
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File Name Conventions

For sample information and report options files, a wildcard character (*) and a default 
extension are displayed. 

The following table shows the file name extensions for the ASAP 2420 program.

Table 2-2: Default File Name Extensions

File Type Extension

Sample Information SMP

Degas conditions DEG

Analysis Conditions ANC

Report Options RPO

Adsorptive Properties ADP

Export to disk (ASCII) ISO

Sample information files from the ASAP 2000 analyzers; may be 
converted to an ASAP 2420-compatible format

DAT

Report to disk RPT

List to disk LST

Thickness curve THK

File Type Extension

Alpha-s curve ALS

The following types are available for reports saved from the Report window

Report REP

Spreadsheet XLS

ASCII TXT
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Common Software Commands

Many of the dialog boxes contain command push buttons, such as Save, that provide the same 
function in each dialog. These commands are described below.

Save

Saves the information entered in the current session; the dialog box remains open.

Close

Closes the active dialog box. If the dialog box contains unsaved changes, you will be 
prompted to save them before the dialog box closes.

Cancel

Discards everything you entered in the dialog box and any subdialog boxes, and closes the 
dialog box. A warning message is displayed before closing.

    Command Push Buttons
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Replace

Allows you to replace the contents of the current file with those from an existing file. For 
example, if you are creating a sample tube file, you can save time by clicking and choosing the 
file containing the values you wish to use. These values are copied into the current file 
automatically. Because the values are actually just copied into the file, you can edit them in 
any way you wish. The file from which they were copied remains intact and ready for the next 
use.

When you select Replace, an Open dialog, similar to the one shown below, is displayed.

Select the file you wish to use, then click Replace.
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Replace All

Use this push button to replace all parameters of the current file with those from an existing 
one. You can edit the parameters after they have been copied into the current file; editing the 
current file does not affect the file from which they were copied.

When you select Replace All, an Open dialog, similar to the one shown below, is displayed.

Select the file you wish to use, then click OK.
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Common Software Functions

There are some software functions that are accessed on numerous dialogs.

For example, there are several dialogs from which you select a file to view, edit, or report on. 
The file is selected from a list of files that reside in the current directory. This list may be 
lengthy; so you may limit the files displayed by entering Selection Criteria. 

File Selection 

Certain dialog boxes contain a list of files available for that particular operation. For example, 
the Open Sample Information File dialog contains a list of sample files.

   Files list

Selected
directory
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The files displayed in the Files list are those contained in the selected directory and having the 
status shown in the Status field. You can change or limit the list of files displayed by:

• Selecting another directory
• Selecting another file status
• Selecting a date or range of dates

Selecting a Directory

The selected directory is displayed just above the Directories list box. You can change 
directories by double-clicking a directory in the Directories list box or double clicking on [..] 
to move up one level in the directory. 

You can also change directories by entering a path name in the File name field. You can use 
wildcard characters in the file name, but must enter the extension appropriate for the type of 
file you wish to open. For example, C:\DEMO\DEMOFILES\*.SMP to display sample files in 
the C:\DEMO\DEMOFILES directory.

Double-click to move up one
level in the selected directory
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Selecting a File Status

You can select a file status from the Status drop-down list. The following table describes each 
file status.

Table 2-3: File Status and Description

Status Description

All All sample information files in the specified directory and within the 
specified range of dates

Analyzing Sample information files that are currently being used with an analysis

Complete Sample information files that have been used with an analysis

Entered Sample information files that contain manually entered data

No analysis Sample information files that have not been used in a degassing 
operation or an analysis

Prepared Sample information files that have been used in an automatic degassing 
operation and are ready for analysis

Preparing Sample information files that are currently being used in an automatic 
degassing operation

The Status drop-down list does not appear on the File > Open dialogs for parameter 
files.
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Selecting a Range of Dates

You can select to show all dates or a specific date or range of dates in the Select Dates dialog, 
which is displayed when you click Date Range.

• Click Show All Dates to show all files.

• Click Show Date Range to enter a date or range of dates. The From and To fields become 
enabled. You can either enter a beginning and ending date in these fields or double-click in 
each field to display a calendar to select a date.

a. Use the left and right arrow keys to select the year and month.

b. Click the day on the calendar.

c. Click OK.

The range of dates remains the default until you change the dates or select Show All 
Dates. 

For convenience, the following shortcut keys are available for selecting dates:

F2 Clears the date
F3 Inserts the current date
F4 Displays a calendar from which you may select a date

Click to show all dates

Click to show a date or range of dates

Click left and right arrow keys to select a year 

Click day

Click left and right arrow keys to select a month
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Report Settings

You can select whether a report will be sent to the screen, a printer, or a file in the Report 
Settings group box, which appears on report screens.

Destination Click Destination to display a drop-down list of output 
destinations. The choices are: File, Printer, or Screen.

If you select Printer, requested reports are sent to the default 
printer.

If you select Screen, requested reports are displayed on the 
screen. 

If you select File, the tabular reports of the requested file are 
converted to a text file which can be viewed with a text 
editor or other text file manipulation tool. Graphical data 
cannot be generated to a File. 

Copies This field is enabled if you chose Printer for destination. 

You can use the up and down arrows to select a number or 
enter a number in the field. You may print from 1 to 4 
copies.

File name This field is enabled if you chose File for destination. The 
default report name is the name of the sample file with the 
.SMP extension replaced by the .RPT extension.

You may accept this file name or enter another file name. If 
you enter another name, make sure you use the .RPT 
extension.
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Menu Structure

All functions for the ASAP 2420 are located on menus which are accessed from the Menu bar. 
Each menu contains commands, and in some cases a submenu. A submenu is indicated when 
the command is followed by an arrow.
 

Brief descriptions of each menu are provided below; refer to the chapter given in parentheses 
for a detailed description of the commands contained on that menu.

               

Submenu

Command

Menu bar

File Enables you to maintain system files. 
(Chapter 5, FILE MENU)

Unit [n] Enables you to perform analyses and other instrument 
operations. 
(Chapter 6, UNIT MENU)

Reports Enables you to generate, customize, and close reports. Also 
provides examples of reports. 
(Chapter 7, REPORTS MENU)

Options Enables you select data presentation formats, and enter 
system default values. 
(Chapter 8, OPTIONS MENU)

Windows Enables you to arrange the windows and icons on your 
screen. It also displays the names of all open files. 
(this chapter, page 2-23)

Help Displays Help information.
(this chapter, page 2-23)
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Windows Menu

Help Menu

Tile Resizes all open windows and arranges them side by side so 
that the contents of all open windows are visible.

Cascade Resizes all open windows and arranges them in a stacked 
fashion. The active window is positioned on top of the stack. 
Each window’s title remains visible, making it easy to select 
other windows.

Arrange Icons Arranges the symbols for all minimized windows in an 
orderly manner.

Open Files Displays all open files; the active window is preceded with a 
check mark. 

Operator’s Manual Displays the operator’s manual in PDF format. 

About ASAP 2420 Displays information about the ASAP 2420 analysis 
program.
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OPERATIONAL PROCEDURES

This chapter contains brief step-by-step instructions on how to:

• specify sample file defaults
• create sample information files
• define parameter files 
• prepare the sample
• perform an analysis
• generate a list of information on a sample or parameter file
• export data in a sample information file to an ASCII file
• overlay graphs

This chapter does not contain detailed descriptions of the dialogs used to perform these 
procedures. Refer to Chapters 5 through 8 for dialog descriptions. Use the index to assist you 
in locating the appropriate dialog. 

Specifying Sample File Defaults

You can specify sample defaults in the Basic or Advanced format. The defaults you specify are 
the ones you see when you create a new sample file in the respective format. Therefore, it is 
best to specify parameters that you plan to use most frequently. You can always edit 
parameters in the sample file when it is created. The ASAP 2420 system automatically 
generates sample information file names and uses the values you specify as the defaults. 
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Basic Format

Perform the following steps to define defaults for a sample information file in the Basic 
format.

1. Select Options > Sample Defaults; the default Basic Sample Information dialog is 
displayed.

2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File > Open > Sample 
information. You can use up to eight characters.

3. In the field on the right of the Sample line, enter a format for the sample identification. Be 
sure to include the $ symbol if you want the sample file number included as part of the 
identification. You can use up to 42 alphanumeric characters.

Select Option Presentation on the Options menu and ensure that Basic is selected as 
the format.

You also can edit the word Sample. For example, you may prefer to use Material or 
Test. You can enter up to 15 characters in this field.
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4. Select Enter to enter a value for the sample’s mass (if different from the default value), or 
Calculate to have the mass calculated automatically. If you select Calculate, you must 
enter weights for the Empty tube and the Tube + sample.

5. The value entered in the Density field is used by the system for calculating free space. 
Enter the sample density in the Density field if desired.

6. Select the down arrow to the right of the parameter fields to choose default parameter 
files:

•   Sample tube
•   Degas conditions
•   Analysis conditions
•   Adsorptive properties
•   Report options

7. Click Save, then Close.

Advanced Format 

The Advanced Sample Defaults dialog resembles a set of index cards. You can move from one 
set of parameters to another by clicking the parameter tab or by using Next and Prev. The 
values you specify in the parameter portions of the sample file (Sample Tube, Analysis 
Conditions, Degas Conditions, Adsorptive Properties, and Report Options) are saved as the 
defaults for newly created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select Open > Sample Information from the File menu, Yes to create the file, and the 
defaults you specify display for all parameters.

• Select Open > Analysis Conditions from the File menu, Yes to create the file, and the 
defaults you specify in the Analysis Conditions portion of the Advanced Sample 
Defaults dialog display in the fields.

1. Select Options > Sample Defaults, the default Advanced Sample Defaults dialog is 
displayed.

Select Option Presentation on the Options menu and ensure that Advanced is 
selected as the format.
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2. In the Sequence field specify a default string for the sample file number; you can use up to 
eight characters. This is the number that appears in the File name field when you select 
File > Open > Sample information.

3. In the right-side field of the Sample line, enter a format for the sample’s identification. 
You can enter up to 42 characters. Be sure to include the $ symbol if you want the sample 
file number (Sequence) included as part of the identification.

4. Edit the Operator and Submitter lines as desired. Or have them omitted entirely by 
selecting Omit.

5. Select Enter to enter a value for the sample’s mass (if different from the default value), or 
Calculate to have the mass calculated automatically. If you select Calculate, you must 
enter weights for the Empty tube and the Tube + sample.

6. The value entered in the Density field is used by the system for calculating free space. 
Enter the sample density in the Density field if desired.

7. Choose whether you wish to have data collected automatically or if you plan to enter the 
data. This option can be changed (if desired) at the time of analysis.

8. Click the Sample Tube tab; enter criteria for the sample tube you most commonly use.

It is not necessary to click Save on each dialog. Clicking Save once on any dialog 
after all defaults have been specified is sufficient. All dialog defaults will be saved.
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9. Click the Analysis Conditions tab. Choose the analysis conditions appropriate for your 
most commonly analyzed material.

10. Click the Degas Conditions tab. Specify degassing criteria.

11. Click the Adsorptive Properties tab. Specify gas characteristics.

12. Click the Report Options tab. Choose desired reports, using Edit to specify details; then 
click Save. 

13. Click Close to close the dialog.

Creating Sample Information Files

Sample information files contain information used to control degassing and analysis. After 
you perform an analysis, the sample information file stores the results. You cannot degas or 
analyze a sample until you assign it a sample information file.

A sample information file consists of the following information:

• sample identification
• sample tube properties
• analysis conditions
• adsorptive properties
• report options
• collected or entered data

Portions of the sample information file can also exist as standalone parameter files. Having 
these files exist independently allows you to use them as many times as you wish. For 
example, if you typically use the same analysis conditions, you can create an analysis 
conditions file containing the desired conditions. Then when you create a sample file, click on 
the Replace button, and select the previously-created analysis conditions, the values will be 
copied into the current sample file and you can edit them if needed. The file from which the 
values were copied remains intact and ready for the next use.

Sample information files reside in a folder, or directory. The more files in a directory, the 
longer it may take to access a file. Therefore, it is a good practice to limit the number of files in 
a directory to approximately 500. You may create additional directories as needed.

Sample information files can be created anytime prior to performing an analysis and stored for 
future use. There are three formats in which you may create sample information files: 
Advanced, Basic, or Restricted format. 

• Advanced
Presents all parts of the sample information file in a tabbed dialog. Each tab opens its asso-
ciated dialog, allowing you to edit conditions. You can also switch to the Basic format if 
desired.
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• Basic
Presents all parts of the sample information file as a single dialog. This format allows you 
to quickly create a sample information file using predefined parameter files. You can also 
switch to the Advanced format if desired.

• Restricted
Identical to the Basic format except that you cannot switch to the Advanced format for 
editing; certain functions are also disabled.

The application also provides a convenient method of creating sample information files using 
the Replace function. In each of the formats listed above, a Replace push button is located in 
the Sample Information dialog box. You can use this command to copy the data from an 
existing sample information file into the one you are creating.

This feature is convenient for creating numerous default sample files. For example, you could 
set up a sample information file for each type of material you wish to analyze. Then, when 
performing an analysis, copy the sample file for the desired material into the new file and edit 
if required.

In addition to creating and storing sample information files for use in future analyses, you can 
create a sample information file using default or predefined parameter files when you begin a 
degas operation or analysis.

The following table outlines the methods by which you can create sample information files. 

Table 3-1. Methods of Creating Sample Information Files

Method for creating 
sample information 
file

When a file can be 
created

Able to edit 
parameters 
in sample 
file?

Able to 
choose 
different 
parameter 
files?

Able to 
replace 
contents?

Basic format Any time before 
performing an 
analysis

No Yes Yes

Advanced format Any time before 
performing an 
analysis

Yes Yes Yes

Restricted format Any time before 
performing an 
analysis

No Yes Yes

Use default sample 
information file

When starting a 
standard analysis

No Yes No
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Advanced Format

The Advanced format allows you to customize the parameters of a sample information file. 
Chapter 5 provides a description of the fields associated with creating sample information 
files.

1. Select File > Open > Sample information from the Main Menu; the Open Sample 
Information File dialog is displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

Use default sample 
information file

When starting a 
krypton analysis

No No No

Use default sample 
information file

When starting a high 
throughput analysis

No No No

Use default sample 
information file

When starting a 
micropore analysis

No No No

Use default sample 
information file

When starting a 
single degas 
operation

No Yes
Degas 
conditions 
only

No

Use default sample 
information file

When starting 
multiple degas 
operations

No No No

Method for creating 
sample information 
file

When a file can be 
created

Able to edit 
parameters 
in sample 
file?

Able to 
choose 
different 
parameter 
files?

Able to 
replace 
contents?
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3. Click OK, then Yes to create the file; the Sample Information dialog is displayed.

The defaults that appear in the fields are the ones specified in Sample Defaults. 

4. Accept the default identification in the Sample field or change it to an appropriate one. 
The dialog box above shows the sample file number because the dollar ($) symbol was 
used when specifying sample defaults.

5. Edit the Operator and/or Submitter fields as needed. If these fields are not displayed, 
they were selected to be omitted in Sample Defaults.

6. Select Enter to enter a value for the sample’s mass (if different from the default value), or 
Calculate to have the mass calculated automatically. If you select Calculate, you must 
enter weights for the Empty tube and the Tube + sample.

7. Enter the sample’s density (if different from the default value) in the Density field.

8. Choose whether you want data automatically collected by the system or whether you wish 
to enter the data.

These fields do not
display if you selected
Omit when specifying
Sample defaults.

If a sample information file already exists containing the values you want to use in 
this file, you can click Replace all to copy those values into this one. You can still 
edit the values after they are loaded. 

Use the Comments window to record specifics of the analysis or its conditions. 
Anything you enter in this window is displayed in the report header.
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9. Click Save to save the information you entered.

10. The steps for completing the remaining parameters of the sample information file are 
explained in subsequent sections:

•   Specifying Sample Tube Criteria (refer to page 3-13) 
•   Defining Degas Conditions (refer to page 3-14)
•   Defining Analysis Conditions (refer to page 3-15)
•   Defining Adsorptive Properties (refer to page 3-16)
•   Defining Report Options (refer to page 3-17)

Simply click on the tabs to open the associated dialog.

Basic and Restricted Formats

Sample information files are created in Basic or Restricted format using predefined parameter 
files. Refer to “Basic Format” on page 5-9 and “Restricted Format” on page 5-11 for a 
description of the fields associated with creating sample information files.

1. Select File > Open > Sample information from the Main Menu; the Open Sample 
Information File dialog is displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed. The 
defaults that appear in the fields are the ones specified in Sample Defaults. 

4. Accept the default identification or change it to an appropriate one. 

Use this push button 
if you want to copy 
parameters from an 
existing file into the 
current file.
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5. Select Enter to enter a value for the sample’s mass (if different from the default value), or 
Calculate to have the mass calculated automatically. If you select Calculate, you must 
enter weights for the Empty tube and the Tube + sample.

6. The value entered in the Density field is used by the system for calculating free space. 
Enter the sample density in the Density field if desired.

7. Using the down arrows to the right of each parameter field, select an appropriate file (or 
accept the defaults). You can review or edit the contents of these files by switching to the 
Advanced format if desired.

8. Click Save, then Close.

Defining Parameter Files

The following file types can exist as part of the sample information file or as an individual 
parameter file:

• Sample tube
• Degas conditions
• Analysis conditions
• Adsorptive properties
• Report options

Having these files exist independently allows you to use them over and over again.
Several predefined parameter files (located in the params directory) are included with the 
ASAP 2420 analysis program. Although these files may come close to the needs of your 
laboratory, you may wish to define additional ones. Or you can use a predefined file as a 
starting point. This is easily accomplished by creating a new file and then selecting Replace. 
A dialog is displayed so that you can select the existing file containing the values you wish to 
use. After the values are copied into the current file, you can edit the values as desired; the 
original file remains intact and ready for the next use. 

If you wish to have parameter files display in the drop-down list on the Basic Sample 
Information dialog, be sure to save them to the directory specified as the Parameter Files 
Directory. (Refer to “Parameter Files Directory” on page 8-15 for additional information.)

If you are using the Restricted format, you cannot switch to the Advanced format.
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Sample Tube

1. Select File > Open > Sample Tube; the Sample tube dialog is displayed.

2. Enter a name in the File name field, then click OK.

3. Click Yes to create the file; the Sample Tube dialog is displayed.

4. Enter a description in the Sample Tube field. Be sure to use an intuitive description so that 
you can recognize it easily.

5. Click Load from Sample File; the Open Sample Information File dialog is displayed.

6. Select the file you used in the blank run with this sample tube, then click Open to copy the 
collected data for the warm and cold free space into the Sample Tube dialog.

7. If a seal frit was used, select Seal Frit, if not, leave the default of None selected.

8. Click Save, then Close.
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Degas Conditions

Degas Conditions files contain degassing information for preparing samples.

Perform the following steps to define a degas conditions file:

1. Select File > Open > Degas Conditions; the Degas Conditions dialog is displayed.

2. Enter a name in the File name field, then click OK.

3. Click Yes to create the file; the Degas Conditions dialog is displayed.

4. Enter a description in the Description field. Be sure to use an intuitive description so that 
you can recognize it easily.

5. Specify values for the evacuation and heating phases for degassing the sample.

6. Click Save, then Close.
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Analysis Conditions

1. Select File > Open > Analysis Conditions; the Open Analysis Conditions File dialog is 
displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.

3. Click Yes to create the file; the Analysis Conditions dialog is displayed.

4. Enter a description (up to 42 characters) in the Description field. Use an intuitive 
description; one that will help you identify the type of sample you plan to analyze using 
these analysis conditions.

5. Select the method to be used for isotherm collection; either Target Pressures or Dose 
Increments. If you choose Target Pressures, you can enter dosing options.

6. Click the following push buttons to define associated analysis conditions. Refer to 
“Analysis Conditions” on page 5-16 for a description of these fields.

Preparation 
Free Space
Po and T
Equilibration
Backfill

7. Click Save, then Close.
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Adsorptive Properties

1. Select File > Open > Adsorptive Properties; the Open Adsorptive Properties File dialog 
is displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.

3. Click Yes to create the file; the Adsorptive Properties dialog is displayed.

4. Enter the name of the adsorptive gas in the Adsorptive field, then enter its mnemonic.

5. Click Psat vs T to edit the Psat vs Temperature table. Edit any other field(s) on this dialog 
as required, then click OK. 

6. Select Non-condensing Adsorptive if the gas is non-condensing.

7. Enter the appropriate information (or accept the defaults) in the following fields.
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Maximum manifold pressure
Non-ideality factor
Density conversion factor
Thermal transpiration hard-sphere diameter
Molecular cross-sectional area

8. Choose the dosing method: Normal for standard and high throughput analyses or From 
Port 6 for krypton analysis.

9. Click Save, then Close.

Report Options

Report options specify the types of reports to be generated from an analysis or from manually 
entered data. They also help you customize details of reports such as axis scale, axis range, 
column headings, and components of thickness curve equations.

You can tailor report options files to accommodate the requirements of your analyses. For 
example, you can generate a simple report that lets you determine the basic characteristics of 
the sample. Then use that report to make choices about the variables you want to include in 
lengthier, more sophisticated reports. You can specify for reports to be generated automatically 
after each analysis, or you can generate reports at any time during or after an analysis. 
However, a report generated during an analysis only includes data collected up to the time of 
the report.

1. Select File > Open > Report Options from the main menu; the Open Report Options File 
dialog box is displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.
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3. Click Yes to create the file; the Report Options dialog is displayed.

4. Enter a description in the Description field. Enter an identifier that gives a more intuitive 
description of the file’s contents. For example, t-Plot Report Options.

5. Select Show report title and enter the title you wish to appear at the top of the report. Or 
deselect this option if you prefer not to have a report title.

6. If you wish to compare the same type of graph from multiple files, click Overlays and 
choose the files. Then be sure you edit the graph from the Selected Reports window and 
choose Samples from the Overlay drop-down list.

7. Select Apply thermal transpiration correction if you want correction made for thermal 
transpiration in the sample tube, then enter the inside diameter of the sample tube.

8. The reports that may be generated are listed in the Selected Reports list. Select reports by 
double-clicking on the desired report. Reports are deselected in the same manner. A report 
is selected when it is preceded by a check mark.

9. You can edit some reports by highlighting the desired report and clicking Edit. Refer to 
Chapter 5, FILE MENU.

10. Click Save, then Close to save the information and close the dialog.

If your company logo exists as a bitmap (bmp) or enhanced metafile (emf), you can 
have it display in the report header by selecting Show graphic. Click Browse to 
select the file; use the Height and Width fields to specify the size.
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Preparing Samples

Care should be taken in choosing, conditioning, and filling sample tubes. The following 
guidelines will help you obtain accurate, reproducible analysis results.

Choosing Sample Tubes

A sample tube set consists of the following parts:

• Sample tube
• Stopper or seal frit
• Filler rod 

Standard sample tubes for the ASAP 2420 degas and analysis stations have a 1.27-cm (1/2-in.) 
outside diameter (OD). Two other sizes are available: 0.64 cm and 0.95 cm (1/4 in. and 3/8 in.) 
OD. Stepped ferrules, smaller O-rings, and filler rods are available for adapting the smaller 
stems to the degas or analysis ports. 

A rubber stopper may be used with all size sample tubes; however, seal frits are recommended 
for 1.27-cm (1/2-in.) OD sample tubes or when helium is used as the degas backfill gas.

Filler rods help ensure accuracy in samples with lower total surface areas by reducing the free-
space volume. It is generally a good practice to use filler rods for samples having less than 100 
square meters of total surface area. Filler rods are unnecessary for samples with total surface 
areas greater than 100 square meters. 

Cleaning and Labeling Sample Tubes

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The 
following procedures are recommended. Refer to the following table for a list of materials 
needed to clean and weigh samples properly.

Supplied by Micromeritics Supplied by User

Sample tube
Sample tube brush
Stoppers for sample tube
Sample tube rack
Sample weighing support
Funnel
Sample data worksheet 
(copied from Appendix A of this manual)
Pipe cleaners

Drying oven
Ultrasonic cleaning unit
Alconox 
Rubber gloves
Lint-free cloth
Acetone or isopropyl alcohol
Safety glasses
Forceps
Balance
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1. Turn on the drying oven used for heating the sample tubes and filler rods and set the 
temperature to 110 ºC.

2. Rinse the sample tubes and filler rods.

3. Check the reservoir of the ultrasonic cleaning unit to make sure it is clean.

4. Using 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water, fill the 
reservoir of the ultrasonic unit with enough water to cover the sample tubes and filler rods. 
Make sure the detergent is dissolved before placing the sample tubes and filler rods into 
the water. If too much detergent is used, it may be difficult to rinse from the sample tubes.

5. Fill the sample tubes with warm water and place the tubes and filler rods in the reservoir of 
the ultrasonic cleaning unit. Turn on the ultrasonic cleaning unit. Leave the glassware in 
the cleaning unit until the walls of the tubes are free of sample material residue.

6. Using rubber gloves, remove the sample tubes and filler rods from the reservoir. 
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7. Clean the interior of the sample tubes with the brush supplied with the ASAP 2420 
System. Rinse the sample tubes and filler rods thoroughly with hot water.

8. After rinsing with hot water, rinse the sample tubes and filler rods with isopropyl alcohol 
or acetone.

9. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in 
the rack. Bake for two hours.

10. Remove the sample tubes from the oven and allow them to cool.

If isopropyl alcohol or acetone is not available, deionized water may be used to rinse 
the sample tubes.
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11. Using either rubber gloves or a lint-free cloth (but not bare hands), place a filler rod (if 
used) in each sample tube by holding the sample tube horizontally and sliding the filler rod 
into the sample tube slowly.

12. Wipe a rubber stopper (or seal frit, if used with 1.27-cm (1/2-in.) tubes) with a lint-free 
cloth. 

13. Label the sample tube and stopper or seal frit for identification.

14. Insert the stopper or seal frit.
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Determining Amount of Sample to Use

The amount of sample to use can be determined best by experiment. In general, a sample 
providing 40 to 120 square meters of total surface area is recommended for nitrogen analysis. 
Less than this may cause variability of results; considerably more than this extends 
unnecessarily the time required for analysis.

Smaller quantities are required for samples having high surface areas. These samples require 
careful weighing after degassing because a small error may represent a considerable percent of 
total weight. Proper weighing techniques are most important in this case. Use no less than 100 
mg to reduce the effect of weighing errors.

Care should be taken when loading powders; the accessory funnel is useful for this purpose. 
Large granules or chunks may be loaded with forceps.

Determining the Mass of the Sample

Analysis results are expressed in units of surface area per gram of sample; therefore, the true 
mass of the sample must be known. The true mass is best calculated by:

1. Weighing the sample tube set (sample tube, filler rod, and stopper or seal frit) before 
degas.

2. Weighing the sample tube set with sample before degas and subtracting the weight from 
the step 1 weight.

3. Weighing the sample tube set with sample after degas and subtracting the weight from the 
step 1 weight.

4. Weighing the sample tube set with sample after analysis and subtracting the weight from 
the step 1 weight.

A Sample Data Worksheet for recording the weights and calculating the mass is included in 
Appendix A. You may make copies as needed.

To weigh the sample before degas:

1. Write the Sample Tube number on the Sample Data Worksheet. 

2. Place the sample weighing support on the balance. Tare the balance and allow it to 
stabilize at zero (0).
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3. Place the sample tube set (sample tube, stopper or seal frit, and filler rod, if used) on the 
sample support. 

4. Record the stabilized weight on the Sample Data Worksheet as Mass of empty sample 
tube. Remove the sample support and sample tube set from the balance.

5. Slowly add the sample to a sample container. 

6. Remove the rubber stopper or seal frit and filler rod from the sample tube.

7. Using a funnel, pour sample from the container into the sample tube; or, if analyzing large 
granules or chunks, use forceps to load the sample tube.

Do not touch the sample or filler rod with bare hands while performing the following 
steps. Doing so could affect the accuracy of results.

If handling toxic sample material, perform steps 5 though 8 under a vent hood.
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If some sample clings to the inside of the sample tube above the top 3 in. (7.5 cm) of the 
tube, use a pipe cleaner or lint-free wipe to remove it. 

8. Replace the filler rod and insert the rubber stopper or seal frit.

9. Weigh the sample tube set containing the sample and record the weight on the Sample 
Data Worksheet as Mass of sample tube plus sample (Before Degas).

10. Subtract the Mass of empty sample tube from the Mass of sample tube plus sample; record 
this value as the Mass of sample.
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Degassing Samples on Degas Ports

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere. 
The sample must be clean when an analysis is performed. The sample is heated and placed 
under vacuum to remove moisture and other contaminants. This process is referred to as 
degassing the sample. 

Attaching Sample Tubes to Degas Ports

1. While holding the degas port plug, loosen, then remove the connector nut and plug from 
the degas port by turning the connector nut counterclockwise. 

2. Remove the rubber stopper (if used instead of a seal frit) from the sample tube. 

Place the degas port connector nut, ferrule, and O-ring onto the sample tube set as shown 
below.

Degas port connector nut

Plug

O-ring (1/4 in. from top)

Ferrule

Connector nut
3-26                                                    Nov 2011



ASAP 2420 Operator’s Manual Degassing Samples on Degas Ports
3. Attach the sample tube set to the degas port. Be sure to push the sample tube in to a full 
stop. Secure the sample tube in place by sliding the connector nut, ferrule, and O-ring up 
onto the degas port and turning the connector nut clockwise. Tighten the nut securely by 
hand.

4. Place a heating mantle over the bulb of the sample tube and secure the mantle in place 
with a mantle clip.

5. Insert the heating mantle thermocouple plug into the thermocouple connector on the 
analyzer. Insert the heating mantle power plug into the power connector on the analyzer 
and twist to lock securely.

      
Thermocouple plug

Power plug

Heating mantle

Mantle clip
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Degassing a Single Sample

You can degas a single sample as described below.

1. Select Start Single Degas from the Unit menu; the Automatic Degas dialog is displayed.

2. Click Browse to the right of the Sample field and choose a sample file.

3. The degas conditions file contained in the sample file is displayed. Click the down arrow 
to display a list of degas conditions files if you wish to choose another file.

4. Click the port you wish to use.

5. Click Start to begin the degassing operation The Degas Status screen is displayed.
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6. When the degas operation is complete, a message dialog is displayed. 

7. Click OK to close the message box.

8. Allow the sample tube to cool before removing it.

9. After the sample has cooled, transfer the sample tube to the analysis port to start the 
analysis (refer to “Transferring a Degassed Sample to an Analysis Port” on page 3-
34).

Degassing Multiple Samples

You can degas up to 12 samples as described below. At any time you can add one or more new 
samples to degas ports. Whenever a sample (or set of samples) is added, the initial evacuation 
will interrupt the degassing of the other samples. If any other samples are still in the initial 
evacuation phase, the new ones will wait until the fast evacuation is started. Starting several 
samples as a batch will allow them to perform the initial evacuation together.

1. Select Start Multiple Degas from the Unit menu; the Automatic Degas dialog is 
displayed.
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1. Click the Browse button next to the port you wish to use. The Select a File for Analysis 
dialog displays.

2. Select a sample information file, then click OK.

3. Repeat steps 1 and 2 for each port you wish to use.

4. Click Start to begin the degassing operation. 

5. When degas is complete, a message dialog is displayed for each port:

6. Click OK to close each message box.

7. Allow the sample tubes to cool before removing them.

8. After the sample tubes have cooled, transfer them to the analysis ports to start the analyses 
(refer to “Transferring a Degassed Sample to an Analysis Port” on page 3-34).
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Filling Dewars

Precautions

We recommend the following be observed when handling Dewars containing liquefied gases:

• Protect yourself by wearing 1) goggles (or a face shield), 2) an insulated or rubber 
apron, and 3) insulated gloves.

• When pouring liquefied gases from one container to another: 1) cool the receiving 
container gradually to minimize thermal shock, 2) pour the liquefied gas slowly to 
prevent splashing, and 3) vent the receiving container to the atmosphere.

• Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases 
(or other materials of extremely low temperature). Do not use a glass or metal stirring 
rod unless it is coated with some form of protective coating.

• Do not handle heavy objects above the Dewar. If an object of sufficient weight is 
accidentally dropped into the Dewar, the Dewar may shatter.

Dewar Covers

Dewar insulators, which cover the opening in the top of a Dewar, are shipped with the 
instrument.These covers help maintain the purity of the liquid cryogen, as well as preventing 
objects from falling into the Dewar. 

Whenever a Dewar is not in use, make sure the Dewar elevator is fully lowered and the top of 
the Dewar is covered with an insulator.

Always handle Dewars with care. Any product incorporating a vacuum is a potential 
safety hazard and should be treated with caution.

      
Dewar insulator
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Filling an Analysis Dewar

1. With the Dewar elevator fully lowered, fill the analysis Dewar with the analysis bath fluid 
to about 5 cm (2 inches) from the top.

2. To check the fluid level, insert the dipstick in the Dewar as shown below. 

Incorrect fluid levels can lead to measurement errors. Do not overfill the Dewar.

Dipstick
3-32                                                    Nov 2011



ASAP 2420 Operator’s Manual Filling Dewars
3. Check the level of the frozen condensation or wetness. It should not be above the 
maximum level indicator mark on the dipstick. 

condensation indicates 
Wetness or frozen 

Maximum level indicator mark

bath liquid level.
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Transferring a Degassed Sample to an Analysis Port

The sample tube must be removed from the degas port, weighed and then installed onto the 
analysis port for analysis.

1. Allow the sample tube to cool. 

2. Carefully remove the heating mantle clip and the heating mantle from the sample tube and 
allow the sample tube to cool to room temperature (approximately fifteen minutes). 

If the sample tube is not mounted to the analysis port immediately, either leave it on 
the degas port or remove it and insert the rubber stopper (unless you are using a 
seal frit) into the sample tube opening.

Do not touch the sample tube or the heating mantle until they have reached room 
temperature. Touching the sample tube, heating mantle, or heating mantle clip 
before they have cooled could result in burns.

Remove clip and
heating mantle; 
allow tube to cool
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3. While holding the sample tube, loosen the port connector nut and remove the sample tube 
from the degas port. If you are not using a seal frit, insert a stopper immediately.

4. Weigh the sample tube set. Enter the weight on the Sample Data Worksheet as Mass of 
sample tube plus sample (After Degas). 

5. Subtract the Mass of empty sample tube (Before Degas) from the Mass of sample tube plus 
sample (After Degas) to determine the mass of the sample. Record this value as the Mass 
of sample (After Degas). 

6. Remove the rubber stopper (if used) from the sample tube.

7. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube 
bulb. 
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8. Place the connector nut, ferrule, and O-ring onto the sample tube stem.

9. Attach the sample tube to the analysis port, pushing it fully up. Turn the connector nut 
clockwise to hand-tighten.

10. If you wish to degas a sample on the sample port, proceed to “Degassing Samples on 
Analysis Ports” on page 3-38.

  Isothermal jacket

O-ring (1/4 in. from top)

Ferrule

Connector nut

If you are using a TranSealTM, refer to the instructions in the TranSeal kit for information on 
sample tube installation.

Connector nut
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If not, place the sample tube Dewar cover over the sample tube stem just above the 
isothermal jacket as shown in the following illustration. Make sure the Po tube is next to 
the sample tube.

11. Place the safety shield over the sample tube and Dewar.

12. Begin the analysis. Refer to “Performing an Analysis” on page 3-44.

    

     Dewar cover

Po tube

Shield
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Degassing Samples on Analysis Ports

The characterization of microporous materials may be significantly improved by starting the 
analysis with the sample pre-evacuated. The additional time required for this user-interaction 
is often offset by improved analyses and faster run time. To avoid exposure to contaminants, it 
is often best to degas a microporous sample on the same port that will be used for analysis.

Side-lacing heating mantles, which are provided with the micropore option, are required for 
this type of degassing. For mantle part numbers, refer to “ORDERING INFORMATION” 
on page 10-1.

To degas a sample on an analysis port:

1. With the sample tube mounted in the sample port, position the Po tube so that it is away 
from the sample tube.

2. Slide the isothermal jacket up to the top of the sample tube.

The isothermal jacket fits tightly on the sample tube to ensure thermal stability. Use 
care when sliding it up or down.
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3. Select Unit [n] > Evacuate Analysis Port. The Evacuate Analysis Port dialog is 
displayed.

4. Select the port to which the sample tube is attached.

5. Select the evacuation parameters, then click Start.

6. Repeat steps 3 through 5 for each sample to be degassed.

7. Select Unit [n] > Show Analysis Schematic, then select Unit [n] > Enable Manual 
Control. The Manual Control screen is displayed.

8. When the evacuation(s) is/are finished, make sure valve 8 is left open ( ).
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9. Open the sample ports (1 through 6) which are in use. Also open corresponding Po ports 
11 through 16. Open ports 7, 9, and 10.

For example, if only four samples are to be degassed and they are on ports 1, 2, 3, and 5, 
then open ports 1, 2, 3, 5, 11, 12, 13, 15, 7, 9, and 10.

10. Insert the heating mantle thermocouple plug into the thermocouple connector on the degas 
portion of the analyzer below the sample port. Insert the heating mantle power plug into 
power connector below the thermocouple connector and twist to lock securely.

11. Loosen the lace on the heating mantle.

12. Slide the heating mantle around the sample tube, then tighten the lace.

13. Secure the heating mantle with a mantle clip.

Thermocouple plug

Power plug

      Clip

Heating mantle 
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14. Gently heat the sample:

a.  Select Unit [n] > Show Degas Schematic to display the Degas Schematic.

b. Right-click on the degas port to which the heating mantle power plug and thermocouple 
are connected, then select Set. 

c. Enter 10 oC/min. for Ramp rate.

d. Enter 200oC for Target temperature.

15. Allow the sample to degas for a minimum of one hour. (Additional time may be required 
to fully degas the sample.)
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16. Right-click on the degas port sample tube, then select Disable.

17. When the heating mantle is cool enough to handle, remove it from the sample tube.

18. Allow the sample to cool to room temperature.

19. Slide the isothermal jacket down.

20. Place the sample tube Dewar cover over the sample tube stem just above the isothermal 
jacket as shown in the following illustration. Make sure the Po tube is next to the sample 
tube.

Do not touch the sample tube or the heating mantle until they have cooled. 
Touching the sample tube, heating mantle, or heating mantle clip before they 
have cooled could result in burns.
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21. Place the safety shield over the sample tube and Dewar.

22. Begin the analysis. Refer to “Performing an Analysis” on page 3-44.

    

     Dewar cover

Po tube

Shield
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Performing an Analysis

Analyses may be performed in one of these modes:

• Standard
• Krypton
• High Throughput
• Micropore

In Standard mode, the system performs nitrogen, or similar, gas analyses at 77 K. All 
analyses must use the same gas. Samples can be removed and added to any of the six ports 
without disturbing the analyses being performed on other ports.

In Krypton mode, up to five Krypton analyses are started together. Port 6 is used to store 
Krypton for dosing. The data collection is done sequentially — one analysis starts and 
completes before the next is started. 

In High Throughput mode, up to six nitrogen, or similar, gas analyses are started together. 
All analyses must use the same analysis gas and the same Psat gas, which may be different 
from the analysis gas. Once a set is started, no other samples can be started until the set is 
complete. The data collection is done in parallel. This mode also supports measured freespace.

In Micropore mode, up to six analyses are started together. Once a set is started, no other 
samples can be started until the set is complete. For micropore analyses, side-lacing heating 
mantles with longer cables are provided to allow in-place degassing on sample ports.
 

Ensure that the analysis gas and the Psat gas (if used) specified in the sample file match the 
system configuration gases; if they do not, correct the sample information file or correct the 
unit configuration gas. You can check the system configuration gas by selecting Unit > Unit 
Configuration (refer to “Unit Configuration” on page 6-36).

Before beginning an analysis, make sure the tank pressure for the gas regulator is at 
least 200 psig. Pressures less than 200 psig may cause the sample to be 
inadequately saturated, resulting in inaccurate data or termination of analysis.
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Selecting or Creating a File for Analysis

All analyses require a sample information file. You may use a predefined sample information 
file (refer to “Creating Sample Information Files” on page 3-7) or create a sample 
information file, using default parameters, when starting an analysis or a degas operation.

When you start an analysis, the Select a File for Analysis dialog is displayed.

You can limit the files displayed in the Files list by specifying Selection Criteria (refer to “File 
Selection” on page 2-17).

Selecting a Predefined Sample Information File

1. Select a file from the Files list.

2. Click OK. The file name is displayed in the analysis dialog. 

Creating a Sample Information File

1. Enter a name for the file in the File name field.

2. Click OK. The following dialog is displayed.

3. Click Yes.

4. The file is created using the default parameters, and the file name is displayed in the 
analysis dialog.
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Standard Analysis

In standard analyses, the six ports operate independently. You can add and remove samples to 
and from ports without disturbing the operations on other ports. The only restriction is that you 
must use the same analysis gas (and the same Psat gas if saturation pressure is being 
measured) for all ports.

1. Select Unit > Start Analysis. The Sample Analysis dialog is displayed with the Start 
Analysis dialog positioned on top. This allows you to select a sample file for your analysis 
or to create a new one. (Refer to “Selecting or Creating a File for Analysis” on page 3-
45).

2. After you have designated a sample file, the Sample Analysis dialog is displayed. The 
fields now contain the values for the selected file or, if you are creating a new file, the 
specified defaults.

3. Verify parameters and make any changes necessary.

4. To generate a report automatically after the analysis, click Report after Analysis and 
choose report output options. (Refer to “Report Settings” on page 2-21).

5. Click Start to begin the analysis; as data are collected, a graph is drawn in the window.

6. When the analysis is complete, the Start button changes to Next.

7. Click Close to exit or Next to perform another analysis. If you click Next, the first view of 
the Analysis dialog is displayed.
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Krypton Analysis

You can perform from one to five krypton analyses using ports 1 through 5. Port 6 is reserved 
for purifying and storing krypton, which is used for dosing. Once a set of analyses is started, 
no other samples can be started until the set is complete. 

1. Make sure the port 6 Dewar contains analysis bath liquid.

2. Install a blank sample tube on port 6, and place a Dewar cover over the sample tube stem 
and the Po tube stem.

3. Select Unit > Start Krypton Analysis. The Krypton Analysis dialog is displayed.    

4. For each port on which you want to start an analysis:

a.  Click Browse and select a sample file. Refer to “Selecting or Creating a File for 
Analysis” on page 3-45.

b.  You may change the mass, density, and warm and cold free space if necessary.

Krypton analyses are available only if the Krypton option is installed on the analyzer.

The Dewar below port 6 must be at least 50% full of the analysis bath liquid and a 
blank sample tube must be installed on port 6 before starting a krypton analysis.
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5. If you wish to print a report after analysis, click Report after analysis (refer to “Report 
Settings” on page 2-21).

6. Click Start to begin the analysis; as data are collected, a graph is drawn in the window.

7. If you wish to view an analysis report, click the appropriate Report Port button.

8. When the analysis is complete, the Start button changes to Next.

9. Click Close to exit or Next to perform another analysis. If you click Next, the first view of 
the Analysis dialog is displayed.
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High Throughput Analysis

You can perform from one to six analyses simultaneously. Once a set of analyses is started, no 
other samples can be started until the set is complete. 

1. Select Unit > Start High Throughput Analysis. The High Throughput Analysis dialog is 
displayed.

2. For each port on which you want to start an analysis:

a.  Click Browse and select a sample file. Refer to “Selecting or Creating a File for 
Analysis” on page 3-45.

b.  You may change the mass, density, and warm and cold free space if necessary.

3. If you wish to print a report after analysis, click Report after analysis (refer to “Report 
Settings” on page 2-21).
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4. Click Start to begin the analysis; as data are collected, a graph is drawn in the window.

5. If you wish to view an analysis report, click the appropriate Report Port button.

6. When the analysis is complete, the Start button changes to Next.

7. Click Close to exit or Next to perform another analysis. If you click Next, the first view of 
the Analysis dialog is displayed.
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Micropore Analysis

You can perform from one to six analyses simultaneously. Once a set of analyses is started, no 
other samples can be started until the set is complete. 

1. Select Unit > Start Micropore Analysis. The Micropore Analysis dialog is displayed.

2. For each port on which you want to start an analysis:

a.  Click Browse and select a sample file. Refer to “Selecting or Creating a File for 
Analysis” on page 3-45.

If you select a sample file that does not have low dosing enabled, the following 
message is displayed.

Micropore analyses are available only if the Micropore option is installed on the 
analyzer.
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Select Yes to continue without low dosing or No if you wish to change the sample file.

b.  You may change the mass, density, and warm and cold free space if necessary.

3. If you wish to print a report after analysis, click Report after analysis (refer to “Report 
Settings” on page 2-21).

4. Click Start to begin the analysis; as data are collected, a graph is drawn in the window.

5. If you wish to view an analysis report, click the appropriate Report Port button.

6. When the analysis is complete, the Start button changes to Next.

7. Click Close to exit or Next to perform another analysis. If you click Next, the first view of 
the Analysis dialog is displayed.
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Printing File Contents

You can print the contents of one or more sample or parameter files.

1. Select File > Print; a drop-down list containing file types is displayed. 

2. Choose the file type; a dialog similar to this one is displayed.

3. From the Files list select the desired file. If you plan to print multiple files, hold down Ctrl 
while clicking on the desired files.

4. In the Settings group box, select the destination. The choices are Printer, Screen, or File. 

If you choose Printer, enter the number of copies, from 1 to 4.

If you choose File, enter a file name.

5. Click OK; the file is printed to the specified destination.

You can use the Status drop-down list and/or the Date Range push button to limit the 
files displayed in the Files list. Refer to “File Selection” on page 2-17.
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Generating a List of File Statistics

You can generate a list of the following information on a sample file or parameter file.

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

Perform the following steps to list file statistics:

1. Select File > List.

2. From the List drop-down menu, select the type of file on which you wish information. A 
dialog similar to the one shown below is displayed:

3. From the Files list box, choose the desired file(s). If you wish to include all files, leave all 
files deselected. 

4. In the Settings group box, select the destination. The choices are Printer, Screen, or File. 

If you choose, Printer, enter the number of copies, from 1 to 4.

If you choose, File, enter a file name. 

5. Click OK, a list for the requested file(s) is sent to the specified destination.

Displays the type of file
on which you requested
information; in this
example, a sample
information file 
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Exporting Isotherm Data

The Export option on the File menu allows you to copy the isotherm data in the sample 
information file and reformat it in ASCII text. If saved to a File, the data can be imported into 
applications, such as spreadsheets. The output file consists of four columns containing the 
absolute pressure, relative pressure, specific volume adsorbed, and the elapsed time.

Perform the following steps to export a sample information file or ASCII data:

1. Select File > Export; the Export Sample Information dialog is displayed.

2. From the Files list box, choose the file(s) you wish to export. You can select multiple files 
by holding down Ctrl while clicking on the desired files. 

3. In the Settings group box, Isotherm is displayed in the Export Type field. This is a Read-
Only field.

The other fields are used to specify the destination. Select Printer, Screen, or File from the 
drop-down list. 

If you choose Printer, enter the number of copies, from 1 to 4.

If you choose File, enter a file name. If you have selected multiple files, each file is 
exported as its file name with the extension .ISO.

4. Click OK; the file(s) is exported to the specified destination.

You can use the Status drop-down list and/or the Date Range push button to limit the 
files displayed in the Files list. Refer to “File Selection” on page 2-17.
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Generating Graph Overlays

Use graph overlays when you wish to compare graphically results for multiple samples or 
multiple graphs for one sample. Graphical lines are differentiated by the use of varying 
symbols and reported in a legend on the report. If color output capability is available, different 
colors are used instead of symbols.

Graph overlays can be generated in two ways:

• Multiple Sample Overlays 
Overlay results for up to eight samples on top of a previously selected sample. 

• Multiple Graph Overlays
Overlay two different types of graphs from one sample. The multiple graph overlay capa-
bility exists for:

BJH Adsorption or Desorption
DFT Pore Size/Surface Energy
Horvath-Kawazoe
MP-Method

• You cannot overlay graphs if your sample file presentation is in the Basic format. You 
must switch to the Advanced format before proceeding.

Multiple Samples Overlay

1. Select File > Open > Sample Information to display the Open Sample Information File 
dialog box. 

2. Select a sample on which to overlay graphs of other samples, then click OK; the Sample 
Information dialog is displayed.
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3. Click the Report Options tab to display the Report Options dialog.

4. Make your report selections (or deselect any you do not wish to generate).

5. Choose the type of report for which you wish to generate overlays; perform the steps 
below:

If overlaying this 
type of report...

Then...

Alpha-S
Isotherm
BET/Langmuir surface area
F-ratio
Freundlich
Temkin
t-Plot

Select the report for which you want an overlay, then click 
Edit. A report options dialog for that report is displayed.

Select Overlay Samples and do any other editing you 
wish.

Click OK; the main Report Options dialog reappears.
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6. Click Overlays; the Graph Overlay Samples dialog is displayed.

7. Click Browse to the right of the Sample 1 field; the Plot Overlay Sample Selection dialog 
is displayed.

8. Choose a sample file, then click OK. You may choose up to eight files in this manner.

Dubinin Select Dubinin, then click Edit; a Report Options dialog 
box for Dubinin is displayed.

Select the desired graph, then click Edit. An options dialog 
box for that graph is displayed (for example, dV/dw Pore 
Volume).

Select Overlay Samples and do any other editing you wish.

Click OK; the options dialog box for Dubinin reappears.

Click OK; the main Report Options dialog box reappears.

BJH Adsorption
BJH Desorption
DFT Pore Size
DFT Surface Energy
Horvath-Kawazoe
MP-Method

Select the report for which you want an overlay, then click 
Edit. A Report Options dialog for that report is displayed.

Select the desired report, then click Edit. An options dialog 
for that graph is displayed.

Click on the down-arrow at the Overlay field and select 
Samples; do any other editing you wish.

Click OK; the options dialog for the selected report 
reappears. Do any other editing you wish. 

Click OK; the main Report Options dialog reappears.
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9. After selecting the desired number of sample files, click OK; the main Report Options 
dialog reappears.

10. Click Save if you wish to save your Selected Reports list in the sample information file. 

11. Select Reports > Start Report. The Start Report screen is displayed with the name of the 
sample information file you edited highlighted. 

12. Click Report; the Select Reports dialog is displayed.

13. Ensure that the desired graph is selected (preceded with a check mark), then click OK.
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Multiple Graphs Overlay

Remember that multiple graph overlays can be done only for:

• BJH Adsorption
• BJH Desorption
• DFT Pore Size
• DFT Surface Energy
• Horvath-Kawazoe
• MP-Method

1. Select File > Open > Sample Information to display the Open Sample Information File 
dialog box.

2. Select a sample for which you want to overlay two graphs; then select Edit; the Sample 
Information dialog box is displayed.

3. Click the Report Options tab to display the Report Options dialog.

4. Make your report selections (or deselect any you do not wish to generate).
3-60                                                    Nov 2011



ASAP 2420 Operator’s Manual Generating Graph Overlays
5. Select the report for which you want multiple graph overlays from the Selected Reports 
list, then select Edit; a Report Options dialog for that report (or graph) is displayed (this 
example shows cumulative pore volume).

6. Click the down arrow at the Overlay field and select a graph type from the list. This 
selection will be overlaid on the graph selected in the Variable field.

7. Select OK to return to the selected Report Options dialog; do any editing you wish.

8. Click OK to return to the main Report Options dialog.

9. Click Save to save your Selected Reports list. Even if you don’t save, all of the options 
regarding overlays and anything else are available as your reports are run. 

10. Select Reports > Start Report; the Start Report screen is displayed with the name of your 
primary file highlighted. 

11. Click OK; the Select Reports dialog is displayed. 

12. Ensure that the desired graph is selected (preceded with a check mark), then click OK.
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SOFTWARE AND SETUP MODIFICATIONS

This chapter provides instructions for:

• Installing the software
• Using the Setup Program for other functions

Installing the Software

The following prerequisites must be completed prior to installing the software:

• Configure an ethernet port on the computer to communicate with the analyzer. Refer to 
“ETHERNET CONFIGURATION” on page D-1.

• Attach the analyzer to the computer’s configured ethernet port and turn on the power to the 
analyzer.

CDs containing calibration files end with a suffix of 99. Update CDs end with a suffix of 00.

The ASAP 2420 analysis program is supplied on a CD. Install the program as follows:

1. Insert the CD into the CD-ROM drive.

2. Select Start from the Status bar, then Run from the Start menu.

3. Enter the drive designator for the CD-ROM drive, followed by setup. For example:

e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select 
setup.exe.

If installing multiple analyzers, connect the ethernet switch to the computer’s 
configured port and connect the analyzers to the ethernet switch (refer to “Adding an 
Analyzer” on page 4-12). Then turn the analyzers on.

The application should not be installed on a network drive with shared access. 
Multiple users cannot operate the application at the same time.

Proceed to Step 4 if AutoPlay is enabled on your computer; Setup will start 
automatically and display the New Installation dialog.
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4. Click OK; the New Installation dialog is displayed.

The Destination Folder group box displays the amount of current disk space required for 
the analysis program and the directory into which the application will be installed. If you 
prefer a different directory for installation, click Browse to select the desired directory.

5. Select the check box just below the Destination Folder group box to add an icon to your 
desktop; this enables quick access to the analysis program.

6. The ASAP 2420 icon is added to the Micromeritics folder by default. If you prefer a 
different folder, enter or select one from the drop-down list.

7. The Install this application for All Users check box enables you to allow or prohibit 
users other than the installer to access the application.

• Select the check box to allow access for all users logged onto Windows.
• Deselect the check box to allow access for only the user installing the application.

Displays the amount 
of current disk space 
available and the 
amount required for 
installation of the 
analysis program. 

The ASAP 2420 application should not be installed on a network drive with shared 
access. Multiple users cannot operate the application at the same time.
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8. Click Next; the Analyzer configuration dialog is displayed.

a. In the Step 1 group box:

b. In the Step 2 group box, enter the serial number(s) for the analyzer(s) you are 
attaching to this computer.

If.... Then....

you are installing the 
analysis program at 
initial installation:

select the number of analyzers you are installing. (If 
installing two analyzers, additional hardware is 
required; refer to Adding an Analyzer on page 4-12 
for detailed information.)

you plan to use the 
analysis program for 
offline data reduction:

select 0

you are moving an 
analyzer from another 
computer to this one:

select 0. (Refer to Moving an Analyzer from One 
Computer to Another Computer on page 4-14.)
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9. Click Next. The following dialog is displayed.

Choose one of the following:

• If the port you plan to use is listed, select the port and proceed to the next step.

• If the port you plan to use is not listed and you have configured the port, click Specify 

and select the port. Then click Next.

• If the port you plan to use is not listed and you have not configured the port, exit the 
Setup program, configure the desired ethernet port (refer to “Configuring an Ethernet 
Port” on page F-3), and run the Setup program again. Click Port Configuration Help 
to view the requirements for a suitable ethernet port. 

10. Click Next; the Calibration File Installation dialog is displayed. Read the information 
displayed on the dialog and proceed accordingly. 

If the ethernet port 
you plan to use is 
not listed, click 
this button to view 
the requirements 
for a suitable port

If you selected 0 as the number of instruments, the calibration dialog will not 
display.
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11. The Installation Complete dialog containing the Readme file will display when installation 
is complete. This dialog may also contain other important notices.

After reading the information contained in this dialog, click Finish to close it. 

12. The Calibration File Installation screen displays.
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Calibration files are located on a separate calibration CD. Replace the setup CD with the 
calibration CD and browse to the calib directory.

To prevent the CD from AutoPlay, press and hold down the Shift key before closing the 
CD door. Do not release the Shift key until the CD light stops blinking.

If installing more than one instrument on the same computer, when the calibration files for 
the first unit have installed, insert the CD for subsequent units.

Click Next.

13. At the Media change screen, if the original setup CD was removed to install the 
calibration files, re-insert the original setup CD at this time. To prevent Autoplay from 
starting, before closing the CD door, hold down the SHIFT key until the CD light stops 
blinking.

14. Click OK.

15. When the Installation Complete screen displays again, click Finish.
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Using the Setup Program for Other Functions

After initial installation of the ASAP 2420 analysis program, the application setup program 
can be used to:

• install software upgrades
• add a second analyzer
• move an analyzer from one computer to another computer
• remove an analyzer from the computer
• reinstall calibration files
• uninstall the analysis program

Starting the Application Setup Program

1. Ensure that the analysis program is not operating.

2. Insert the CD into your CD-ROM drive.

3. Select Start from the Status bar, then Run from the start menu.

4. Enter the drive designator of the CD-ROM drive, followed by setup. For example:

e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select 
setup.exe.Click OK; the setup Welcome screen showing the options available is displayed.

Options available
for the ASAP 2420
are enabled.
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5. Select the operation you wish to perform. Procedures for performing each operation are in 
subsequent sections.

After the requested operation is completed, the setup Welcome screen is again displayed. 
A confirmation message indicating completion of the operation is shown in the lower 
section of the dialog.

6. After you have completed all desired operations, click Exit to close the dialog.

7. Remove the CD and store in a secure location.

Indicates status of
last operation
performed
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Installing Subsequent Software Versions

When you install a software upgrade, the system installs all of the application files and any 
status files that do not already exist on the computer. Existing analyzer status files are not 
affected and default and data files are not overwritten. There are three types of subsequent 
installation; the software version controlled by the setup program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. Start the Setup program (see “Starting the Application Setup Program” on page 4-9). 
Choose the software option; remember, only the applicable option will display:

•   Upgrade software to version (number) from version (number)
•   Reinstall software version (number)
•   Downgrade software to version (number) from version (number)

2. Click Start File Installation; the application installs the software and displays the 
Installation Complete dialog. 

3. Click Finish.

4. The setup Welcome dialog is displayed. If no other operations are desired using this 
dialog, click Exit to close the dialog.
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Adding an Analyzer

The following items are required for installing a second analyzer:

• One Ethernet switch, capable of communicating with a 10 base-T ethernet card

• Three standard (straight-through) Ethernet cables, one for each analyzer and one for 
connecting the computer and the Ethernet switch

1. Connect the power cord of the Ethernet switch to an appropriate power outlet.

2. Disconnect the Ethernet crossover cable that is connected to the current analyzer and 
computer; store in a safe place.

3. Connect one end of a standard Ethernet cable to the Ethernet connector (exposed on the 
rear panel of the computer) and the other end to a numbered port on the Ethernet switch 
(do not use the uplink port).

4. Connect one end of a standard Ethernet cable to the connector labeled Ethernet on the 
rear panel of each analyzer and the other ends to numbered ports on the Ethernet switch. 
The finished configuration should look like the following illustration. 

5. Turn on the computer and both analyzers.

6. Insert the analysis program CD into the CD-ROM drive.

Be sure the analyzer and computer are turned off before performing this 
procedure.

Analyzer 2

Analyzer 1

Computer

Ethernet switch

Be sure cables are not 
connected to the uplink port.
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7. Start the Setup program (refer to Using the Setup Program for Other Functions on 
page 4-9). Select Add an analyzer, then click Next; the Setup analyzer dialog is 
displayed.

8. Enter the serial number of the analyzer being added.

9. Click Next; the Calibration File Installation dialog is displayed (for the analyzer you are 
adding). Read the information displayed on the dialog and proceed accordingly. 

The Installation Complete dialog containing the Readme file will display when 
installation is complete. This dialog may also contain other important notices.

10. After reading the information contained in this dialog, click Finish to close it. 

11. Remove the program CD and store in a secure location. The original program CD 
contains the calibration files specific to your instrument. Upgrade CDs do not contain 
calibration files. Therefore, it is important that you maintain your original program CD in 
a secure location in the event calibration files need to be reinstalled.
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Moving an Analyzer from One Computer to Another Computer

Use the instructions in this section to move a configured analyzer, along with its status and log 
files, from one computer (Source PC) to a different computer (Destination PC). This operation 
does not move sample or parameter files. Use a file management program such as Explorer or 
a backup/restore utility to move these type of files.

Moving a Configured Analyzer to a New Computer

This section provides steps for moving a configured analyzer to a computer that does not have 
an analyzer installed.

1. Install the analysis program on the destination computer (refer to “Installing the 
Software” on page 4-3). Be sure to select 0 as the number of instruments; all related 
instrument information will be transferred in the Move operation.

2. Start the application setup program on the source computer (refer to “Starting the 
Application Setup Program” on page 4-9).

3. Select Move an analyzer from one PC to another PC, then click Next; the Move 
analyzer operation dialog is displayed.

If the analysis program is already installed on the destination computer, proceed 
to Step 2.
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4. Select Source PC, then click Next; the following dialog is displayed.

5. From the drop-down list in the Step 1 group box, select the analyzer that is to be moved 
from this computer.

6. In the Step 2 group box, click Browse to select a location for storing the status and log 
files associated with the source computer. If possible, the location should be a shared 
network drive. If this is not possible, select a local folder and then use a transfer utility to 
copy its contents from the Source PC to the Destination PC.

7. Click Next; the files are copied to the specified location and the setup Welcome screen is 
displayed.

8. Start the Setup program on the destination computer (refer to “Starting the Application 
Setup Program” on page 4-9).

9. Select Move an analyzer from one PC to another PC; the Move analyzer operation 
dialog is displayed.

Sample and parameter files are not copied and moved with the analyzer. Use  a 
file management program such as Explorer or a backup/restore utility to move 
these files.
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10. Select Destination PC, then click Next; the Move analyzer information to this PC dialog 
is displayed.

11. In the Step 1 group box, enter the serial number of the unit you are adding.

12. In the Step 2 group box, click Browse to choose the location of the files that were stored 
previously from the Source computer.

13. Click Next; the files are transferred and the setup Welcome screen is displayed. Click Exit 
to close the dialog.

14. Turn on the analyzer and start the analysis program.

Moving a Configured Analyzer to a Computer with an Existing Analyzer

This section provides steps for moving a configured analyzer to a computer that already has 
the analysis program and a configured analyzer installed, this being the second analyzer. 
When installing two analyzers on one computer, additional hardware is required.

1. Perform Steps 2 through 7 (steps for Source computer) of the procedure Moving an 
Analyzer from One Computer to Another on page 4-14.

2. Disconnect the Ethernet cable of the analyzer from the Source computer (or Ethernet 
switch). Reconnect the cable to the Ethernet switch for the Destination computer. You 
must use a switch when attaching multiple analyzers. Refer to Adding an Analyzer, page 
4-12 for configuring ethernet connections using a switch.
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3. After ethernet connections have been established, return to page 4-14 and begin with Step 
8 (steps for Destination computer). You will not see the Ethernet Ports dialog (Step 13) 
since an ethernet port has already been assigned.

4. Turn on both analyzers and start the analysis program. 

If the Ethernet cable is connected to a switch, the cable can be used with the 
Destination computer. If it is connected to the back of the computer, it is a 
crossover cable and must be exchanged for a standard Ethernet cable.
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Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an analyzer, the 
status files are removed as well.

1. Start the application setup program on the source computer (refer to “Starting the 
Application Setup Program” on page 4-9).

2. Select Remove an analyzer, then click Next; the Remove an analyzer dialog is displayed.

3. From the drop-down list, choose the serial number of the analyzer you wish to remove.

4. Click Remove; the analyzer is removed and the Welcome screen is displayed.

5. Click Exit to close the dialog.
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Reinstalling Calibration Files

Calibration files specific to the analyzer are contained on the original program CD; they are 
not contained on an update CD. It is important that you store your original program CD in a 
safe location. The Micromeritics part number on CDs containing calibration files will always 
end with a suffix of 99. Update CDs end with a suffix of 00.

Reinstall calibration files as follows:

1. Start the Setup program. See “Starting the Application Setup Program” on page 4-9.

2. Select Re-install calibration files for an analyzer, then click Next; the Re-install 
calibration files dialog is displayed.

3. Select the analyzer whose calibration files you wish to reinstall from the drop-down list. 
If you have only one analyzer installed, a drop-down list is not included.

4. Ensure that the CD drive is displayed as the Calibration file source location. If not, click 
Browse and choose the CD drive.

5. Click Next; the calibration files are reinstalled and the Welcome dialog is displayed.

6. Click Exit to close the dialog.

Not shown if only 
one analyzer is 
installed.

If you did not use the original program CD to start the Setup program, you must 
insert it now since it contains the calibration files. You do not have to exit the 
Setup program. Simply remove the CD and insert the program CD.
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Uninstalling the Analysis Program

You can remove the ASAP 2420 analysis program as follows. When you perform this 
operation, the application removes the analysis program, status files, analyzer setup files, and 
resulting empty directories. It does not remove data files.

1. Start the Setup program. See “Starting the Application Setup Program” on page 4-9.

2. Select Uninstall, then click Next; the Uninstall dialog is displayed.

3. Click Uninstall; the Select Uninstall Method dialog is displayed.

4. Choose one of the following:

• Automatic: click Next; the system uninstalls the ASAP 2420 software automatically 
and the setup Welcome dialog redisplays.

• Custom: click Next; a series of dialogs is displayed, allowing you to choose the files 
you wish to uninstall. After all files are selected and uninstalled, the setup Welcome 
dialog redisplays.

5. Click Exit to close the Welcome dialog.
4-20                                                    Nov 2011



 

5 FILE MENU

Description 5-3

Open 5-4

Save 5-91

Save As 5-91

Save All 5-92

Close 5-93

Close All 5-93

Print 5-93

List 5-95

Export 5-96

Convert 5-98

Exit 5-100
Nov 2011                                               5-1 



ASAP 2420 Operator’s Manual
5-2                                                    Nov 2011



ASAP 2420 Operator’s Manual Description
FILE MENU

The File menu contains commands which allow you to manage sample and parameter files.

Description

Listed below are brief descriptions of the File menu commands. Detailed descriptions follow 
this section.

Open Opens an existing sample information or parameter file or 
creates a new one.

Save Saves the file in the active window.

Save As Saves the file in the active window as a different name. You 
also can use this option to save a subset of the sample file as a 
parameter file.

Save All Saves all open files.

Close Closes the file in the active window.

Close All Closes all open files.

Print Prints the contents of a sample or parameter file. 
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Open

Open allows you to create a new file or edit an existing one. The following file types are 
available:

• Sample information
• Sample tube
• Degas conditions
• Analysis conditions
• Adsorptive properties
• Report options

Regardless of which file type you select, a dialog similar to the one shown here is displayed.

List Generates a list of certain information for sample or 
parameter files. 

Export Copies the isotherm data in a sample information file and 
exports it in ASCII format.

Convert Allows you to convert a sample file in the ASAP 2405 format 
to a format compatible with the ASAP 2420 program.

Exit Exits the analysis program.
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File name For sample information files, this field contains the next 
sequenced file name (as specified in sample defaults) 
generated by the system. If this is a new file, you can use the 
name displayed or enter a different one.

For parameter files, the file name displayed includes the wild 
card (*) and a default extension as follows:

*.DEG for degas conditions
*.STB for sample tube 
*.ANC for analysis conditions
*.ADP for adsorptive properties
*.RPO for report options

If you are creating a new file, enter a name in the File name 
field. You can use up to 8 characters.

If you are opening an existing file, select the name from the 
Files window, then click OK. 

Selection Criteria Refer to “File Selection” on page 2-17.

Status Refer to “Selecting a File Status” on page 2-19.

Date Range Refer to “Selecting a Range of Dates” on page 2-20.

Directories Refer to “Selecting a Directory” on page 2-18.
Nov 2011                                            5-5 



Open ASAP 2420 Operator’s Manual
Sample Information

Sample information files contain information used to control an analysis and store analysis 
results. Therefore, an analysis cannot proceed until it has been assigned a sample information 
file. A sample information file consists of the following:

• sample identification
• sample tube criteria
• analysis conditions
• adsorptive properties
• report options
• collected or entered data

Portions of the sample information file can also exist as standalone parameter files. Having 
these files exist independently allows you to use them as many times as you wish. For 
example, if you typically use the same analysis conditions, you can enter them in an analysis 
conditions file. Then when you create a sample file, select the analysis conditions file; the 
values will be copied into the sample file. After it becomes part of the new sample file, you 
can edit it as desired. The file from which the values were copied remains intact and ready for 
the next use.

Sample information files can be created and presented in the Advanced, Basic, or Restricted 
format. (You can select which format to display by selecting Options > Option 
Presentation).

• Advanced
Presents all parts of the sample information file in a tabbed dialog. Each tab opens its asso-
ciated dialog, allowing you to edit conditions. You can also switch to the Basic format if 
desired.

• Basic
Presents all parts of the sample information file as a single dialog. This format allows you 
to quickly create a sample information file using predefined parameter files. You can also 
switch to the Advanced format if desired.

• Restricted
Identical to the Basic format except that you cannot switch to the Advanced format for 
editing; certain functions are also disabled.
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Advanced Format

The Advanced format displays all parts of the sample file in a tabbed dialog. This format 
allows you to customize your sample file moving easily among the parameters simply by 
clicking on the tabs. Alternatively, you can use Prev and Next. Refer to “Advanced Format” 
on page 3-9 for step-by-step instructions on creating a sample information file using the 
Advanced format.

Sample Contains the description of the current sample file. 

If this is a new file, this field contains the file description 
specified in Sample Defaults. The above dialog box shows 
the sample file number because the dollar ($) symbol was 
included when sample defaults were specified.

You can enter a new description or edit the existing one if 
desired.
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Operator
Submitter

Displays the operator and submitter names in the current 
sample file.

If this is a new file, these fields contain the names specified 
in Sample Defaults.

You can enter a different name or edit the current one if 
desired. 

Either (or both) of these fields can be prevented from 
displaying on this dialog by selecting Omit in Sample 
Defaults. The labels also can be edited in Sample Defaults 
(refer to “Sample Defaults” on page 8-6).

Mass You can enter a sample mass or have the mass calculated 
automatically.

Enter Enables the Sample Mass field allowing you to enter a 
value.

Calculate Enables the Empty tube and Sample + tube fields, allowing 
you to enter appropriate values. These values are used to cal-
culate the mass of the sample, 

               

You should always use the same gas (typically nitrogen) for degassing and analysis. 
If different gases are used, the mass of the sample tube plus sample after degas and 
after analysis will not be equal. For example, if you use helium to backfill after 
degassing and nitrogen after analysis, you can get as much as a 0.02-gram 
difference.

Density Enter the sample density.

Type of Data Displays the type of data for the current sample file.

If this is a new file, choose whether you wish to have data 
collected automatically or if you plan to enter data collected 
from another source.

Comments Allows you to enter information about the sample or 
analysis. The information you enter in this window is 
displayed in the report header. You may enter up to 500 
characters in this window.

Masssample Masssample tube+ Masstube–=
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Basic Format

The Basic format displays all parts (parameters) of the file on a single dialog. With this format, 
you can quickly create a sample information file using predefined parameter files. You can 
also switch to the Advanced format if a specific parameter requires editing. Refer to “Basic 
and Restricted Formats” on page 3-11 for step-by-step instructions for creating a sample 

Save Refer to “Save” on page 2-14.

Add Log Entry Displays the Add Log Entry dialog allowing you to enter 
text that will appear in the log report.

Enter the desired text, then click OK.

Close Refer to “Close” on page 2-14.

Basic
Switches the sample editor to the Basic format.
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information file using the Basic format.

If you are creating a new file, this dialog displays the defaults you specified in 
Sample Defaults. Refer to “Sample Defaults” on page 8-6.

Sample Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced file 
description based on the format specified in Sample Defaults. 
The above dialog box shows the sample file number because 
the dollar ($) symbol was included when sample defaults 
were specified.

You can enter a new description or edit the existing one if 
desired.

Mass Allows you to enter the sample mass. If you are using the 
Sample Data worksheet, this is the value recorded for Mass of 
Sample after Degas.

Enter Enables the Sample Mass field allowing you to enter a value.
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Restricted Format

The Restricted format is used when analysis parameters must remain constant. For example, in 
the pharmaceutical industry where consistency and accuracy are crucial. A password is 
required to enter and exit this format.

When you open an existing sample information file or create a new one using the Restricted 
format, all parts of the sample file are displayed in the same manner as the Basic format. Some 
menu functions, however, are disabled and you cannot switch to the Advanced format to edit 

Calculate Enables the Empty tube and Sample + tube fields, allowing 
you to enter appropriate values. These values are used to cal-
culate the mass of the sample, 

               

Density
Enter the sample density.

Sample tube
Degas conditions
Analysis conditions
Adsorptive properties
Report options

Each parameter field contains the description of the current 
parameter file.

If this is a new sample file, these fields contain the 
descriptions of the files chosen as the defaults.

Click on the down arrow to the right of each field to choose a 
different file. File parameters can be viewed or edited by 
switching to the Advanced format.

Replace All Refer to “Replace All” on page 2-16.

Save Refer to “Save” on page 2-14.

Close Refer to “Close” on page 2-14.

Advanced Switches the sample editor to the Advanced format, allowing 
you to view or edit parameters of the current file.

Masssample Masssample tube+ Masstube–=
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file parameters.

Sample Tube

The fields on this dialog are used for storing sample tube information. Before creating a 
sample tube file, you should perform a blank analysis (no sample) using the sample tube.

Sample Tube Contains the description of the current file.

If this is a new file, this field contains the description you 
specified as the default. You can enter a new description or 
add to the existing one if desired.
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Replace Use this push button to replace the values of the current file 
with those from an existing file. The Open Sample Tube 
dialog is displayed, allowing you to choose a file. After the 
values are copied into the current file, you can edit them as 
desired.

Warm free space Displays the warm free space for the current file.

Cold free space Displays the cold free space for the current file.

Non-ideality factor Displays the non-ideality factor determined during the blank 
analysis.

Use isothermal jacket Select this option if an isothermal jacket is to be used in the 
analysis.

Use filler rod Select this option if a filler rod is to be used in the sample 
tube.

Vacuum seal type If the sample tube has a seal frit installed, select Seal Frit. If 
not, leave None selected.

Load From Sample File Click this push button to choose the sample file that was used 
in the blank analysis. The collected data for the Warm and 
Cold free spaces and the non-ideality factor will be copied 
into the sample tube file.

Save Refer to “Save” on page 2-14.

Close Refer to “Close” on page 2-14.
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Degas Conditions

The Degas operation is separated into an evacuation phase and a heating phase. The 
evacuation phase must be completed before the heating phase starts.

The fields on this dialog are used for specifying degas conditions.

Description Contains the description of the current Degas Conditions file.

If this is a new file, this field contains the name (description) 
you specified as the default. You can enter a new description 
or add to the existing one if desired.

Replace Refer to “Replace” on page 2-15.

Evacuation group box The options in this group box allow you to specify conditions 
for the evacuation phase of the degassing operation.

Temperature ramp 
rate

Allows you to specify the rate at which the temperature is to 
change while advancing to the target temperature during 
evacuation.

Target temperature Allows you to specify a temperature at which the sample will 
be held for the remainder of the evacuation.

Evacuation rate Enables you to specify an evacuation rate for initial 
evacuation.
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Unrestricted evac. 
from

Enables you to specify a pressure at which unrestricted 
sample evacuation will begin.

Vacuum setpoint Enables you to specify the vacuum level to be achieved 
before evacuation begins.

Evacuation time Enables you to specify how long the sample is to be 
evacuated prior to the second stage of heating.

Heating Phase table Allows you to specify conditions for the heating phase of the 
degassing operation.

Temperature Enables you to enter a target temperature for the heating 
phase of the sample.

Temperature Ramp 
Rate

Enter the rate at which the temperature is to change when 
advancing to the temperature.

Time Enter the amount of time at which to hold the sample at the 
target temperature.

Insert Inserts a row into the conditions table. A row is inserted 
above the selected line; the cursor moves to the new line.

Delete Deletes the selected row from the conditions table.

Clear Clears all entries contained in the conditions table. The rows 
do not have to be selected.

Hold Pressure If during the temperature ramp the pressure exceeds the value 
you enter in this field, the ramp will be suspended until the 
pressure returns to a safe level.

Backfill Sample Tube Select this option to have the sample tube backfilled. 

Select Automatically if you wish to have the sample tube 
backfilled automatically.

Select Wait for operator if the instrument should wait until 
the operator requests backfill.

Save Refer to “Save” on page 2-14.

Close Refer to “Close” on page 2-14.
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Analysis Conditions

The Analysis Conditions dialog allows you to specify the data used to guide the analysis. You 
can create an Analysis Conditions file as an independent parameter file or include it as part of 
the sample information file.

Refer to “Analysis Conditions” on page 3-15 for step-by-step instructions on creating an 
analysis conditions file.

 
Description Contains the description of the current Analysis Conditions 

file.

If this is a new file, this field contains the name you specified 
as the default. You can enter a new description or add to the 
existing one if desired.

Replace Refer to “Replace” on page 2-15.

Isotherm Collection The choices in this group box allow you to specify how you 
wish to have isotherms collected.

Target Pressures Select this option to have isotherms collected by specifying 
target pressures. When you select this option, Pressures and 
Options (directly to the right of this field) become enabled. 
Select each push button to verify or edit data.
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Pressures Displays the Entered Pressures dialog.

Edit the existing pressure table or clear the table and enter a 
new pressure table.

A pressure is a table of relative pressure points (and possibly 
calculation assignments) at which data (isotherms) are to be 
collected. The relative pressures may span the entire range of 
0.00000001 to 0.995 P/Po. There must be one adsorption 
branch followed, optionally, by one desorption branch.

Several analysis conditions files containing complete 
pressure tables are included with the ASAP 2420 software; 
they are located in the PARAMS subdirectory. These files 
(and all other parameter files) can be changed. If you want to 
use any of these files, it is recommended that you use the 
Save As option on the File menu to save the file as a different 
name, then make your changes.

The pressure table for automatically collected data includes 
the pressure points for data collection and (when Use 
calculation assignments is selected) identifies calculations 
through which the data are processed. The system processes 
data for the following reports:

BET surface area
Langmuir surface area
t-Plot
BJH Adsorption
BJH Desorption
Total pore volume
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Insert Inserts a row into the table above the selected line.

Delete Deletes the selected row.

Clear Removes all but one required entry from the table. The rows 
do not have to be selected. A warning message appears 
requesting confirmation before the table is cleared.

Insert Range Displays the Insert Pressure Range dialog box.

This dialog allows you to specify the starting pressure, the 
ending pressure, the number of points to insert within the 
specified range, and whether you wish to have linear or 
geometric progression.

Linear inserts evenly spaced points into your table.

Geometric from low pressure inserts geometrically spaced 
points from the low pressure range. For example, to insert 5 
points with a 0.01 starting pressure and a 0.16 ending 
pressure, the following points are inserted into the table:

0.01
0.02
0.04
0.08
0.16
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Geometric towards saturation inserts geometrically spaced 
points to the saturation pressure. For example, to insert 5 
points with a 0.84 starting pressure and a 0.99 ending 
pressure, the following points are inserted into the table:

0.84
0.92
0.96
0.98
0.99

Insert predefined Displays the Insert Predefined Pressures dialog.

Choose predefined pressure points for surface area, t-Plot 
micropore, and/or BJH adsorption/desorption.
Click on the down arrow for each field to choose the desired 
set of points. You can also specify Adsorption/ Desorption 
total pore volume and Saturation.
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Options Allows you to specify target pressure options; the Dosing 
Options dialog box is displayed.

First Pressure Fixed 
Dose

The most frequent use of this option is for performing a 
standard nitrogen analysis of mesoporous materials such as 
catalysts. This option can shorten the time required to reach 
the first point in the pressure table if the first pressure table 
point is low and the expected gas uptake of the sample is 
high.

The sample is dosed repeatedly at low pressures with a 
specified amount of gas until the first pressure point is 
reached. This initial dosing quickly meets the adsorptive 
demand of the sample.

The first point on the pressure table is the threshold value, 
triggering the transition from the Fixed Dose Mode to 
Pressure Table Mode. When the first pressure table value is 
reached, Fixed Dose Mode is disabled, and points are 
equilibrated and recorded in accordance with the specified 
pressure table. 

In the field adjacent to this option, enter the amount of gas 
that is to be added to the sample for each dose cycle. 
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Maximum volume 
increment

Select this option to determine when additional data points 
are collected between target pressures in regions of 
adsorption. When the maximum increment has been adsorbed 
since the last collected data point, another point is 
equilibrated and collected.

During desorption, this field is treated as a maximum volume 
“decrement” value.

Absolute and Relative 
pressure tolerance

The values entered in these fields are used to determine how 
close the actual pressure must be to each target pressure from 
the pressure table. At lower pressures the relative tolerance 
value is lower, and at higher pressures the absolute tolerance 
value is lower. The lesser of these two criteria is used to 
determine the tolerance.

For example, with relative tolerance = 5% and absolute 
tolerance = 5 mmHg, the relative tolerance at 40 mmHg 
target pressure is 5% of 40 mmHg, or 2 mmHg; 2 mmHg is 
smaller than the absolute tolerance of 5 mmHg, so 2 mmHg is 
used. At 200 mmHg target pressure, the relative tolerance is 
5% of 200 mmHg, or 10 mmHg; in this case, the absolute 
tolerance of 5 mmHg is lower and is used.

In the above example, a minimum pressure of 40 - 2 = 38 
mmHg must be attained to collect data for a target pressure of 
40 mmHg. For a target of 200 mmHg, 200 - 5 = 195 mmHg 
must be attained.

Normally, surface area measurement points are widely 
spaced, and the resulting measurement is not very sensitive to 
the precise location of points so wider tolerances may be 
used. Unnecessarily tight tolerances lengthen the analysis.

Low pressure 
incremental
dose mode

Choose this option when you are performing an analysis of 
microporous materials. At low pressures on Type 1 
isotherms, the pressure points are very closely spaced, 
making a useful pressure table difficult to define. Choosing 
this mode enables you to measure equilibrium points at 
approximately equal intervals on the quantity adsorbed axis. 
Each dose is fully equilibrated and recorded as a data point.
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Low pressure 
incremental
dose mode
(continued)

In this mode, the sample is successively dosed with a speci-
fied amount of gas until the first pressure point is reached. 
The first point is the threshold value, triggering the transition 
from Incremental Dose Mode to Pressure Table Mode. When 
the first pressure table value is reached, Incremental Dose 
Mode is disabled, and points are recorded in accordance with 
the specified pressure table. Because the data points recorded 
during Incremental Dose Mode may define most of the analy-
sis, one point on the pressure table can be sufficient and serve 
as the end point for the analysis.

This field is disabled if First Pressure Fixed Dose Mode is 
selected.

Dose amount Enter the amount of gas to be added to the sample for each 
data point until the first point on the pressure table is reached.

Enabled when Low pressure incremental dose mode is 
selected.

Equilibration delay Enabled when Low pressure incremental dose mode is 
selected.

Minimum: Prevents premature equilibration caused by 
reduced percentage sensitivity to pressure changes at the 
lowest pressures.

Maximum: Prevents the effects of long term temperature or 
pressure drift, which may cause the instrument to wait an 
excessive length of time for equilibration.

Dose Increments In this form of dosing, there is no predefined pressure table. 
The sample is dosed repeatedly with a fixed amount of gas 
and isotherm points are collected after equilibrating each 
dose. Each entry in the table defines how much to dose for a 
segment of the isotherm.
5-22                                                    Nov 2011



ASAP 2420 Operator’s Manual Open
Options Displays the Dose Increments dialog.

Insert or edit target ranges for up to 10 dose increments.

The current specified dose increments are displayed. The 
ending relative pressure and the dose amount (entered or as 
the fraction of the previous volume adsorbed) for each target 
range are shown.

Insert
Edit

Displays the Dose Increment Edit dialog.

Ending Pressure:
Enter the desired ending pressure of this segment.

Dose increment
Select this option to have the sample dosed with a specified 
amount of gas for each isotherm point taken.
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Insert
Edit
(continued)

Percent of Previous
Select this option to have the sample dosed with a percentage 
of the volume adsorbed during the previous interval of the 

table. For example, if in the previous segment 5 cm3 STP of 
gas was adsorbed and you enter 40% in this field, this 

segment will dose 2 cm3 STP for each isotherm point taken.

This feature is disabled for the first entry of the dose 
increment table.

Delete Deletes the selected range.

Clear Clears the table of all entries except one; one entry is 
required.

Low pressure incremental
dose mode

Enabled only if the MicroPore option is installed. Choose this 
option when you are performing an analysis of microporous 
materials. At low pressures on Type 1 isotherms, the pressure 
points are very closely spaced, making a useful pressure table 
difficult to define. Choosing this mode enables you to 
measure equilibrium points at approximately equal intervals 
on the quantity adsorbed axis. Each dose is fully equilibrated 
and recorded as a data point.

In this mode, the sample is successively dosed with a speci-
fied amount of gas until the first pressure point is reached. 
The first point is the threshold value, triggering the transition 
from Incremental Dose Mode to Pressure Table Mode. When 
the first pressure table value is reached, Incremental Dose 
Mode is disabled, and points are recorded in accordance with 
the specified pressure table. Because the data points recorded 
during Incremental Dose Mode may define most of the analy-
sis, one point on the pressure table can be sufficient and serve 
as the end point for the analysis.

This field is disabled if First Pressure Fixed Dose Mode is 
selected.

Dose amount Enter the amount of gas to be added to the sample for each 
data point until the first point on the pressure table is reached.

Enabled when Low pressure incremental dose mode is 
selected.
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Equilibration delay Enabled when Low pressure incremental dose mode is 
selected.

Minimum: Prevents premature equilibration caused by 
reduced percentage sensitivity to pressure changes at the 
lowest pressures.

Maximum: Prevents the effects of long term temperature or 
pressure drift, which may cause the instrument to wait an 
excessive length of time for equilibration.

Preparation

Fast evacuation

Displays the Analysis Preparation dialog.

Select Fast evacuation when analyzing samples (such as 
pellets) that do not fluidize or shed particles under 
evacuation.

If you deselect Fast evacuation, Evacuation rate and 
Unrestricted evac. from become enabled. Enter the desired 
evacuation rate and the pressure value at which unrestricted 
sample evacuation should begin.

 Vacuum setpoint Allows you to specify the vacuum level to be achieved before 
evacuation begins.

Evacuation time Enter the time you wish to allow for preliminary evacuation 
which takes place prior to free-space measurement.
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   Leak test Enables the system to check for leaks or sample outgassing 
before the analysis. The leak test allows sample pressure to 
rise during the test. If the pressure rises more than 0.15 
mmHg, the analysis does not proceed and you are notified. 
While leak testing slightly increases analysis time, it prevents 
the continuation of analysis and collection of erroneous data 
if a leak exists.

   Leak test duration Enables you to specify how long the pressure is to be 
monitored.

  Use TransSeal Select this option if you are using the TransSeal to transfer 
the sample from the preparation port to the analysis port 
under vacuum.

Free Space Allows you to specify free-space measurement conditions; 
the Free Space dialog is displayed.
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   Measure Select this option to have free space measured automatically 
by the system. 

Typically, it is best to measure the free space when analyzing 
macro- and mesoporous samples, and for routine surface area 
measurements. 

Select Lower dewar for evacuation to lower the Dewar 
following free-space measurements. 

Evacuation time enables you to specify how long evacuation 
is to take place following the measured free space.

Select Outgas test to check for system leaks or sample 
outgassing. After free space is measured, the Dewar is 
lowered and the sample evacuated for 30 minutes. The leak 
test is performed after evacuation. If a leak is found, the leak 
test repeats nine times, with 30 minutes evacuation between 
tests. If the 10th leak check fails, the analysis stops and you 
are notified. While leak testing slightly increases analysis 
time, it prevents the continuation of analysis and collection of 
erroneous data if a leak occurs.

Outgas test duration indicates the number of seconds the 
leak test is performed.

 Enter Select this option to enter values for the warm and free 
spaces. You may need to use this option if the sample retains 
helium and measurement of very low micron range pressures 
are required.

If you are creating a new file, this dialog displays the defaults you specified in 
Sample Defaults. Refer to “Sample Defaults” on page 8-6.

Warm free space is the sample tube gas capacity measured at 
room temperature.

Cold free space is the sample tube gas capacity measured 
with the Dewar raised.
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   Calculate Select this option to have the free-space measurement 
calculated. The free space is calculated using the mass, 
density, and sample tube parameters entered in the Sample 
Information and Sample Tube files. 

Calculated free space measurement takes less time than 
measured free space, so if you know the mass and density of 
the sample and the sample tube parameters, you may wish to 
use this choice of free space methods. If you do not know the 
parameters, you may wish to use measured free space.

Po and T Displays the Po and Temperature Options dialog box, 
allowing you to choose saturation pressure and analysis bath 
temperature.

This dialog provides six options for obtaining the saturation 
pressure (Po) and analysis bath temperature. Clicking on each 
option prompts you for the entry of related parameters in the 
lower portion of the dialog box. 

Displays as Analysis 
Bath Temperature only 
when Absolute dosing 
is selected (Analysis 
conditions dialog)
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Option Prompts for...

1 the analysis bath temperature

2 the analysis bath temperature

3 a Po; the analysis bath temperature is 
calculated at the time of analysis

an analysis bath temperature only (when 
Absolute pressure dosing is selected on the 
Analysis dialog)

4 a Psat gas 

Click Psat vs. T to edit the values of the Psat 
vs T table if desired. Editing the values in the 
current table does not affect the ones of the 
original table.

5 a Po; the analysis bath temperature is 
calculated at the time of analysis

6 an analysis bath temperature

Equilibration Displays the Equilibration dialog.

Relative Pressure 
(P/Po)

The relative pressure for which the equilibration interval will 
be applied. 

Does not display when 
Absolute Dosing is 
selected.
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 Equilibration Interval The number of seconds between successive pressure readings 
during equilibration. Long equilibration intervals tend to 
lengthen analyses, however, they do improve data integrity. 
Short equilibration intervals produce a faster analysis but 
may reduce the accuracy of data.

 Minimum 
equilibration delay 
at P/Po> = 0.995

The value entered in this field determines the minimum 
number of seconds required before equilibration can occur 
for a relative pressure greater than or equal to 0.995.

This field does not display if you select Absolute pressure 
dosing on the analysis conditions dialog.

Insert Inserts a row into the table above the selected line.

Delete Deletes the selected row.

Clear Removes all but one required entry from the table. The rows 
do not have to be selected. A warning message appears 
requesting confirmation before the table is cleared.

Backfill Displays the Sample Backfill Options dialog, allowing you to 
select options for backfilling the sample tube at the start and 
end of an analysis.

The options on this dialog are not available if the file status 
displayed in the Open Sample Information File dialog is 
Entered, Complete, or Analyzing.
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  Backfill sample at 
  start of analysis

Backfills the sample tube at the beginning of the analysis 
with the specified backfill gas.

For micropore analyses, it may be best not to select this 
option. Generally, it is best to manually evacuate the sample 
and start the analysis under vacuum. This minimizes any 
stray gas contamination.

 Backfill sample at 
 end of analysis

Backfills the sample tube at the end of the analysis with the 
specified backfill gas. If the sample mass is determined after 
the analysis, it is best to use nitrogen as the backfill gas.

It is recommended that you backfill the sample tube at the start and at the end of 
the analysis. If you deselect either backfill option, proceed with caution as damage 
to the analyzer or sample tube may occur.

 Backfill Gas Lists the available backfill gases. The gases in this list are 
the ones for which Adsorptive Properties files have been 
created; helium is also included.
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Adsorptive Properties

This dialog allows you to specify the characteristics of the gases used in the ASAP 2420 
system. An Adsorptive Properties file can be created as an independent parameter file or 
included as part of the sample information file.

Refer to “Adsorptive Properties” on page 3-16 for step-by-step instructions on creating 
adsorptive properties files.

Adsorptive If this is a new file, this field contains either the name of the 
default adsorptive gas or is blank. Enter the name of the 
desired adsorptive gas.

Replace Refer to “Replace” on page 2-15.

Mnemonic The mnemonic for the adsorptive gas. 

Maximum number of characters: 3 alphanumeric

Non-condensity 
Adsorptive

Select this option if this file is for a non-condensing gas 
(adsorptive). When you select this option, the Density 
conversion factor field and the Psat vs. T push button 
become disabled.

Maximum manifold 
pressure

The maximum gas pressure allowed in the manifold.
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Non-ideality factor The factor compensating for the forces of attraction between 
molecules in a real gas.

Density conversion factor This value is used to convert the gas volume at STP to liquid 
volume for the adsorptive. It is the ratio of gas density at STP 
to liquid density.

Therm. tran. hard-sphere 
diameter

The thermal transpiration hard-sphere diameter.

Molecular cross-sectional 
area

The molecular cross-sectional area.

Dosing Method Select the manner in which the sample tube is dosed. 

Select Normal for nitrogen and nitrogen-like gases. 

Select From Port 6 for krypton analyses. 

Psat vs. T Click to view or edit the Psat vs. Temperature table for the 
adsorptive gas; this example shows Nitrogen.
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Report Options

This dialog allows you to specify report options. A report options file can be created as an 
independent parameter file or included as part of the sample information file.

Refer to “Report Options” on page 3-17 for instructions on creating report options files.

Psat vs. T
(continued)

This table contains saturation pressures and their 
corresponding temperatures. As many as 10 entries may be 
included; at least two entries are required. 

You can edit the table by clicking on the desired saturation 
pressure or temperature and entering a different value. 

Use Insert to insert a new row above the selected line; the 
cursor moves to the new line. Use Delete to delete the 
selected row.

Refer to Appendix C, CALCULATIONS for an explanation of the equations used for 
reporting analysis results.
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Description Displays a description of the current Report Options file. 

If this is a new file, this field contains the description you 
specified as the default. You can enter a new description or 
add to the existing one if desired.

Replace Click this push button to choose a file containing parameters 
you wish to copy and use in the current file. After the values 
have been copied into the file, you can edit them as desired. It 
does not affect the values of the file from which they were 
copied.

Show report title This option allows you to enter a title for your report.

If this is a new file, the title you specified as the default is 
displayed. Accept the default title or enter a different one.

Deselect this option to omit the report title. 

Show graphic Select this option to have a graphic display above the report 
title. 

The graphic can be in a bitmap (bmp) or an enhanced 
metafile (emf) format. For example, you may wish to display 
your company logo. 

Click Browse to choose the graphic, then use the height and 
width fields to specify the size. The image can also be edited 
from the report window.
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Overlays Displays the Graph Overlay Samples dialog so that you can 
choose the sample files containing the data you wish to 
overlay onto a selected plot.

Click Browse to the right of the sample number field to 
choose the desired file. Use Clear to clear a field of its entry. 
You can select up to eight files. 

After choosing the desired files, select the Overlay samples 
option for each report type you plan to overlay.

Edit Allows you to edit parameters of the selected report. This 
push button is disabled for the Options report.

Apply Thermal transpiration 
correction

Select this option to correct for the temperature-induced 
pressure difference between the manifold and the chilled 
sample tube. This option is most significant for pressures less 
than approximately 1.0 mmHg. Never use filler rods in the 
sample tube when applying the correction for thermal 
transpiration.

You should always use thermal transpiration when 
performing micropore analyses.

Inside diameter of 
sample tube

Enabled when you select Thermal transpiration 
correction, so that you may enter the inside diameter of the 
sample tube.
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Selected Reports Contains a list of available reports. Choose reports by double-
clicking on the desired report(s). Alternatively, you can 
highlight the desired report and press the Spacebar. A report 
is selected when it is preceded by a check mark. You may 
deselect reports in the same manner. 

The following reports are available:

Summary
Isotherm
BET Surface Area
Langmuir Surface Area
Freundlich
Temkin 
t-Plot
Alpha-S Method
f-Ratio Method
BJH Adsorption 
BJH Desorption
Dollimore-Heal Adsorption
Dollimore-Heal Desorption
Horvath-Kawazoe
DFT Pore Size
DFT Surface Energy
Dubinin
MP-Method
Options
Sample Log
Validation

Editing options for these reports are found in subsequent 
sections.

You can find printed examples of some reports in “Report 
Examples” on page 7-26.
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Summary Report

The Summary report allows you to take the most commonly used statistics and data results 
from the other reports produced by the software and place them in one, convenient report. 

The choices on this dialog allow you to choose the types of data to include in the Summary 
report. 

If you choose Adsorption or Desorption total Pore Volume data, the P/Po field is enabled so 
that you can enter the relative pressure at which to calculate the total pore volume. If Use cal-
culation assignments (Collected Data screen) is not selected, the isotherm is interpolated to 
this value and that point used for the Total pore volume calculation. Otherwise, the point 
selected with calculation assignment is used.

This dialog also enables you to specify Pass/Fail criteria for up to four parameters.

Select All Selects all choices on the dialog.

Deselect All Deselects all choices on the dialog.
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Pass/Fail Selection Displays the parameter you selected on the Pass/Fail Options 
dialog.

Pass/Fail Displays the Pass/Fail Options dialog so that you can choose 
a parameter on which to specify pass/fail criteria. 

Upper/Lower Select these options to specify upper and lower limits for the 
selected parameter; a valid range for the selected field is 
displayed in the information bar. 

You can leave the range open by deselecting one of the limits. 
For example; if you wish to leave the upper limit open, 
deselect the Upper check box and specify a value only for 
the Lower limit.

Each of these fields has a message line in which you can 
enter advice to the operator if a failure occurs. You may enter 
up to 120 characters in each field.
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Isotherm Report Options

The isotherm report indicates adsorption (up to saturation pressure) and desorption (down 
from saturation pressure) of a gas by a solid held at constant temperature. 

Select Reports Lists the types of reports offered. 

Choices: Tabular Report, Linear plot, Logarithmic plot,
 Linear Absolute plot, Logarithmic Absolute

plot, Pressure Composition plot

When you select Pressure Composition plot, the Adsorbate 
Molecular Weight field is enabled so that you can enter a 
value for the adsorbate. This plot is useful for plotting 
pressure as a function of Weight % adsorbed; for example, H2 
adsorbed on carbon.
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Options Displays the related Plot Options dialog; this example shows 
the dialog for the Linear plot.

All plot dialogs contain the same options.

You can plot the graphs as a curve, points, or both.

Select Overlay samples to overlay data from the current plot 
with data from other samples. The other sample files are 
selected by clicking Overlays on the Report Options dialog.

Autoscale options enable you to have the X- and/or Y-axes 
automatically scaled. 

Linear X-axes begin at zero, and logarithmic X-axes begin at 
an appropriate value. Y-axes begin at zero. The system uses 
the highest values collected during analysis as the ending 
points for axes ranges. 

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to specify a range. Data collected 
outside these ranges are not included in the plot.

Tabular Options Enables you to have Run Time and/or Time Between Points 
reported. Run time reports the time elapsed from the 
beginning of the analysis to the finish. Time between points 
reports the time elapsed between each point.

Also enables you to report Weight %.

Plot Options Enables you to choose the type of isotherm you wish to plot.

You can plot the adsorption and/or the desorption isotherm.
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BET or Langmuir Surface Area Report Options

• The BET calculation obtains the sample surface area value by determining the monolayer 
volume of adsorbed gas from the isotherm data.

• The Langmuir calculation determines the surface area of a sample by relating the surface 
area to the volume of gas adsorbed as a monolayer. 

Volume Adsorbed Enables you to choose the manner in which the volume 
adsorbed is reported. These data are reported by default as 

Per Gram (cm3/g). However, you can choose to report data 

Per BET Surface Area (cm3/m2) or Per Other Surface Area 

(m2/g). If the latter field is selected, a field is enabled 
allowing you to enter a value.

Absolute Molecular 
Weight

Enables you to enter the molecular weight of the adsorbate.

This field is enabled when you choose Pressure Composition 
plot under Select Reports or when you choose Weight under 
Tabular Options. 

Displays as Langmuir
Surface Area Report Options
if the Langmuir report is being 
edited.

The Langmuir and BET Surface Area dialogs include the same fields; the operating 
instructions for both are the same.
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Tabular report Select this option to generate a tabular report of the plotted 
data.

BET transform plot Generates a traditional BET (Langmuir) surface area plot that 
is used to determine monolayer volume and BET C constant.

BET Isotherm plot Uses the BET (Langmuir) monolayer volume and constant to 
produce an isotherm.

Overlay samples Allows you to overlay data of the selected type from the 
current plot with data from other samples. The other samples 
are selected by clicking Overlays on the main Report 
Options screen.

Autoscale x-axis 
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled 
automatically.

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. If you 
choose not to autoscale data, the From and To fields are 
enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. The values entered 
in the To field must be greater than the value entered in the 
From field. 

The X-Axis Range fields show the relative pressure. 

The Y-Axis Range fields show the quantity of gas adsorbed.
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Pressures Displays the Report Pressure Table dialog so that you may 
edit or enter relative pressure points.

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, the isotherm is interpolated to 
these pressure points, and those interpolated values are 
used in the BET calculations.

• If Use calculation assignments is selected, the collected 
data are used.

Insert predefined Displays the Surface Area Report Pressure Selection dialog, 
allowing you to select predefined points. 

Choices:   1 Point, 3 Point, 5 Point, 5 Point Low Pressure

Insert Inserts a row into the table above the selected line.

Delete Deletes the selected row.

Clear Removes all but one entry from the table; one entry is 
required. The rows do not have to be selected. 

A warning message requesting confirmation is displayed 
before the table is cleared.
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Freundlich Isotherm

The Freundlich isotherm is an empirical isotherm that is used to model low-pressure 
adsorption data. It can also be applied to model some micropore isotherms.

Specify monolayer 
capacity

In this field, enter the monolayer capacity of the sample.

Absolute pressure range Allows you to enter a pressure range when calculation 
assignments are not requested.   

Tabular report Select this option to have a tabular report of the pressure 
points generated.

Transform plot Plots the linear form of the Freundlich equation.

Overlay samples Choose this option to overlay Freundlich isotherm data from 
the current file with the same type of data from other samples 
(files). The desired files are chosen by clicking Overlays on 
the Report Options dialog.
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Temkin Isotherm

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops 
linearly with increasing coverage.

Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axis scaled 
automatically. 

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points.

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

The X-axis shows the log of absolute pressure and the Y-axis 
shows the quantity of gas adsorbed.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. 
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Specify monolayer 
capacity

In this field, enter the monolayer capacity of the sample.

Specify differential 
heat of adsorption at
zero surface coverage

Enter the differential heat of adsorption at zero surface 
coverage. This allows inclusion of all of Temkin constants.

Absolute pressure 
range

Allows you to enter a pressure range when calculation 
assignments are not requested. 

Tabular report Select this option to have a tabular report of the pressure 
points generated.

Transform plot Plots a linear form of the Temkin isotherm.

Overlay samples Choose this option to overlay Temkin isotherm data from the 
current file with the same type of data from other samples 
(files). The desired files are chosen by selecting Overlays on 
the Report Options dialog.

Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axis scaled 
automatically. 

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. 

The X-axis shows the natural log of absolute pressure and the 
Y-axis shows the quantity of gas adsorbed.

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. 
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t-Plot Report Options

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to 
micropores. Matrix area, the area external to micropores, is directly determined and often 
proves to be a valuable way of characterizing complex mixed materials.

Thickness Curve Presents the type of thickness curves available. 

• Reference
• Kruk-Jaroniec-Sayari
• Halsey
• Harkins and Jura
• Broekhoff-de Boer
• Carbon Black STSA

You can also apply the Frenkel-Halsey-Hill thickness curve 
using the Halsey option, and entering the appropriate values 
in the equation. Use Edit to edit the values in the equation. 

Edit Displays the equation for the type of thickness curve selected 
so that you may view or edit the values.
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Edit
      (Thickness curve type:
      Reference)

Displays the Entered t-Curve dialog allowing you to define a 
t-curve by entering the relative pressure and thickness values. 

This table can also be created in another application if desired 
and imported into this dialog using Open. When creating the 
table in another application, the file must be saved as ASCII 
text with a. THK extension. Use a two-column format with 
the relative pressures in the first column and the thickness 
values in the second column. Columns must be separated by a 
space (or a tab).

Insert
Inserts a row above the selected row. A row cannot be 
inserted if the value in the selected row is at its lowest value; 
values must be strictly increasing. For example, in the table 
shown above the default value is 0.000000001. Therefore, 
you must use Ctrl + Down Arrow to insert rows.

Delete
Deletes the selected row.

Clear
Clears the table of all but one entry; one entry is required.

Open
Enables you to import the values from an existing t-curve.

Save As
Enables you to save the current table of values under a 
different name.
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Kruk-Jaroniec-Sayari
      Edit

Displays the Kruk-Jaroniec-Sayari Thickness Equation 
dialog.

You can edit the values for the numerator, the first element of 
the denominator, and the exponent.The range for a selected 
field is shown in the information bar at the bottom of the 
dialog.

Halsey
      Edit

Displays the Halsey Thickness Equation dialog.

You can edit the values for the multiplier, numerator, and 
exponent.The range for a selected field is shown in the 
information bar at the bottom of the dialog.
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Harkins and Jura
      Edit

Displays the Harkins and Jura Thickness Equation dialog.

You can edit the values for the numerator, first element of the 
denominator, and exponent. The range for a selected field is 
shown in the information bar at the bottom of the dialog.

Broekhoff-de Boer
      Edit

Displays the Broekhoff-de Boer equation dialog. 

You can edit the values for the multiplier, numerator, and 
exponent. The range for a selected field is shown in the 
information bar at the bottom of the dialog.

Carbon Black STSA
      Edit 

Displays the STSA Thickness Equation dialog.

All coefficients can be edited. The range for a selected field is 
shown in the information bar at the bottom of the dialog.
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Surface Area group box Allows you to choose the surface area value used for 
thickness calculations. You can use BET (most commonly 
used), Langmuir, or enter one of preference.

Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report. 

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.

Surface area correction 
factor

This value corrects for surface areas that are not smooth and 
brings the values for BET surface area and micropore surface 
area into accordance. For most samples, the default value of 
1.000 is adequate.

Fitted Thickness Range Provides two fields, allowing you to enter the minimum and 
maximum thicknesses you wish to include in the thickness 
curve.

Tabular report Select this option to generate a table of collected data.

t-Plot Select this option to generate a graphical representation of the 
collected data.

Overlay samples Allows you to overlay data from the current sample file with 
data from other sample file(s). The other sample file(s) are 
chosen by clicking Overlays on the main Report Options 
screen. 
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Autoscale x-axis 
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled 
automatically.

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points.

The X-Axis Range fields show the relative pressure.

The Y-Axis Range fields show the quantity of gas adsorbed

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis.

Data collected outside these ranges are not included in the 
plot. 
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Alpha-S Plot

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm 
using the quantity adsorbed at a relative pressure of 0.4.

Table Provides two columns for entering the relative pressure (first 
column) and the alpha-s values (second column). 

This table can also be created in another application if desired 
and imported into this dialog using Open. When creating the 
table in another application, the file must be saved as ASCII 
text with an ALS extension. Use a two-column format with 
the relative pressures in the first column and the alpha-s 
values in the second column. Columns must be separated by a 
space (or a tab). 

Insert Inserts a row above the selected row. A row cannot be 
inserted if the value in the selected row is at its lowest value; 
values must be strictly increasing. For example, in the table 
shown above, the default value is 0.000000001. Therefore 
you must use Ctrl + Down Arrow to insert rows.

Delete Deletes the selected row.
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Clear Clears the table of all but one entry; one entry is required.

Open Allows you to import the values from an existing alpha-s 
curve (ALS) into the table. One predefined curve is shipped 
with the analysis program. After the values are copied into 
the table, you may edit them if desired. Editing these values 
will not affect the file from which they were copied.

Save As Enables you to save the current table of values under a file 
name.

Fitted Alpha-S range Provides two fields for entering the minimum and maximum 
relative pressures from which the fit will be determined.

Ref. surface area Enables you to enter the surface area from the reference 
curve. This value is used to calculate the sample surface area.

Relative pressure range Provides two fields for entering a pressure range when 
calculation assignments are not used.

Tabular report Select this option to generate collected data in a tabular 
manner.

Alpha-S plot Select this option to generate collected data graphically.

Overlay samples Allows you to overlay data from the current sample file with 
data from other sample file(s). The other sample file(s) are 
chosen by clicking Overlays on the main Report Options 
screen.

Autoscale x-axis 
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled 
automatically.

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. 

The X-Axis Range fields show the relative pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.
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f-Ratio Plot

The f-Ratio report allows you to take the measured isotherm and normalize it using a reference 
isotherm.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis.

Data collected outside these ranges are not included in the 
plot. 

Reference Isotherm Displays the sample file you choose as a reference. You 
should always choose a file containing an isotherm measured 
from a non-porous sample of the same material as the current 
sample.

Browse Click to choose the sample file you wish to use as a reference 
for the isotherm. 

Relative pressure range Allows you to enter a pressure range when calculations 
assignments are not used. 
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Tabular report Choose this option to have a tabular report generated. The 
tabular report contains four columns: relative pressure, 
quantity adsorbed for the isotherm of interest, quantity 
adsorbed for the reference isotherm, and the ratio of the 
quantities adsorbed.

f-Plot Choose this option to have the data plotted as a graph.

Overlay samples Allows you to overlay data from the current sample file with 
data from other sample file(s). The other sample file(s) are 
chosen by clicking Overlays on the main Report Options 
screen.

Autoscale x-axis 
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled 
automatically.

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. 

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. 
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BJH Adsorption or Desorption Report Options

The BJH calculation determines the mesopore volume/area distribution which accounts for 
both the change in adsorbate layer thickness and the liquid condensed in pore cores. You can 

Or BJH Desorption 
Report Options

Does not display 
on the Desorption 
dialog.

The BJH Adsorption and Desorption dialogs include the same fields; the operating 
instructions for both are the same.
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generate BJH reports from adsorption and desorption data.Tabular Report

Thickness Curve Type Presents the type of thickness curves available. 

• Reference
• Kruk-Jaroniec-Sayari
• Halsey
• Harkins and Jura
• Broekhoff-de Boer
• Carbon Black STSA (ASTM D-6556-0lA)

You can also apply the Frenkel-Halsey-Hill thickness curve 
by using the Halsey option and entering the appropriate 
values in the equation. Use Edit to edit the values in the 
equation. Halsey is the default thickness curve and typically 
is used for BJH calculations.

If you select a thickness curve which is not a good match for the sample being 
analyzed, an incomplete pore distribution may be generated.

Edit Displays the equation for the type of thickness curve selected.

Refer to t-Plot Report Options on page 5-48 for information 
on the equations for thickness curves.

Minimum/Maximum BJH Provides fields for entering the minimum and maximum size 
pore to be included in BJH reports. 

The size can be reported in width (default), radius, or 
diameter. Select Options > Units to specify the desired unit.

Fraction of pores open 
at both ends

(not displayed on desorption 
dialog)

During calculations, the software assumes that all pores are 
closed at one end. Sometimes a percentage of pores may be 
open at both ends, causing disagreement in the adsorption 
and desorption data or in the values for total volume and total 
BJH pore volume. Enter a value in this field to compensate 
for this error.

This field does not display on the BJH Desorption Report 
Options dialog.
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Due to normal hysteresis, data may disagree even after applying this corrective 
factor.

Adsorptive Displays the BJH Adsorptive Options dialog, allowing you 
to specify up to ten adsorptive/adsorbate property factor 
combinations.

The recommended adsorptives and their values are shown. 
You may specify up to six additional adsorptive/adsorbate 
property factor combinations.

The adsorbate property factor is the combination of con-
stants in the numerator of the BJH equation which is 
specific to the type of gas used. Adsorbate property factors 
may be specified in angstroms or nanometers. Select 
Options > Units to specify the desired units.

Smooth differentials Smooths all of the differential calculations, eliminating 
variations in the differential computation caused by noise in 
the input data.

Cumulative Reports Select Larger to report the total volume found in pores larger 
than the current pore size. This is the traditional way in which 
BJH data are displayed.

Select Smaller to report the total volume found in pores 
smaller than the current pore size.
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Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report.

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.

BJH Correction Enables you to choose the type of correction to apply to 
calculations. The type you choose will be displayed in the 
report header.

Standard Uses original BJH models.

Kruk-Jaroniec-Sayari Good for reference thickness curves.

Faas Good for statistical thickness curves.

Selected Reports Lists the available BJH reports:

Tabular Report 
Cumulative Pore Volume
dV/d* Pore Volume
dV/dlog(*) Pore Volume
Cumulative Pore Area
dA/d* Pore Area
dA/dlog(*) Pore Area

* = width, radius, or diameter

Choose a report by double-clicking on the report name or 
click the report name and press Spacebar. A report is 
selected when it is preceded with a check mark.

Edit Displays an associated dialog for the selected report. Editing 
options for available reports are shown in subsequent 
sections. 
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The BJH Adsorption/Desorption tabular report allows you to specify the method of data 
reduction.

You can measure port width (W), pore radius (R), or pore diameter (D) for BJH 
reports. Select Options > Units to specify the desired measurement.

Fixed pore size table Select this option to specify exact pore sizes for which 
volume or area data are reported. Only the pore sizes within 
the specified range appear on the report. Click Table to enter 
(or edit) a fixed pore size table.

Collected points Select this option to include in the report calculations the 
values collected by the system.

Columns Displays the BJH Adsorption (or Desorption) Tabular Report 
Column Options dialog, allowing you to select up to six 
columns of data for the tabular report.
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Columns
(continued)

The default column title appears next to the column number. 
Each column includes a pull-down list of the data types to 
include in the report; the pore width, radius, or diameter can 
be measured (select Options >Units to choose the desired 
unit).

Table Enabled when Fixed pore size table is selected for tabular 
data. Displays the BJH Adsorption (or Desorption) Fixed 
Pore Size Table dialog, allowing you to enter or edit a fixed 
pore size table.

The table must contain a minimum of two points and may 
include as many as one thousand. Points must be strictly 
decreasing.

Insert
Inserts a row into the pressure table. The row is inserted 
above the selected row and the cursor moves to the new row.

Delete
Deletes the selected row from the pressure table.

Clear
Removes all entries (except the two required ones) from the 
table. A warning message requests confirmation before the 
table is cleared.
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Plot Options

Selecting a BJH plot option from the BJH Adsorption or Desorption Report Options dialog 
enables you to specify the plotting method used for your report and to customize the plot. 

When you edit a BJH Adsorption or Desorption plot, a dialog similar to the following is 
displayed. 

Plot Options Allows you to have data plotted as a curve, points, or both.

X-Axis Lists the scale options for the X-axis.

Linear/Logarithmic Choose whether you wish to have the X-axis on a logarithmic 
or linear scale. Unless you are performing micropore 
analyses, use the logarithmic option.

Autoscale Choose this option to have the x-axis scaled automatically. 
Linear X-axes begin at zero, and logarithmic X-axes begin at 
an appropriate value. The system uses the highest values 
collected during analysis as the ending points. 

If you deselect this option, the corresponding fields are 
enabled so that you may enter a beginning and ending value. 
Data collected outside the specified ranges are not included in 
the plot.
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X-axis range fields show pore radius or diameter in 
angstroms or nanometers.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.

Y-axis Lists the options for the Y-axis.

Variable Click on the down-arrow to choose a variable for the Y-axis.

Overlay Displays a list of overlay choices. You can choose a different 
type of plot to overlay with the current plot. Or, you can 
choose Samples to overlay the current type of plot with the 
same type from other sample files. If you choose Samples, 
you select the other files using Overlays on the Report 
Options dialog box. 

Autoscale Choose this option to have the y-axis scaled automatically. Y-
axes begin at zero. The system uses the highest values 
collected during analysis as the ending points. 

If you deselect this option, the corresponding fields are 
enabled so that you may enter a beginning and ending value. 
Data collected outside the specified ranges are not included in 
the plot.

Y-axis range fields show the quantity of gas adsorbed.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
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Dollimore-Heal Adsorption/Desorption Report Options

You can generate Dollimore-Heal reports from both adsorption and desorption.

The options for Dollimore-Heal reports are the same as those for the BJH reports with the 
exception of BJH Correction; this item is not applicable for Dollimore-Heal reports. Refer to 
“BJH Adsorption or Desorption Report Options” on page 5-58 for a description of the 
fields on this dialog.

Or Dollimore-Heal 
Desorption Report 
Options
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Horvath-Kawazoe Report Options

Pore Geometry Select the option in this group box which best represents the 
physical geometry of the micropores in the sample material. 
Refer to Appendix C for additional information on 
calculations used for these parameters.

Apply Cheng/Yang 
correction

Allows you to apply the Cheng/Yang correction to the pore 
size analysis. This correction substitutes the Langmuir 
equation of state for Henry’s Law in the Horvath-Kawazoe 
derivation (see Appendix C).

Smooth differentials Smooths the differential calculations, eliminating variations 
in the differential computation caused by noise in the input 
data.

Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report.

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.
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Interaction Parameter Select one of the options in this group box to determine 
which interaction parameter is used during report generation.

Computed The interaction parameter is calculated using the parameters 
on the Horvath-Kawazoe Physical Properties dialog. You can 
click Properties to view or edit these parameters. Each time 
you change one of the parameters, the interaction parameter 
is recalculated. The formula for computing the interaction 
parameter is given in Appendix C. 

Entered The value you enter in the adjacent field will be used.

Properties Use this push button to view or edit the constants (used 
during report generation) describing the physical properties 
of the adsorbent and adsorptive; the Horvath-Kawazoe 
Physical Properties dialog box is displayed.
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Adsorbent Group Box Contains the parameters for the sample. If you select 
Computed for the interaction parameter, all fields are 
enabled and can be edited if desired. If you select Entered, 
only the values in the Diameter and Diameter at zero 
energy fields may be edited.

Description
The name of the adsorbent used in the analysis. 

Click on the down arrow to make a new selection. Each time 
you change the selection, the values for that adsorbent are 
displayed in the appropriate fields.

Diameter
The diameter of the sample atom.

Diameter at zero energy
The diameter of an atom at zero interaction energy,

(2/5)1/6 x diameter.

Polarizability
The polarizability of the adsorbent.

Magnetic susceptibility
The magnetic susceptibility of the adsorbent.

Density
The density per unit area of the adsorbent.

Adsorptive Group Box Contains the parameters for the adsorptives (provided with 
the software and/or user-defined). If you select Computed 
for the interaction parameter, all fields are enabled and can be 
edited if desired. If you select Entered, only the values in the 
Diameter and Diameter at zero energy fields may be 
edited.

Mnemonic
The mnemonic name of the adsorptive gas in use. 

Click on the down arrow to make a new selection. Each time 
you change the selection, the values for that adsorptive 
display in the appropriate fields. If no parameters have been 
defined, the default values are displayed.

Diameter
The diameter of the adsorptive atom.
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Tabular Report Options

Displays the Horvath-Kawazoe Tabular Report Column Options dialog so that you can select 
the type of data to display in each column.

The default column title displays next to the column number. Each column includes a drop-
down list of the types of data to include in the report.

Adsorptive Group Box
(continued)

Diameter at zero energy
The diameter of an atom at zero interaction energy,

(2/5)1/6 x diameter.

Polarizability
The polarizability of the adsorptive.

Magnetic susceptibility
The magnetic susceptibility of the adsorptive.

Density
The density per unit area of the adsorptive.

Selected Reports Lists the available Horvath-Kawazoe reports. Choose a report 
by double-clicking on the report name or highlight the report 
name and press the Spacebar. A report is selected when it is 
preceded with a check mark.

The following reports are available:

• Tabular Report
• Cumulative Pore Volume
• dV/dw Pore Volume

Edit Allows you to edit the selected report.
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Plot Options

Selecting a Horvath-Kawazoe plot option from the Horvath-Kawazoe Report Options dialog 
enables you to specify the plotting method used for your report and to customize the plot. Plots 
for Cumulative Pore Volume and dV/dw Pore Volume are available.

When you select either of these plots from the Horvath-Kawazoe Report Options dialog, a 
dialog like the following is displayed. 

Plot Options Lists the data presentation styles available; you must choose 
to plot a curve, points, or both.

X-axis options Choose Autoscale to have the x-axis scaled automatically. 
The X-axis begins at zero and the system uses the highest 
value collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so 
that you may enter a beginning and ending value. Data 
collected outside these ranges are not included in the plot.

X-axis range fields show pore radius or diameter in 
angstroms or nanometers.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
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Y-axis options Click on the down-arrow at the Variable field to choose a 
variable for the Y-axis.

Click on the down-arrow at the Overlay field to overlay the 
plot with data from other samples.
 
Choose Autoscale to have the y-axis scaled automatically. 
Y-axes begin at zero. The system uses the highest value 
collected during analysis as the ending point.

If you deselect Autoscale, the corresponding fields are 
enabled so that you may enter a beginning and ending value. 
Data collected outside these ranges are not included in the 
plot.

Y-axis range fields show the quantity of gas adsorbed.
Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
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DFT Pore Size

Type Drop-down list containing the types of models available; 
DFT or Classical.

DFT models are based on the density functional theory. 
Classical models are based on the Kelvin equation and 
thickness for determining the pore size distribution. Refer to 
Appendix E for a discussion on models.

Geometry Drop-down list containing pore shapes available; Slit or 
Cylinder.

Models Lists the models that meet the criteria specified and which 
match the adsorbate and temperature of the sample data.

The models display in alphabetical order with the first one 
automatically selected; you may select any one desired.

If the list is empty, there were no models that meet the 
selected criteria.
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Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report. 

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.

Regularization These choices enable you to choose the extent of smoothing 
you wish to have applied to your data, or your can choose 
None.

If you choose Entered, its field is enabled allowing you to 
enter a number giving a relative weight for the smoothing 
during deconvolution. Larger values produce more 
smoothing.

Reports to Generate Displays the types of reports available.

Tabular report
Isotherm table
Cumulative area graph
Incremental area graph
Differential area graph
Cumulative volume graph
Incremental volume graph
Differential volume graph
Log goodness of fit graph
Goodness of fit graph

Graph details can be edited by selecting the Edit push button.
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Edit Use this push button to edit details of a selected graph; a 
dialog similar to the following is displayed.

This push button is disabled for tables and Goodness of Fit 
graphs.

Plot Type Enables you to choose the manner in which you wish to 
display plotted data.

Autoscale Options Select these options to have the axes scaled automatically.

If you deselect one or both of these options, you must enter a 
range in the related Axis Range fields.

Overlay This drop-down list contains the type of overlays available 
for the current graph.

Choose Samples to overlay the same type of graph as the 
current one from other data reductions. Then click Overlays 
on the Report Options dialog to choose your files.

Axis Range The fields in this group box become enabled when you 
deselect Autoscale, allowing you to specify beginning and 
ending values for the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. 

Valid ranges for a selected field are displayed in the 
information bar across the lower portion of the dialog. 

The X-axis displays the energy and the Y-axis displays the 
area.

Displays the type of 
graph you are 
editing.

Displays the range 
for the selected field
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DFT Surface Energy

The fields on the DFT Surface Energy dialog are identical to those on the DFT Pore Size 
dialog with the following exceptions:

Refer to “DFT Pore Size” on page 5-73 for information on the fields contained on this dialog.

Geometry drop-down list Is not applicable to the Surface Energy report and, therefore, 
does not display on its dialog.

Reports to Generate Displays the types of reports available.

Tabular report
Isotherm table
Cumulative area graph
Incremental area graph
Differential area graph
Log goodness of fit graph
Goodness of fit graph

Graph details can be edited by selecting the Edit push button.
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Dubinin Report Options

Report Type Group Box Allows you to specify the type of report you want. At least 
one type of report must be selected.

Select Radushkevich to generate the Radushkevich report. 

Select Astakhov to generate the Astakhov report. With this 
choice, you may select Optimize Astakhov exponent. If you 
do not select this option, the Exponent value field is enabled 
so that you can enter a value.

Fitted relative 
pressure range

Allows you to specify minimum and maximum limits on 
relative pressures included in the line fit. Data collected 
outside these limits are not included.
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Adsorptive Displays the Dubinin Adsorptive Options dialog allowing 
you to specify up to 8 adsorptive/affinity coefficient (beta) 
combinations. 

Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report.

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.

Selected Reports Lists the available Dubinin reports. Choose a report by 
double-clicking on the report name or highlight the report 
name and press the Spacebar. A report is selected when it is 
preceded with a check mark.

The following reports are available:

Tabular Report
Transformed Isotherm
dV/dw Pore Volume (Astakhov only)
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Tabular Report 

The Tabular report enables you to customize your report with one to six columns of data for 
Astakhov reports and one to five columns of data for Radushkevich reports. The Dubinin 
Tabular Report Column Options dialog box is displayed.

The default column title appears next to the column number. Each column includes a drop-
down list of the data types to include in the report. 

Transformed Isotherm

The Transformed Isotherm report allows you to restrict the line fit to a portion of the isotherm. 
The Dubinin Transformed Isotherm Plot Options dialog box is displayed.

Overlay Samples Select this option to overlay the current plot with data from 
other samples. Then click Overlays on the Report Options 
dialog to choose the sample files.
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Pore Volume

When you select the dV/dw Pore Volume plot from the Dubinin Report Options dialog box, 
the Dubinin dV/dw Pore Volume Options dialog is displayed.

Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axes 
automatically scaled. Both X- and Y-axes begin at zero, and 
the system uses the highest values collected during analysis 
as the ending points for axes ranges. 

If you choose not to autoscale data for either (or both) axis, 
the adjacent fields are enabled so that you may enter a 
beginning and ending value. Data collected outside these 
ranges are not included in the plot. 

The X-Axis Range fields show the quantity of gas adsorbed 
at standard temperature and pressure. The Y-Axis Range 
fields show the log of relative pressure. 

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.

The Pore Volume report is unavailable if you choose Radushkevich as the type of 
report.

Plot options You can plot data with a curve, points, or both.

Overlay Samples Select this option to overlay data from other samples. Then 
click Overlays on the Report Options dialog to choose the 
files.
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Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axes 
automatically scaled. Both X- and Y-axes begin at zero, and 
the system uses the highest values collected during analysis 
as the ending points for axes ranges. 

If you choose not to autoscale data for either (or both) axis, 
the adjacent fields are enabled so that you may enter a 
beginning and ending value. Data collected outside these 
ranges are not included in the plot. 

The X-axis Range fields show pore width, radius, or 
diameter in angstroms or nanometers.

The Y-axis Range fields show the quantity of gas adsorbed. 

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
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MP-Method Report Options

Thickness Curve 
group box

Select the type of thickness curve from this group box. 
You must choose either the Halsey equation or the 
Harkins and Jura equation. Use Equation to edit the 
values in the equation. 

Equation Displays the equation for the type of thickness curve 
selected

Harkins and Jura Displays the Harkins and Jura Thickness Equation 
dialog.

You can edit the values for the numerator, first element of 
the denominator, and exponent. The range for a selected 
field is shown in the information bar at the bottom of the 
dialog.
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Halsey Displays the Halsey Thickness Equation dialog.

You can edit the values for the multiplier, numerator, and 
exponent.The range for a selected field is shown in the 
information bar at the bottom of the dialog.

Pressure Range Displays the Report Relative Pressure Range dialog so 
that you may specify minimum and maximum relative 
pressures to use with this report.

• If Use calculation assignments is not selected on 
the Collected/Entered dialog, all of the nonoutlier 
points of the collected data within the specified range 
are used for calculating the data for this report.

• If Use calculation assignments is selected, col-
lected data points which are assigned to this report 
type are used.

Selected Reports Lists the available MP-Method reports. Choose a report 
by double-clicking on the report name or highlight the 
report name and pressing the Spacebar. A report is 
selected when it is preceded with a check mark.

The following reports are available:

MP Tabular Report 
Cumulative Pore Volume
dV/dw Pore Volume 
Cumulative Pore Area
dA/dw Pore Area
Nov 2011                                            5-83 



Open ASAP 2420 Operator’s Manual
MP Tabular Report 

The Tabular report enables you to customize your report with one to six columns of data. (The 
data types in the first and second columns cannot be changed.) The MP-Method Tabular 
Report Column Options dialog box is displayed.

The default column title appears next to the column number for columns three through six. 
Each of these columns includes a drop-down list of the data types to include in the report. 

Pore Volume/Pore Area Plot

MP-Method plot options enable you to specify the plotting method used for your report and to 
customize the plot. A dialog box similar to the following is displayed. The fields on all dialogs 
are the same.

The MP-Method reports hydraulic radius only. If you select Pore size in diameter from 
the Units menu, the MP-Method still reports pore size in radius.
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Plot options You can plot data with a curve, points, or both.

X-axis options Choose Autoscale to have the X-axis scaled automatically. 
The X-axis begins at zero and the system uses the highest 
value collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so 
that you may enter a beginning and ending value. Data 
collected outside these ranges are not included in the plot.

X-axis range fields show pore radius or diameter in 
angstroms or nanometers.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.

Y-axis options Allows you to choose Y-axis options.

Variable Click on the down-arrow to choose a variable for the Y-axis.

Overlay You can use the choices in this drop-down list to overlay 
plots. You can choose a different type of plot for the current 
sample to overlay with the listed Variable, or you can choose 
Samples to overlay the Variable plot with the same type of 
plot from other samples.

Autoscale Choose this option to have the y-axis scaled automatically. 
Y-axes begin at zero. The system uses the highest value 
collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so 
that you may enter a beginning and ending value. Data 
collected outside these ranges are not included in the plot.

Y-axis range fields show the quantity of gas adsorbed.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
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Options Report

The Options report is a subset of the contents report; it provides pertinent information for the 
following:

• Degas conditions
• Adsorptive properties
• Analysis conditions
• Sample tube criteria
• Free space
• Po and temperature
• Equilibration
• Isotherm collection

Sample Log Report

The Sample Log report displays the date, time, and a brief description of the following:

• Analysis operations
• Calibration operations
• Warnings and/or errors which occurred during analysis
• Information entered using Add Log Entry on the sample file editor

The Sample Log report is a new feature with the ASAP 2420 program. Therefore, if you 
request a Sample Log report on a file that was used with the ASAP 2405 program, no 
information will be available.
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Validation Report

Use this report to have your data examined by the software to determine if the results are 
within typical ranges. 

If the data for any report(s) you selected for validation are determined to be out of range, a 
warning is displayed and suggestions are given for corrective action. This information is also 
detailed in the report and plotted on the graph as a unique plot symbol.
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Collected or Entered Data

If you choose Automatically collected as the type of data in the Sample Information dialog, a 
Collected Data tab is added when analysis is complete. The Collected Data dialog will 
contain the data points collected during analysis and the specified calculation assignments.

This example shows the Collected Data dialog from a completed sample information file.

If you choose Manually entered as the type of data in the Sample Information dialog, an 
Entered tab is added allowing you to enter the data.
5-88                                                    Nov 2011



ASAP 2420 Operator’s Manual Open
Pressure table For collected data, columns for the following are displayed:

• absolute pressure

• relative pressure

• quantity adsorbed

• outliers (if Use calculation assignments is not selected)

• calculation assignments for each requested report option 
(if Use calculation assignments is selected)

For entered data, columns for the following are displayed:

• absolute or relative pressure (depending on the selection 
in the Pressures group box)

• quantity adsorbed

Pressures This button appears on the dialog for Entered data only. 
Select either Relative or Absolute pressure.

Insert Enabled for entered data; inserts a row into the pressure 
table.

Delete Enabled for entered data; deletes the selected row.

Clear Enabled for entered data; clears the entire table of all entries 
except one (one is required).

Use calculation
assignments

If selected, allows you to assign the points to be collected for 
each report type.

If deselected, each report (with the exception of Langmuir 
and BET) uses a range of pressures as selected in Report 
Options. The Langmuir and BET reports interpolate to 
entered relative pressures on Report Options. 

The outlier points can be selected so that they will not be 
reported.

Po and T Displays the Po and T dialog, allowing you to edit the 
saturation pressure and temperature. Only the applicable 
options are enabled. 
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Free Space Displays the Free Space dialog, allowing you to edit the cold 
and warm free spaces. This dialog also includes the plotted 
isotherm. The isotherm is redrawn each time you edit the 
values in either field. 

Also available for the isotherm is a shortcut menu containing 
options allowing you to edit the curve and axes. You also can 
zoom in for finer detail. The options available are explained 
in “Graphs” on page 7-23.
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Save

Save enables you to save any changes you have made to the file in the active window.

Save As

Save As enables you to:

• save a sample or parameter file in the active window under a different name. This option is 
useful for making a duplicate copy of a file that you can modify as desired without chang-
ing the original one. The original file remains open when you use this function, so be sure 
to open the new file before making any changes.

• save a subset (parameter) of the sample file in the active window as a standalone parame-
ter file. For example, select Analysis Conditions from the Save As menu to create a stand-
alone parameter file of the analysis conditions portion of the active sample file.

• save as an ASCII file the relative pressures and corresponding thicknesses. These data are 
derived by dividing the condensed volume of adsorptive by the selected surface area. The 
density conversion factor in the adsorptive properties file is used to convert quantity 
adsorbed to volume of condensed adsoptive.

• save as an ASCII file the relative pressures and resulting quantities adsorbed. These data 
are derived by taking the isotherm and dividing it by the quantity adsorbed at 0.4 relative 
pressure.

Sample and Parameter Files

A dialog similar to the one shown below is displayed when you select Sample Information, 
Sample Tube, Degas Conditions, Analysis Conditions, Adsorptive Properties, or Report 
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Options. 

Enter a file name (up to eight characters) in the File name field; the appropriate extension is 
appended automatically when you click OK. The new file is saved as specified, but does not 
remain in the active window. Be sure to open the new file before making any changes to the 
file.

t-Curve and Alpha-S Files

The same type of dialog box shown above is also displayed when you select t-Curve or Alpha-
S. However, before you receive this dialog for t-Curve, the Save As t-Curve dialog is 
displayed. This dialog allows you to choose the surface area for the sample.

Save All

Save All enables you to save all open files under their current names. This option provides a 
faster way to save all open files at one time and avoids having to perform a Save operation on 
each individual file. 

Indicates the type of 
file being saved
5-92                                                    Nov 2011



ASAP 2420 Operator’s Manual Close
Close

Close enables you to close the file in the active window. If the file contains changes that have 
not been saved, the following message is displayed:

(file name) has been changed. Save changes before closing?

Yes No Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file closes.
Click No to close the file without saving the changes.
Click Cancel to return to the active file.

Close All

Close All enables you to close all open files under their current names. The following message 
displays for every file containing changes that have not been saved:

(file name) has been changed. Save changes before closing?

Yes No Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file closes.
Click No to close the file without saving the changes.
Click Cancel to return to the active file.

Print

Print enables you to print the contents of one or more files to the screen, a printer, or a file. For 
example, if you choose Analysis Conditions, you will receive the parameters used for all 
analysis conditions associated with the file(s). The print dialog is common to all file types. 

Select the desired file type from the drop-down menu; a dialog similar to the following is 
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displayed:

File name The name of the file you choose to print is copied to this 
field. If you choose multiple files, the name of the last one 
selected is displayed.

Settings Refer to “Report Settings” on page 2-21. 

Indicates the type 
 
printing
of report you are
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List

List enables you to generate a listing of the following information on a selected sample or 
parameter file.

• File name
• Date the file was created or last edited
• Time the file was created or last edited
• File identification
• File status

Regardless of the type of file you choose, the dialogs are similar; the options presented in the 
header vary slightly. The types of dialogs displayed are identical to the ones displayed for the 
Print function; you simply obtain different types of information. This example shows a dialog 
for sample files.

Refer to “Print” on page 5-93 for an explanation of the fields on this dialog box.

You may request a list of multiple files by holding down Ctrl while selecting files. If no files 
are selected, a list is generated for all files.

Indicates the type
of file on which you
have requested a
list of statistics
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Export

Export copies the isotherm data in the sample information file and reformats it in a text format 
acceptable to other programs, such as spreadsheets. The output file consists of 5 columns 
containing the absolute pressure, relative pressure, specific quantity adsorbed, elapsed time, 
and the volume dosed.

 
File name The name of the file you choose to export is copied to this 

field. If you choose multiple files, the name of the last one 
selected is displayed.

Settings This group box enables you to choose print options.

Destination Select Destination to export files to a printer, the screen, or 
to a file. The Copies field is enabled if you choose printer, 
allowing you to print up to four copies.

The File name field is enabled if you select File for export 
destination. For the name, you can:

• Accept the default value where all selected files you 
choose to export will have the same name as those in the 
sample information file with an .ISO extension.
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For example, if you select the following files to 
export, names will be assigned as indicated:

Selected Files Export Names

C:\DATA1\SAMP1.SMP C:\DATA1\SAMP1.ISO

C:\DATA1\SAMP2.SMP C:\DATA1\SAMP2.ISO

C:\DATA1\SAMP3.SMP C:\DATA1\SAMP3.ISO

• Enter a name for the file (full path name). The extension 
does not have to be .ISO. If exporting more than one file, 
a wildcard character should be entered. 

For example, if you use a .TXT extension, enter 
C:\DATA2\*.TXT in the File name field. 

Selected Files Export Names

C:\DATA1\SAMP1.SMP C:\DATA2\SAMP1.TXT

C:\DATA1\SAMP2.SMP C:\DATA2\SAMP2.TXT

C:\DATA1\SAMP3.SMP C:\DATA2\SAMP3.TXT
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Convert

Convert allows you to convert sample information files created with an ASAP 2400 or ASAP 
2405 system to files compatible with the ASAP 2420 system. 

Destination File name This field enables you to specify different names for the 
converted files. You may choose one of the following 
options:

• Accept the default for the converted file name. If you 
accept this option, the converted file(s) will retain their 
original name; only the extension will change. For exam-
ple, if you choose si0140.dat from the Files list box, it is 
converted to si0140.smp.

• Type the name for the converted file. For example, if you 
wish to convert the following file on the C drive:

From:  C:\DATA1\SI0010.DAT
To:    C:\DATA2\SAMP90.SMP
Then type: C:\DATA2\SAMP90.SMP
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The following message is displayed when the first file containing a fixed pore size table is 
encountered: 

Fixed pore size tables will not be converted. If a sample file to be 
converted uses a fixed pore size table, the fixed pore size table can be 
entered after conversion is complete.

This message informs you that fixed pore size tables are not converted to the new format. You 
must enter a fixed pore size table after conversion if you desire to use one with the sample 
information file. Click OK to clear the message. 

Destination File name
(continued)

If you wish to convert the following file on the D drive:

From:  D:\SI0010.DAT
To:    C:\DATA2\SAMP90.SMP
Then enter C:\DATA2\SAMP90.SMP

If you wish to convert more than one file, enter wildcard 
characters. For example, the following chart shows the 
selected files and converted file names resulting when you 
enter the following:

C:\NEWDIR\*.SMP.

Selected Files Export Names

C:\DATA1\S1001.DAT C:\NEWDIR\S1001.SMP

C:\DATA1\S1002.DAT C:\NEWDIR\S1002.SMP

C:\DATA1\S1003.DAT C:\NEWDIR\S1003.SMP 

Selection Criteria Refer to “Selecting a Range of Dates” on page 2-20.
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Exit

Exit enables you to exit (close) the ASAP 2420 program. 

• If an analysis is in progress, the following message is displayed:

CAUTION: Sample analysis is in progress. If you exit 
the program, analysis will continue to completion, but 
the data are not saved to disk until the program is 
restarted. Do you want to exit the program?

Yes No

Click Yes to close the ASAP 2420 program. The analysis continues and data are collected.
Click No to allow the program to remain active.

• If a report is in progress, you are cautioned that reports are being generated, and given the 
opportunity to either cancel the print job or allow the reports to print before exiting.

Although data are stored in the analyzer after you exit the program during analysis, 
they are not saved in the file until the program is restarted. At that time the data are 
saved automatically. If a power failure occurs in the interim and you do not have an 
Uninterruptible Power Supply (UPS) attached, loss of data will result.

 

Observe the Status area of the instrument schematic; it indicates when an analysis is 
complete.
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UNIT MENU

The Unit menu contains the operations that can be performed with the ASAP 2420 analyzer. 
The main menu contains a Unit menu for each attached analyzer. For example, if you have 
two attached analyzers, the main menu contains two Unit menus. The appropriate unit num-
ber and serial number display in the title bar of the operational windows. The status windows 
also display in different colors. This feature is useful when you have more than one analyzer 
attached to the same computer.

Description

Following are brief descriptions of the Unit menu options. Detailed descriptions are found in 
subsequent sections.

The Unit menu does not display on the menu bar if the analysis program is being 
used for offline data manipulation on a computer other than the one controlling the 
analyzer.

Start Analysis Starts an analysis on a sample in the selected port. 

Start Krypton Analysis Starts a krypton analysis on the samples in the selected ports 
(up to five). 
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Start High Throughput 
Analysis

Starts an analysis on the samples in the selected ports (up to 
six).

Start Micropore Analysis Starts a micropore analysis on the samples in the selected 
ports (up to six)

Start Single Degas Allows you to start the degassing operation on one sample.

Start Multiple Degas Allows you to start the degassing operation on up to 12 
samples.

Evacuate Analysis Port Allows you to manually evacuate an analysis port.

Evacuate Degas Ports Allows you to manually evacuate degas ports.

Enable Manual Control Allows you to control the system manually.

Show Analysis Schematic Displays a schematic of the ASAP 2420 analysis system.

Show Degas Schematic Displays a schematic of the ASAP 2420 degas system.

Show Analysis Status Displays a window showing the status of current analyses.

Show Degas Status Displays a window showing the status of current degas 
operations.

Show Instrument Log Displays a log of recent analyses, calibrations, and error 
messages.

Unit Configuration Displays the configuration of the analyzer.

Diagnostics Enables you to perform predefined user diagnostics. 

Calibration Data Enables calibration data to be entered. This option is enabled 
only with the direction of a Micromeritics service 
representative.

Calibrate Analysis Enables calibration procedures to be performed on certain 
analysis system components.This option is enabled only 
with the direction of a Micromeritics service 
representative.

Calibrate Degas Enables calibration procedures to be performed on certain 
degas system components.This option is enabled only with 
the direction of a Micromeritics service 
representative.
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Start Analysis

This option allows you to start an analysis using nitrogen or a similar gas. Use the following 
guidelines for performing standard analyses:

• Standard analyses cannot be performed if a high throughput or krypton analysis is in prog-
ress.

• One analysis can be started at a time.

• A sample can be added to any idle port and an analysis started without disturbing the analy-
ses being performed on other ports. 

• Samples can be removed from any of the six ports without disturbing the analyses being 
performed on other ports.

• The sample dosing method should be Normal.

• All analyses must use the same gas.

• If saturation pressure is being measured, all analyses must use the same Psat gas.

• A manual evacuation can be performed on any idle port while analyses are in progress.

When you select this option from the Unit menu, the Sample Analysis dialog is displayed 
with the Select a File for Analysis dialog positioned on top. This allows you to select a sam-
ple file for your analysis or to create a new one. (Refer to “Selecting or Creating a File for 
Analysis” on page 3-45).

After you have designated a sample file, the Sample Analysis dialog is displayed. The fields 
now contain the values for the selected file or, if you are creating a new file, the specified 
defaults.

Service Test Enables certain troubleshooting procedures to be performed. 
This option is enabled only with the direction of a 
Micromeritics service representative.
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View Allows you to view one of the following in the current 

window:

• the current operation

• the analysis system schematic (refer to “Show Analysis 
Schematic” on page 6-29)

• the instrument log (refer to “Show Instrument Log” on 
page 6-34)

• a graph of the analysis in progress 

Browse Displays the Select a File for Analysis dialog allowing you 
to select or change the sample file for the current analysis.

Port Allows you to select the port to be used for the analysis. 
Only one port may be selected at a time.

Sample Displays the sample’s file name.
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Mass Displays the mass entered in the sample information file. 
You may edit it if required.

Density Displays the density entered in the sample information file. 
You may edit it if required.

Sample Tube
Analysis Conditions
Adsorptive Properties
Report Options

These fields display the names of the parameter files in the 
current sample file.

If this is a new sample file, the fields contain the files you 
specified as defaults.

The drop-down lists contain a list of predefined parameter 
files that were saved to the Parameter Files Directory (refer 
to “Parameter Files Directory” on page 8-15), as well as 
those included with the analysis program. You may choose a 
different file from this list if desired.

Po Enabled if you have chosen to enter the Po measurement. 
Enter (or confirm) the saturation pressure of the adsorptive, 
or edit the current one if desired.

Bath temperature Enabled if you have chosen to enter the bath temperature 
(Po and T option on the Analysis Conditions dialog). Enter 
(or confirm) the temperature for the analysis bath.

Warm Free Space Enabled if you have chosen to enter the free space value 
(Free Space option on the Analysis Conditions dialog). 
Enter (or confirm) the warm free space value.

Cold Free Space Enabled if you have chosen to enter the free space value 
(Free Space option on the Analysis Conditions dialog). 
Enter (or confirm) the cold free space value.

Report After Analysis Displays the Report Settings dialog so that you may specify 
report output options. (Refer to “Report Settings” on 
page 2-21).

Start Begins the analysis.
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Use the Skip function with caution; the ASAP 2420 performs multiple steps for a given 
task. Skipping certain steps may cause corruption of data, instrument damage, or 
personal injury.

Report Displays a report of the data collected during analysis.

Next When the analysis is complete, the Start button changes to 
Next. The Next button returns you to the first analysis 
dialog, enabling you to start another analysis.

Close Enabled at the completion of analysis. Closes the dialog.
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Start Krypton Analysis

When you select this option from the Unit menu, the Krypton Analysis dialog is displayed. 

Use the following guidelines for performing krypton analyses:

• All ports must be idle in order to start an analysis.

• All analyses must use krypton gas.

• From one to five analyses can be started at the same time using ports 1 through 5. Port 6 is 
reserved for dosing.

• A blank tube must be installed in port 6.

• The sample file used for an analysis must specify the Dosing Method: From Port 6 in the 
Adsorptive Properties.

• Samples cannot be removed from or added to ports until the full set of analyses has 
completed.
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View Allows you to view one of the following in the current 
window:

• the instrument schematic (refer to “Show Analysis Sche-
matic” on page 6-29) 

• the instrument log (refer to “Show Instrument Log” on 
page 6-34) 

• the status of the analyses on all active ports (refer to 
“Show Analysis Status” on page 6-31)

• a graph of the analysis in progress 

Browse Displays the Select a File for Analysis dialog allowing you 
to select or create a sample file for the associated port 
(refer to “Selecting or Creating a File for Analysis” on 
page 3-45).

When you select a file, its path name and description are 
displayed.

Clear Removes the information entered for the associated port 
enabling you to select a different sample file.

Mass Displays the mass entered in the sample information file. 
You may edit it if required.

Density Displays the density entered in the sample information file. 
You may edit it if required.

Warm Enabled if you have chosen to enter the free space value 
(Free Space option on the Analysis Conditions dialog). 
Enter (or confirm) the warm free space value.

Cold Enabled if you have chosen to enter the free space value 
(Free Space option on the Analysis Conditions dialog). 
Enter (or confirm) the cold free space value.
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Report After Analysis Displays the Report Settings dialog so that you may specify 
report output options. (Refer to “Report Settings” on 
page 2-21).

Po Enabled if you have chosen to enter the Po measurement. 
Enter (or confirm) the saturation pressure of the adsorptive, 
or edit the current one if desired.

Bath temperature Enabled if you have chosen to enter the bath temperature 
(Po and T option on the Analysis Conditions dialog). Enter 
(or confirm) the temperature for the analysis bath.

Start Begins the analyses on the specified ports.

Use the Skip function with caution; the ASAP 2420 performs multiple steps for a given 
task. Skipping certain steps may cause corruption of data, instrument damage, or 
personal injury.

Report Port (1 - 5) Displays a report for the sample on the selected port.
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Start High Throughput Analysis

When you select this option, the High Throughput Analysis dialog is displayed. This dialog 
enables you to start up to six analyses at the same time. Use the following guidelines for per-
forming high throughput analyses:

• All ports must be idle in order to start an analysis.

• All analyses must use the same analysis gas.

• All analyses that measure Psat must use the same Psat gas (which may be different from the 
analysis gas).

• The sample dosing method should be Normal.

• From one to six analyses can be started at the same time.

• Samples cannot be removed from or added to ports until the full set of analyses has com-
pleted.

Next When the analysis is complete, the Start button changes to 
Next. The Next button returns you to the first analysis 
dialog, enabling you to start another analysis.

Close Enabled at the completion of analysis. Closes the dialog.
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View Allows you to view one of the following in the current 
window:

• the instrument schematic (refer to “Show Analysis Sche-
matic” on page 6-29) 

• the instrument log (refer to “Show Instrument Log” on 
page 6-34) 

• the status of the analyses on all active ports (refer to 
“Show Analysis Status” on page 6-31)

• a graph of the analysis in progress 

For ports 1 through 6, you may use the following commands:

Browse Displays the Select a File for Analysis dialog allowing you 
to select or create a sample file for the associated port 
(refer to “Selecting or Creating a File for Analysis” on 
page 3-45). 

When you select a file, its path name and description are 
displayed.
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Clear Removes the information entered for the associated port 
enabling you to select a different sample file.

Mass Displays the mass entered in the sample information file. 
You may edit it if required.

Density Displays the density entered in the sample information file. 
You may edit it if required.

Warm Enabled if you have chosen to enter the free space value 
(Free Space option on the Analysis Conditions dialog). 
Enter (or confirm) the warm free space value.

Cold Enabled if you have chosen to enter the free space value 
(Free Space option on the Analysis Conditions dialog). 
Enter (or confirm) the cold free space value.

Report After Analysis Displays the Report Settings dialog so that you may specify 
report output options. (Refer to “Report Settings” on 
page 2-21).

Po Enabled if you have chosen to enter the Po measurement. 
Enter (or confirm) the saturation pressure of the adsorptive, 
or edit the current one if desired.

Bath temperature Enabled if you have chosen to enter the bath temperature 
(Po and T option on the Analysis Conditions dialog). Enter 
(or confirm) the temperature for the analysis bath.

Start Begins the analyses on the specified ports.
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Resume Resumes suspended analyses.

Suspend Suspends the analyses of all samples.

Skip Skips the current step on all analyses.

Use the Skip function with caution; the ASAP 2420 performs multiple steps for a given 
task. Skipping certain steps may cause corruption of data, instrument damage, or 
personal injury.

Report Port (1 - 6) Displays a report for the sample on the selected port.

Cancel Cancels the analyses.

Next When the analysis is complete, the Start button changes to 
Next. The Next button returns you to the first analysis 
dialog, enabling you to start another analysis.

Close Enabled at the completion of analysis. Closes the dialog.
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Start Micropore Analysis

When you select this option, the Micropore Analysis dialog is displayed. This dialog enables 
you to start up to six analyses at the same time. Use the following guidelines for performing 
micropore analyses:

• All ports must be idle in order to start an analysis.

• All analyses must use the same analysis gas.

• All analyses that measure Psat must use the same Psat gas (which may be different from the 
analysis gas).

• The sample dosing method should be Normal.

• From one to six analyses can be started at the same time.

Samples cannot be removed from or added to ports until the full set of analyses has 
completed.
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View Allows you to view one of the following in the current 
window:

• the instrument schematic (refer to “Show Analysis Sche-
matic” on page 6-29) 

• the instrument log (refer to “Show Instrument Log” on 
page 6-34) 

• the status of the analyses on all active ports (refer to 
“Show Analysis Status” on page 6-31)

• a graph of the analysis in progress 

Browse Displays the Select a File for Analysis dialog allowing you 
to select or create a sample file for the associated port 
(refer to “Selecting or Creating a File for Analysis” on 
page 3-45). 

When you select a file, its path name and description are 
displayed.

Clear Removes the information entered for the associated port 
enabling you to select a different sample file.

Mass Displays the mass entered in the sample information file. 
You may edit it if required.

Density Displays the density entered in the sample information file. 
You may edit it if required.

Warm Enabled if you have chosen to enter the free space value 
(Free Space option on the Analysis Conditions dialog). 
Enter (or confirm) the warm free space value.

Cold Enabled if you have chosen to enter the free space value 
(Free Space option on the Analysis Conditions dialog). 
Enter (or confirm) the cold free space value.
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Report After Analysis Displays the Report Settings dialog so that you may specify 
report output options. (Refer to “Report Settings” on 
page 2-21).

Po Enabled if you have chosen to enter the Po measurement. 
Enter (or confirm) the saturation pressure of the adsorptive, 
or edit the current one if desired.

Bath temperature Enabled if you have chosen to enter the bath temperature 
(Po and T option on the Analysis Conditions dialog). Enter 
(or confirm) the temperature for the analysis bath.

Start Begins the analyses on the specified ports.

Use the Skip function with caution; the ASAP 2420 performs multiple steps for a given 
task. Skipping certain steps may cause corruption of data, instrument damage, or 
personal injury.
6-18                                                    Nov 2011



ASAP 2420  Operator’s Manual Start Micropore Analysis
Report Port (1 - 6) Displays a report for the sample on the selected port.

Next When the analysis is complete, the Start button changes to 
Next. The Next button returns you to the first analysis 
dialog, enabling you to start another analysis.

Close Enabled at the completion of analysis. Closes the dialog.
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Start Single Degas

This option allows you to start a degas operation on one port at a time. This approach is use-
ful for degassing samples without using predefined sample information files. You can, for 
example, create a default degas conditions file and use it to perform multiple degas opera-
tions, creating new sample files as you proceed. Use these guidelines:

• One degas operation can be started at a time.

• A sample can be added to any idle port and a degas operation started. When you add a sam-
ple, the degas operation in progress will be suspended until the sample reaches the target 
temperature, then degassing on all ports will resume. 

• Samples can be removed from any of the 12 ports without disturbing the degas operations 
being performed on other ports.

• A manual evacuation can be performed on any idle degas port.

Browse Enables you to select or create a sample file. The Select a 
File for Analysis dialog is displayed (refer to “Selecting or 
Creating a File for Analysis” on page 3-45).

Degas Conditions Displays the Degas Conditions file designated as the default. 
After you choose a sample file, this field displays the file 
associated with the sample file.

You can choose a different Degas Conditions file from the 
drop-down list if desired. If you choose a different file, the 
values in the current file will be overwritten with the values 
of the new one.

Port (1 through 12) Enables you to choose the port on which to degas the 
sample.

Clear Clears the sample file from the port assignment. Click 
Browse to choose a different file.

Start Starts the degassing operation.

Cancel Closes the dialog, canceling the degassing operation.
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Start Multiple Degas

This option enables you to degas up to 12 samples at the same time. Use these guidelines for 
performing multiple degas operations:

• Up to 12 degas operations can be started at a time.

• A sample can be added to any idle port and a degas operation started. When you add a sam-
ple, the degas operation in progress will be suspended until the sample reaches the target 
temperature, then degassing on all ports will resume.

• Samples can be removed from any of the 12 ports without disturbing the degas operations 
being performed on other ports.

• A manual evacuation can be performed on any idle degas port.

Browse Enables you to select or create a sample file. The Select a 
File for Analysis dialog is displayed (refer to “Selecting or 
Creating a File for Analysis” on page 3-45).

Clear Clears the Sample field and enables you to select another 
sample file.

Start Starts the degassing operation.

Cancel Closes the dialog, canceling the degassing operation.
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Evacuate Analysis Port

This option enables you to manually evacuate a single analysis port. Select Unit > Evacuate 
Analysis Port.

 This option is not available if the system is performing a High Throughput or Krypton 
analysis.

Ports 1 through 6 Click the port you wish to evacuate.

Backfill Gas Select the backfill gas to be used from the drop-down list.

Fast evacuation Select Fast evacuation when analyzing samples (such as 
pellets) that do not fluidize or shed particles under 
evacuation.

Unrestricted evac pressure
Evacuation rate

If you deselect Fast evacuation, Unrestricted evac. 
pressure and Evacuation rate become enabled. Enter the 
pressure value at which unrestricted sample evacuation 
should begin and the evacuation rate.

Vacuum setpoint Allows you to specify the vacuum level to be achieved 
before evacuation begins. When this level is reached, the 
evacuation begins and continues for the amount of time 
specified in the Analysis Conditions dialog.

Start Starts the evacuation.

Cancel Cancels the evacuation.
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Evacuate Degas Port

This option enables you to manually evacuate up to 12 degas ports. Select Unit > Evacuate 
Degas Port.

Ports 1 through 12 Click the ports you wish to evacuate.

Unrestricted evac pressure Enter the pressure value at which unrestricted sample 
evacuation should begin.

Vacuum setpoint Allows you to specify the vacuum level to be achieved 
before evacuation begins. When this level is reached, the 
evacuation begins and continues for the amount of time 
specified in the Degas Conditions dialog. (Refer to “Degas 
Conditions” on page 5-14.)

Evacuation rate Enter the evacuation rate.

Start Starts the evacuation.

Cancel Cancels the evacuation.
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Enable Manual Control

Select this option to control certain components of your analysis or degas system manually. 

Analysis System

If the analysis schematic is not displayed, select Unit > Show Analysis Schematic, then 
select Enable Manual Control. 

When manual control is enabled, the valve symbols change color on the computer screen to 
indicate their status. 

Use the mouse pointer to select a component. A component is selected when it is surrounded 
by a thin line. Each component has a shortcut menu displaying the operations available for that 
particular component. These menus may be accessed by right-clicking on the desired 
component.

Servo valve

1000-mmHg transducers

Sample tube

Elevator

Po tube

 

 

Gas inlet valves

   

Status window

1000-mmHg transducer
10-mmHg transducer
Vacuum gauge

1-mmHg transducer

Analysis manifold temperature

Po port

1000-mmHg transducers

Analysis ports

Green = open

Yellow = closed
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You can open and close valves, and raise or lower the elevator by using one of the following 
methods:

• Right-click on the valve or elevator symbol to access the shortcut menu and select the 
appropriate action.

• Double-click on the valve or elevator symbol.

• Select the valve or elevator symbol and press the Spacebar.

     

Valves System valves and their functions are listed below.

Actions:  Open, Close, Pulse

Pulse briefly opens and closes (or vice versa) the valve.

Valve Description

1 through 6
7
8
9
10
11 through 16
17
18
21 through 26
Unmarked

Sample ports
Lower manifold isolation
Sample ports unrestricted vacuum
Po ports access
Po ports unrestricted vacuum
Po ports
Upper manifold isolation
Gas inlets unrestricted vacuum
Gas inlets
Servo

Transducers Each sample port and Psat port contains a 1000-mmHg 
transducer. The transducer readings display next to the ports. 

Dewar positions The Dewar can be raised, lowered, or stopped.

Indicates the Dewar is being raised; note the position of the 
arrow in the center of the Dewar symbol.

Indicates the Dewar is being lowered; note the position of 
the arrow in the center of the Dewar symbol.
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The remainder of the components are displayed for informational purposes only; they cannot 
be controlled manually.

Indicates the Dewar is stopped in the raised position.

Indicates the Dewar is stopped in the lowered position.

Represents the sample tube.

Represents the Psat tube.

 

This group of rectangles on the right side of the schematic 
displays the temperature, the 1000-mmHg and 10-mmHg 
transducer readings, and the vacuum gauge pressure. 

The 1000-mmHg transducer is present in all ASAP 2420 
systems. The 10-mmHg transducer is shown only on units 
containing the Krypton or Micropore option.

This rectangle, in the middle of the schematic, displays the 
1-mmHg transducer reading.

This transducer is optional and is shown only if installed.

Status window This is a two-line status window enabling you to view the 
status of the analysis on each port. The top line displays the 
state of the analysis, or Idle if an analysis is not in progress. 
The second line displays the point being collected during 
data collection.
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Degas System

If the degas schematic is not displayed, select Unit > Show Degas Schematic, then select 
Enable Manual Control.

When manual control is enabled, the valve symbols change color on the monitor screen to 
indicate their status. 

Use the mouse pointer to select a component. A component is selected when it is surrounded 
by a thin line. Each component has a shortcut menu displaying the operations available for that 
particular component. These menus may be accessed by right-clicking on the desired 
component.

Valve Description

1 through 12
13
14
15

Sample ports
Backfill
Servo vacuum
Unrestricted vacuum

Heater readings

  

Sample tubes

Degas ports

Vacuum gauge

Servo valve          1000-mmHg 
          transducer

 Green = open Yellow = closed
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Represents the sample tube. The following are displayed 
below the sample tube: 

• Current temperature
• Target temperature
• Ramp Rate

You can set the target temperature or disable the heater for a 
port as follows:

To enter the ramp rate and target temperature, right-click on 
the appropriate sample tube and select Set. The Heater Set-
tings dialog is displayed.

Enter the ramp rate and target temperature, then click OK to 
close the dialog.

To disable the heater for a port, right-click on the appropri-
ate sample tube and select Disable. To enable a disabled 
heater, enter a new target temperature.
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Show Analysis Schematic

Select this option to display a schematic of the ASAP 2420 analysis system. The schematic is 
a graphical representation of the analysis system including system valves, analysis stations, 
and Dewar positions. The valves and elevators can be controlled from the schematic when 
Manual control is enabled. Refer to “Analysis System” on page 6-24 for an explanation of 
the components displayed on the analysis schematic.

The state of the valves can be determined quickly by color representation even when manual 
control is not enabled:

If you wish to change the state of a valve, you must enable manual control.

 Green = open

White = closed
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Show Degas Schematic

Select this option to display a schematic of the ASAP 2420 degas system. The schematic is a 
graphical representation of the plumbing system including degas valves and preparation ports. 
The valves and port heaters can be controlled from the schematic when Manual control is 
enabled. Refer to “Degas System” on page 6-27 for an explanation of the components dis-
played on degas schematic.

The state of the valves can be determined quickly by color representation even when manual 
control is not enabled:

If you wish to change the state of a valve, you must enable manual control.

 Green = open

White = closed
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Show Analysis Status

The Show Analysis Status option enables you to view the status of all active analysis ports 
during a high-throughput or krypton analysis.

The following information is displayed for each active port. 

Analysis status bar Shows the progression of the analysis. This bar contains 
three stages:

• Preliminary: warm and cold free spaces are determined; 
displays green during progression.

• Analysis: data are collected; displays blue during progres-
sion.

• Termination: the Dewar lowers, and the sample tube is 
warmed and backfilled; displays gray during progression.

All stages are displayed in red if the analysis has been 
suspended.
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Show Degas Status

The Show Degas Status option enables you to view the status of all active degas ports.

Analysis details The following analysis details are displayed:

Sample: Sample file name

Stage:       Stage of the analysis (as in status bar)

Last Point: Last point and number of points requested

P: Absolute pressure of last point

P/Po: Relative pressure of last point

Q(cm3/g STP): Volume adsorbed

Po: Absolute pressure of last measured or 
calculated saturation pressure (Po)

Run Time: Elapsed time since the start of analysis

Step details Provides details of the current step of the analysis.

Sample Status Shows the status of the degas operation on each port.
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Check Allows you to check the outgassing rate of the samples on 
the selected ports; the following actions occur:

• The current degassing step is suspended.

• The vacuum valves are closed and the vacuum level on 
the selected ports is monitored.

• The Status window indicates that the degassing operation 
is being checked and displays the outgassing rate as it 
becomes available.

During the degas check, this push button changes to 
Continue. When Continue is clicked, the valves open and 
the degassing operation resumes. 

If the outgassing rate indicated that the sample has been 
freed of contaminants (minimal pressure increases), you can 
click Skip to advance to the next state of the degassing 
operation. For example, if you check degassing after the 
setpoint is attained, Skip advances you to the ramping stage.

Skip Enables you to skip the current degas operation. When you 
click Skip, the following dialog is displayed.

Click Yes to skip the operation or No to continue the 
operation.

Cancel Cancels the current degas operation. When you click 
Cancel, the following dialog is displayed.

Click Yes to cancel the operation or No to continue the 
operation.
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Show Instrument Log

Displays a log of recent analyses, calibrations, and errors or messages. 

By default, this information is logged for a 60-day period for analyses and messages, and a 
90-day period for calibrations.You may change the time for which this information is retained 
in the Unit section of the WIN2420.INI file. Simply replace the default value with the desired 
number.

    
Analysis 
Calibration 
Messages

These options allow you to choose which entries are 
displayed in the window. For example, select the 
Calibration check box to display only calibration 
information.

Add Log Entry Enables you to make an entry in the instrument log that can-
not be recorded automatically through the application 
software. For example, you may change the port filter. The 
field adjacent to the push button allows you to enter the 
operation; the push button is enabled when you make an 
entry in the field, allowing you to add the entry.
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Report Displays the Log Report Settings dialog allowing you to 
generate the log contents to a specified destination.

Use the Start Date field to specify the date at which to start 
the printout. This date does not limit the entries that display 
in the window, it only limits the entries printed on the 
report.

You can specify a date using one of the following methods:

• Highlight the field (or press F2 to clear the field) and type 
in the desired date.

• Press F2 to clear the field, then F3 to insert the current 
date.

• Double-click in the field (or press F4) to display a calen-
dar to choose a date.

Enter the number of copies desired in the Copies field; you 
may print up to 4. This field is disabled if you are printing 
to a File or to the Screen.

Choose the report destination from the drop-down list in the 
Destination field. If you choose File, the File name field is 
enabled, allowing you to enter a name for the printed file.
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Unit Configuration

Select this option to view the current calibration settings, the date on which calibration was 
performed, and the software and hardware configuration of your system. 

Software Versions Shows the software versions of the Controller and ASAP 
2420 System software.

Options Shows the options installed in the ASAP 2420 system (for 
example, Krypton, Micropore, or 1 Torr).

Gas Displays the Gas Configuration dialog.

This dialog allows you to choose the gases attached to each 
analysis port of the analyzer.
6-36                                                    Nov 2011



ASAP 2420  Operator’s Manual Unit Configuration
Configuration Displays the IP address of the unit. The Change button 
enables you to change the IP address. When you click 
Change, the following dialog is displayed. 

Enter the IP address, then click OK.

Board ID Displays the Board ID dialog so that you can view informa-
tion about the board contained in the requested slot of the 
card cage in the instrument.

Volume Calibration Shows the system, lower, and reference volumes from the 
most recent calibration. It also displays the date and time the 
calibration was completed.

Analysis Calibration Shows analysis calibration data.

Degas Calibration Shows degas calibration data.
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Diagnostics

This option enables you to perform diagnostic tests which your service representative may 
request to resolve a problem. The data generated from these tests may be insignificant to you 
as a user, but are very helpful to your service representative. Ultimately, the results obtained 
from these tests in many situations can eliminate costly downtime, as well as on-site repair 
costs.

Each test generates a file to the 2420\Service\userdiag directory, assuming you used the 
default directory. Your service representative will request that you E-mail this file to him so 
that he may examine the data. If E-mail is unavailable, you may print the report and fax it. 
Your service representative will provide you with applicable destination information.

When you select Unit [n] > Diagnostics, the User Diagnostics dialog is displayed:

View Allows you to view the current operation, the instrument 
schematic, or the instrument log in the User Diagnostics 
dialog. Operation is the appropriate choice for this test.

Test Contains a list of the diagnostic tests. Click the down 
arrow to the right of the field to choose the test.

Analysis Inlet Valve Leak Test Rev A
Tests the analysis inlet valve for leaks; this test should be 
performed before any others.

Leak Test All Manifolds Rev. –
Tests for leaks in the manifolds.
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SVC: Analysis Servo & Transducer Rev. B
Tests the servo operation at various pressures.

SVC: Analysis Vacuum Gauge Test Rev. B
Tests the analysis vacuum gauge.

SVC: Analysis Sample + Po Xdcr Test Rev. A
Tests the accuracy of the sample and Po transducers at 
various pressures.

SVC: Degas Servo Evacuation Test Rev. B
Tests the accuracy of the degas servo at various pressures.

SVC: Degas Vacuum Gauge Test Rev. A
Tests the degas vacuum gauge.

SVC: Degas Transducer Test Rev. A
Tests the linearity of the degas transducer.

Sequence Displays the test file number. This number is assigned 
automatically and incrementally sequenced by the software 
each time a test is performed. This also serves as the name of 
the file that is generated to the userdiag directory, and will 
be appended with SVT. For example, the name of the file for 
the test shown in the above dialog will be 0001.SVT. Be sure 
to make a note of this number so you will know which file to 
send.

Report after test Select this option to have a report generated automatically 
after the test. Refer to “Report Settings” on page 2-21 for 
an explanation of output options.

If you do not select this option, you can still generate a 
report from the second view of the User Diagnostics dialog.

Cancel Cancels the test and closes the dialog.

Next Begins the test; displays the next view of the User 
Diagnostics test dialog. While this dialog is displayed, you 
will receive a series of messages. Two types of messages 
may display:
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Next
(continued)

Task message: this type of message will instruct you to 
perform a task. After you have completed the task, click OK 
to close the dialog. This is an example of a Task message:

Informational message: this type of message simply 
provides you with information. After you have read the 
information, click OK to close the dialog. This is an example 
of an Informational message:

At the end of the test, you will receive a message similar to 
this one indicating completion of the test:

Simply click OK to close the dialog; all valves will close 
automatically.
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Report (drop-down list) Contains a list of predefined reports.

Item [n[ These drop-down lists contain components of the 
selected report. Item 1 data display in the upper pane and 
Item 2 data display in the lower pane.

Report (pushbutton) Enables you to generate a report.

Cancel Cancels the test.

The following push buttons become enabled when the test is complete.

Repeat Repeats the current test, using the same test number and 
writing over the data. Typically, this function will not be 
used.

Next Returns you to the first view of the User Diagnostics 
window allowing you to perform other diagnostics.

Close Closes the dialog.
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Calibration Procedures and Service Tests

Various calibration procedures and service tests are included in the ASAP 2420 operating 
program. These procedures and tests are designed to provide your service representative with 
instrument readouts, as well as to assist him in troubleshooting potential problems and, per-
haps, eliminating unnecessary repair services. This service strategy allows you to conduct 
expert tests in less time than it would take to be trained in servicing the instrument properly.

These procedures are disabled (grayed out) on the Unit menu and can be enabled and per-
formed only with the assistance of a trained Micromeritics service representative:

•  Calibration Data
•  Calibrate Analysis
•  Calibrate Degas
•  Service Test
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REPORTS MENU

This chapter describes the commands on the Reports menu; it also contains examples of 
reports. 

Reports can be generated for data:

• collected on a sample that has completed analysis

• collected on a sample that is currently being analyzed (includes only the information col-
lected up to the time of the report)

• that is manually entered

Description

Listed below are brief descriptions of the commands contained on the Reports menu. Detailed 
descriptions follow this section.

Start Report Allows you to generate a report on a completed sample 
analysis or on the data collected thus far for an analysis in 
progress.

Close Reports Closes all open report windows.

Open Report Enables you to open a report that was saved from the report 
window.

SPC Report Options Allows you to specify the sample data to be included in SPC 
reports.

Regression Report Allows you to generate a regression report.
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Start Report

Select this option to generate a report on a sample analysis. Select Start report from the 
Reports menu to display the Start Report dialog.

Control Chart Allows you to generate a control chart report.

Heat of Adsorption Allows you to generate a heat of adsorption report.

File name The name you select from the Files list box is copied to this 
field. If you select multiple files, only the last one selected is 
displayed. If you have a sample file open when you select 
this option, its name is displayed.

Status Refer to File Selection, page 2-17.

Settings Refer to Report Settings, page 2-21.

Directories Displays a list of available drives and directories. The drive 
and directory last accessed is displayed immediately above 
the Directories list box. 

If you choose a single sample file, the Reports to Generate 
dialog is displayed. The reports selected are the ones you 
specified in the sample file. This dialog allows you to 
deselect reports or select additional ones.
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Close Reports

This option enables you to close all open report windows at one time. 

Open Report

This option enables you to open a report that you saved from the report window.

Double-click on the report(s) you wish to select (or deselect); 
alternatively, you can highlight the report and press Space-
bar. A check mark is placed before each selected report. 
After you make your report selection and click OK, the 
requested reports are sent to the specified destination.

If you choose more than one file, this dialog is not displayed. 
The reports specified in each sample file will be generated.
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SPC Report Options

When you select SPC Report Options, the SPC Report Options dialog is displayed.

The SPC Report Options dialog lists the variables that are most frequently used for SPC 
reporting. You can check as many as desired. All variables selected are computed for each 
sample file used in an SPC report.

Click More for additional SPC calculations for the detailed reports.
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Regression Report

Select this option to generate a regression report. The regression report is used to determine 
the interdependency between two variables. Up to three dependent variables (Y-axis) may be 
plotted against a single independent variable (X-axis). The degree of correlation between the 
variables also is reported. The graphs for the regression report are scaled so that all three fit on 
a single page. If you choose less than three, the graphs are scaled to fill most of the page.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. You can enter up to 40 
alphanumeric characters. 

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your report 
title. For example, you may wish to display your company 
logo. The graphic must be a bitmap (bmp) or enhanced 
metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited in the 
report window (when printed to the screen), or removed if 
desired.
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X- and Y-Axes 
Variable fields

Allows you to designate the X- and Y-axes variables. Click 
on the down arrow to display a list of variables. The variables 
in this list are the ones you specified in the SPC report 
options.

With this option, you can plot the regression of up to three Y-
axis variables against the X-axis variable. The X-axis 
specifies the independent variable for the regression, while 
the Y-axes provide the dependent variables.

Axis Range Enables you to specify the beginning and ending values for 
the X- and Y-axis ranges. Data collected outside these ranges 
are not included in the plot. These fields are disabled if you 
choose Autoscale.

Autoscale Allows you to have the X- and/or Y-axes scaled 
automatically. When scaled automatically, both axes begin at 
zero. The analysis program uses the highest values collected 
during analysis as the ending points.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalculated. 
This ensures that any changes made to the SPC Report 
Options are included in the new report; however, it does 
lengthen the time required to generate the report.

Tabular report Enables you to generate tabular, as well as graphical, data of 
the included samples. A tabular report contains the numeric 
values contributed by each sample.

Label data Allows you to label the points on the plot to correspond with 
the values in the sample files.

Samples Displays the Regression Report Sample Selection dialog, 
allowing you to choose the sample files you wish to have 
reported.
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File name Use this field to limit the files displayed in the Available Files 
pane. For example; enter c*.smp to display only the files 
beginning with a c.

Status This drop-down list determines the type of sample files that 
display in the Available Files pane in the selected directory 
for all dates, or within the specified range of dates (using 
Date Range push button). Refer to Table 2-3: File Status 
and Description, page 2-19 for an explanation of the Status 
types.

Date Range Displays the Select Dates dialog so that you can specify a 
range of dates. Refer to Selecting a , page Selecting a Range 
of Dates, page 2-20 for an explanation of this dialog.

Use all files in
this directory

Select this option to include all files from the selected 
directory in the report.

Directories Lists the current directory. Use the directory window to 
navigate to a different directory.

Add Moves the selected file in the Available Files pane to the 
Selected Files pane. Alternatively, you can simply double-
click on the desired file(s). You can select multiple files by 
holding down Ctrl while making your selections. You can 
include up to 200 sample files.
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Remove Removes the selected file from the Selected Files pane and 
places it back into the Available Files pane.

Save As Default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose output 
criteria.

The Copies field is enabled when you choose Printer as the 
destination, enabling you to print up to four copies of the 
report.

Report Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a statistic.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. You can enter up to 40 
alphanumeric characters.

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your report 
title. For example, you may wish to display your company 
logo. The graphic must be a bitmap (bmp) or enhanced 
metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited in the 
report window (when printed to the screen), or removed if 
desired.

X-axis Order By Enables you to choose the order in which X-axis statistics are 
placed. You can have them placed by Time, File name, Date, 
Minutes, or Days.
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Graph [n] Displays the Control Chart Graph [n] Options dialog, 
allowing you to define the Y-axis of each graph. 

Statistic This drop-down list displays the SPC variables selected on 
the SPC Report Options dialog. The variable you choose will 
be plotted against time.

Autoscale Allows you to have the Y-axis scaled automatically. If you 
wish to specify a range, deselect this option and enter a range 
in the From and To fields.

Center Line Displays placement options for the variable’s optional value. 
Choose Entered to specify placement of the line.

Limit Lines Displays the options available for limiting lines. You can 
have the lines placed at some multiple of the standard 
deviation or at specified positions (Entered).

When you select Entered, the High limit and Low limit 
fields are enabled, allowing you to enter appropriate values.

Tabular report Allows you to generate tabular, as well as graphical, data of 
the included samples. A tabular report contains the numeric 
values contributed by each sample.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalculated. 
This ensures that any changes made to the SPC Report 
Options are included in the new report. It also lengthens the 
time required to generate the report.
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Samples Displays the Control Chart Sample Selection dialog, allowing 
you to choose the sample files on which you wish to report. 

This dialog functions in the same manner as the Regression 
Report Sample Selection Dialog explained on page 7-8.

Save as Default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose output 
criteria.

The Copies field is enabled when you choose Printer as the 
destination, enabling you to print up to four copies of the 
report.

Report Generates the report.
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Heat of Adsorption Report

The isosteric heat of adsorption is an important parameter for characterizing the surface 
heterogeneity and for providing information about the adsorbent and the adsorption capacity. 
Multiple adsorption isotherms are obtained on the same sample using the same adsorptive but 
at different temperatures to obtain the heat of adsorption.

This option allows you to choose the sample files, define the quantities, and generate a Heat of 
Adsorption report; the Heat of Adsorption dialog is displayed.

Table Contains the files you choose; also lists the quantity 
adsorbed.

Add Samples Displays the Select Samples dialog so that you can choose 
desired files.
 

Remove Samples Removes the selected sample from the list. If no samples are 
selected, the last one is removed.

Clear Samples Removes all samples from the list.
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Edit Quantities Displays the Edit Quantities Adsorbed dialog so that you can 
specify the range of surface coverage to include in the heat of 
adsorption report.

Quantity Adsorbed 
table

Allows you to enter the points.

Insert Range Displays the Insert Quantity Range dialog box.
This dialog allows you to specify the starting and ending 
quantities adsorbed, as well as the number of points to insert 
within the specified range.

Save Table Allows you to save the current table as a file (QNT 
extension).

Load Table Allows you to import a previously saved table.
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Insert Inserts a row above the selected row.

Delete Deletes the selected row.

Clear Clears the entire table of all entries except one; one is 
required.

Report Settings The options in this group box allow you to choose report 
criteria.

Show report title Choose this option to have a title display in the header of 
your report, then use the adjacent field to enter the title.

Show graphic This option allows you to have a graphic appear in your title; 
for example, you may wish to show your company logo. You 
can use a bitmap or an enhanced metafile.

Use the Height and Width fields to define a size.

Copies Enabled when you choose Printer or Printer/Plotter as the 
destination, allowing you to print up to four copies of your 
report(s).

Destination Enabled when you choose Printer or Printer/Plotter as the 
destination, allowing your to print up to four copies of your 
report(s).

File name Enabled when you choose File as the destination, allowing 
you to enter a name (or you can accept the default).

Report Generates the report.

Tabular report Select this option to have data generated in a tabular format.

Isostere plot Select this option to generate a graph showing quantities of 
gas adsorbed vs. the temperature.

Heat of adsorption plot Select this option to generate the Heat of Adsorption data in a 
graphical format.
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Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics, as shown in the following example.

The report header may contain a graphic (such as company logo) and/or title if specified by the 
user. The header also contains: 

• the measurement principle and calculation method used in compiling the report

• sample and instrument statistics such as date and time of analysis, analysis conditions, and 
background data for tabular and graphical reports

• notes of any changes to the sample file which occur after analysis (excluded in summary 
reports)

Onscreen Reports

The report window containing onscreen reports provides many options for customizing and 
manipulating reports: 

• a tool bar
• shortcut menus
• zoom feature
• axis cross-hairs 
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When reports are printed to the screen, they are printed in a window like the one shown below. 
Each requested report is listed in the Reports window on the tool bar; they are also indicated 
by selectable tabs across the top of the report header. To view a specific report, select its tab or 
select the report in the Reports window and click Show.

Displays graphical 
(or tabular) data

List of reports 
requested

Tabs display for each type of report you chose to generate.

Header

Options on 
Tool Bar
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Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the report 
has been hidden, it and its associated tab will become 
visible.

Delete Deletes the selected report. A deletion confirmation dialog is 
displayed since this function cannot be undone. The deleted 
report(s) will have to be regenerated if deleted in error.

Hide Hides (removes) the selected report from the report window. 
The report’s associated tab is also removed.

Open Allows you to open a previously saved report file.

Print Displays a print dialog so that you can choose an appropriate 
printer for report output. A list of available reports is 
displayed in the window on the right side of the dialog.
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For convenience in selecting which reports to print, push 
buttons are provided beneath the report window.; or, you can 
make your selection by clicking on the desired reports. 

Current selects the report displayed in the report window.

Shown selects only the shown reports; any non-highlighted 
reports indicate they are hidden. You can still select hidden 
reports from this window to print.

All selects all reports, including those that may have been 
hidden.

Clear clears all selections. 

Save Saves all reports of the currently open file in a report format 
using the same name as the sample file. The file will be 
given an rep extension. If you wish to specify a name and/or 
specific reports to save, use the Save As push button.
7-20                                                    Nov 2011



ASAP 2420 Operator’s Manual Printed Reports
Save As Saves all or specified reports from the currently open file. 
The push buttons displayed on this dialog perform in the 
same manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows you 
to reopen the file using the push button on the Report 
window tool bar.

Spreadsheet (*.xls): Saved in a format which can be 
imported into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be 
imported into programs accepting this type of file.

Default Style Displays the Default Style dialog so that you can specify 
default parameters for report fonts and curve properties.

Font Contains a list of report elements for which the font can be 
edited. Simply highlight the desired element and click Edit; 
a font dialog is displayed so that you can specify the desired 
font and attributes.

Curve The items in this group box enable you to specify a thickness 
for report curves and, when using histograms, the type of fill 
to apply.

Graph border line
thickness

Enables you to specify a thickness for the border of the 
graph.

Load Loads the last saved defaults.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

Tabular Reports

Save Saves the changes as the defaults. 

Close Closes the dialog and applies the changes. If you clicked 
Save, the changes become the defaults. If you did not click 
Save, the changes apply to the current report only.

Resize column Displays a dialog so that you can specify the width of the 
selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column to 
the left or to the right.

Align column Enables you to right-align, left-align, or center the data in 
the selected column.

Hide column Displays a list of the columns that have not been hidden, 
enabling you to select the one you wish to hide.

Show column Displays a list of all hidden columns, enabling you to select 
the one you wish to have shown again.
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Graphs

Column font Displays a Font dialog, allowing you to change font 
attributes for the tabular data in the current report. 

Header font Displays a Font dialog, allowing you to change font 
attributes for column headers in the current report.

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns are 
tab-delimited, allowing easy alignment

Autoscale Autoscales all axes of the graph. This function is useful for 
returning to a full view after having zoomed in.

Redraw Sets axis boundaries to its original view. You can also use 
this function to remove cross-hairs.

Show curve Shows any curves that have been hidden. This option is 
disabled (grayed) if no curves have been hidden.

Hide curve Hides (removes from view) any unwanted curves.
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Edit curve Displays the Curve Properties dialog, allowing you to edit 
curve properties.

Title Displays the title of the curve you are editing. You can edit 
the title if desired.

Style This drop-down list contains the styles in which collected 
data can be displayed.

Choices: Curve, Histogram, Points, Curve and Points

Curve group box Contains options for curves and points. You can edit the 
curve interpolation, the style of curve and/or points, as well 
as the pen color. The options in this group box are disabled if 
Histogram is chosen in the Style drop-down list.

Histogram group box The options in this group box are enabled when you choose 
Histogram as the style for collected data. The choices in the 
drop-down list allow you to choose the type of fill for the 
Histogram, then you can click Color to select the fill color.

Edit axis Displays the Axis Properties dialog, allowing you to edit 
axis properties.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
details. To use this feature, simply hold down the left mouse button and drag the mouse cursor 
(drawing a box) across the area you wish to view; then release the button. The enlarged area 
immediately fills the graph area. Right-click in the graph area and choose Autoscale from the 
shortcut menu to return to the normal view

Edit legend Displays the Legend Properties dialog, allowing you to edit 
the placement of the legend. You can also edit the font if 
desired.

Edit title Displays the Title Properties dialog, allowing you to edit the 
current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing 
you to paste it into other applications accepting Windows 
metafiles.

Copy as text Copies the data used to generate the graph as a series of tab-
delimited columns of text.
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Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, 
simply left-click in the desired area of the graph.

Right-click in the graph area and choose Autoscale or Redraw from the shortcut menu to 
remove cross-hair lines and return to the normal view. Alternatively, you can click outside of 
the graph area.

Report Examples

The remainder of this chapter contains samples of some of the reports that can be generated by 
the ASAP 2420 Program. Most of the reports can be varied through entries on the report 
options screens.

              Y-axis position

X-axis position

             Point of coordination
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Summary Report
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Isotherm Tabular Report
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Isotherm Linear Plot
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Bet Surface Area
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Bet Surface Area Plot
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t-Plot Report
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t-Plot
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BJH Adsorption Pore Distribution 
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BJH Adsorption Cumulative Pore Volume
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BJH Adsorption dV/dlog(w) Pore Volume
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BJH Desorption Pore Distribution 
7-38                                                    Nov 2011



ASAP 2420 Operator’s Manual Report Examples
BJH Desorption Cumulative Pore Volume
Nov 2011                                                7-39 



Report Examples ASAP 2420 Operator’s Manual
BJH Desorption dV/dlog(w) Pore Volume
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Validation Report
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Micropore Reports

Horvath-Kawazoe
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Dubinin
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OPTIONS MENU

The commands on the Options menu enable you to configure the system to your laboratory’s 
requirements and establish sample defaults.

Description

Option Presentation Allows you to display the sample file dialog in Advanced, 
Basic, or Restricted mode.

Sample Defaults Enables you to enter default sample information file values. 
When you create a new sample information file, the file 
initially contains the default values.

Units Enables you to choose the way in which data are presented 
on the screen and in printed reports. 

Graph Grid Lines Enables you to choose the type(s) of grid lines to show on 
your report. 

Live Graph Enables you to choose the variable for the X-axis during 
data collection.

Parameter Files Directory Allows you to specify a location for the parameter files used 
in the Basic sample file editor.

Service Test Mode Enables you to perform certain troubleshooting procedures. 
This option is available only under the direction of a 
Micromeritics service representative.
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Option Presentation

The sample editing dialogs for the ASAP 2420 analysis program may be presented in three 
modes: Restricted, Basic, and Advanced. Each format displays sample information dialogs 
differently.

• Advanced: displays all parts of the sample information file in a tabbed dialog as in an 
index card file. You just click on the tab of the desired parameter. This format also allows 
you to switch to the Basic mode.

• Basic: displays all parts of the sample file as a single dialog and enables you to select 
parameters from predefined files. This format also allows you to switch to the Advanced 
mode if editing of parameters is desired.

• Restricted: displays in the same manner as the Basic format. Certain menu options, how-
ever, become disabled and you cannot switch to the Advanced mode. You also must enter 
a password to access and exit this format.

Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Each 
tab opens its associated dialog. For example, if you are using the Advanced format and you 
open or create a sample information file, the following dialog is displayed. 

The Advanced format can be used to edit sample parameters and customize files. 
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Basic

The Basic format presents the sample information file and its parameter files as a single 
dialog. You also have access to all menu options. For example, if you are using the Basic 
format and open or create a sample information file, the dialog is displayed in this manner.

The Basic format is used to quickly create sample information files using previously defined 
parameter files. You also can switch easily to the Advanced format to view or edit details of 
parameter files.

Restricted

The Restricted format is identical to the Basic format, except that certain options are disabled. 
You also cannot switch to the Advanced format. This format is password-protected and 
typically is used in laboratories where analysis conditions must remain constant, for example, 
in the pharmaceutical industry.

When you select Restricted, a dialog requesting a password is displayed.

Predefined 
parameter files 
are selected from 
drop-down lists
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You can enter any password (up to 31 characters) to enable the Restricted mode. You must 
enter the same password to exit the Restricted mode. For example, if you enter “password” to 
enable the Restricted format, then you must enter “password” to exit. If you forget the 
password, open the application INI file and navigate to the Private section. The current 
password is shown immediately following “OptionPresentationPassword.” Make a note of the 
password, exit the INI file, and enter the password where requested. Deleting the password 
from the INI file will not disable the Restricted mode; you must enter the password using the 
Password dialog to exit the Restricted format.

Sample Defaults

Sample defaults are the values included in the file when you create a new sample file. This 
option allows you to specify the default values. This feature makes it easy for you to apply the 
same conditions to many samples. 

For efficiency, it is best to specify defaults for materials you most commonly analyze. You can 
always edit the values in the sample file when it is created. Sample defaults can be specified 
using the Basic or Advanced format. 

The analysis program contains one complete default sample information file. When you select 
Open, Sample information from the Main Menu, a new file with these default values is 
generated. Default files for degas conditions, analysis conditions, adsorptive properties, and 
report options also are included.

Basic Format

When you select Sample Defaults using the Basic format, the Basic Sample Defaults dialog is 
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displayed.

Sequence Allows you to specify a default sequence for the sample file 
name. The number you specify is incrementally sequenced 
each time you create a sample file. It is the number that 
appears in the File name field when you select File, Open, 
Sample information.

Use numbers, letters, or other printable characters, such as 
dashes. At least three numbers must be included.

• Use up to eight characters.
• Do not use special characters such as * or ?. 
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Sample Allows you to enter an additional identification that provides 
more information than the sample file name itself. 

The field on the left allows you to specify a name for the 
identification label. For example, you may prefer to use Test 
or Material.

• Use up to 20 characters for the prompt.

The field on the right allows you to specify a format for the 
sample identification. 

• Use numbers, letters, or other printable characters, such 
as dashes.

• Use up to 43 characters (including the $ symbol).

• Include the automatically generated file name as part of 
the identification by using the $ symbol where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter 
the identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

for the second file:

   Lab #25 - 000-002, and so on.

Mass Enter a value that represents the approximate mass of your 
most commonly analyzed material. You can enter a more 
accurate value in the sample file when the analysis is 
completed.

Enter Enables the Sample Mass field allowing you to enter a 
value.
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Calculate Enables the Empty tube and Sample + tube fields, allowing 
you to enter appropriate values. These values are used to cal-
culate the mass of the sample, 

               

Density Enter the density of the sample.

Sample Tube
Degas Conditions
Analysis Conditions
Adsorptive Properties
Report Options

Each parameter has a drop-down list containing files 
included with the software, as well as any you may have 
created and saved to the Parameter Files Directory. 

Choose from the list provided for each parameter the file you 
wish to use as the default.

Replace All Refer to “Replace All” on page 2-16.

Save Saves the current definition as the defaults

Close Closes the dialog box.

Advanced Switches the sample editor to the Advanced format.

Masssample Masssample tube+ Masstube–=
Nov 2011                                            8-9 



Sample Defaults ASAP 2420 Operator’s Manual
Advanced Format

When you select Sample Defaults while using the Advanced format, the Advanced Sample 
Defaults dialog is displayed.

The defaults you specify for the parameters in the Advanced format display as the 
defaults for newly created standalone parameter files.

Sequence Allows you to specify a default sequence for the sample file 
name. The number you specify is incrementally sequenced 
each time you create a sample file. It is the number that 
appears in the File name field when you select File > Open 
> Sample information.

• Use numbers, letters, or other printable characters, such 
as dashes. At least three numbers must be included.

• Use up to eight characters.

• Do not use special characters such as * or ?. 
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Sample Allows you to enter an additional identification that provides 
more information than the sample file name itself. 

The field on the left allows you to specify a name for the 
identification label. For example, you may prefer to use Test 
or Material.

• Use up to 20 characters for the prompt.

The field on the right allows you to specify a format for the 
sample identification. 

• Use numbers, letters, or other printable characters, such 
as dashes.

• Use up to 43 characters (including the $ symbol).

• Include the automatically generated file name as part of 
the identification by using the $ symbol where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter 
the identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

for the second file:

       Lab #25 - 000-002, and so on.

Operator
Submitter

These fields contain the name (or other identification) of the 
operator and submitter. 

The fields on the left can be edited to display a different label 
if desired.

• Use up to 20 characters for the label.
Nov 2011                                            8-11 



Sample Defaults ASAP 2420 Operator’s Manual
Operator
Submitter
(continued)

The fields on the right allow you to specify default names or 
titles.

• Include the automatically generated file number as part 
of the identification by using the symbol $ where you 
want the sequence number to appear. Refer to the exam-
ple in the previous section.

• Use up to 43 characters (including the $ symbol).Omit 
either (or both) item entirely from the sample information 
file by selecting Omit.

Mass You can enter a sample mass or have the mass calculated 
automatically.

Enter Enables the Sample Mass field allowing you to enter a value.

Calculate Enables the Empty tube and Sample + tube fields, allowing 
you to enter appropriate values. These values are used to cal-
culate the mass of the sample, 

               

Density Enter the density of the sample.

Type of Data Choose whether you wish to enter data or have it collected 
automatically by the system.

User Parameters The fields in this group box are used primarily for SPC (Sta-
tistical Process Control) reporting. They are used to specify 
characteristics of the sample or its manufacturing process.

Once specified, these parameters display on the sample edi-
tor and in the SPC Sample Options dialog (accessed through 
the SPC Report Options dialog).

These fields can also be used to record analysis conditions or 
sample information so that it can be printed on the Summary 
report.

Select Omit if you do not wish to use these fields; this will 
prevent them from displaying on the sample information dia-
log.

Masssample Masssample tube+ Masstube–=
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Units

This menu command displays the Units Selections dialog which allows you to choose the 
manner in which to display data on reports. 

Comments Use this window to enter sample characteristics, analysis 
conditions, etc. Anything you type in this window is printed 
in the report header.

Add Log Entry Choose this command if you want to add comments to be 
included in the ASAP 2420 log.

Replace All Refer to “Replace All” on page 2-16.

Save Saves the current definition as the defaults.

Close Closes the dialog box.

Basic Switches the sample editor to the Basic format.
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Graph Grid Lines

Graph Grid Lines enables you to choose the type(s) of grid lines to show on your reports; the 
Graph Grid Lines dialog is displayed.

Live Graph

This option enables you to choose the variable for the x-axis during data collection. You can 
also choose to correct for thermal transpiration which should always be selected for micropore 
analyses (refer to page 5-36 for additional information on thermal transpiration).

X-Axis
Y-Axis

Enables you to choose Major and/or Minor lines to 
display in printed reports for the Logarithmic and Linear 
scales. 

If you deselect these items (remove the check marks), 
your report will not display grid lines.

Grid Line Style Allows you to choose the type of grid line to display if 
grid lines are being shown.
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Parameter Files Directory

This option allows you to specify a location for the predefined Sample tube, Analysis 
conditions, Degas conditions, Adsorptive properties, and Report options files displayed in the 
drop-down lists on the Basic Sample Information dialog. The current directory is displayed 
above the drives/directory window.

The default directory is params and includes several parameter files supplied with the 
analysis program. If you specify a different directory, these files will not be included in the 
drop-down lists unless you copy (or move) them to the new directory.

If you wish to continue using the params directory for parameter files, be sure to save any files 
you create to this directory.

Service Test Mode

Various service tests are included in the ASAP 2420 operating program. These tests can be 
performed only with the assistance of a trained Micromeritics service representative. When 
you select Service Test Mode from the Options menu, a dialog box prompting you to enter a 
password is displayed. This password is coded to change on a regular basis and is known only 
by your service representative. You will not be able to perform these tests without his 
guidance. 
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TROUBLESHOOTING AND MAINTENANCE 

The ASAP 2420 system has been designed to provide efficient and continuous service. 
However, to get the best results over the longest period of time, certain maintenance 
procedures must be followed. This chapter includes troubleshooting information, 
recommended preventive maintenance procedures, and routine maintenance procedures. 

Troubleshooting

Most operational problems are caused by the following:

• Leaks (commonly around the sample tube O-ring at the analysis port)
• Sample weighing errors
• Use of too much analysis bath fluid in the Dewar at the start of an analysis
• Entry of incorrect system volume for analysis

Always check these first when expected analysis results are not obtained. Some common 
operational problems, which are not indicated on the computer screen, and their respective 
causes and solutions are provided in the following table. 

                 

What Happened Why What To Do

Analysis Dewar cannot 
be raised (or lowered).

Elevator that moves Dewar 
stuck in up position, down 
position, or somewhere in 
between.

Check for possible obstruction 
to elevator movement.

Vacuum pump system 
makes loud noise 
continuously.

Sample tube connector nut is 
loose.

Turn the connector nut 
clockwise to tighten. 
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What Happened Why What To Do

Vacuum makes loud 
noise continuously.
(continued)

Sample tube fitting is loose. Tighten the fitting securely with 
a wrench. 

Sample tube O-ring is worn or 
cracked. 

Replace the sample tube O-ring. 
Refer to “Replacing a Sample 
Tube O-ring” on page 9-12.

Sample tube is cracked. Replace with a new sample tube.

No sample tube is loaded on a 
selected port.

A gas inlet valve is open while 
the vacuum valve is open.

Make sure the port valve is 
closed. Install a plug or empty 
sample tube on the port.

Enable manual control, then use 
the instrument schematic to 
close the gas inlet valve. Refer 
to “Enable Manual Control” 
on page 6-24.

Vacuum gauge shows 
reading above 20 
mHg, even after 
extended pumping 
through unrestricted 
valve with analysis or 
degas ports closed.

Oil-based Pump Only:
Vacuum pump oil is low, 
causing ineffective 
evacuation.

Add or change vacuum pump 
oil. Be sure to add oil to proper 
level according to indicator 
window on the pump. Refer to 
“Inspecting and Changing 
Vacuum Pump Fluid” on 
page 9-16.

No power to the vacuum 
pump.

Check the pump power plug, 
power switch, and line circuit 
breaker.

Filter in the port being used 
is dirty.

Replace the port filter. Refer to 
“Replacing the Port Filters” 
on page 9-9.
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What Happened Why What To Do

Vacuum gauge shows 
reading above 20 
mHg, even after 
extended pumping 
through unrestricted 
valve with analysis or 
degas ports closed.
(continued)

Alumina in the oil vapor trap 
is holding moisture because 
it was not sufficiently dried 
before being added to the 
alumina trap.

Replace or dry the alumina. 
Refer to “Replacing the 
Alumina in the Oil Vapor 
Traps” on page 9-20.

Oil-Free Pump Only:
Filter in the port being used 
is dirty.

Replace the port filter. Refer to 
“Replacing the Port Filters” 
on page 9-9.

High-vacuum pump may 
have timed out.

Remove the lower front panel 
from the analyzer. 

Refer to “Accessing the 
Vacuum Pumps” on page 9-14. 

Turn the high-vacuum pump 
power switch off, then back on.

No power to the vacuum 
pump.

Check the pump power plug, 
power switch, and line circuit 
breaker.

The diaphragm in the pump 
is worn or damaged.

Contact your Micromeritics 
Service Representative.

  High-vacuum pump power switch
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What Happened Why What To Do

Analysis valves cannot 
be operated.

Circuit was opened by the circuit 
breaker.

Push in the breaker button, 
located on the side of the 
instrument near the power 
entrance. If it will not stay in, 
contact appropriate service 
personnel.

Cable from the computer to the 
analyzer is loose.

Make sure the cable is connected 
properly to the computer and the 
analyzer.

High-vacuum pump 
indicator light does not 
come on.

No power to the high-vacuum 
pump.

Remove the lower panel on the 
front of the analyzer. 

Refer to “Accessing the 
Vacuum Pumps” on page 9-14.

Check the pump power plug.

Turn the high-vacuum pump 
power switch off, then back on. 

Breaker button 

                   
High-vacuum   High-vacuum pump
pump power     power switch   
plugs
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Preventive Maintenance

The table below lists the preventive maintenance procedures you should complete to keep 
your analyzer operating at peak performance. Instructions for each procedure follow the table. 
Micromeritics also recommends that you have preventive maintenance procedures and 
calibration performed by one of our service representatives every 12 months.

Maintenance Required Frequency

Checking and cleaning analysis port Dewars, page 9-8 Weekly

Replace port filters, page 9-9 Every 30 days

Replace sample tube O-ring, page 9-12 As required or every 3 months

Inspect and change vacuum pump fluid*, page 9-16 As required or every 3 months

Replace alumina in oil vapor traps*, page 9-20 As required or every 3 months

Lubricate elevator screw, page 9-25 As required or every 6 months

Clean the outside of the analyzer, page 9-25 As required or every 6 months

Check analyzer outgassing rate, page 9-26 Every 6 months

Test analyzer for leaks, Appendix D As required or every 12 
months

Replace vacuum pump exhaust filter, page 9-30 As required or every 12 
months

Replace diaphragm in vacuum pump (if an oil-free 
pump is used)**

Every 12 months

*Oil-sealed vacuum pumps only.

**For oil-free pumps only: After about 12 to 18 months of operation, the diaphragm in 
the pump will wear out. When the diaphragm wears out, the pump becomes completely 
inoperable. To prevent any instrument down time due to an inoperable pump, we 
recommend that you have the diaphragm replaced by a Micromeritics Service 
Representative every 12 months.
Nov 2011                                            9-7 



Preventive Maintenance ASAP 2420 Operator’s Manual
Checking and Cleaning the Analysis Port Dewars

Ice and suspended frost particles may accumulate in the bottom of an analysis port Dewar. 
Particles or deposits exceeding 1/4 in. (0.64 cm) in depth may jam between the bottom of the 
sample tube and the bottom of the Dewar, causing the Dewar not to raise fully. Accumulations 
of fine particles impede liquid nitrogen circulation around the bottom of the sample tube. This 
causes the sample temperature to be slightly higher which, in turn, can cause pore volume 
measurement errors in those samples exhibiting high isotherm slope above 0.97 relative 
pressure. 

Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen 
evaporates. The water must be removed; otherwise it will solidify when liquid nitrogen is 
added and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use. 
Clean Dewars on a weekly basis as follows:

1. Remove the sample tubes from the analysis ports.

2. Ensure that the Psat tubes are out of the way.

3. Display the Analysis schematic and enable manual control (refer to “Enable Manual 
Control” on page 6-24).

When handling Dewars, be sure to observe the Dewar precautions outlined in 
“Filling Dewars” on page 3-31.
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4. Raise the Dewar elevators (refer to “Enable Manual Control” on page 6-24).

5. Remove the Dewars and pour the liquid nitrogen from the Dewars into an appropriate 
cryogenic container.

6. Rinse the Dewars with warm water to melt any ice accumulation which may remain in the 
Dewars then dry thoroughly.

7. Replace the Dewars.

8. Lower the Dewar elevators (refer to “Enable Manual Control” on page 6-24).

9. Reposition the Psat tubes and tighten the tube fittings.

Replacing the Port Filters

A porous metal filter is located in each analysis and degas port. If a degas port is not plugged 
with either a sample tube or a port plug then the filter will absorb atmospheric gases, resulting 
in extended degassing time for samples on that port. 

Using a contaminated filter on an analysis port may extend the time required to achieve a 
vacuum at that port. More importantly, the contaminant may adsorb or desorb during analysis, 
affecting the analysis results. A contaminated filter on an analysis port may cause a leak test to 
fail (if the contaminant outgasses) or cause a free space reading to be much lower than normal.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes 
to burst.
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Analysis Ports

1. Using a wrench, remove the sample tube fitting from the analyzer.

2.  Remove the filter and O-ring.

Before removing and installing a port filter, ensure that the port valve is closed. 
Observe the analysis system schematic to verify valve status.

Place a Dewar cover on the Dewar before replacing port filters.This prevents parts 
from falling into the Dewar and possibly causing breakage.

Sample tube

fitting

   O-ring

     Filter
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3. Replace the filter and the O-ring. 

4. Reinstall the analysis port fitting; securely tighten with a wrench to prevent leaks during 
evacuation.

Degas Ports

1. Using a wrench, remove the degas port fitting.

2.  Remove the O-ring and filter. 

3. Replace the filter and the O-ring. 

4. Reinstall the degas port fitting; securely tighten with a wrench to prevent leaks during 
evacuation.

To avoid analysis problems, the new filter and O-ring must be clean. Do not 
touch them with bare hands.

Before removing and installing a port filter, ensure that the port valve is closed. 
Observe the degas system schematic to verify valve status.

Degas port fitting

O-ring

Filter

To avoid analysis problems, the new filter and O-ring must be clean. Do not 
touch them with bare hands.
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Replacing a Sample Tube O-ring

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-
ring becomes worn or cracked, it does not provide a good seal and will need to be replaced. 
This procedure applies to both degas and analysis ports.

1. Holding the sample tube firmly with one hand, loosen and remove the sample tube 
connector nut by turning it counterclockwise.

2. Carefully pull the sample tube down until it is free from the port. 

Before removing (or installing) a sample tube, ensure that the port valve is 
closed. Observe the analysis schematic or degas schematic to verify valve 
status. 

Be careful not to let the sample tube connector nut drop onto the sample tube 
bulb as it may break the tube.
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3. The connector nut contains a ferrule and an O-ring. Remove the O-ring from the top of the 
sample tube. 

4. While holding the connector nut in place, slide a new O-ring over the sample tube, about 
1/4-in. (5 mm) from the top of the tube.

5. After the new O-ring is in place, insert the sample tube back into the sample port until it is 
fully seated.

6. Turn the connector nut clockwise until it is hand-tight.

                    Ferrule

                  O-ring

If the O-ring remains inside the sample port, you may use a pair of tweezers or 
needle-nose pliers to remove it.

Ferrule

Connector nut

 

O-ring - 1/4 in. (5 mm) from top
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Accessing the Vacuum Pumps

You will need to access the vacuum pumps to perform certain maintenance procedures. The 
pumps can be accessed by removing the lower front panel of the analyzer.

To remove the panel:

1. Remove the three screws located along the bottom of the panel.

2. Use the hand grips in the front panel to pull the panel away from the magnetic latches, 
then lift the panel up and off the analyzer.

Remove these screws

      

 Lift up to remove panel
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3. The pumps are housed on a shelf on the bottom of the analyzer as shown below.

Your system may contain two oil-based pumps, two oil-free pumps, or one of each type. A 
high-vacuum pump is installed for each oil-free pump. 

The illustration above shows two oil-free pumps and two high-vacuum pumps.

4. If you plan to remove a vacuum pump(s) for servicing, select Unit > Show Degas 
Schematic on the ASAP 2420 main menu, then select Unit > Enable Manual Mode.

5. Turn off the vacuum pumps:

• For oil-based pumps: disconnect the power plug from the power source.

• For oil-free pumps: place the On/Off switch on the side of the pump in the Off position. 
Place the high-vacuum pump power switch in the Off position.

 Oil-free analysis and               High-vacuum pumps         High-vacuum         High-vacuum          

                                                                                         pump(s) power       pump(s) power degas vacuum pumps 
                                                                                          plugs                      switch

Vacuum pump power switch location

                Open valves 13 and 15
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6. Open valve 13 and valve 15.

7. When the pressure stabilizes around atmospheric pressure, close valve 13, then 15. 

This step fills the vacuum section with the backfill gas before you disconnect a pump.

Inspecting and Changing Vacuum Pump Fluid

The fluid in the vacuum pump should be changed every three months or when the efficiency of 
the vacuum pump declines (requiring increased time to reach vacuum levels). The fluid can 
first be inspected to determine if a change is necessary.

Use oil supplied by Micromeritics, or refer to the vacuum pump manual for other acceptable 
oils.

Inspecting Fluid

1. Remove the lower front panel from the analyzer (refer to “Accessing the Vacuum 
Pumps” on page 9-14).

2. View the vacuum pump fluid through the oil level window. Fluid in good condition is 
clean, clear or light in color, and transparent. If the color of the fluid is darkened, the fluid 
should be changed. 

This procedure applies to oil-sealed vacuum pumps only. 

Oil-level window
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Changing Fluid

1. Remove the lower front panel from the analyzer if it is not already removed. (refer to 
“Accessing the Vacuum Pumps” on page 9-14). 

2. Unplug the vacuum pump from the power source.

3. Loosen the wing nut on the clamp at the top of the oil vapor trap. Swing the clamp open 
and remove the trap from the hose.

Always drain the vacuum pump while the pump is warm and disconnected from 
the power source.

Disconnect hose

Oil-vapor trap

Clamp wing-nut
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4. Grasp the handle on top of the vacuum pump and lift it out of the analyzer; place the 
vacuum pump on a work table.

5. Drain the used oil: 

a. Place a waste container under the drain spout.

b. Remove the plug from the drain spout.

c. Allow the oil to drain into the waste container.

d. Replace the drain plug.

        

    

        Oil-fill level

Drain plug
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6. Remove the oil-fill plug.

7. Add fresh fluid to the oil-fill port until the level is midway between the two indicator lines 
in the oil-level window.

8. Check the washer or O-ring used at the oil-filling port; replace if necessary. 

9. Insert the oil-fill plug and turn counterclockwise to tighten.

10. If the fluid was badly contaminated (dark brown color), flush the pump with fresh fluid as 
follows:

a.  Cover the top of the oil vapor trap.

b.  Plug the pump power cord into a power source and run for about 2 minutes.

c.  Unplug the power cord.

d.  Remove the plug from the drain spout.

e.  Allow the oil to drain into the waste container.

f.  Reinstall the drain plug.

g.  Add fresh fluid to the oil-fill port until the level is midway between the two indicator 
lines.

h.  Reinstall the oil-fill plug.

i.  Repeat steps a through h if necessary.

11. Check the alumina in the oil vapor trap and replace if necessary (refer to “Replacing the 
Alumina in the Oil Vapor Traps” on page 9-20).

12. Place the vacuum pump back onto the drip tray in the analyzer.

Oil-fill port

Adding fluid above the midway position on the fluid level indicator may cause 
fluid to splash into the vacuum hoses and leak from the vacuum pump.
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13. Reconnect the vacuum pump hose.

14. Reconnect the power cord to the power source.

15. Reinstall the front analyzer panel.

16. The pump must run a few hours (or overnight) to eliminate air and moisture from the fresh 
fluid and to produce efficient vacuum operations.

Replacing the Alumina in the Oil Vapor Traps

The activated alumina in the oil vapor traps becomes saturated during use. The alumina should 
be replaced if either of the following conditions exist:

• The alumina has been used for a three-month period.
• Most of the alumina pellets are no longer white.

This procedure applies to oil-based vacuum pumps only.

Oil vapor trap 

Alumina
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1. Prepare fresh alumina as follows:

a. Heat an oven between 250 °C and 350 °C.

b. Pour about 180 grams of alumina into a glass or metal container for each trap 
(approximately 250 mL if a graduated beaker is used). Place the container in the 
oven.

c. Bake the alumina for two hours; turn off the oven.

d. Allow the alumina to cool in the oven before pouring it into the traps.

2. Choose one of the following:

• If the vacuum pump is removed from the analyzer, proceed to step 3.

• If the vacuum pump is not removed from the analyzer and you wish to remove it, refer 
to steps 1 through 4 under “Changing Fluid” on page 9-17. 

• If the vacuum pump is not removed from the analyzer and you do not wish to remove it, 
remove the lower front panel of the analyzer (refer to “Accessing the Vacuum Pumps” 
on page 9-14), then unplug the pump from its power source. 

3. Loosen the wing nut on the clamp at the bottom of the oil vapor trap. Swing the clamp 
open and remove it. 

4. Remove one end fitting from the trap body.

5. Remove the used alumina from the trap body and dispose of it in an appropriate manner.

Do not perform the following procedure on used alumina. The resultant oil 
vapors may cause a fire or an explosion.

Oil vapor trap 

     End fitting

    Wing nut
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6. If the trap body interior appears oily or dirty, wash it with isopropyl alcohol or ethyl 
alcohol and dry it thoroughly.

7. Pour the new activated alumina pellets into the trap until they are level with the top of the 
trap body.

8. Screw the end fitting back onto the trap and tighten securely by hand. Insert the O-ring and 
screw the end fitting back onto the trap and tighten securely by hand.

9. Make sure the centering ring is in place on the intake port.

Exposure of the trap body to oil vapor may cause small cracks on the inside 
surface of the trap body. Under normal circumstances, these cracks will not 
cause problems or leaks.

Ensure adequate ventilation when using solvents for cleaning purposes.

Centering ring

O-ring

End fitting
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10. Place the trap on the centering ring.

11. Open the clamp and place it around the flange of the intake port and the flange of the trap. 
Swing the clamp fastening screw toward the intake port until it fits into the slot in the 
other half of the clamp. Tighten the wing nut securely by hand.

12. If you removed the pump from the analyzer, place it onto the drip tray in the analyzer.

   Oil vapor trap

      Centering ring

  Intake port
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13. Reconnect the hose from the analyzer to the oil vapor trap using the clamp and wing nut as 
described in step 11 above.

14. Plug the pump power cord into the power source.

15. Reinstall the front panel on the analyzer.

Tighten clamp to attach
trap to hose
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Lubricating the Elevator Screws

1. Remove the analyzer’s back panel by loosening, then removing the retaining screws.

2. Apply a light coat of lithium grease to the six elevator screws.

3. Replace the back panel.                                    

Cleaning the Analyzer

The ASAP 2420 should be cleaned every six months, or sooner if required. 

Clean the outside casing of the analyzer (including the shields) with a clean cloth dampened 
with isopropyl alcohol (IPA), a mild detergent in water, or a 3% hydrogen peroxide solution. It 
is not necessary to remove any switches or screws to clean the outside casing.
 

      

Elevator
Screw

Use a mild detergent in water or isopropyl alcohol to clean the shields. Avoid 
using acetone because it will damage the surface of the shields.
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Checking the Analysis Manifold Outgassing Rate

1. Close the supply valves (Nupro valves) on the gas inlet lines.

2. Insert leak tight plugs in unused gas inlet ports.

3. If the analysis system schematic in manual control mode is not displayed on the computer 
screen, select Unit > Enable Manual Control, then Unit > Show Analysis Schematic. 

4. Open valves 18, 8, 17, and 7. 

5. Set the servo valve to dose to 1000 mmHg to ensure that it stays open. 

6. Evacuate the inlet ports by opening valves 21 to 26.

7. Evacuate at least 20 minutes. Overnight evacuation is preferable.
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8. Close valves 8 and 18, and record the pressure as the Initial Reading for Inlet Ports in the 
table below. 

9. Wait 3 minutes, then record the pressure as the 3 Minute Reading in the table above.

10. Subtract the first reading from the second reading and record in the Difference column in 
the table above. 

11. If the value in the Difference column is at or below the value in the Limits column, enter 
Yes in the OK? column. If the Difference value is not below the Limits value, a gas inlet 
valve, inlet plug, or gas line is leaking from atmosphere.

12. Close all gas inlet manifold valves (21 through 26).

13. Record the pressure as the Initial Reading, then begin timing as soon as you complete the 
next step.

14. Gas inlet valves 21 through 26 must remain closed during this procedure. Pressurize the 
inlet to valve 21 by opening the supply valve or removing the port plug. This allows gas or 
air to pressurize the inlet valve above the seat.

15. After 3 minutes, record the pressure as the 3 Minute Reading. Subtract the first reading 
from the second and record in the Difference column in the table above.

16. Repeat steps 13 through 15 for the inlet valves 22 through 26. 

Test Initial Reading 3 Min. Reading Difference Limits OK?

Inlet Ports 30 microns
(0.3 mmHg)

Valve 21 2.1 microns
(0.0021 mmHg)

Valve 22 2.1 microns
(0.0021 mmHg))

Valve 23 2.1 microns
(0.0021 mmHg)

Valve 24 2.1 microns
(0.0021 mmHg)

Valve 25 2.1 microns
(0.0021 mmHg)

Valve 26 2.1 microns
(0.0021 mmHg)
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Checking the Degas Manifold Outgassing Rate

1. If the degas system schematic in manual control mode is not displayed on the computer 
screen, select Unit > Enable Manual Control, then Unit > Show Degas Schematic.

2. Close all valves except valve 15. Leave valve 15 open to thoroughly evacuate the degas 
manifold.

3. Evacuate the degas manifold for at least one hour or longer after attaining a pressure 
below 10 microns. The outgas rate is affected by how recently the manifold was exposed 
to air, water vapor in the air, and any other gas. Prolonged evacuation, such as overnight, 
will help to remove such gases and water vapor from the elastomer seals and the surface of 
the manifold itself.

4. Close valve 15.

5. Remove all of the plugs from the degas ports if present. If the pressure rises, one of the 
degas stations is leaking. Clear leaks before proceeding to the next step.

    Degas vacuum
     gauge reading
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6. Record the reading of the degas vacuum gauge in the Reading 1 row in the table below.

7. Wait 5 minutes.

8. Record the degas vacuum gauge reading in the Reading 2 row in the table above.

9. Subtract the first reading from the second reading.

10. Divide the result by 5 to obtain the degas manifold outgassing rate in microns/min.

If the result is at or below the maximum rate shown in the table, no degas valves or 
manifold components are leaking. If the result is above the maximum rate, a leak is 
present. The leak may be from the gas inlet valve or it may be across a seal to atmosphere.

Testing the Analyzer for Leaks

Refer to Appendix D TESTING THE ANALYZER FOR LEAKS for instructions on testing 
the ASAP 2420 for leaks.

Manifold Degas Vacuum Gauge Reading

Reading 1

Reading 2

Reading 2 minus Reading 1

Result divided by 5

_____________________________

_____________________________

=____________________________

_________/5 = ________________

Maximum Rate = 10 microns/min. (0.010 mmHg/min.) after overnight 
evacuation.
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Replacing the Vacuum Pump Exhaust Filter

The gases used by the ASAP 2420 are exhausted by vacuum pumps. An exhaust filter is 
installed on the exhaust port of each oil-sealed vacuum pump. The filter minimizes the release 
of oil vapor and should be replaced when it becomes so saturated with oil that it is ineffective. 

1. Remove the lower front panel from the analyzer (refer to “Accessing the Vacuum 
Pumps” on page 9-14). 

2. If you wish to remove the vacuum pump from the analyzer, refer to steps 1 through 4 
under “Changing Fluid” on page 9-17.

This procedure applies to oil-based vacuum pumps only.

Exhaust filters are used on the vacuum pump to minimize the release of oil 
vapors. The gases used are diluted substantially upon being released from the 
vacuum pumps. However, it may be desirable in some locations to provide a 
fume hood for added protection from hazardous gases and vapors released into 
the work area.

 

Vacuum pump 
exhaust filter
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3. Loosen the wing nut of the clamp at the vacuum pump exhaust port. Swing the clamp 
away from the exhaust port and remove it.

4. Discard the oil filter.

5. Retain the centering ring, clamp, and wing nut.

6. Remove the dust cover from the new filter.

7. Make sure the centering ring is on the exhaust port.

8. Place the new filter on the centering ring.

9. Open the clamp and place it around the flange of the exhaust port and the flange of the 
exhaust filter. Swing the clamp fastening screw toward the exhaust port until it fits into the 
slot in the other half of the clamp. Tighten the wing nut securely by hand.

10. If you removed the vacuum pump from the analyzer, place it back onto the drip tray in the 
analyzer, then reinstall the vacuum pump panel.

 Clamp

Exhaust Port

 Wing Nut

Filter
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Routine Maintenance

The procedures in this section are performed as needed.

Changing Gases

Guidelines for Connecting Gases to the Analyzer

Use these guidelines when installing regulators and gas lines:

• Ensure that all gases needed are available and near the instrument. If the gas bottles are not 
located near the instrument, you will have to use gas line extenders, which may degrade 
gas quality and reduce pressure.

• Carefully route the gas lines from the bottle to the analyzer, avoiding overlapping or 
entangling gas lines. This will ensure the correct gas pressure and make maintenance eas-
ier.

• Label both ends of the gas lines before connecting for ease in identification and mainte-
nance.

• Ensure that all gas bottles are closed before connecting them to the analyzer.

The instructions below describe a typical installation. Some configurations require additional 
components, such as regulator expansion kits, when one gas source will be used for several 
operations or when the gas bottle cannot be located close to the analyzer.

Connecting a Gas Regulator to the Gas Supply

1. Attach an appropriate dual-stage regulator to the gas supply bottle or gas line you want to 
connect and tighten with a wrench. Leave the gas bottle shut-off valve closed until 
instructed otherwise.

Dual-stage regulators must be used for all gas supplies.

If an expansion kit is required, attach it to the regulator before 
proceeding. (Refer to the instructions included in the expansion 
kit.)
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2. If the regulator has a 1/8-in. outlet, proceed to the next step. If the regulator has a 1/4-in. 
outlet, attach the reducer fitting to the outlet of the regulator shut-off/isolation valve and 
tighten the valve nut with a 9/16-in. wrench.

3. Attach the gas inlet line to the regulator, reducer fitting, or regulator expansion and tighten 
with a wrench.

4. Purge the regulator as follows: 

a.  Close the regulator shut-off valve by turning it fully clockwise.

b.  Turn the pressure regulator control knob fully counterclockwise. 

c.  Slowly open the gas bottle valve by turning it counterclockwise, then quickly close the 
gas bottle valve.

d.  Observe the high pressure gauge.

Do not overtighten the fittings. Doing so could collapse the 
copper tubing and cause a leak.

It is important to purge the regulator before proceeding. This will 
prevent contamination of the analysis gas.

Gas bottle
shut-off valve

Pressure
control
knob

Regulator shut-off/
isolation valve

           1/4-in. to 1/8-in.
          brass reducer fitting

1/8-in. copper tubing

Low-pressure gauge        High-pressure gauge
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If the pressure decreases, tighten the nut connecting the regulator to the gas bottle. If 
the pressure is stable, proceed to step e.

e. Turn the pressure regulator control knob clockwise until the low pressure gauge 
indicates 15 psig (100 kPag). Open each regulator shut-off valve by turning it 
counterclockwise. Open the gas bottle shut-off valve. Flow gas for 10 to 30 seconds, 
then close each valve. These actions purge the regulator and gas inlet tubing.

f.  Ensure that the gas shut-off bottle valve is completely closed (turn clockwise).

5. Repeat steps 1 through 4 for each gas supply bottle to be attached to the analyzer.

6. Proceed to the next section to connect the copper delivery tubing to the analyzer.

Connecting the Gas Delivery Tubing to the Analyzer 

The gas inlet ports are located on the right side panel of the analyzer. The ports are labeled 1 
through 6 and Degas Backfill for the backfill gas.

To change the gas attached to one of the ports:

1. Make sure the port valve is closed (refer to “Enable Manual Control” on page 6-24).

2. Detach the gas line from the desired port.

3. Attach the new gas line to the port.

4. Make sure any unused gas inlet ports are plugged.

5. Record the gas installed in the port in the analysis program as described in the following 
section.

If you are using hazardous gases, make sure the gas supply 
equipment is adequately vented to prevent purging the regulator 
and tubing into the lab atmosphere in the following step.
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Specifying Gas Ports

When you change the gas attached to a port on the analyzer, you must enter the change in the 
analysis program as follows.

1. Select Unit 1 > Unit Configuration from the main menu. The Unit Configuration dialog 
is displayed.

2. Click Gas. The Gas Configuration dialog is displayed.

3. Click on the down-arrow at the port to which you attached a gas line and choose the 
appropriate gas.

4. Click OK to close the dialog, and then click OK again to close the Unit Configuration 
dialog.

Performing a Reference Material Analysis

When you have doubts about the integrity of analysis data or when you would just like to 
ensure the highest quality data, perform a reference analysis. Reference Material Kits are 
available from Micromeritics (refer to Chapter 10, ORDERING INFORMATION). Each kit 
contains reference material and an instruction booklet. Follow the instructions in the booklet to 
perform the analysis and review the results.
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ORDERING INFORMATION

The ASAP 2420 system components and accessories can be ordered using one of the 
following methods: 

• Call our Customer Service Department at (770) 662-3636.
• Access our web site at www.micromeritics.com.
• Contact your local sales representative.

When ordering, please use the information provided in this chapter to place your order:

Analysis System Components and Accessories

Part Number Item and Description

Accessories

060-00030-00 FlowPrep 060, degasses up to six samples at up to 400 ºC with 
flowing gas

061-00030-00 VacPrep 061, degasses up to six samples at up to 400 ºC with either 
flowing gas or by evacuation (evacuation requires a vacuum pump)

021-00000-00 Model 021 LN2 transfer system, for easy filling of sample Dewars; 

includes 47-L Dewar, mobile platform, and pump with 100-cm 
discharge line

201-25830-00 Dewar, 2.5 liter

240-25901-00 Dewar depth gauge

202-31707-00 Dewar cover (used during analyses)

240-25895-00 Dewar insulator (used when Dewar is in the lowered position)

004-25103-00 Ferrule, front, Teflon 1/4 in.

004-25104-00 Ferrule, rear, Nylon 1/4 in.

004-25913-00 Ferrule set, 1/8-in. PEEK, used on gas lines

290-25846-00 Copper tube, for gas inlet, 1/8-in. diameter

004-25549-00 Reducer, 1/8-in. tube x 1/4-in. tube, accepts 1/8-in. tube, connects to 
1/4-in. swage fittings

004-62230-58 Gas pressure regulator assembly, CGA 580, no-pressure relief valve 
(30 psig for N2, He, Kr)
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Part Number Item and Description

004-33601-00 Regulator Expansion Kit; adds an additional outlet to the gas regulator, 
includes fittings and instructions

004-33602-00 Pressure Relief Kit; prevents excessive gas pressure in the event of 
regulator failure (not to be used with noxious gases)

004-62230-32 Gas pressure regulator, CGA 320 fitting (CO2), 30 psig

003-26044-00 Heating mantle with type K thermocouple, 450 ºC maximum, 24 V 

003-26045-00 Heating mantle with type K thermocouple, 450 ºC maximum, 24 V, 
side-laced with extended leads

230-25808-00 Heating mantle clip

242-42801-01 Operator’s manual

004-16821-00 Reference material, high surface area

004-16816-00 Reference material, low surface area (krypton)

004-16843-00 Reference material, micropore, 13X

004-16844-00 Reference material, micropore, Y-zeolite

004-54609-00 Sample tube brush

240-25853-00 Sample tube funnel

240-14855-00 Sample tube rack

240-32805-00 Sample tube support, assists sample weighing

200-25840-00 Saturation pressure (Po) tube, includes isothermal jacket

004-25006-00 O-ring, size 006, Buna-N, for Po tube

004-54618-00 Sample Port O-ring removal tool

250-25608-00 Valve gasket, Kel-F, for analysis manifold

250-25627-00 Valve plunger, Buna-N seal, for analysis manifold and fast evacuation 
valve on degas manifold

201-22600-00 Valve spring, for Buna-N plunger, for analysis manifold and fast 
evacuation valve on degas manifold

003-22617-01 Valve, for gas inlet ports, degas ports, and saturation pressure ports 
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Part Number Item and Description

Vacuum System Components

062-00200-00 Vacuum foreline pump, oil-free, for systems with high-vacuum 
option, 115/230 VAC

004-62109-01 Service Kit, for Pfeiffer dry forepump

004-62023-01 Service Kit, for Vacuubrand dry forepump

062-00001-11 Vacuum pump, oil-based, with built-in anti-suckback valve, 100/120 
VAC; includes hose kit and alumina oil vapor trap

062-00001-23 Vacuum pump, oil-based, with built-in anti-suckback valve, 220/240 
VAC; includes hose kit and alumina oil vapor trap

062-33002-00 Activated alumina oil vapor trap, for one vacuum pump

004-16003-01 Vacuum pump oil, 1 liter

200-25879-00 Vacuum pump oil funnel

004-27040-00 Vacuum pump exhaust filter

004-16830-00 Activated alumina, 500 grams, for oil vapor trap

004-25652-00 O-ring, size 217, for oil vapor trap

Software

202-33024-00 DataMaster; includes software and operator’s manual. This program 
allows you to generate and manipulate data on a computer other than 
the one controlling the analyzer

242-20800-00 Software package, ASAP 2420; includes current version of software 
and operator’s manual
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Sample Tubes and Components

A B
C

D E
F
G

H

J
K L

N Q T

O

P

R U

S
V

I

Part Number Item and Description

Sample Tubes and Components

004-25466-00   A O-ring, size 010, for 1/4-in. sample tube

004-25022-00   B O-ring, size 012, for 3/8-in. sample tube

260-25891-00  C Opener, seal frit, for 1/2-in. sample tube

240-25803-00  D Ferrule, 1/4 in.

300-25826-00  E Ferrule, 3/8 in.

004-25044-00  F O-ring, size 013 for 1/2-in. sample tube

260-25843-00  G Ferrule, 1/2 in.

300-25824-00  H Nut, sample tube

004-32604-00  I Cap (stopper), for 1/4-in. sample tube 

004-32004-00  J Stopper, for 3/8-in. sample tubes

240-32000-00  K Stopper, for 1/2-in. sample tube
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Part Number Item and Description

260-25890-00  L Seal Frit with built-in check valve for air-sensitive samples 
(for 1/2-in. tubes only)

202-25901-00  N Isothermal jacket, 1/4 in.

240-61001-00  O Sample tube, 1/4 in.

240-61014-00  P Volume displacement insert, 1/4 in.

202-25902-00  Q Isothermal jacket, 3/8 in.

240-61002-00  R Sample tube, 3/8 in.

240-61015-00  S Volume displacement insert, 3/8 in.

202-25903-00  T Isothermal jacket, 1/2-in. sample tube

240-61003-00  U Sample tube, 1/2 in.

240-61016-00  V Volume displacement insert

Part Number Item and Description

      TranSeal and Components

201-33026-00 TranSeal Kit; includes three TranSeals, three low-profile retaining 
nuts, three split ferrules, three retaining rings, and installation 
instructions

300-25862-00 TranSeal only

004-25466-00 O-ring, for TranSeal, -010 Buna-N

300-25865-00 Retaining ring for TransSeal

300-25866-00 Ferrule, split, for TransSeal

300-25824-00 Retaining nut, low profile, for TransSeal
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ASAP Series Sample Data Worksheet

This form is provided to assist you in obtaining an accurate sample mass for report calculations. 
You may use the After Degas value (Step 5) or the After Analysis value (Step 7), provided they 
are close to the same.

 

Compare the sample mass obtained after analysis (Step 7) with the sample mass after degas (Step 
5). These two values should be close in range. If a significant difference is noted, analysis 
problems may exist or the sample may have been improperly degassed.

Sample tube:_____________________              Sample: _______________________________

Before Degas:

1. Mass of empty sample tube ________ (g)

2. Mass of sample tube plus sample ________ (g)

3. Mass of sample (Step 2) – (Step 1) ________ (g)

After Degas:

4. Mass of sample tube plus sample ________ (g)

5. Mass of sample (Step 4) – (Step 1) ________ (g)

After Analysis:

6. Mass of sample tube plus sample ________ (g)

7. Mass of sample (Step 6) – (Step 1) ________ (g)
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B ERROR MESSAGES

2200 and 2400 Series B-3

2500 Series B-14

4000 Series B-21

6100 Series B-38

6500 Series B-47
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B.  ERROR MESSAGES

Error messages are listed numerically. If the Action response instructs you to contact your 
service representative, record the error message and make backup copies of any files involved 
in the operation.

2200 and 2400 Series

2201- Cannot execute report subsystem.

2204- Communication attempt with <application file name> timed out. Please check 
application directory for file.

2401- FATAL ERROR: (error message).

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause: Start Report failed to execute the report subsystem (which is a separate 
process).

Action: Restart the computer. If the problem persists, reinstall the application 
(this will not affect any of your sample files). If the problem continues, 
contact a Micromeritics service representative.

Cause: A secondary software application may have become corrupt and can-
not be started.

Action: Restart the computer. If the problem persists, reinstall the application 
(this will not affect any of your sample files). If the problem continues, 
contact a Micromeritics service representative.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2430- Error accessing file (file name), error code = (number). 

2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

2433-  New entries have been found in this directory. Refresh the directory 
information?

Cause A: A computer or network problem occurred.

Action A: Check the performance of your computer devices or network.

Cause B: A software error occurred when the file was accessed.

Action B: Contact a Micromeritics service representative.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to a diskette, CD, or 
network directory, delete them from the hard disk, and then try the 
operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Several ASAP 2420 files (sample information, analysis conditions, 
adsorptive properties, or report options) have been added to this direc-
tory by some function other than the ASAP 2420 program.

Action: Select Yes to update the directory information with data from each new 
file. This operation may take a minute.

Select No if you do not want to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file you 
wish to access.
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2434- File (file name) — Subset # (number) wrote (number) bytes, expected (number) 
bytes.

2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.

2439- Could not register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Bad header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.
2447- Error writing data.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press 
Enter. 

Cause: You entered a file specification that does not exist.

Action: Enter an existing file specification or select a file name from the list 
box.

Cause: You selected a disk drive that is not presently accessible.

Action: Ensure that the disk is not write-protected.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.
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2448- File directory (path name) is invalid. Resetting to the installation directory.

2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

2452- Attempt to write MICATTR.DIR in read only mode. (file name)
2453- Attempt to append MICATTR.DIR in read only mode. (file name)

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories: list to move to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your Windows man-
ual and re-enter the name.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then 
restart the automatic analysis.

Cause: The Read-Only attribute is turned on in the application’s 
MICATTR.DIR file (this file exists in each folder containing sample or 
parameter files).

Action: Use Windows Explorer to access the folder containing the 
MICATTR.DIR file and disable the Read-Only option.
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2454- Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit?

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message. 

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for 
open files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.

Cause: You attempted to exit the application while the analyzer is performing 
a critical operation. This operation must be completed before the appli-
cation can be stopped.

Action: Wait a few minutes before attempting to exit the application again.

Cause: You attempted to exit the application while the analyzer was perform-
ing an operation.

Action: Rather than exiting the application you may choose to minimize it.
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2460-  Fatal Communications error on (unit nn).

2461- No instruments are in operation. This application will unconditionally 
terminate.

2471-  Unit n - S/N; nn has an invalid communications port specified. It cannot be 
initialized.

Cause: Repeated attempts to maintain communication with the analyzer have 
failed.

Action: Check the communications cable connecting the analyzer to the com-
puter. Confirm that the analyzer is turned on and that the status light is 
not blinking. 

If these checks are okay, exit the analysis program and then restart the 
application. If this error persists, contact your service representative.

Cause: At least one analyzer must be active for the application to operate. The 
initialization of the analyzers configured with the Setup program has 
failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer’s failure to initialize. See the instructions for that mes-
sage. 

Action B: Check the cable connection between the analyzer and the computer. 
Verify that the analyzer has the power switch in the ON position and 
that the light on the front panel is illuminated. If the application con-
tinues to fail in its attempts to initialize the analyzer, contact your ser-
vice representative.

Cause: The communications port specified for this analyzer during installation 
(or configuration) is invalid.

Action: Use the setup program to change the analyzer configuration.
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2474-  (Unit {number}) Communications port COM (port number) specified in the pro-
gram control files is already in use. Unit cannot initialize.

2475-  (Unit {number}) Communications port COM (port number) specified in the pro-
gram control files cannot be accessed. Unit cannot initialize.

2476-  Unit startup failed. Cannot initialize the communications port.

2477- (Unit n; Serial nn) did not properly initialize.

Cause: The communications port assigned to the indicated unit is in use by 
another program.

Action: End the program using the busy port or use the Setup program to 
change the communications port assigned to this program.

Cause: The operating system has prevented the application from accessing the 
communications port.

Action: Review the hardware configuration of the computer, ensure that no 
other application is using the port. Contact your service representative 
if you continue to receive this error message.

Cause: The communications port specified during installation is invalid.

Action: Use the setup program to change the analyzer configuration. Contact 
your service representative if you continue to receive this error mes-
sage.

Cause: The software was unable to initialize the analyzer.

Action A: Run the Setup program and ensure that a valid port is specified; if not, 
specify a valid one when prompted.

Action B: Reinstall the software, then restart application.

Action C: Contact your service representative if you continue to get this message.
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2478-  Error copying sequential data segment.

2479-  (Unit n; Serial nn) The instrument is busy performing an operation of which this 
application is unaware. Do you want to cancel? (Yes, No)

2480- File (file name) cannot be analyzed. It is currently being edited.

2481- Error accessing the sample information file (file name).

Cause: An internal processing and/or hardware error occurred while accessing 
a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for 
example, you may wish to use a utility such as ScanDisk. Contact your 
service representative if you continue to receive this error message.

Cause: During initialization of the application, the status of the analyzer was 
found to be in a different state than expected.

Action: Click Yes to cancel the operation in process, allowing the analyzer to 
reset and continue with initialization.

Click No to cancel the initialization process.

If you continue to get this message, verify that files in the application 
directory structure are not being changed or removed.

Cause: You attempted an analysis using a sample file that is being edited.

Action: Save the changes and close the dialog box.

Cause A: You attempted to open a file that is already open, possibly minimized.

Action A: View the minimized icons, locate and maximize the file.

Cause B: A computer or network problem occurred.

Action B: Check the performance of your computer devices or network.
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2482- File cannot be opened for writing. It is already in use.

2483-  An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

2484- The edit session for (file name) must be saved before the analysis. Save 
changes and continue with the analysis.

2485- The service test file has an invalid status and cannot be used for this analysis.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause: You are attempting to open a file that is currently being used (either by 
this application or another).   

Action: Locate the application using the file (in the Micromeritics application, 
use the Windows menu item to get a list of all windows, one of which 
may contain this file).

Cause: You attempted to use a sample file containing errors that is currently 
open.

Action: Go to the window containing the file, correct the errors, and save it.

Cause: You attempted an analysis using a sample file that contains unsaved 
changes.

Action: Select Yes to save the changes and continue with the analysis. 

Select No to abort the analysis and return to the sample file.

Cause: The selected service test file has a status other than No Analysis.

Action: Select a different service test file or create a new one and use Replace 
All to copy parameters from the file you originally selected.
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2486- Cannot construct (name) report type. Program will terminate.
2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

2489- File (file name) cannot be opened for writing. It is already in use.

2490- No ‘.INI’ file present. Application will terminate.

Cause A: You may not have full rights to the application’s folders and files.

Action A: Contact your system administrator and have him grant you full rights.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error 
message.

Cause: The file you specified is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII (.INI) file containing initialization and system options 
information cannot be found. The .INI file may have become cor-
rupted. The application cannot operate without this file

Action: Use the Setup CD to uninstall the ASAP 2420 application. When you 
uninstall the application, only the application files are deleted; data 
files remain intact.

After the uninstall operation is complete, reinstall the ASAP 2420 
application.
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2491- Highlighted fields contain errors. Please correct the errors before closing dia-
log box.

2492- This field’s entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.
2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

Cause: The highlighted fields contain invalid entries. You will not be able to 
close the dialog box until you correct the errors.

Action: Check the entries, correct the errors, and close the dialog box

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select an appropriate value.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.
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2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

2500 Series

2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered) could not be done.

Action: Contact your service representative if you continue to receive this error 
message. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.

Cause: No more sample information files can be created using the currently 
entered file name sequence number.

Action: Select Options > Sample Defaults from the Main Menu and enter a 
new sequence number.

Cause: A large number of windows are open and consuming the system 
resources available to all applications.

Action: Close one or more windows on the screen. Contact your service rep-
resentative if you continue to receive this error message.
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2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (file name). Could not create DIO intermediate file.

2504- Cannot create output file for sample (sample name).

2505- Error Logger cannot be initialized!  Error code (number). Program will exit.

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed 
in the directory specified by the TEMP environment variable. 

Action A: Determine if there is sufficient space on the drive where the TEMP 
directory is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error 
message.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this error message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.

Cause: The selected output device is not installed in Windows.

Action: Select a different output device in the System Configuration dialog 
box. Install the device using the Control Panel, Printers operation.
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2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.
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2511- Print job (name) has been cancelled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been cancelled.

2513- Unable to read the calibration file (file name).

2514- Unable to write the calibration file (file name).

2515- Warning: Changing the calibration information will affect the performance of 
the instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: You selected an invalid calibration file or one that cannot be read.

Action: Be sure the media containing the calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Be sure the media you want to Save the file to has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: You have started the process of performing a calibration operation.

Action: Calibration operations should only be done by or under the direction of 
qualified service personnel.
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2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

2517- Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

2521- Unable to program controller.

2522- Invalid controller application file.

2523- Programming the controller failed.
2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.
2527- Controller CRC error on boot block.
2528- Controller DRAM error.
2529- Controller Com1: error.
2530- Controller Com2: error.
2531- Controller debug port error.

Cause: You have performed a calibration operation; a backup copy is recom-
mended.

Action: Perform a calibration Save operation.

Cause: You have not accepted the calibration you performed.

Action: If the calibration operation was successful, press Accept.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the ASAP 2420 analysis program.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2534- Error opening file (name) for printing. Error code: (number).

2548- System status 1 or 2.

2549- Error accessing online manual file (code #).

Cause: The application has discovered a different version of software operat-
ing in the analyzer. 

Action: If there are no analyzers other than the ASAP 2420 connected to the 
computer, select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: A hardware error has occurred.

Action: Contact your service representative.

Cause: The operator’s manual file could not be located.

Action A: Reinstall the application.

Action B: Copy the contents of the \manual folder on the setup CD to the appli-
cation directory.
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2550-  Attempts to acquire the instrument’s status timed out.

2551-  Cannot access web page (name) (code [n])

Cause: Repeated attempts to maintain communication with the analyzer have 
failed.

Action: Check the communications cable connecting the analyzer to the com-
puter. Confirm that the analyzer is turned on and that the status light is 
not blinking. 

If these checks are okay, exit the analysis program and then restart the 
application. If this error persists, contact your service representative.

Cause: You tried to access Micromeritics on the web and the operating system 
could not take you there.

Action: Make sure you have internet access.

Action: Make sure you have a default web browser.
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4000 Series

4000- Memory Allocation Error.

4002- Thermal Transpiration correction had no effect.

4003- Error Converting Pressures.
4004- Error Computing Quantity Adsorbed.

4005- Pressures were not smoothed. Not enough pressures below 0.10 P/Po.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The Thermal transpiration correction option was selected on the Report 
Options dialog box. However, the correction did not change any pres-
sure by more than one percent. 

Action: De-select this option to disable this message. This correction is only 
meaningful for very low pressures.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The Smooth pressures below 0.10 P/Po option was selected on the 
Report Options dialog. There must be at least 10 pressures within this 
range for smoothing to occur.

Action: Deselect this option to disable this message.
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4006- Report Type Not Found.
4007- Error Processing Report.

4008- Report requested on sample file with no data points.

4009- Error, No Reports Selected.

4010- Summary Report was not included in the Selected Reports.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You selected a file for reporting which contains no collected data.

Action: Select another file which contains collected data and restart the report.

Cause: You attempted to generate reports for a sample that has no reports 
selected in its report options.

Action: Select the desired reports in the sample’s report options and save the 
sample file.

Cause: You did not select a plot or a table for any of the Selected Reports in 
the Report Options dialog; you selected the reports only to generate an 
entry in the summary. However, the Summary was not included in the 
Selected Reports.

Action: Select a plot or table in one or more of the Selected Reports, and/or add 
the Summary to the Selected Reports. 
B-22                                                    Nov 2011



ASAP 2420 Operator’s Manual Appendix B
4011- Analysis gas in sample file does not match analysis gas in unit.

4012- Psat gas in sample file does not match Psat gas in unit.

4014-  File (name) is not a valid file for conversion.

4015- Error creating export file for sample <sample file name>.

Cause: You attempted to start an analysis using a sample information file in 
which the analysis gas specified does not match the analysis gas 
entered in the unit configuration.

Action: If necessary, attach the appropriate gas bottle, then enter the gas in the 
Unit Configuration dialog box. 

Cause: You attempted to start an analysis using a sample information file in 
which the Psat gas does not match the Psat gas entered in the unit con-
figuration.

Action: If necessary, attach the appropriate gas bottle, then enter the gas in the 
Unit Configuration dialog box. 

Cause: The file selected for conversion is not a MICMOS 2400 or 2405 file.

Action: Select only files that have been created by MICMOS 2400 or 2405  
programs.

Cause: A file error occurred during creation of an export output file.

Action: The output file name may be invalid. Ensure that the target directory 
exists. Ensure that the target diskette or CD is not full or write pro-
tected. The target disk drive may be damaged or inoperative. Verify 
that other files may be created on the same drive. Contact your service 
representative if you continue to receive this error message.
Nov 2011                                                     B-23 



Appendix B ASAP 2420  Operator’s Manual
4016- Sample (file name) has no data for export.

4017- Damage to the instrument will result if the sample has not been manually evac-
uated. Have you evacuated the sample?

4020- Disabling this option may damage the instrument. Are you sure that the sample 
should not be backfilled?

Cause: The file selected for export has a status of No Analysis. No export file 
will be created.

Action: Select a file which contains analysis data.

Cause: You did not select Backfill sample at start of analysis on the Sample 
Backfill Options dialog box. The sample tube is normally at atmo-
spheric pressure when an analysis is started, and it must be backfilled 
before the analysis begins to prevent sample material from being 
drawn into the manifold.

Action: If you have manually evacuated the sample tube, select Yes. If you 
have not, select No and then either perform a manual evacuation or go 
to the Sample Backfill Options dialog box and select Backfill sample 
at start of analysis.

Cause: You did not select Backfill sample at start of analysis on the Sample 
Backfill Options dialog. The sample tube is normally at atmospheric 
pressure when an analysis is started; it must be backfilled before the 
analysis begins to prevent sample material from being drawn into the 
manifold.

Action: If you want to manually evacuate the sample prior to the start of the 
analysis, select Yes. Otherwise, select No, go to the Sample Backfill 
Options dialog, and select Backfill sample at start of analysis.
B-24                                                    Nov 2011



ASAP 2420 Operator’s Manual Appendix B
4021- The entered Po value (Po and Temperature Options of the Analysis Conditions) 
is outside the range of the pressures listed in the Psat vs. Temperature Table (Adsorp-
tive Properties). 

4022- The entered bath temperature value (Po and Temperature Options of the Anal-
ysis Conditions) is outside the range of the temperatures listed in the Psat vs. 
Temperature Table (Adsorptive Properties). 

4023- The file (sample file) cannot be prepared for analysis. It is open for editing and 
contains errors.

4024- Backfill gas in sample file does not match any gas in unit.

Cause: The temperature that corresponds to the entered Po cannot be found 
because the entered Po is outside of the range of values in the Psat vs. T 
table.

Action A: Enter a Po that is within the range of the table.

Action B: Use a different Psat vs. T table.

Cause: The Po that corresponds to the entered temperature cannot be found 
because the entered temperature is outside of the range of values in the 
Psat vs. T table.

Action A: Enter a temperature that is within the range of the table.

Action B: Use a different Psat vs. T table.

Cause: You attempted an analysis using a sample file that is being edited and 
has invalid values in one or more of its fields.

Action: Enter valid values into the fields that have errors, save the changes, and 
close the dialog box.

Cause: You selected a backfill gas that is not included in the gas configuration.

Action: Make sure that gas selections match the gases that are attached to the 
instrument. Choose one of the gases as the backfill gas, or edit the sam-
ple file and choose one of the existing gases as the backfill gas.
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4025- There is no Helium attached to the unit. 

4026-  Cannot calculate Dubinin-Astkahov: bad least squares data.

4027- Fewer than two sample files have data suitable for heat of adsorption reports.

4028- Dubinin calculations cannot be performed because the affinity coefficient of 
the analysis gas is zero.

4029- At least two fitted data points are needed for Alpha-S calculations.

Cause: A measured free space has been requested but helium does not appear 
to be available.

Action: Make sure the helium cylinder is attached to the unit at its designated 
port.

Cause: Less than two selected data points are within the fitted pressure range.

Action: Edit the calculation assignments on the Collected Data dialog, or 
change the fitted pressure range on the Dubinin report options dialog.

Cause: Less than two of the sample files you selected for heat of adsorption 
reports contain appropriate data.

Action: Edit the Quantity Adsorbed table, or select other sample files.

Cause:  Dubinin values could not be calculated because the affinity coefficient 
of the analysis gas is zero.

Action:  Access the Dubinin Report Adsorptive options in the sample file and 
enter an appropriate value for the analysis gas.

Cause: Fewer than two data points fall within the selected Alpha-s range.

Action: Edit the calculation assignments or the fitted Alpha-s range, or use a 
different reference curve.
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4030- Preparations failed in primary data.

4031- Not enough points with a relative pressure in the range (n,n)

4033- Not enough points to generate Dubinin Tabular Report.

4034- Fewer than 2 points available for Dubinin calculations.

Cause: Appropriate data were not available to generate the report.

Action: This message was preceded by a different error message; refer to the 
cause/action of the preceding message.

Cause: Fewer than two data points selected for the Dubinin report falls within 
the selected relative pressure range.

Action: Edit the calculation assignments or the fitted relative pressure range.

Cause: There are fewer than two valid data points available for the Dubinin 
tabular reports.

Action: Examine the calculation assignments in the Collected Data dialog of 
the sample file. You must have at least two micropore pressures 
selected for inclusion in the Dubinin report.

Cause: There are fewer than two valid data points available for Dubinin 
reports in one of the sample files selected for overlaying.

Action: Examine the calculation assignments in the Collected Data dialog of 
the sample file. You must have at least two micropore pressures 
selected for inclusion in the Dubinin report.
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4035- Cannot calculate optimized Astakhov exponent: Not enough points with a rel-
ative pressure in the range [(pressure), (pressure)].

4036- Fewer than 2 points available for Horvath-Kawazoe calculations.

4037- Computations failed while processing the primary data set. No reports will be 
produced.

4038- Fewer than 2 points available for the Langmuir Qm computation. Cheng/Yang 
correction will not be applied.

Cause: There are fewer than two valid data points in the relative pressure 
range specified. Astakhov reports will not be produced.

Action: Examine the calculation assignments in the Collected Data dialog for 
the sample file. You must have at least two pressures in the given range 
selected for inclusion in the Dubinin report.

Cause: You must select at least two data points for inclusion in the Horvath-
Kawazoe analysis on the Collected Data dialog. No report will be pro-
duced.

Action: From the Collected Data dialog, select the data points to be analyzed.

Cause: The preparation of data for reporting could not be successfully com-
pleted. No Horvath-Kawazoe reports will be produced. This message 
will always be preceded with another one containing additional infor-
mation.

Action: Refer to the number of the error message which preceded this one for 
an explanation.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires 
the value of the monolayer volume as calculated from the Langmuir 
equation. The isotherm must include at least two points above 0.02 rel-
ative pressure for the Langmuir equation to be applied.

Action: The analysis will be performed without the Cheng/Yang correction. 
Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe 
Report Options dialog to prevent this message from appearing on 
future reports.
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4039- The isotherm does not meet the constraints of the Cheng/Yang assumption. 
Cheng/Yang correction will not be applied.

4040- The value of Qm computed from the Langmuir equation is too low. The pore 
size will not be computed for all data points.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires 
the value of the monolayer volume as calculated from the Langmuir 
equation. The isotherm does not correlate to the Langmuir assumption 
with a coefficient of 0.98 or more. The correction is not applicable to 
this isotherm or to the range of the data points selected.

Action A: The analysis will be performed without the Cheng/Yang correction. 
Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe 
Report Options dialog to prevent this message from appearing on 
future reports.

Action B: Generate the Langmuir report for the same data points selected for the 
Horvath-Kawazoe report. If the Langmuir correlation coefficient can 
be brought above 0.98 by removing some points at high relative pres-
sure, remove them and reproduce the Horvath-Kawazoe reports.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires 
the value of the monolayer volume as calculated from the Langmuir 
equation. The computed value is less than the volume adsorbed at the 
largest relative pressure included in the analysis. The correction is not 
applicable to this isotherm or to the range of the data points selected.

Action: The analysis will be performed and the Cheng/Yang correction will be 
applied to all points with a volume adsorbed less than the value of Vm. 
The pore size will not be calculated for data points with an invalid vol-
ume adsorbed. Deselect Apply Cheng/Yang correction on the Horvath-
Kawazoe Report Options dialog to clear this message.
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4041- Cheng/Yang correction is inappropriate for some P/Po.

4042- 0.0 cannot be a starting or ending pressure for a geometric progression from 
low pressure.

4043-  1.0 cannot be a starting or ending pressure for a geometric progression toward 
saturation.

4044- Points in the Langmuir report pressure table lie outside the collected data.

Cause: The Cheng/Yang correction is usually inappropriate for any P/Po above 
the isotherm knee. In some instances, the computed pore sizes may 
decrease above the knee. While it is possible to include these relative 
pressures (usually above 0.1 P/Po) in the analysis, the computed pore 
sizes for these pressures are usually meaningless.

Action: Change the data points selected for the Horvath-Kawazoe report to 
include only relative pressures at or below the knee of the isotherm, or 
change the Horvath-Kawazoe report options so that the Cheng/Yang 
correction is not applied.

Cause: You selected to generate a pressure table from a geometrically pro-
gressing range.

Action: Change the 0.0 entered value.

Cause: You selected to generate a pressure table from a geometrically pro-
gressing range.

Action: Change the 1.0 entered value.

Cause: Calculation assignments are not being used and more than one of the 
report pressure table points is above the range of the collected data, and 
more than one is below.

Action: Change the report pressure table to be more consistent with the col-
lected data.
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4045- Points in the report pressure table lie outside the collected data.

4046-  (file name) could not be opened for reading.

4047- Warning: An error occurred while reading (file name).

4051- The sample (file name) does not have any data in the range of the requested 
quantities adsorbed.

4052- Fewer than two points are selected for this report.

Cause: Calculation assignments are not being used and more than one of the 
report pressure table points is above the range of the collected data, and 
more than one is below.

Action: Change the report pressure table to be more consistent with the col-
lected data.

Cause: A thickness curve file could not be opened.

Action: If the problem persists, restart your computer and optionally perform a 
media integrity check (using ScanDisk).

Cause: An error happened during a read operation of a thickness curve file.

Action: If the problem persists, restart your computer and optionally perform a 
media integrity check (using ScanDisk).

Cause:  The sample’s data cannot be interpolated to any of the quantities 
adsorbed.

Action:  Edit the quantities adsorbed so that they are within the range of the col-
lected data. 

Cause:  At least two points are required for the BET calculations.

Action:  Edit the calculation assignments for the BET report.
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4053-  At least two data points must be selected for t-Plot calculations.

4054- Fewer than two data points are inside the fitted thickness range.

4055- A positive BET surface area could not be calculated.

4056- A positive Langmuir surface area could not be calculated.

Cause:  At least two points are required for the t-Plot calculations.

Action:  Edit the calculation assignments for the t-Plot report.

Cause:  At least two points must be within the fitted thickness range for the t-
Plot calculations.

Action A: Edit the calculation assignments for the t-Plot report.

Action B: Edit the fitted thickness range in the t-Plot report editor.

Cause: Fewer than two points were assigned to the requested surface area cal-
culation in the collected data table.

Action A: Assign more points to the surface area calculation.

Action B: Select a different surface area in the t-Plot report editor.

Cause:  Fewer than two points were assigned to the requested surface area cal-
culation in the collected data table.

Action A: Assign more points to the surface area calculation.

Action B: Select a different surface area in the t-Plot report editor.
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4057- At least two data points are needed for Freundlich calculations.

4058- At least two data points are needed for Temkin calculations.

4059- Fewer than 2 points available for MP-Method calculations.

4060- Sample (file name) contains no data points.

Cause: Less than two data points have been selected for the Freundlich report; 
at least two are required.

Action: Select Freundlich points on the Collected Data dialog. If calculation 
assignments are not being used, edit the Freundlich Report options, 
Absolute pressure range in the sample file.

Cause: Less than two data points have been selected for the Temkin report; at 
least two are required.

Action: Select Temkin points on the Collected Data dialog. If calculation 
assignments are not being used, edit the Temkin Report options, Abso-
lute pressure range in the sample file.

Cause: You have selected at least one point with a negative pressure value to 
include in the Temkin report.

Action: Negative pressure points void Temkin calculations. Open the sample 
file and click the Collected Data tab. Locate the negative value(s) in 
the Temkin column and deselect it (them).

Cause: At least two points are required for the MP-Method calculations.

Action: Edit the calculation assignments for the MP-Method report.

Action: An attempt was made to save a sample without collected data as a t-
curve or alpha-S curve.

Cause:  Repeat the save as t-curve or save as alpha-S operation after opening 
a sample that has collected data.
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4061- The t-curve must contain at least 2 points.

4062- Error during report preparation.

4063- The data requested on this report are not available.

4067- No data points are within the range of pressures in the reference isotherm.

4068- No points were selected for the f-Ratio report.

Cause:  At least two points are required in a thickness curve definition.

Action:  Edit the thickness curve.

Cause:  An internal processing error has occurred.

Action:  Contact your Micromeritics service representative.

Cause:  There is no information in the sample log to report.

Action:  You selected a sample file for which no instrument operations have 
been used. Select a sample file with a status of Prepared, Preparing, 
Analyzing, or Complete to obtain a valid sample log report.

Cause:  There are no collected data points within the range of pressures in the 
reference isotherm.

Action:  Select data points that are in the range of the reference isotherm, or 
select a more appropriate reference isotherm.

Cause:  The collected data column for the f-Ratio report does not have any 
points selected.

Action:  Edit the collected data dialog and select points for the f-Ratio report.
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4069- Dosing method choice is invalid. The Analysis Conditions choice of Absolute 
pressure dosing requires that the Adsorptive Properties (Dosing Method) is set to 
Normal.

4070- Unable to load deconvolution model (name).

4071- The selected pressures points do not form a valid set for deconvolution.

4072- The range of pressures selected is too small to deconvolute using this model.

Cause:  There is an incompatibility between the analysis conditions choice of 
Absolute pressure dosing and the adsorptive properties dosing 
method.

Action:  Edit one of the choices.

Cause:  For some reason, the list of available models was corrupted, therefore, 
the model selected could not be loaded for the deconvolution.

Action:  Exit the program and reinstall the software, then try again.

Cause:  The data points selected for analysis do not contain enough informa-
tion to allow a DFT data reduction.

Action A:  Edit data points in the table of the Collected Data dialog, or select 
another sample file. At least two points with strictly increasing pres-
sures and volumes adsorbed are required for a DFT Plus data reduc-
tion.

Action B:  Edit the pressure range on the DFT report options dialog.

Cause:  A null result was found using the selected model.

Action:  Edit data points in the table of the Collected Data dialog, or select 
another sample file. At least two points with strictly increasing pres-
sures and volumes adsorbed are required for a DFT data reduction.
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4073- The analysis gas (name) does not match the model gas (name).

4076- Invalid sample file - Adsorptive Properties “Non-condensing adsorptive” can-
not be used unless Analysis Conditions “Absolute pressure dosing” is selected.

4077- Cannot get surface area for: (file name)

4078- Slope and Y-Intercept cannot be determined from the selected points.

Cause:  The model assumes a specific gas and the sample file uses a different 
one.

Action:  Select a model that assumes the same gas.

Cause:  You selected a sample file that has Non-condensing adsorptive 
selected in the Adsorptive Properties but does not have Absolute pres-
sure dosing selected in Analysis Conditions.

Action A:  If you plan to use a non-condensing adsorptive, select Absolute pres-
sure dosing on the Analysis Conditions dialog.

Action B:  If you are not using a non-condensing adsorptive, deselect the Non-
condensing adsorptive option on the Adsorptive Properties dialog, or 
choose an adsorptive that you are sure in not non-condensing.

Cause:  The Isotherm report for the named overlay file has Per gram selected 
for the Volume Adsorbed, and the Isotherm report for the primary file 
has a surface area option selected for the Volume Adsorbed.

Action A:  Edit the Isotherm report for the named overlay file and select a surface 
area option for Volume Adsorbed.

Action B:  Click Overlays on the Report options dialog of the primary file and 
remove the named overlay file from the list.

Cause:  The Langmuir report cannot be generated from the selected points.

Action:  Edit the calculation assignments in the Langmuir column on the 
Collected Data dialog.
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4079- Points found with negative pressure values will not appear on the graph.

Cause:  Collected data contains negative pressure values.

Action:  Negative pressure points are automatically removed from isotherm 
graphs. If you wish to have negative pressure values appear on the 
graph, open the sample file and click the Collected Data tab. Deselect 
Use calculation assignments and then select the points with negative 
pressures as Outliers.
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6100 Series

6100- Unable to establish the TCP connection with the instrument.

6101- Configured serial number does not match instrument.

6102- The instrument (unit number) is not calibrated.

Cause:  A communications problem between the computer and the analyzer 
has occurred. 

Action A:  Check the cable connection between the computer and the analyzer.

Action B:  Select Unit [n] > Unit Configuration from the main menu and verify 
that the TCP/IP configuration for the computer and the analyzer are 
correct.

Action C: Exit the 2420 application and turn off the analyzer. Then turn on the 
analyzer and restart the 2420 application. If the problem persists, con-
tact your Micromeritics representative.

Cause:  The serial number of the instrument is different than the serial number 
the application expects.

Action:  Run the setup program on the installation CD; choose the Remove 
operation to remove the incorrect serial number. Then choose the Add 
operation to add the correct serial number.

Cause:  One or more calibration operations have not been performed.

Action:  If using the setup CD, reinstall the calibration files. If this does not cor-
rect the problem, contact your Micromeritics representative.
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6200 Series

6201- ‘GetOpenFile()’ reports error code (number). File selection cannot be made.

6203- No serial number available. Unit cannot initialize.

6204- This sample has an invalid status and cannot be used for degassing.

6206- Error dosing.

6209- Analysis startup failed. (Secondary message number and text.)

Cause: You specified a file name which does not exist.

Action: Confirm that the file name used is valid and that the file exists.

Cause: The ASAP 2420 control file does not contain a serial number for the 
unit.

Action: Run the ASAP 2420 Setup program, select Change analyzer setup, 
and define the serial number for the instrument.

Cause: You tried to degas a sample that has a status other than No Analysis.

Action: Select a sample with a status of No Analysis.

Cause: The degas system failed to dose the backfill gas to a pressure of 850 
mmHg.

Action: The gas regulator may be set too low or turned off.

Cause: The ASAP 2420 Program was unable to start an analysis with the indi-
cated unit.

Action: Refer to the specified error number and text for instructions.
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6212- Calibrating. This action must be completed before the application exits.

6213- Error overheating on port (number). Current = (temperature), Target = (temper-
ature), Limit = (temperature).

6216- Instrument could not initialize. Reason: (reason).

6217- Error thermocouple unplugged Current = (temperature), Target = (temperature).

6218- SmartVac is not in a valid state to check degas.

Cause: The unit is calibrating.

Action: Do not exit the application until the calibration is complete.

Cause: A heating mantle and/or its thermocouple are not plugged into the cor-
rect port.

Action: Verify heating mantle connections. If the problem persists, contact 
your service representative.

Cause: An internal processing and/or hardware error has occurred. 

Action: The specific reason given may identify a possible corrective action. 
Contact your service representative if you continue to receive this error 
message.

Cause: The thermocouple is not plugged into the correct degas port. 

Action: Check the heating mantle connections for the specified degas port.

Cause: You clicked Check to check degassing but the sample was not in an 
appropriate state. You can only check the degassing operation after the 
vacuum setpoint has been attained, or during a temperature ramp or 
hold.

Action: Wait until an appropriate time during the degassing operation and 
check the degassing operation again.
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6219- The file name (name) has already been used.

6220- There are currently no available ports to start a degas operation.

6221- An evacuation cannot be started because all degas ports are currently in use.

6222- At least one port must be selected before an evacuation can be started.

6226- An analysis cannot be started because all ports are currently is use.

6227- File (name) cannot be analyzed. It is currently being edited.

Cause: You entered a file name that is already in use.

Action: Enter a unique file name.

Cause: All degas ports are in use.

Action: Wait until the degas operation is complete on a port, then another degas 
operation may be started.

Cause: All degas ports are in use.

Action: Wait until the degas operation is complete on a port, then an evacuation 
can be started on the port.

Cause: You clicked Start on the Evacuate Degas dialog without first selecting 
a port.

Action: Select the port you wish to evacuate, then select Start.

Cause: You tried to start an analysis while all ports are in use.

Action: Wait until the analysis completes on a port, then another analysis can 
be started.

Cause: You tried to start an analysis using a sample information file that is cur-
rently being edited.
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6228- Analysis gas in sample file does not match analysis gas in other active 
samples.

6229- This file already selected for the analysis.

6230- Dosing method choice is invalid. The analysis requires that Adsorptive Prop-
erties\Dosing Method\is set to Normal.

6231- Dosing method choice is invalid. The Krypton analysis requires that Adsorptive 
Properties\Dosing Method\is set to From Port 6.

Action: Close the edit session on the sample information file, then the file can 
be used for analysis.

Cause: You tried to start an analysis using a sample file that contains an anal-
ysis gas other than the gas currently being used. All current analyses 
must use the same analysis gas.

Action A: Change the gas in the sample file to use the current analysis gas.

Action B: Wait until the current analyses are complete, then run the sample.

Cause: You selected a sample file that is already being used for an analysis.

Action: Select another sample information file.

Cause: You tried to perform a nitrogen or nitrogen-like analysis with From 
Port 6 selected as the dosing method.

Action: Choose Normal for Dosing Method in the Adsorptive Properties dia-
log, then start the analysis.

Cause: You tried to perform a Krypton analysis method with Normal selected 
as the dosing method.

Action: Choose From Port 6 for Dosing Method in the Adsorptive Properties 
dialog, then start the analysis.
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6232- Po gas in sample file does not match Po gas in other active samples.

6233- (Gas name) gas in sample file does not match (gas name) gas in other active 
samples.

6234- Analysis Conditions Pressures or Dose Increments table has no entries.

6236- An evacuation cannot be started because all analysis ports are currently in 
use.

Cause: You tried to start an analysis using a sample file that contains a Po gas 
other than the Po gas currently being used. All current analyses must 
use the same Po gas.

Action A: Change the gas in the sample file to use the current Po gas.

Action B: Wait until the current analyses are complete, then run the sample.

Cause: You tried to start an analysis using a sample file that contains an anal-
ysis gas other than the gas currently being used. All current analyses 
must use the same analysis gas.

Action A: Change the gas in the sample file to use the current analysis gas.

Action B: Wait until the current analyses are complete, then run the sample.

Cause: You tried to start an analysis using a sample file that contains no entries 
in either the pressure table or dose increments table.

Action A: In the Isotherm Collection group box on the Analysis Conditions dia-
log, select either Target Pressures or Dose Increments, then enter 
values in the associated table.

Cause: You tried to evacuate one or more analysis ports while all ports are in 
use.

Action: Wait until the current operation completes to evacuate a port.
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6240- Leak test failed on port (port number).

6241- (Unit [number]) Analysis canceled: Maximum time exceeded before the port 
(port number) elevator reached the UP (or DOWN) position.

6244- (Unit [number]) Analysis canceled: Time limit exceeded while storing analysis 
gas in Psat tube.

Cause: With the sample port valve closed, the sample pressure increased by 
0.15 mmHg before the leak test duration was completed.

Action: Check sample tube fitting and ensure that it is securely attached to the 
port. Then restart the analysis.

Cause A: The maximum time for the analysis was exceeded before the elevator 
reached the UP (or DOWN) position. Ice may be present in the bottom 
or the neck of the Dewar.

Action A: Check the Dewar and remove ice if necessary. Refer to “Checking and 
Cleaning the Analysis Port Dewars” on page 9-8. Then restart the 
analysis.

Cause B: The Psat tube is interfering with elevator movement.

Action B: Make sure the Psat tube is close to the sample tube and the Dewar 
cover is over both the sample and Psat tubes. Then restart the analysis.

Cause A: The time limit (10 minutes) was exceeded while storing the analysis 
gas in the Psat tube. The Psat gas regulator may be set too low or 
turned off.

Action A: Set the Psat gas regulator to 15 psig (1.03 bar). Then restart the 
analysis.

Cause B: The Psat gas bottle is empty.

Action B: Connect a new Psat gas bottle. Then restart the analysis.
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6247- Warm Freespace failure: P1 = (pressure), P2 = (pressure).

6248- Cold Freespace failure: P3 = (pressure).

6249- Zeroing of a transducer failed. Analysis Canceled.

6250- Matching of Sample port transducer failed. Analysis Canceled.

Cause C: The Psat tube fitting is loose.

Action C: Check the Psat tube fittings and ensure that the tube is attached 
securely to the port. Then restart the analysis.

Cause A: Helium gas line is not properly connected to the analyzer.

Action A: Check the helium gas connections.

Cause B: A valve, transducer, or elevator has failed.

Action B: Contact your Micromeritics representative.

Cause A: Helium gas line is not properly connected to the analyzer.

Action A: Check the helium gas connections.

Cause B: A valve, transducer, or elevator has failed.

Action B: Contact your Micromeritics representative.

Cause: The transducer did not respond correctly.

Action: Contact your service representative.

Cause: The transducer did not respond correctly.

Action: Contact your service representative.
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6251- Matching of Psat port transducer failed. Analysis Canceled.

6264- Krypton gas is not condensing in sample port 6 (pressure).

Cause: The transducer did not respond correctly.

Action: Contact your service representative.

Cause A: The krypton gas may be contaminated.

Action A: Evacuate the krypton gas inlet line.

Action B: Manually verify the saturation pressure of the krypton gas:

1. Evacuate station 6 with an empty tube.
2. Backfill with krypton gas to 20 mmHg.
3. Raise the Dewar in Station 6.

These steps should condense your krypton to a pressure below 3 
mmHg.

Cause B: The Dewar on sample port 6 does not contain enough cryogen.

Action B: Refill the Dewar.
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6500 Series

6510- Main pressure transducer overrange detected.
6511-  Sample transducer (number) overrange detected.
6512-  Po transducer (number) overrange detected.
6513-  Hardware pressure overrange detected.

6516- (Unit [number[) Analysis canceled: Pressure of (pressure point) mmHg exceeds 
the maximum manifold pressure of (pressure point) mmHg.

6517- (Unit [number]) Analysis canceled: Total volume dosed greater than (volume) 
cm3 is not allowed.

Cause: A manifold pressure over 1000 mmHg was detected by the hardware.

Action: Observe caution when operating the analyzer manually. If the problem 
persists, contact your service representative.

Cause: An absolute pressure greater than (pressure) mmHg was attained that 
exceeded the specified maximum manifold pressure.

Action: The analysis was canceled. All previously collected data were stored.

Cause A: More than (volume) cm3 has been dosed onto the sample, possibly due 
to leaks in the system.

Action A: Perform leak checks on the system. Refer to Appendix D, “TESTING 
THE ANALYZER FOR LEAKS” on page D-1.

Cause B: The value for the Po may be too low, causing the instrument to mistake 
condensation for actual adsorption.

Action B: Change the analysis variables to directly measure the value of Po dur-
ing the experiment.
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6518- (Unit [number]) Analysis canceled: Pressure of (pressure point) mmHg exceeds 
the maximum manifold pressure of (pressure point) mmHg.

6519- (Unit [number]) Analysis canceled: Psat gas is not condensing.

6520- Power failure detected. The sample is in an unknown condition. A run termina-
tion will be performed for safety.

Cause C: The amount of sample you used may be too large. Multiply the max-
imum value from the Volume Adsorbed column of the Isotherm Report 
by the sample weight. If the result exceeds (volume) cm3, the amount 
of sample is too large.

Action C: Reduce the amount of sample.

Cause: An absolute pressure greater than (pressure) mmHg was attained that 
exceeded the specified maximum manifold pressure. 

Action: The analysis was canceled. All previously collected data were stored. 
Change the maximum manifold pressure value in the Adsorptive Prop-
erties file.

Cause A: The working Dewar does not contain enough bath liquid.

Action A: Retry the operation after filling the Dewar.

Cause B: The Psat tubing from the regulator to the instrument is contaminated.

Action B: Pump out the tubing.

Cause C: The Psat gas is contaminated.

Action C: Replace the Psat gas supply.

Cause: A total power failure occurred while an analysis was in progress.

Action: Allow the analysis to terminate.
B-48                                                    Nov 2011



ASAP 2420 Operator’s Manual Appendix B
6521-  Time limit exceeded while dosing manifold to (target pressure) with (gas).

6522- Time limit exceeded while evacuating manifold. 

6523- Analysis suspended: Time limit exceeded while evacuating sample 
(unrestricted). 

Cause A: The maximum time was exceeded before the target pressure point was 
reached. The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to 15 psig (1.0 bar). Then resume the 
analysis.

Cause B: The analysis gas bottle is empty.

Action B: Connect a new analysis gas bottle. Then resume the analysis.

Cause A: Maximum manifold evacuation time was exceeded before the vacuum 
set point was achieved. Vacuum pump may be turned off.

Action A: Turn on vacuum pump switch. Then restart the analysis.

Cause B: The vacuum pump oil level is low. 

Action B: Check the vacuum pump oil level and add more oil if necessary. Then 
restart the analysis.

Cause C: The manifold is contaminated or leaking.

Action C: Correct the problem. Refer to Appendix D, TESTING THE ANA-
LYZER FOR LEAKS.

Cause: The maximum time for evacuating the sample through the unrestricted 
valve was exceeded. 

Action: Check the sample tube and the sample tube fitting; ensure that the tube 
is securely attached to the port. Verify that the sample is properly 
degassed; then restart the analysis.
Nov 2011                                                     B-49 



Appendix B ASAP 2420  Operator’s Manual
6524- Analysis suspended: Time limit exceeded while evacuating sample (servo).

6525- Time limit exceeded while backfilling manifold to (target pressure) with (gas).

Cause: The maximum time for evacuating the sample through the restricted 
valve was exceeded. Possible causes are a leak in the sample tube fit-
ting, a crack in the sample tube, or a poorly degassed sample.

Action: Check the sample tube and the sample tube fitting; ensure that the tube 
is securely attached to the port. Verify that the sample is properly 
degassed; then resume the analysis.

Cause A:  The maximum time was exceeded before the target pressure point was 
reached. The gas regulator may be set too low or turned off.

Action A:  Set the gas regulator to 15 psig (1.03 bar). Then resume the analysis.

Cause B: The gas bottle is empty.

Action B: Connect a new gas bottle. Then resume the analysis.
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CALCULATIONS

Saturation Pressure (Po)

Po method is selected by the user on the Po and Temperature Options dialog box. It may be 
entered, measured, or calculated from temperature.

If entered, Po = user entered value

If measured, Po = equilibrated pressure reading after saturating Po tube

If calculated from temperature, interpolate Po from the Psat vs Temperature table on the Po 
and Temperature Options dialog box, given the analysis bath temperature

Relative Pressure

If Po was measured:

For points taken before the previous Po measurement,

For points taken after the previous Po, use the previous Po:

PoI = Po1

If Po was entered, use the entered Po:

PoI = PoE

If Po was calculated, use the calculated Po:

PoI = PoC

Calculate relative pressure for the Ith data point:

where

PoI Po1
Po2 Po1–  TI To1– 

To2 To1– 
------------------------------------------------------------+=

Prel1

P1

PoI

--------=
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PoI = saturation pressure for the Ith data point (mmHg)

Po1 = most previous measured saturation pressure before Ith data 
point (mmHg)

Po2 = first measured saturation pressure after the Ith data point (mmHg)
PoC = calculated Po
PoE = entered saturation pressure (mmHg)

TI = time when the Ith data point was taken (minutes)
To1 = time when Po1 was measured (minutes)
To2 = time when Po2 was measured (minutes)

PrelI
= relative pressure for the Ith data point (mmHg)

PI = absolute pressure for the Ith data point, taken at equilibrium (mmHg)

Free Space

Free-space volumes are calculated using the following equations:

where:\

P1 = system manifold pressure before dosing helium onto sample (mmHg)
P2 = system manifold pressure after dosing helium onto sample (mmHg)
P3 = sample pressure after raising Dewar and equilibrating with helium (mmHg)
TSTD = standard temperature (273.13 K)
TRM = approximate room temperature (298 K)
T1 = system manifold temperature before dosing helium onto sample (K)
T2 = system manifold temperature after raising Dewar and equilibrating with 

helium (K)
VLOW = lower manifold volume (cm3)

VFC = volume of free space, cold (cm3 at standard temperature)

VFW = volume of free space, warm (cm3 at standard temperature)
VABT = portion of cold free space at analysis bath temperature: used in non-ideality 

VFW

VLOW

T1

------------
P1

P2

----- 1– TSTD=

VFC

VLOW

T2

------------
P1

P3

----- 1– TSTD=

VABT
VFC VFW–

1
TABT

TRM

----------–
------------------------=
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correction (cm3 at standard temperature)
TABT = analysis bath temperature (K), from the Po and Temperature Options dialog 

box

Volume Adsorbed

For the Ith dose:

where:

C = non-ideality correction factor, user-entered on Adsorptive Properties dialog 
box 

NgasI = total amount of gas dosed into sample tube after Ith dose (cm3 STP)

NadsI = amount of gas adsorbed after equilibrating Ith dose (cm3 STP)
PSTD = standard pressure (760 mmHg)

Psys1I = system manifold pressure before Ith dose of gas onto sample (mmHg)

Psys2I = system manifold pressure after Ith dose of gas onto sample (mmHg)

PsamI = sample pressure after equilibrating Ith dose of gas onto sample (mmHg)

Tsys1I = system manifold temperature before Ith dose of gas onto sample (K)

Tsys2I = system manifold temperature after Ith dose of gas onto sample (K)
Wsam = weight of sample (g) 
VI = amount of gas adsorbed per gram of sample (cm3/g STP) 

NgasI NgasI 1– VLOW
Psys1I

Tsys1I

----------------
Psys2I

Tsys2I

----------------–
TSTD

PSTD

-----------+=

NadsI NgasI PsamI PSTD VFC PsamI VABT C+ –=

VI
NadsI

Wsam
---------------=
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Equilibration

Equilibration is reached when the pressure change per equilibration time interval (first 
derivative) is less than 0.01% of the average pressure during the interval. Both the first 
derivative and average pressure are calculated using the Savitzky-Golay1 convolution method 
for polynomial functions. The equations below are those used to compute weighted average 
and first derivative, respectively, for the 6th point of an 11-point window.

where the numerical constants are from the Savitzky-Golay convolution arrays, and

PAVG = average pressure (mmHg)
PCHG = change in pressure (mmHg)

PI = Ith pressure reading taken at equilibrium intervals (mmHg)

After equilibration has been reached, if the user-entered minimum equilibration time from the 
Low Pressure Options dialog box has not elapsed, the equilibration continues until the entered 
time has elapsed.

If the user entered a non-zero maximum equilibration time from the Low Pressure Options 
dialog box, and this time period has elapsed before equilibration has been reached, the 
equilibration ends as if equilibration had been reached, and the point is collected.  

PAVG
36 P11 P1+ – 9 P10 P2+  44 P9 P3+  69 P8 P4+  84 P7 P5+  89 P6 + + + + +

429
--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

PCHG
5 P11 P1–  4 P10 P2–  3 P9 P3–  2 P8 P4–  P7 P5– + + + +

110
-----------------------------------------------------------------------------------------------------------------------------------------------------------=

If a non-zero value that is too small is entered for the maximum equilibration time, 
the points are collected before equilibration is reached. 

 If PAVG is greater than 0.995 times the current Po, equilibration will not take place 
until the Minimum equilibration delay for P/Po 0.995 has expired, in addition to the 
standard equilibration criteria.
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Thermal Transpiration Correction 

During data reduction, thermal transpiration correction is applied to the data if the user 
selected Thermal transpiration correction from the Report Options dialog box. Starting 
with the first collected pressure, the following calculations are performed until the pressure 
ratio (PC/P) is greater than or equal to 0.99.

where:

P = equilibrated collected pressure measured by gauge at temp 
TRM (mmHg)

SD = inside diameter of sample tube (mm), from the Report Options
dialog box

MD = thermal transpiration hard sphere diameter of gas (Å), from 
the Adsorptive Properties dialog box

T = average temperature [TABT + TRM] / 2 (K)
 = Weber’s coefficient, 0.033
 = Weber’s coefficient, 0.245
G = Weber’s coefficient, 2.5
H = Weber’s coefficient, 2 
TABT = analysis bath temperature (K), from the Po and Temperature Options dialog 

box
TRM = room temperature (298 K) 
PC = corrected equilibrated pressure at temperature TABT (mmHg)
F,Y, = intermediate values for subsequent calculations

Y
P SD MD2

2.33 T
----------------------------------- 103=

 1 G Y+
1 H Y+
-----------------------=

F 1

 Y2   Y  + +
------------------------------------------------------=

PC 1 F F
TABT

TRM

---------- 
 

0.5

 
 ––

 
 
 

P=
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BET Surface Area

For each point designated for surface area calculations, the BET2 transformation is calculated 
as follows:

where BI is in units of g/cm3 STP.

A least-squares fit is performed on the (PrelI ,BI) designated pairs where PrelI  is the 
independent variable and BI is the dependent variable. The following are calculated:

a. Slope (S g/cm3 STP)

b. Y-intercept (YINT g/cm3 STP)

c. Error of the slope (SERR g/cm3 STP)

d. Error of the y-intercept (YIERR g/cm3 STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated: 

BET Surface Area (m2/g):

where

CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the 
Adsorptive Properties dialog box

BET C value:

Volume of the Monolayer (cm3/g STP):

B1

Prel1

1.0 Prel1
–  Nads1


----------------------------------------------=

SABET
CSA 6.023 1023 

22414 cm3 STP  1018 nm2/m2  S YINT+ 
---------------------------------------------------------------------------------------------------------------------=

C
S YINT+

YINT

-------------------=

VM
1

C YINT
-------------------- 1

S YINT+
-------------------= =
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Error of the BET Surface Area (m2/g):

 

Langmuir Surface Area

For each point designated for surface area calculations, the Langmuir3 transformation is cal-
culated as follows:

where LI is in units of g/cm3 STP

A least-squares fit is performed on the (PrelI  ,LI) designated pairs where PrelI  is the inde-

pendent variable and LI is the dependent variable. The following are calculated:

a. Slope (S g/cm3 STP)

b. Y-intercept (YINT g/cm3 STP)

c. Error of the slope (SERR g/cm3 STP)

d. Error of the y-intercept (YIERR g/cm3 STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated: 

Langmuir Surface Area (m2/g):

  

where

CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the 
Adsorptive Properties dialog box  

BETERR
SABET SERR 2 YIERR 2+ 

0.5


YINT S+
---------------------------------------------------------------------=

LI

PrelI

NadsI

-----------=

SALAN
CSA 6.023 1023 

22414 cm3 STP  1018 nm2/m2  S
-----------------------------------------------------------------------------------------------=
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Volume of the Monolayer (cm3/g STP):

 

Langmuir b Value:

 

Error of the Langmuir Surface Area (m2/g):

t-Plot

For each point designated for t-Plot4 calculations, the following calculations are done:

Thickness for the Ith point (Å):

 (Halsey5)     

or

(Harkins and Jura6)

where:

tI = thickness for Ith point 
HP1 = Halsey parameter #1
HP2 = Halsey parameter #2
HP3 = Halsey parameter #3
HJP1 = Harkins and Jura parameter #1
HJP2 = Harkins and Jura parameter #2
HJP3 = Harkins and Jura parameter #3
PrelI = relative pressure for the Ith point (mmHg)

A least-squares analysis fit is performed on the (tI, NadsI) data pairs where tI is the indepen-
dent variable and NadsI is the dependent variable. Only the values of tI between tMIN and 

VM
1
S
---=

b YINT   VM =

LANERR
SALAN SERR

S
-------------------------------=

tI HP1
HP2

PrelI
 ln

--------------------
HP3

=

tI
HJP1

HJP2 PrelI
 log–

-------------------------------------------
HJP3

=
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tMAX, the minimum and maximum thickness, are used. The following are calculated: 

a. Slope (S cm3/g-Å STP)

b. Y-intercept (YINT cm3/g STP)

c. Error of the slope (SERR cm3/g-Å STP)

d. Error of the Y-intercept (YIERR cm3/g STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated: 

External Surface Area (m2/g):

where

F = surface area correction factor, user-entered on the t-Plot Report Options dialog 
box

D = density conversion factor, user-entered on the Adsorptive Properties dialog 
box

Micropore Surface Area (m2/g):

where SATOT is the BET surface area if the user enabled the BET report exclusively, or Lang-
muir surface area if the user enabled the Langmuir report exclusively. If neither report has 
been selected, SATOT is the BET surface area value calculated using a set of default 
parameters.

Micropore Volume (cm3 liquid/g):

SAEXT
S cm3/g A STP–  1010 A/m  D  cm3 liquid/cm3 STP 

F 106 cm3/m3 
--------------------------------------------------------------------------------------------------------------------------------------------------------=

SAP SATOT SAEXT+=

VP YINT cm3/g STP  D cm3 liquid/cm3 STP =
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BJH Pore Volume and Area Distribution

For adsorption data, the relative pressure and volume adsorbed data point pairs collected dur-
ing an analysis must be arranged in reverse order from which the points were collected during 
analysis. All calculations are performed based on a desorption model, regardless of whether 
adsorption or desorption data are being used.

The data used in these calculations must be in order of strictly decreasing numerical value. 
Points which do not meet this criterion are omitted. The remaining data set is composed of 
relative pressure (Pr), volume adsorbed (Va) pairs from (Pr1, Va1) to (PrN, VaN) where (PrN = 
0, VaN = 0) is assumed as a final point. Each data pair represents an interval boundary (or 
desorption step boundary) for intervals i=1 to i=N-1 where N = total number of (Pr, Va) pairs.

Generally, the desorption branch of an isotherm is used to relate the amount of adsorbate lost 
in a desorption step to the average size of pores emptied in the step. A pore loses its con-
densed liquid adsorbate, known as the core of the pore, at a particular relative pressure related 
to the core radius by the Kelvin7 equation. After the core has evaporated, a layer of adsorbate 
remains on the wall of the pore. The thickness of this layer is calculated for a particular rel-
ative pressure from the thickness equation. This layer becomes thinner with successive 
decreases in pressure, so that the measured quantity of gas desorbed in a step is composed of 
a quantity equivalent to the liquid cores evaporated in that step plus the quantity desorbed 
from the pore walls of pores whose cores have been evaporated in that and previous steps. 
Barrett, Joyner, and Halenda8 developed the method (known as the BJH method) which incor-
porates these ideas. The algorithm used on the ASAP 2420 is an implementation of the BJH 
method.

Explanation of Terms

A pore filled with condensed liquid nitrogen has three zones:

a. The core - evaporates all at once when the critical pressure for that radius is reached; 
the relationship between the core radius and the critical pressure is defined by the 
Kelvin equation.

b. The adsorbed layer - composed of adsorbed gas that is stripped off a bit at a time 
with each pressure step; the relationship between the thickness of the layer and the 
relative pressure is defined by the thickness equation.
C-12                                                    Nov 2011



ASAP 2420  Operator’s Manual Appendix C
c. The walls of the cylindrical pore - the diameter of the empty pore is required to 
determine the pore volume and pore area. End area is neglected.

Calculations

The volumes adsorbed (Va) are converted to the liquid equivalent volumes (V1, cm3/g):

where D is the Density Conversion Factor from the Adsorptive Properties dialog box.

The relative pressure (Pr1) is assumed to be close to unity so that substantially all the pores in 
the sample are filled.

The corresponding Kelvin core radius is calculated. Only pores smaller than this size will be 
included:

where

A = adsorbate property factor (the BJH Adsorptive Options dialog box)
F = fraction of pores open at both ends (from the BJH Adsorption Report Options 

dialog box or the BJH Desorption Report Options dialog box); assumed to be 
zero for desorption

This radius will be adjusted for the thickness of the adsorbed layer during subsequent calcu-
lation steps.

a
d
s
o
r
b
e
d

l
a
y
e
r

wall

c
o
r
e

Insignificant 
compared to 
core length

pore

VII VaI  D =

RcI
A–

1 F+  PrI ln 
-----------------------------------------=
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The thickness of the remaining adsorbed layer at this relative pressure is calculated:

where

HP1, HP2, and HP3 are Halsey Parameters 1, 2, and 3 (respectively) from the Halsey Thick-
ness Equation dialog box.

These calculations illustrate the use of the Halsey thickness equation. If the Harkins/Jura 
equation was selected, substitute the following wherever the thickness equation appears:

where

HJ1, HJ2, and HJ3 are Harkins-Jura Parameters 1, 2, and 3 (respectively) from the Harkins-
Jura Thickness Equation dialog box.

The following calculations (a-c) are made for each relative pressure interval based on the 
increment of volume desorbed during that interval. The variable I refers to the interval num-
ber, that is I=1 for the first interval from Pr1 to Pr2, and so on. J refers to each previous 
interval during which new pores were found. K refers to the total number of intervals in 
which new pores have been found. K is also the number of lines reported on the BJH table for 
collected data.

a. The thickness of the adsorbed layer at the end of the interval is calculated as follows:

(For the last pressure interval from the lowest PrI to zero relative pressure, TwI+1 = 0.)

For the first pressure interval, there are no previously opened pores so the volume 
desorbed from walls of previously opened pores is zero (Vd1 = 0), and the remainder 
of Step a is skipped.

The change in thickness of the wall layer due to desorption from previously opened 
pores is calculated:

Tw1 HP1
HP2

Pr1 ln
------------------

HP3

=

Tw1
HJ1

HJ2 Pr1 log–
--------------------------------------

HJ3

=

TwI 1+ HP1
HP2
PrI 1+ ln

------------------------
HP3

=

Tw Tw1 TwI 1+–=
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The annular cross-sectional area of the wall layer desorbed is calculated for all pre-
viously opened pores:

The total volume of gas desorbed from walls of previously opened pores is 
calculated:

 for all previously opened pores

where LPJ = length of previously opened pores as calculated in Step b(2).

b. The physical processes occurring for this pressure interval are determined as follows:

(1) If VdI is greater than the current increment of volume desorbed (VlI - VlI+1), 
desorption from walls only is occurring. Total surface of walls exposed thus far 
(cm2/g) is calculated as follows:

   for all previously opened pores

where

DavgJ  =  weighted average pore diameter calculated below in Step b(2).

A new layer thickness (Tw) that will not overcompensate for the actual volume 
desorbed in this interval is calculated:

Since no cores are evaporated in this pressure interval, no new pores are revealed. 
Thus no ending Kelvin radius and average pore diameter are calculated for this 
interval. Note that this means the report may have fewer tabulated intervals on 
the collected data report than experimental pressure intervals.

(2) If VdI is less than the volume increment desorbed during this interval, the 
remaining volume is due to new pores with core evaporation taking place in this 
interval. K, the number of intervals with new pores exposed, is increased by 1. 
(For the interval from the lowest  to zero relative pressure, no new pore volume is 
calculated and the rest of Step b is skipped.)

The volume desorbed from newly opened pores in this interval is calculated as 
follows:

CSAJ  Rcj Tw+ 2 Rcj 
2–  10 16–  cm2/A2 =

VdI LpJ  CSAaJ =

SAW  LPJ  DavgJ
  10 8–  cm/A =

Tw
V1I V1I 1+–  108 A/cm 

SAwI

--------------------------------------------------------------=

VcI VII VII 1+–  VdI–=
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The Kelvin radius for the end of the interval is calculated as follows:

All new pores opened in this interval are represented by one pore having a 
length-weighted average pore diameter and a corresponding length sufficient to 
account for the required volume of adsorbate. The weighted average pore diam-
eter is calculated as follows:

DavgK is the diameter of a pore which would have a surface area that is the aver-
age of the areas for pores with radius and, if its length was the mean of the 
lengths at those radii. 

The relative pressure corresponding to DavgK is calculated as follows:

The thickness of the adsorbed layer at this pressure is calculated as follows:

The decrease in thickness of the wall layer by desorption from the walls of new 
pores during the lower portion of the pressure interval is calculated as follows:

The cross-sectional area of the newly opened pores is calculated as follows:

The length of the newly opened pores is calculated as follows:

RcK 1+
A–

1 F+  PrI 1+ ln 
-----------------------------------------------=

DavgK

2  RcK RcK 1++  RcK  RcK 1+ 

RcK 2 RcK 1+  2+
-------------------------------------------------------------------------------=

PavgK
 1– 2A–

1 F+  DavgK
 

-----------------------------------ln=

TwavgK
HP1

HP2
PavgK
 ln

----------------------
HP3

=

Td TwavgK
TWI 1+–=

CSAcK
DavgK

2
---------------- Td+

2

10 16–  cm2/A2 =

LPK
VcI

CSAcK

-----------------=
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c. Pore diameters and radii are adjusted for the change in thickness of the adsorbed wall 
layer during this interval. If new pores were opened during this interval, the average 
diameter is adjusted by the change in layer thickness during the second portion of the 
desorption interval as follows:

The layer thickness change during the whole interval is added to diameters of previ-
ously opened pores as follows:

(not including DavgK)

The layer thickness change desorbed during this interval also is added to the radii 
corresponding to the ends of the pressure intervals as follows:

for all except RcK+1.

Steps a to c are repeated for each pressure interval.

After the above calculations have been performed, the diameters corresponding to the 
ends of the intervals are calculated as follows:

for all RcJ including RcK+1.

The remaining calculations are based on DP(I), Davg(I), and LP(I). These calculations 
are only done for values that fall between the Minimum BJH diameter and the Max-
imum BJH diameter specified by the operator on the BJH Adsorption Report Options 
dialog box or the BJH Desorption Report Options dialog box.

1) Incremental Pore Volume  (VpI, cm3/g):

2) Cumulative Pore Volume (VpCUM(1), cm3/g):

DavgKnew
DavgKold

2 Td +=

DavgJnew
DavgJold

2  Tw +=

RcJnew RcJold Tw+=

DpJ 2 rcJ =

VpI  LpI 
DavgI

2
-----------

2

1016 cm2/A2=

VPCUM 1 
VpJ for J 1 =
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3) Incremental Surface Area (SAI, m2/g):

4) Cumulative Surface Area (SACUM(I), m2/g):

5) dV/dD pore volume (dV/dDI, cm3/g-A):

6) dV/dlog(D) pore volume (dV/dlog(D)I, cm3g):

7) dA/dD pore area (dA/dDI, m2/g-A):

8) dA/dlog(D) pore area [dA/dlog(D)I, m2/g]:

For fixed pore size tables (if selected), the following calculations are performed:

1) Average Fixed Pore Size (DFavgJ, A):

calculated for all intervals in the fixed pore size table.

For the intervals with between the Minimum BJH diameter and the Maximum 
BJH diameter.

SAI  LPI  10 2–  m/cm  DavgI
  10 10–  m/A =

SACUM10
SAJ for J 1=

dV/dDI
VPI

DpI DpI 1+–
------------------------------=

dDv/d D I VPI/
DpI

DpI 1+

--------------- 
 log=log

dA/dDI
SAI

DpI DpI 1+–
------------------------------=

dA/d D Ilog SAI/
DpI

DpI 1+

--------------- 
 log=

DFavgJ

DpFJ
DpFJ 1+

+

2
---------------------------------=
C-18                                                    Nov 2011



ASAP 2420  Operator’s Manual Appendix C
2) Cumulative Pore volume (VpFCUMI, cm3/g):

where INTERP(x) is the value interpolated from the function X = DpJ+1 and Y = 
VPCUMJ, using an AKIMA semi-spline interpolation.

3) Incremental Pore Volume (VpFI, cm3/g):

where VpFCUM0 = 0.

4) Cumulative Surface Area (SAFCUMI, m2/g):

where INTERP(x) is the value interpolated from the function X = DpJ+1 and Y = 
SACUMJ.

5) Incremental Surface Area (SAFI, m2/g):

where SAFCUM0 = 0.

6) dV/dD pore volume (dV/dDpFI, cm3/g-A)):

where INTERP(x) is the value interpolated from the function X = DavgJ and Y = 
dV/dDJ.

7) dV/dlog(D) pore volume [dV/dlog(DpF)I, cm3/g]:

where INTERP(x) is the value interpolated from the function X = DavgJ and Y = 
dV/dlog(D)J.

VpFCUMI
INTERP DpFI 1+ =

VpFI VpFCUMI
VpFCUMI 1–

–=

SAFCUMI
INTERP DpFI 1+ =

SAFI SAFCUMI
SAFCUMI 1–

–=

dV/dDpFI INTERP DpFI 1+ =

dV/d D pFI log INTERP DpFI 1+ =
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8) dA/dD pore area (dA/dDpFI, m2/g-A):

where INTERP(x) is the value interpolated from the function X = DavgJ  and Y = 
dA/dDJ.

9) dA/dlog(D) pore area [dA/dlog(DpFI), m2/g]:

where INTERP(x) is the value interpolated from the function X = DavgJ  and Y = 
dA/dlog(D)J.

Compendium of Variables

Va = quantity adsorbed expressed as a volume (cm3/g STP)
Vl = liquid equivalent volume of volume adsorbed (cm3/g)
D = density conversion factor from the Adsorptive Properties dialog box

(cm3/cm3 STP)
Pr = relative pressure
Dp = pore (or core) diameter (A)
Rc = Kelvin radius (A) of core
A = adsorbate property factor; from the BJH Adsorptive Options dialog box
F = fraction of pores open at both ends; from the BJH Adsorption Report 

Options dialog box or the BJH Desorption Report Options dialog box
Tw = thickness of adsorbed layer desorbed during interval (A)
Tw = thickness of remaining adsorbed wall (A)

HP1, HP2, and HP3 are Halsey Parameters from the Halsey Thickness Equation dialog box.

HJ1, HJ2, and HJ3 are Harkins and Jura Parameters from the Harkins/Jura Thickness Equa-
tion dialog box.

Vd = volume of gas desorbed from walls of previously opened pores (cm3/g)
Davg = average pore diameter (A)
CSAa = annular cross-sectional area of the desorbed layer (cm2)
CSAc = cross-sectional area of opening of newly opened pores (cm2)
SAw = total surface area of walls exposed (cm2/g)
Td = thickness of layer desorbed from walls of newly opened pores (A)
Vc = volume desorbed from cores of newly opened pores (cm3/g)
Lp = length of pore (cm/g)

dA/dDpFI INTERP DpFI 1+ =

dA/d D pFI log INTERP DpFI 1+ =
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Horvath-Kawazoe

A relative pressure lower limit is determined such that L-d0 never equals zero. All pressure 
points less than this limit are discarded. For each collected relative pressure point, values of L 
are chosen in an iterative manner, and the relative pressure (P/Po) determined by solving one 
of the following equations:

• Slit Pore Geometry (original Horvath-Kawazoe)
• Cylinder Pore Geometry (Saito/Foley)
• Sphere Pore Geometry (Cheng/Yang) 

Slit Pore Geometry (original HK)

When you use the original Horvath-Kawazoe9 method, the following equation is solved for 
each value of P. The value of L is determined when the solved-for relative pressure is within 
0.1% of the collected absolute pressure.

where

K = Avogadro’s number (6.023 x 1023)
R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated 

value on the Po and Temperature Options dialog box

 = gas solid nuclear separation at zero interaction energy (Å), 

where:

ZS = sample equilibrium diameter at zero interaction energy (Å) from the 
Horvath-Kawazoe Physical Properties dialog box 

ZA = zero interaction energy diameter from the Horvath-Kawazoe Physical 
Properties dialog box 

d0 =

where:

DA = molecular diameter (Å) from the Horvath-Kawazoe Physical
Properties dialog box 

DS = diameter of sample atom (Å) from the Horvath-Kawazoe Physical 
dialog box 

P
Po
-------ln

K
RT
------- IP 1032 JA4/J cm4

4 L 2 d0– 
-------------------------------------------------- 4

3 L d0– 3
------------------------------ 10

9 L d0– 9
------------------------------– 4

3 d0 
3

---------------– 10

9 d0
 9

---------------+=

ZS ZA+
2

-----------------

DA DS A  +
2

------------------------------
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L = pore width (nucleus to nucleus) (Å)
P = equilibrium pressure (mmHg)
Po = saturation pressure (mmHg)
IP = interaction parameter (10-43 ergs-cm4) from the Horvath-Kawazoe 

Report Options dialog box

Cylinder Pore Geometry (Saito/Foley)

When you use the Saito-Foley10 method, the following equation is solved for each value of P. 
The value of L is determined when the solved-for relative pressure is within 0.1% of the 
collected absolute pressure.

where

K = Avogadro’s number (6.023 x 1023)
R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated 

value on the Po and Temperature Options dialog box
L = pore width (nucleus to nucleus) (Å)
P = equilibrium pressure (mmHg)
Po = saturation pressure (mmHg)
IP = interaction parameter (10-43 ergs-cm4) from the Horvath-Kawazoe Report 

Options dialog box

d0 =

where:
DA = molecular diameter (Å) from the Horvath-Kawazoe Physical

Properties dialog box 
DS = diameter of sample atom (Å) from the Horvath-Kawazoe Physical

dialog box 

k =

k =

rp = radius of the cylindrical pore, 

P
Po
------- 
 ln

3
4
---K

RT
------- IP 1032 JA4/J cm4

d0 4
-------------------------------------------------- 1

k 1+
------------ 1

d0

rp

-----– 
  2k 21

32
------k

d0

rp

----- 
 

10

k

d0

rp

----- 
 

4

–
 
 
 


k 0=



=

DA DS A +
2

----------------------------

4.5– k–
k

-------------------- 
 

2

 k 1– ,0 1.0=

1.5– k–
k

-------------------- 
 

2

 k 1– ,0 1.0=

L
2
---
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Sphere Pore Geometry (Cheng/Yang)

When you use the Cheng/Yang11 method, the following equation is solved for each value of 
P. The value of L is determined when the solved-for relative pressure is within 0.1% of the 
collected absolute pressure.

where

R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated value on the Po 

and Temperature Options dialog 

d0 =

where:
DA = molecular diameter (Å) from the Horvath-Kawazoe Physical Properties 

dialog  
DS = diameter of sample atom (Å) from the Horvath-Kawazoe Physical 

dialog  
L = pore width (nucleus to nucleus) (Å)
P = equilibrium pressure (mmHg)
Po = saturation pressure (mmHg)
N1 = 4 L2 NS, where NS = number of sample atoms/cm2 at monolayer

N2 = 4 (L - d0)2 NA, where Ns = number of gas molecules/cm2 

e*12 = , where  

 *22 = , where  

T1 =

T2 =

T3 =

P
Po
------- 
 ln

6 N1
* 12 N2

* 22+ L3 1032 J A4/J cm4

RT L d0– 3
----------------------------------------------------------------------------------------------------=

d0

L
----- 
 

6 1
12
------T1

1
8
---T2+ 

 –
d0

L
----- 
 

12 1
90
------T3

1
80
------+ T4 

 +

DA DS A +
2

----------------------------

AS

4dS 6
------------ AS

6 MC2 S A
S

S

-----
A

A

------+
---------------------------------------------=

AA

4DA 6
-------------- AA

3 MC2 A A
2

---------------------------------------------=

1

1 S– 3
------------------- 1

1 S+ 3
-------------------–

1

1 S+ 2
------------------- 1

1 S– 2
-------------------–

1

1 S– 9
------------------- 1

1 S+ 9
-------------------–
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T4 =

where    

Cheng/Yang Correction

This factor corrects for the nonlinearity of the isotherm. It adds an additional term to the 
equations for the different geometrics:

where

G(L) = one of the Horvath-Kawazoe equations given above
 = degree of void filling;  is estimated by first computing the monolayer 

capacity (Vm) with the Langmuir equation over the range of data points from 
relative pressure 0.02 to 0.2 or the maximum relative pressure included in the 
Horvath-Kawazoe analysis.  is computed as the volume adsorbed over Vm.

Interaction Parameter

The interaction parameter (IP) results from the following calculations:

The Kirkwood-Muller dispersion coefficients -

where

MC2 = kinetic energy of electron (0.8183 x 10-6 erg)
S = polarizability of sample atoms (cm3)

A = polarizability of gas molecule (cm3)

S = diamagnetic susceptability of sample atom (cm3)

1

1 S+ 8
------------------- 1

1 S– 8
-------------------–

S
L d0–

L
--------------=

P
Po
------- 
 ln G L  1

1

--- 1

1 –
------------ 
 ln––=

AS
6 MC2 S A

S

S

-----
A

A

------+
---------------------------------------------=

AA
3 MC2 A A

2
---------------------------------------------=
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A = diamagnetic susceptability of gas molecule (cm3)

where:

NA = number of gas molecules/cm2 at monolayer from the Horvath-Kawazoe 
Physical Properties dialog 

NS = number of sample atoms/cm2 from the Horvath-Kawazoe Physical Properties 
dialog 

Refer to Interaction Parameter Components later in this Appendix for recommended 
values.

Additional Calculations

Based on the previous calculations, the following can be calculated:

Adjusted Pore Width (Å):
         (Shell to Shell)

Cumulative Pore Volume (cm3/g):

 

where 

D = density conversion factor (cm3 liquid/cm3 STP) on the Adsorptive Properties 
dialog box

dV/dD Pore Volume (cm3/g-Å): 

 

IP NA A A  NS AS +=

ALI LI DS–=

VCUMI
VI D=

dV
dDI

---------
VCUMI

VCUMI 1–
–

ALI ALI 1––
--------------------------------------=
Nov 2011                                               C-25 



Appendix C ASAP 2420 Operator’s Manual
Median Pore Width (Å):

 

where

VCUMN = total cumulative pore volume (VCUMI) for points designated for Horvath-
Kawazoe calculations

VHALF = 50% of total cumulative pore volume 
VL = cumulative pore volume (VCUMI) for first point less than VHALF

VG = cumulative pore volume (VCUMI) for first point greater than VHALF

DL = pore width (LI) that corresponds to VL 
DG = pore width (LI) that corresponds to VG

VHALF

VCUMN

2
--------------=

DMED 10 DL log VHALF  VL log–log 
DG  DL log–log
VG  VL log–log

----------------------------------------------+=
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Interaction Parameter Components

Table C-1. Interaction Parameters

The following values were used to calculate the values in Table C-1.

Gas

Bath 
Temperature

(K) Sample Type

Interaction 
Parameter 
Calculated 

Value*

Argon  87.3 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

2.61
5.89
3.19

Carbon 
Dioxide

298.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.20
9.20
5.08

273.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.34
9.35
5.22

194.65 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.72
9.72
5.60

Nitrogen  77.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

2.84
6.53
3.49

*The interaction parameter is entered in the Horvath-Kawazoe Report Options dialog in the 
following field:

Interaction parameter: (calculated value) x 10-43 ergs-cm4

Carbon-Graphite Zeolite
DS = 3.40 DS = 3.04
NS = 3.845 x 1015 NS = 3.75 x 1015

S = 1.05 x 10-29  (Ross/Olivier) S = 1.94 x 10-29

13.5 x 10-29 (Horvath/Kawazoe, implicit) S = 0.85 x 10-24

S = 1.02 x 10-24

Nitrogen Argon
DA = 3.00 DA = 2.95
A = 6.71 x 1014 A = 7.608 x 1014

A = 3.6 x 10-29 A = 3.22 x 10-29

A = 1.76 x 10-24 A = 1.63 x 10-24
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DA values are from van der Waal’s constant.
NA values are from liquid densities.

 and  values are derived from data found in Ross and Olivier12.

The physical parameters referenced in Saito/Foley are as follows:

Carbon Dioxide
DA = 3.23
NA = 4.567 x 1014 (25 ºC)

5.45 x 1014 (0 ºC)
7.697 x 1014 (-78 ºC)

A = 5.0 x 10-29

A = 2.7 x 10-24

Aluminophosphate Aluminosilicate
DS = 2.60 DS = 2.76
NS = 1.48 x 1015 Ns = 1.31 x 1015

S = 1.3 x 10-29 S = 1.3 x 10-29

S = 2.5 x 10-24 S = 2.5 x 10-24
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Dubinin-Radushkevich

The Dubinin-Radushkevich9 equation is as follows:

 

where:

V = volume adsorbed at equilibrium pressure (cm3/g STP)
Vo = the micropore capacity (cm3/g STP)
Po = saturation vapor pressure of gas at temperature T (mmHg) 
P = equilibrium pressure (mmHg)
B = a constant
 = the affinity coefficient of analysis gas relative to Po gas 

(for this application  is taken to be 1)
T = analysis bath temperature (K), from the Po and Temperature 

Options dialog box 

For each point designated for Dubinin-Radushkevich calculations, the following calculations 
are done:

LV = log (V)

The intercept, log(Vo) can be found by performing a least-squares fit on the (LP,LV) desig-
nated pairs where LP is the independent variable and LV is the dependent variable. Assuming 
the adsorption of gas is restricted to a monolayer, Vo is the monolayer capacity. Based on this 
assumption, the following are calculated:    

a. Slope (S cm3/g STP)

b. Y-intercept (YI cm3/g STP)

c. Error of the slope (SERR cm3/g STP)

d. Error of the y-intercept (YIERR cm3/g STP)

e. Correlation coefficient (Cc)

V log Vo  B T2
 

--------------- Po
P

-------log
2

–log=

LP
Po
P

------- 
 

2

log=
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Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):

Vo = 10YI

Error of Monolayer Capacity (cm3/g STP):

VoERR = Vo x (10YIERR - 1.0)

Micropore surface area (m2/g):

where

 = molecular cross sectional area of gas (nm2)from the Adsorptive Properties 
dialog box 

Dubinin-Astakhov

The Dubinin-Astakhov equation is a follows:

 

where

V = volume adsorbed at equilibrium pressure (cm3/g STP)
Vo = the micropore capacity (cm3/g STP)
Po = saturation vapor pressure of gas at temperature T (mmHg) 
P = equilibrium pressure (mmHg)
T = analysis bath temperature (K) 
R = the gas constant (0.0083144 kJ/mol)
E0 = characteristic energy (kJ/mole)
N = Astakhov exponent, may be optimized or user entered from the Dubinin 

Report Options dialog box
 = the affinity coefficient of the analysis gas relative to the Po gas, from the 

Dubinin Adsorptive Options dialog box

SDP  Vo 6.023 1023 
22414 cm3 1018 nm2/m2 
--------------------------------------------------------------------=

V log Vo  RT
E0

---------
N Po

P
-------log

N

–log=
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For each point designated for Dubinin-Astakhov calculations, the following calculations are 
done:

LV = log(V)

A least-squares fit is performed on the (LP,LV) designated pairs where LP is the independent 
variable and LV is the dependent variable. If the user selected yes for the Optimize Astakhov 
Exponent prompt, a systematic search for the optimum value of N is conducted by recalcu-
lating the linear regression and selecting the value of N that gives the smallest standard error 
of the y-intercept. The exponent N is optimized to within 10-4. If the optimum value for N is 
not found in this range, an exponent of 2 is used. The following are calculated:     

a. Slope (S cm3/g STP)

b. Y-intercept (YI cm3/g STP)

c. Error of the slope (SERR cm3/g STP)

d. Error of the y-intercept (YIERR cm3/g STP)

e. Correlation coefficient (Cc)

f. Optimized Astakhov exponent (N)

Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):

V0 = 10YI

Micropore Volume (cm3/g):

WI = (VI x D)

where

D = density conversion factor (cm3 liquid/cm3 STP) from the Adsorptive 
Properties dialog box

LP Po
P

-------log
N

=
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Limiting Micropore Volume (cm3/g):

W0 = (V0 x D)

where 

D = density conversion factor (cm3 liquid/cm3 STP) from the 
Adsorptive Properties dialog box

Error of Limiting Micropore Volume (cm3/g):

W0ERR = W0 x (10YIERR - 1.0)

Characteristic Energy (KJ/mole):

Modal Equivalent Pore Width (nm):

where 

k = the interaction constant for benzene, 8.969 kJ•nm3/mol

Maximum Differential Pore Volume (cm3/g-nm):

This value is also known as frequency of the mode10

E 2.303 R T
 2.303 S 1/N
-------------------------------------=

wmode 2
3N

3N 1+
----------------

1/N k
E0

-----
 
 
 

1/3

=

dV
dwmode

----------------Max 0.5 3N 1+  Wo 3N 1+
3N

----------------
1/3N


E0

k
-----

1/3 3N 1+
3N

----------------– 
 exp=
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Mean Equivalent Pore Width (nm):

Micropore surface area (m2/g):

 is calculated by a polynomial approximation11 over the domain 0  x  1 as follows:

(x+1) = 1+b1x + b2x2 + b3x3 + b4x4 + b5x5 + b6x6 + b7x7 + b8x8 + (x) | (x) |   3 x 10-7

where

b1 = -0.57719 1652
b2 =   0.98820 5891
b3 = -0.89705 6937
b4 =   0.91820 6857
b5 = -0.75670 4078
b6 =   0.48219 9394
b7 = -0.19352 7818
b8 =   0.03586 8343

and where

Equivalent Pore Width (nm):

wmean 2

k
E0

-----
1/3

 3N 1+
3N

---------------- 
 

--------------------------=

SDA 1000 2.0 W0
E0

k
-----

1/3

  3N 1+
3N

---------------- 
 =

x 1+
3N 1+

3N
---------------- 
 =

wi 2

k
E0

----- 
  N

–

W i  W0 ln–ln
-----------------------------------------

1/3N

=
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dV/dw Pore Volume (cm3/g-nm):

MP-Method

For each point designated for MP-method10 calculations, the following calculations are done:

Thickness for the Ith point (Å):

(Halsey6)     

or

(Harkins and Jura7)

where:

tI = thickness for Ith point 
HP1 = Halsey parameter #1
HP2 = Halsey parameter #2
HP3 = Halsey parameter #3
HJP1 = Harkins and Jura parameter #1
HJP2 = Harkins and Jura parameter #2
HJP3 = Harkins and Jura parameter #3
PrelI = relative pressure for the Ith point (mmHg)

With the (tI,VI) data pairs, the Akima semi-spline interpolation method is used to interpolate 
volume adsorbed values based on thickness values that are evenly spaced 0.2 Angstrom apart 
starting at the first outlier point. Outliers are defined as those points have the maximum 
instantaneous slope within an iteratively shrinking subset of all points. The remaining pore 
surface area calculation result is the slope of the line defined by two consecutive interpolated 
points. The slopes of each pair of consecutive points from the origin to the last point must be 
monotonically decreasing and non-negative. With the interpolated points set the following 
can be calculated:

Average pore hydraulic radius (Å):

 

dV
dwi

-------- 0.5 W0 3N
k

E0

-----
N


wi

2
----- 
 

3N 1+ –

 k
E0

-----
 N


 wi

2
----- 
 

3N–

–exp=

tI HP1
HP2

PrelI
 ln

--------------------
HP3

=

tI
HJP1

HJP2 PrelI
 log–

-------------------------------------------
HJP3

=

RI
tI tI 1–+

2
------------------=
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Remaining pore surface area for the Ith point (m2/g):

 

where 

D = density conversion factor (cm3 liquid/cm3 STP) on the Adsorptive Properties 
dialog box

Incremental pore surface area occluded for the Ith point (m2/g):

 

Cumulative pore surface area occluded for the Ith point (m2/g):

  

dA/dR pore surface area for the Ith point (m2/g-Å):

 

Incremental pore volume occluded for the Ith point (cm3/g):

 

Cumulative pore volume occluded for the Ith point (cm3/g):

 

dV/dR pore volume for the Ith point (cm3/g-Å):

 

SI
VI VI 1––  D 10 6–  m3/cm3 

tI tI 1––  10 10– m/A
-------------------------------------------------------------------------------=

SINCI
SI 1– SI–=

SCUMI
SINCI

SINCI 1–
 SINC1

+ + +=

dA
dRI

--------
SINCI

tI tI 1––
------------------=

VINCI
SINCI

104 cm2/m2  RI 10 8–  cm/Å =

VCUMI
VINCI

VINCI 1–
 VINC1

+ + +=

dV
dRI

--------
VINCI

tI tI 1––
------------------=
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Freundlich Isotherm

The Freundlich isotherm has the form:

where 

Q = quantity of gas adsorbed
QS = quantity of gas in a monolayer
C = temperature-dependent constant
m = temperature-dependent constant

The pressure is absolute; typically, m > 1. In terms of quantity adsorbed,

Taking the log of both sides yields:

Temkin Isotherm

The Temkin isotherm has the form,

where

Q = quantity of gas adsorbed
QS = quantity of gas in a monolayer
q0 = the differential heat of adsorption at zero surface coverage
A0 = a0 exp {-q0/RT}, where 0 and a0 are adjustable constants

In terms of quantity adsorbed,

Thus, the plot of the natural log of absolute pressure vs. quantity adsorbed yields a straight 
line with slope RTQS/q0 and intercept (ln A0) RTQS/q0.

Q
QS

------ CP1/m=

Q QSCP1/m=

Qlog  QS C
1
m
----  Plog+log=

Q
QS

------
RT
q0
--------- A0P ln=

Q
RTQS

q0
-------------- A0  

P
Po
------- 
 ln+ln=
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DFT (Density Functional Theory)

The adsorption isotherm is known to convey a great deal of information about the energetic 
heterogeneity and geometric topology of the sample under study. The data of physical adsorp-
tion have been used for many years as the basis for methods to characterize the surface area 
and porosity of adsorbents. Real solid surfaces rarely approach ideal uniformity of structure. 
It is accepted that in general, the surface of even a nonporous material presents areas of 
greater or lesser attraction for adsorbed molecules. 

This energetic heterogeneity greatly affects the shape of the adsorption isotherm with the 
result that simple theories such as the Langmuir and BET formulas can, at best, give only 
approximate estimates of surface area. Porous solids virtually are never characterized by a 
single pore dimension, but instead exhibit a more or less wide distribution of sizes. The 
observed adsorption isotherm for a typical material is therefore the convolution of an adsorp-
tion process with the distribution of one or more properties which affect that process. This 
was first stated mathematically by Ross and Olivier11 for the case of surface energy distribu-
tion and has become known as the integral equation of adsorption.

The Integral Equation of Adsorption

In a general form for a single component adsorptive, the integral equation of adsorption can 
be written as

(1)

where

Q(p) = the total quantity adsorbed per unit weight at pressure p,
a,b,c,... = a set of distributed properties,
f(a,b,c,...) = the distribution function of the properties, and
q(p,a,b,c,...) = the kernel function describing the adsorption isotherm on unit 

surface of material with fixed properties a,b,c,...

Equation (1), a Fredholm integral of the first kind, is a member of a class of problems known 
as ill-posed, in that there are an infinite number of functional combinations inside the integral 
that will provide solutions. Even when the kernel function is known, experimental error in the 
data can make solving for even a single distribution function a difficult task. Solving for mul-
tiple distribution functions requires more data than provided by a single adsorption isotherm.

Q p  a d b d cq p a b c    f a b c  d=
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Application to Surface Energy Distribution

Under certain conditions, an energetically heterogeneous surface may be characterized by a 
distribution of adsorptive energies. The conditions are that the sample is not microporous, i.e., 
that adsorption is taking place on essentially a free surface with no pore filling processes at 
least to about 0.2 relative pressure. Secondly, that each energetically distinct patch contributes 
independently to the total adsorption isotherm in proportion to the fraction of the total surface 
that it represents. This condition is satisfied if the patches are relatively large compared to an 
adsorptive molecule, or if the energy gradient along the surface is not steep. In mathematical 
terms, this concept is expressed by the integral equation of adsorption in the following form.

(2)

where

Q(p) = the experimental quantity adsorbed per gram at pressure p,
q(p,e) = the quantity adsorbed per unit area at the same pressure, p, on 

an ideal free surface of energy e, and 
f(e) = the total area of surface of energy e in the sample.

The exact form of the energy-dependent term depends on the form of the model isotherms 
expressed in the kernel function and is provided in the model description (refer to the appen-
dix on DFT models for a description of the available models).

Application to Pore Size Distribution

Similarly, a sample of porous material may be characterized by its distribution of pore sizes. 
It is assumed in this case that each pore acts independently. Each pore size present then con-
tributes to the total adsorption isotherm in proportion to the fraction of the total area of the 
sample that it represents. Mathematically, this relation is expressed by 

(3)

where 

Q(p) = the experimental quantity adsorbed at pressure p,
q(p,H) = the quantity adsorbed per unit area at the same pressure, p,  in 

an ideal pore of size H, and 
f(H) = the total area of pores of size H in the sample.

Numerical values for the kernel functions in the form of model isotherms can be derived from 
modern statistical mechanics such as density functional theory or molecular simulations, or 
can be calculated from one of various classical theories based on the Kelvin equation. Several 
types are found in the models library.

Q p   q p   f  d=

Q p  H q p H  f H d=
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Performing the Deconvolution

The integrations in equations (2) and (3) are carried out over all surface energies or pore sizes 
in the model. The functions q(p,e) and q(p,H), which we call the kernel functions, are con-
tained in numeric form as model isotherms. Because, in general, there is no analytic solution 
for equation (1), the problem is best solved in a discrete form; the integral equation for any 
distributed property Z becomes a summation:

(4)

Given a set of model isotherms, q(p,Z), from a model chosen from the models library and an 
experimental isotherm, Q(p), contained in a sample information file, the software determines 
the set of positive values f(Z) that most nearly, in a least squares sense, solves equation (4). 
The distributed property, surface energy or pore size, is then displayed on the Report Options 
dialog box as a selection of tables or graphs. 

Regularization

DFT allows a selectable regularization (also referred to as smoothing) constraint to be applied 
during the deconvolution process to avoid over-fitting in the case of noisy data or ill-fitting 
models. The method used is based on co-minimization of the second derivative of the distri-
bution. The relative weight given to this term is determined by the value of the regularization 
parameter, which is set on the DFT Pore Size or Surface Energy dialog box and also is shown 
in the header of reports. The value of the regularization parameter varies from zero (for no 
second derivative constraint) to ten (indicating a weight equal to minimizing the residuals), or 
even larger. When the distribution and residuals obtained change little with the value of the 
regularization parameter, it indicates that the chosen model provides a good representation of 
the data. Conversely, a large sensitivity to the regularization parameter might indicate inade-
quate data or a poor choice of model to represent the data.

Summary Report

The following calculations and the results of previous calculations (as noted) are used to gen-
erate the summary report:

a. BET Surface Area

See BET Surface Area Calculations

b. Langmuir Surface Area

See Langmuir Surface Area Calculations 

Q p  q p Zi  f Zi 
i

=
Nov 2011                                               C-39 



Appendix C ASAP 2420 Operator’s Manual
c. Single Point Surface Area (m2/g)

where 

Pr = pressure closest to 0.3 of the relative pressure points designated for surface area 
calculations. 

Va = volume corresponding to Pr

d. Micropore Area

See t-Plot calculations.

e. Micropore Volume

See t-Plot calculations.

f MP-Method Cumulative Surface Area of Pores

MPSTOT = SCUMI, (see MP-method Calculations) for the last collected data point used 
in the MP-method Calculations, and the range of hydraulic pore radii over which the 
cumulative surface area was computed. 

g. MP-Method Cumulative Pore Volume of Pores

MPVTOT = VCUMI, (see MP-method Calculations) for the last collected data point 
used in the MP-method Calculations, and the range of hydraulic pore radii over 
which the cumulative pore volume was computed. 

h. Average Pore Hydraulic Radius (A)

S1PT
Va 1 Pr–   CSA 6.023 1023 

22414 cm3 STP 1018 nm2/m2
-------------------------------------------------------------------------------------------------=

MPDAVER

MPVTOT

MPSTOT

-------------------- 10 6– m3/cm 1010 Å/m=
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SPC Report Variables

Regressions Chart Variables

The line of best fit for the Regression Chart is calculated by the usual Least Squares methd. 
(Refer to BASIC Scientific Subroutines Vol II, by F.R. Ruckdeschel, Copyright 1981 BYTE 
Publications/McGraw Hill, p. 16.) If there is only a single point or all N points have the same 
x-value, there can be no line of best fit in the standard form.

The coefficient of Correlation for this line is also calculated in the usual way. (Refer to Math-
ematical Handbook for Scientists and Engineers, by Granino A. Korn and Theresa M. Korn, 
Copyright 1961, 1968 McGraw Hill, Sec. 18.4.)

XAve
 xi

N
---------=

XAve
 yi

N
---------=

Slope
 xi XAve–  yi XAve– 

 xi XAve– 2
---------------------------------------------------------------=

x
 xi XAve– 2

N
------------------------------------=

y
 yi XAve– 2

N
------------------------------------=

Cov x y 
 xi XAve–  yi XAve– 

N
---------------------------------------------------------------=

Correlation Coefficient Cov x y 
xy

-----------------------=
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Control Chart Variables

  

Mean
 yi

N
---------=

StdDev  y Mean– 2

N 1–
------------------------------------=

CoefVar StdDev
Mean

-------------------=

PlusNSig Mean n StdDev+=

MinusNSig Mean n StdDev–=
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TESTING THE ANALYZER FOR LEAKS

Valve Locations

Valves are located in the degas and analysis system manifolds. The valves are labeled with 
numbers that correspond to the numbers on the degas and analysis schematics.

Degas Manifold

Degas
servo valve

Degas
solenoid

Degas
port

          Instrument Front View with Panel Lowered

valves

valve

(12) 
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Valve Description

1 through 12
13
14
15

Sample ports
Backfill
Servo vacuum
Unrestricted vacuum

          Degas Schematic

Degas Valves
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Analysis Manifold

 
         Instrument Top View with Panel Removed

           

Analysis port
valves (6)

Po port valves (6)

            

    Vacuum valves

Analysis valves 

Gas inlet valves (6)

        Servo valve
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                                      Analysis Valves

Valve Description

1 through 6
7
8
9
10
11 through 16
17
18
21 through 26
Unmarked

Sample ports
Lower manifold isolation
Sample ports unrestricted vacuum
Po ports access
Po ports unrestricted vacuum
Po ports
Upper manifold isolation
Gas inlets unrestricted vacuum
Gas inlets
Servo
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Degas Manifold Valves

1. Place empty sample tubes on all 12 degas ports.

2. If the degas schematic is not displayed, select Unit > Degas Schematic.

If the degas schematic is not in manual mode, select Unit > Enable Manual Control to  
display the degas schematic in manual control mode.

3. Close all open degas valves by double-clicking the open valves.

4. Open valve13 and backfill the degas manifold to approximately 800 mmHg with nitrogen. 
Close valve 13 when the pressure is set to the desired value.

5. Open degas valves 1 through 12.

6. Open valve 15 and evacuate the degas manifold to below 20 microns.

7. Allow the system to evacuate for at least an hour.

8. Close valves 1 through 12.

9. Allow the system to evacuate for another 30 minutes.

10. Close valve 15 and record the reading on the degas vacuum gauge.

The degas system must be in idle mode (no degas operations running) in order to 
perform the leak test procedures.

Servo valve

Vacuum
gauge

Green = open

Yellow = closed
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Vacuum reading  ______________ microns

11. Wait 5 minutes, then immediately record the degas vacuum gauge reading.

Vacuum reading  ______________ microns

12. Subtract the reading in step 11 from the reading in step 12. Divide the results by 5. This 
gives the system outgassing rate in microns/ min.

Record the system outgassing rate   _____________  microns/min. All valves should be 
closed at this time and should remain closed.

13. While observing the degas vacuum gauge, remove the empty sample tube from station 1. 
Determine the outgassing rate as in the above steps 11 through 13. If the rate exceeds 1 
micron/ min., the station one plunger is leaking. Clear the leak before proceeding.

14. Record the outgassing rate for station 1 in the space provided below step 17.

15. Clear all leaks and repeat steps 4 through 14 of this procedure for each station.

16. Record the outgassing rates below. If a rate exceeds 1 micron/ min., that station plunger is 
leaking. Clear the leak before proceeding.

Station 1 outgassing rate    _____________  microns/min. 

Station 2 outgassing rate    _____________  microns/min. 

Station 3 outgassing rate    _____________  microns/min.

Station 4 outgassing rate    _____________  microns/min.  

Station 5 outgassing rate    _____________  microns/min.

Station 6 outgassing rate    _____________  microns/min.  

Station 7 outgassing rate    _____________  microns/min.  

Station 8 outgassing rate    _____________  microns/min.  

Station 9 outgassing rate    _____________  microns/min.  

Station 10 outgassing rate  _____________  microns/min.  

Station 11outgassing rate   _____________  microns/min. 

Station 12 outgassing rate  _____________  microns/min. 

17. Open valve 15 and leave the system evacuating. 

18. Remove the sample tubes and place plugs in all sample stations.
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Analysis Manifold Valves 

1. Place empty sample tubes on analysis stations 1 through 6.

2. Ensure the six Po tubes are mounted properly on stations 1 through 6.

3. Close all shut-off valves on the gas regulators.

4. Place plugs in any unused gas inlet ports.

5. If the analysis schematic is not displayed, select Unit > Analysis Schematic. 

If the schematic is not in manual mode, select Unit > Enable Manual Control to display 
the analysis schematic in manual control mode.

6. Close all valves except valves 7, 17 and 18. Leave these valves open.

7. Set the analysis servo valve to evacuate to zero mmHg. This opens the servo completely.

8. Open valve 8.

The analysis system must be in idle mode (no analyses running) in order to perform 
this procedure.

Servo valve
Analysis

       

Vaccum
Gauge

Green = open

Yellow = closed
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9. Wait for 5 minutes.

10. Open valves 1, 2, 3, 4, 5 and 6.

11. Close valves 17 and 18 and the analysis servo valve.

12. Continue to evacuate for 2 hours or longer.

13. Close analysis valves 1, 2, 3, 4, 5 and 6.

14. Continue to evacuate for 2 hours.

15. Close valve 8 and record the analysis vacuum gauge reading.

Vacuum reading  ______________ microns

16. Wait 5 minutes and record the analysis vacuum gauge reading.

Vacuum reading  ______________ microns

17. Subtract the reading in step 15 from the reading in step 16. Divide the results by 5. This 
gives the system outgassing rate in umHg/min. The system outgassing rate should not 
exceed 0.7 umHg/min.

Record the outgassing rate ___________________________microns/min.

All valves (except valve 7) should be closed at this time and should remain closed.

18. The sample port valves should remain closed during this procedure. While observing the 
analysis vacuum gauge, remove the empty sample tube from analysis station 1. Determine 
and record the outgassing rate as in steps 15 through 17 above.

19. If the outgassing rate exceeds 1 umHg/min., the station 1 plunger is leaking. Clear the leak 
before proceeding.

20. Record the outgassing rate for station 1 in the space provided in step 23.

21. Clear all leaks and repeat steps 15 through 17 of this procedure for that station before 
proceeding.

22. Repeat steps 15 through 20 of this procedure for each station.

23. Record the outgassing rate for stations 1 through 6 in the spaces provided below. If the 
outgassing rate exceeds 1 umHg/min., that station plunger is leaking. Clear the leak before 
proceeding.

Station 1 outgassing rate __________________  umHg/min.

Station 2 outgassing rate    ____________  umHg /min.  

Station 3 outgassing rate    ____________  umHg /min.  

Station 4 outgassing rate    ____________  umHg /min. 
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Station 5 outgassing rate    ____________  umHg /min.  

Station 6 outgassing rate    ____________  umHg /min.  

24. Open valves 8 and 17, set the analysis servo valve to evacuate, and leave the system 
evacuating.

Gas Inlet Valves

1. Make sure the analysis schematic is displayed in manual control mode. (Refer to step 5 on 
page D-9.)

2. Open valves 7, 8 and 17, if closed. All other analysis valves should be closed.

3. Set the analysis servo valve to evacuate to zero mmHg.

4. Open valve 18.

5. When pressure is below 10 mmHg, open valve 21 and wait 5 minutes.

6. Open valve 22 and wait 5 minutes.

7. Open valves 23 through 26, waiting 5 minutes between each.

8. When valves 21 through 26 are open, allow the system to continue to evacuate for 2 hours.

9. All gas inlets should evacuate below 20 microns or there is a leak in one of the inlets. Find 
and clear the leak before proceeding.

10. Close valves 21 through 26 and allow the system to evacuate for 2 hours.

11. Close valves 8 and 18. Set the servo valve to dose to 1000 mmHg.

12. Record the analysis vacuum gauge reading.

13. Wait 5 minutes and record the analysis vacuum gauge reading.

Vacuum reading  _____________    umHg

14. Subtract the reading in step 12 from the reading in step 13. Divide the results by 5. This 
gives the system outgassing rate in umHg/min.

The gas regulator shut-off valves must remain closed during this procedure.

The analysis system must be in idle mode (no analyses running) in order to perform 
this procedure.
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   Vacuum reading  _____________    umHg

15. Valves 21 through 26 should remain closed during this procedure. Open the gas regulator 
shut-off valve for the gas attached to gas inlet valve 21.

16. Determine and record the outgassing rate as in steps 11 through 14 above. If the 
outgassing rate exceeds 1 umHg/min., valve 21 is leaking. 

17. Record the outgassing rate for valve 21 in the space provided in step 22.

18. Clear all leaks and repeat steps 11 through 15 of this procedure for valve 21 before 
proceeding.

19. While observing the analysis vacuum gauge, open the gas regulator shut-off valve for the 
gas attached to gas inlet valve 22.

20. Determine and record the outgassing rate as in steps 10 through 14. If the outgassing rate 
exceeds 1 umHg/min., valve 22 is leaking.

21. Record the outgassing rate for valves 22 through 26 in the spaces provided below.

22. Continue to test the remaining gas inlet valves in a like manner.

Record outgassing rate  _____________    umHg/min.  Valve 21

Record outgassing rate  _____________    umHg/min.  Valve 22

Record outgassing rate  _____________    umHg/min.  Valve 23

Record outgassing rate  _____________    umHg/min.  Valve 24

Record outgassing rate  _____________    umHg/min.  Valve 25

Record outgassing rate  _____________    umHg/min.  Valve 26

23. Open valves 8, 17 and 18, set servo valve to evacuate to zero mmHg, and leave the system 
evacuating. 
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Po Valves

1. Make sure the analysis schematic is displayed in manual control mode. (Refer to step 5 on 
page D-9.)

2. Close all open valves by double-clicking their icon on the analysis schematic.

3. Open valve 10.

4. Ensure all Po tubes are installed properly.

5. Open valves 11 through 16.

6. Wait 5 minutes.

7. Open valves 7, 8 and 9.

8. Allow the system to evacuate for 2 hours or longer.

9. Close valves 11 through 16.

10. Allow the system to evacuate for 2 hours or longer.

11. Close valves 8 and 10.

12. Record the reading on the analysis vacuum gauge.

Vacuum reading  _______________  umHg

13. Wait 5 minutes and record the analysis vacuum gauge reading.

Vacuum reading  _______________  umHg

14. Subtract the reading in step 12 from the reading in step 13. Divide the results by 5. This 
gives the system outgassing rate in umHg/min.

Outgassing rate  _______________  umHg/min.

15. The Po valves must remain closed during this procedure. Remove the Po tube from 
station 1.

16. Determine and record the outgassing rate as in steps 12 through 14 above. If the 
outgassing rate exceeds 1 umHg, valve 11 is leaking.

17. Record the outgassing rate for valve 11 in the space provided in step 22.

The analysis system must be in idle mode (no analyses running) in order to perform 
this procedure.
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18. Clear all leaks and repeat steps 10 through 14 of this procedure for valve 11 before 
proceeding.

19. While observing the analysis vacuum gauge, remove the Po tube from station 2.

20. Determine and record the outgassing rate as in steps 12 through 14 above. If the 
outgassing rate exceeds 1 umHg/min., valve 12 is leaking.

21. Record the outgassing rates for valves 12 through 16 in the spaces provided below.

22. Continue to test the remaining Po valves in a like manner.

Outgassing rate  _______________  umHg/min.

Outgassing rate  _______________  umHg/min.

Outgassing rate  _______________  umHg/min.

Outgassing rate  _______________  umHg/min.

Outgassing rate  _______________  umHg/min.

Outgassing rate  _______________  umHg/min.

23. Open valves 8, 10 and 17, 18, and set the servo valve to dose to 1000 mmHg. Leave 
system evacuating.
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What To Do If You Detect a Leaking Valve

If you determine that a specific valve is leaking, remove differential pressure from the valve 
and continue testing the remaining valves for leaks.

Removing Differential Pressure from a Leaking Valve

1. Select either of the following actions:

• Close the regulator outlet valve for the gas supply line to the valve.
• Reinstall the plug that was removed to test the valve.

2. On the manual mode schematic screen, open the leaking valve. 

3. Evacuate the analyzer until you obtain an outgas rate of less than 0.7 mHg per minute. 
Refer to the previous sections for detailed instructions on determining the outgas rate for 
specific valves.

Repairing or Replacing a Leaking Valve

Whether you repair or replace a valve depends on the type of valve that is leaking. 

• Analysis manifold valves should be repaired.
• Degas and inlet manifold valves should be replaced.
• Degas solenoid valve should be repaired.
• Servo valves should be replaced. 

Repairing Valves on the Analysis Manifold

1. Backfill the manifold with nitrogen to approximately 800 mmHg.

• Close off the helium gas supply if you are repairing the helium inlet valve.
• Turn off the vacuum pump system if you are repairing a vacuum valve.

2. Remove and replace the plunger for the leaking valve.

As an alternative, you may repair or replace the leaking valve after removing the 
differential pressure on the valve. However, opening the analysis system to 
replace or repair a valve exposes the analyzer manifold to atmospheric gases and 
moisture. These gases and moisture greatly increase the time required to 
evacuate the analyzer and prepare it for further testing or operation.
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3. Closely inspect the valve seat area for any debris which may cause another leak.

4. Reassemble the valve.

• Reopen the helium supply if you are repairing the helium inlet valve.
• Turn on the vacuum pump system if you are repairing a vacuum valve.

5. Using the Analysis Schematic in manual control mode, open and close the repaired valve 
approximately 20 to 30 times; this allows the valve to seat properly.

6. Evacuate the analyzer until the outgas rate is less than 0.7 mHg per minute. 

Replacing Valves on the Degas and Gas Inlet Manifold

1. Backfill the manifold with nitrogen to approximately 800 mmHg.

2. Turn off the gas supply for the gas inlet valves.

3. Unscrew and remove the complete valve from the manifold.

4. Install the new valve, then reconnect the wiring.

5. Turn on the gas supply and vacuum pump system.

6. Evacuate the analyzer until the outgas rate is less than 0.7 mHg per minute.

                 Plunger
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Replacing a Servo Valve

1. Make sure the vacuum pump is turned off.

2. Unscrew and remove the servo valve.

3. Unplug the cable.

4. Install the new servo valve while ensuring the two sealing O-rings are in place on the 
manifold block.

Repairing the Degas Solenoid Valve

1. Make sure the vacuum pump is turned off.

2. Backfill the manifold with nitrogen to approximately 800 mmHg.

3. Ensure that the solenoid valve is closed (on the Degas Schematic in manual mode).

4. Unscrew and remove the valve from the manifold using a spanner wrench.

5. Remove and replace the plunger.

6. Closely inspect the valve seat area for any debris which may cause another leak.

7. Insert the new plunger and reassemble the valve.

8. Reassemble the valve.

9. Using the Degas Schematic in manual control mode, open and close the repaired valve 
approximately 20 to 30 times; this allows the valve to seat properly.

 Plunger
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10. Evacuate the analyzer until the outgas rate is less than 0.7 mHg per minute.

Valve Test Data Sheet

Make a copy of this form to record pressure readings and outgassing rates when leak-testing 
system valves. 

VALVE(s)
P1

(1st pressure reading)
P2

(2nd pressure reading) OUTGASSING RATE

Analysis Valves

1

2

3

4

5

6

7

8

Gas Inlet Valves

17

18

21

22

23

24

25

26

Po Valves

10

11

12

13

14

15

16
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VALVE(s)
P1

(1st pressure reading)
P2

(2nd pressure reading) OUTGASSING RATE

Degas Valves

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15
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E.  DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In 
the experimental physical sciences, theories are often expressed in terms of a model that can 
be visualized and described mathematically. Early models of physical adsorption were quite 
simple, both conceptually and mathematically, for very practical reasons — hand computa-
tions were required. Today we can explore complex models that describe adsorption systems 
on the atomic scale of size and sub-picosecond time frame. This is not because scientists are 
smarter, but because of available tools. The DFT models are created by classical approaches 
to adsorption as well as models based on modern statistical thermodynamics. 

Models Based on Statistical Thermodynamics

Included in this group are methods that model the adsorption system in terms of forces acting 
between individual molecules. 

Theoretical Background

Traditional adsorption theories attempt to describe experimental adsorption isotherms with an 
isotherm equation containing a small number of parameters. At a minimum, these parameters 
include the extent of the surface, such as the monolayer capacity (Vm), and the molar inten-
sity of the gas-surface interaction, such as the Langmuir “K” constant or the BET “C” 
constant. In some equations, additional parameters take into account the lateral interaction of 
adsorbed molecules with each other. Other theories, such as the Dubinin-Astakhov approach, 
also include parameters for the effect of adsorbent porosity. 

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based 
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the micro-
scopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters, 
the pore size, the pore geometry, and the temperature.

The following example is given so that you may understand how such a theory is constructed.

A clean sample of a solid material containing slit-shaped pores of a single width is placed in 
an evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is 
admitted into the space surrounding the sample. The pressure within the space is recorded 
over time. In this situation, the pressure falls rapidly from its initial value and gradually 
approaches a steady reading, called the equilibrium pressure. The amount adsorbed corre-
sponds to the quantity of gas effectively removed from the gas phase by the solid surface. A 
graph that plots amount adsorbed versus equilibrium pressure is called an adsorption 
isotherm.

Under such conditions, the argon atoms that randomly enter the pore space feel the presence 
of the solid surface as the action of an external attractive force (the dispersion forces or Van 
der Waal’s forces) and spend more time near the surface. As a result, the space near the sur-
face acquires a greater average density of argon atoms than regions farther removed. 
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If the equilibrium distribution of the gas atoms near the surface could be described as a func-
tion of pressure and the molecular properties of the components of the system, then a model 
could be constructed for the adsorption isotherm for the system. Modern physical chemistry 
provides several ways to calculate this distribution. All these methods are based on the fun-
damental thermodynamic law that such a system adopts a configuration of minimum free 
energy at equilibrium. Also needed is a description of the pairwise interaction energy between 
atoms, U(s), commonly given by a Lennard-Jones potential:

where

 = a characteristic energy of the adsorptive,
 = the diameter of the adsorptive molecule, and
s = the separation distance. 

Molecular Simulation Methods

Two simulation techniques are commonly used to determine the distribution of gas molecules 
in a system in equilibrium: the molecular dynamics method and the Monte Carlo method. 
Both of these are used as reference methods because their results are considered exact.

Molecular Dynamics Method

In the molecular dynamics method, the position and velocity of individual gas particles are 
calculated over time at very short intervals. This method takes into account both the forces 
acting between the gas particles themselves and those acting between the gas particles and the 
atoms of the simulated surface. As the simulated particles collide with each other and with the 
surface, the average concentration of particles in the space near the surface is calculated; this 
calculation yields the amount of gas adsorbed. 

This method can be thought of as a way to determine the chronological record of the move-
ment of each particle in the system using time steps of 10-14 seconds. Although the 
mathematics are simple, the number of calculations required for a system of even a few hun-
dred particles is astronomical and challenges even the fastest computers.

Monte Carlo Method

In the Monte Carlo method, determination of the system equilibrium distribution begins with 
an assumption (which may be only approximate) about the initial configuration of particles in 
the system. The system is “equilibrated” through a process of randomly selecting one particle 
and conditionally moving it a random distance in a random direction. 

If the move results in a configuration of lower total energy, then the move is completed and 
another particle is randomly selected to be moved. 

U s  
s
--- 
  12 

s
--- 
  6

–=
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If the move results in a configuration of higher energy, a probability for that event is calcu-
lated, and a random number between zero and one is generated. If the generated number is 
smaller than the probability of the event, then the move is accepted; otherwise, another par-
ticle is selected and the process is repeated. This process continues until the average total 
energy of the system no longer decreases; at this point, average configuration data are accu-
mulated to yield the mean density distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic 
simulations and can yield the same results; however, neither method provides a really prac-
tical way to calculate complete isotherms.

Density Functional Formulation

Density functional theory offers a practical alternative to both molecular dynamic and Monte 
Carlo simulations. When compared to reference methods based on molecular simulation, this 
theory provides an accurate method of describing inhomogeneous systems yet requires fewer 
calculations. Because the density functional theory provides accuracy and a reduced number 
of calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls sepa-
rated by a distance H. The pore is open and immersed in a single component fluid 
(adsorptive) at a fixed temperature and pressure. Under such conditions, the fluid responds to 
the walls and reaches an equilibrium distribution. In this condition (by the definition of equi-
librium), the chemical potential at every point equals the chemical potential of the bulk fluid. 
The bulk fluid is a homogenous system of constant density; its chemical potential* is deter-
mined by the pressure of the system using well-known equations. The fluid near the walls is 
not of constant density; its chemical potential is composed of several position-dependent con-
tributions that must total at every point to the same value as the chemical potential of the bulk 
fluid.

As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free 
energy, known thermodynamically as the grand potential energy (GPE). Density functional 
theory describes the thermodynamic grand potential as a functional of the single-particle den-
sity distribution; therefore, calculating the density profile that minimizes the GPE yields the 
equilibrium density profile. The calculation method requires the solution of a system of com-
plex integral equations that are implicit functions of the density vector. Since analytic 
solutions are not possible, the problem must be solved using iterative numerical methods. 
Although calculation using these methods still requires supercomputing speed, the calculation 
of many isotherm pressure points for a wide range of pore sizes is a feasible task. The com-
plete details of the theory and the mathematics can be found in the papers listed under 
References at the end of this appendix.

The following graphs and accompanying text illustrate the results of using density functional 
theory to predict the behavior of a model system. 

*Chemical potential may be thought of as the energy change felt by a probe particle when it is inserted 
into the system from a reference point outside the system. It can also be defined as the partial derivative 
of the grand potential energy with respect to density (or concentration).
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Figure E-1 shows the density profile for argon at a carbon surface as calculated by density 
functional theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Figure E-1. Density Profile for Argon on Carbon at 87.3 K and a Relative Pressure of 0.5   

This figure represents a cross-section of the region near the surface. Note the layerwise dis-
tribution of adsorbate; the first monolayer is sharply defined and a third layer can be 
distinguished. The area under the profile curve represents the amount adsorbed per unit area 
at this pressure. The positions of the maxima are separated by a distance determined by the 
size of the adsorptive atom.

Given the density profile, the amount adsorbed at the stated pressure can be easily calculated 
as the integral over the profile. Repeating this calculation over a range of pressures yields the 
adsorption isotherm for the model. If the value of H is very large, the isotherm obtained cor-
responds to that of an external, or free, surface. If H is smaller, a range of pressures is reached 
where two minima exist for the grand potential, showing the presence of two metastable 
phases having different density distributions but the same chemical potential. The phase with 
the lower GPE is the stable one. As the pressure is increased, a point is reached where the 
other phase becomes the stable one. This phase transition reflects condensation of adsorbate 
in the pore; the pressure at which it occurs is called the critical pore-filling pressure. This 
pressure is analogous to the condensation pressure predicted by the Kelvin equation in the 
classical model of pore filling.

Figure E-2 shows how the profiles change with pressure for a model pore with H = 40 ang-
stroms. The insets show the density profiles for the corresponding points of the isotherm.
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Figure E-2. Model Isotherm for Argon at 87.3 K in a 40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half 
of the distribution is a mirror image of the profile shown. 

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position 
close to the surface.

• Inset a shows the profile corresponding to point a on the isotherm where the surface is 
about half covered. 

• At point b, the first layer is so full that it is more favorable for atoms to start a new 
layer. 

• At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling 
pressure. In inset c, the profile shows the density decreasing to near zero (actually the 
bulk gas density) at 4 or 5 molecular diameters from the surface. 

• Inset d shows the profile converging on a density similar to that of bulk liquid argon in 
the center of the pore, indicating a phase transition.

Note that the adsorption isotherms for pores larger than the one shown in Figure E-2 is iden-
tical up to point c. The lower branch of the isotherm simply continues to a higher pressure for 
larger pores. This trend is illustrated in Figure E-3, where isotherms for some larger size 
pores are shown. It is clear that pore size is uniquely characterized by a corresponding critical 
pore-filling pressure. At large pore sizes, density functional theory produces results for the 
critical filling pressures that are in good agreement with those produced by the Kelvin 
equation.
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Figure E-3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K    

Figure E-4 shows model isotherms for pores in the micropore size range. Note the logarith-
mic scale for pressure.

Figure E-4. Model Isotherms in the Micropore Size Range of Pore Width
Argon on Carbon at 87.3 K            
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 mil-
litorr. Pores below 15 Å fill before a monolayer is completed on the surface of the larger 
pores. In the micropore size range, the pore volume fills more gradually with pressure and the 
total shape of the isotherm is important in characterizing the pore size. 

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Using the methods of non-local density functional theory, two sets of isotherms have been 
calculated to serve as kernel functions for the characterization of porous solids from adsorp-
tion data. The model isotherms are stored in binary format files. These models assume a slit-
like pore geometry. The pore size range from 4.0 to 4000 Å is covered in 91 classes in a geo-
metric progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A 
model for the free or external surface is included to account for unfilled pores. Each of the 92 
model isotherms has been calculated at 181 pressure points from near 1x10-6 to near 1.00 rel-
ative pressure.

These models are identical to those supplied with the original DOS version of DFT software. 
Some slight difference from the DOS results may be noted when they are applied to the same 
data due to improvements in the deconvolution algorithm and better regularization of the cur-
rent software.

Non-Local Density Functional Theory with Density-Dependent Weights 

N2 - Modified Density Functional

Using the modified Tarazona prescription described by Olivier (refer to References, refer-
ences 3 and 4), model isotherms were calculated for a wide range of adsorptive energies to a 
relative pressure of 0.6. The model makes no provision for pore filling in the micropore 
region. If the sample solid contains small mesopores, the isotherm data should be truncated 
(using the Select Data Points dialog box) to a suitably low relative pressure to avoid trying to 
fit this region; mesopore filling reports as a large area of low energy in the calculated distri-
bution of adsorptive potential. 

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K
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The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, 
e, for the adsorptive/adsorbent pair divided by Boltzmann’s constant. The units are therefore 
Kelvins.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Model isotherms were calculated using a combination of statistical mechanical calculations 
and experimental observations for macroporous silicas and MCM-41 mesoporous silicas as 
well as zeolites. The pore-filling pressures were determined as a function of the pore size 
from adsorption isotherms on MCM-41 materials characterized by X-ray and other tech-
niques. The variation of the pore fluid density with pressure and pore size has been accounted 
for by density functional theory calculations. The N2 model reports pore sizes ranging from 
3.8 to 387 angstroms and the AR model from 3.8 to over 500 angstroms.

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Model isotherms were calculated using a combination of statistical thermodynamic Non-
Local Density Functional Theory  (NLDFT) calculations and experimental isotherms for ref-
erence samples of montmorillionite.The construction method for the hybrid models was 
analogous to that described in the first reference below (Jaroniec et al,1999). The additional 
references add additional theoretical details as well as examples of the application of the 
model to pillared clay catalysts.This model reports pore widths from 3.8 to 387 angstroms.

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Reference: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the 
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Mesoporous 
Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77 K
E-10                                                    Oct 2011



ASAP 2420 Operator’s Manual Appendix E
C02 - DFT Model

Model isotherms were calculated, using the non-local prescription of Tarazona, employing 
molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model 

This model was produced in the same manner as the N2 Modified Density Functional model 
listed earlier, except applicable to argon adsorbed at 87.3 K.

References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New 
Method for the Characterization of Mesoporous Silicas,” Proceedings of 
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of 
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of a 
Pillared Interlayered Clay (PILC) from a Hybrid Density Functional Theory 
(DFT) Method,” The Journal of Physical Chemistry B; 2001, 105(3), 
623-629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface 
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded Clay 
Catalysts from Hybrid Density Functional Theory (DFT) and Adsorption 
Microcalorimetry Methods,” Langmuir 2002, 18, 9816-9823.9b

James P. Olivier, “The Importance of Surface Heterogeneity in Developing 
Characterization Methods.” 6th International Symposium on the Character-
ization of Porous Solids, Studies in Surface Science and Catalysis 144, 
Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of 
Pillared Rectorite Catalysts from a Hybrid Density Functional Theory 
Method,” Microporous and Mesoporous Materials 2003, 57, 291-296.

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Geometry: Free Surface
Substrate: Any
Category: Surface energy
Method: Argon at 87 K
Oct 2011                                                     E-11 



Appendix E ASAP 2420 Operator’s Manual
N2 - Tarazona NLDFT, Esf = 30.0K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent 
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typ-
ical for a silica or alumina surface. 

This model file is particularly useful for sizing zeolites or zeolite containing materials that 
have substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent 
weighting functions and a slit-like pore geometry. These models are slightly different from 
N2-DFT and Ar-DFT models that were calculated using NLDFT with density independent 
weighting functions.

The reported pore size range is from 3.5 to 1000 angstroms.

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density 
dependent weighting functions assuming 2D model of finite slit pores having a diam-
eter-to-width aspect ratio of 6.

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77 K

Reference: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Reference: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K
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This model is particularly useful for microporous carbon materials. The reported pore 
size range is from 3.5 to 250 angstroms.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Model isotherms were calculated using the same methods and assumptions that were used in 
the model above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent 
analytical techniques such as high-resolution transmission electron microscopy (HRTEM) 
and/or X-ray diffraction (XRD) to obtain comprehensive information about the structure of 
studied carbon material.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent 
weighting functions and cylindrical pore geometry. The pore wall potential is described by 
the Lennard-Jones potential of interaction between a gas molecule and the graphitic surface 
of an infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The 
reported pore size range is from 3.5 to 1000 angstroms.

Reference: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT 
model of gas adsorption in finite carbon pores. Application to pore structure 
analysis.,”  The Journal of Physical Chemistry C, 113(45):19382-19385, 
2009.

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Reference: See above reference.

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87K

Reference: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).
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N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent 
weighting functions and cylindrical pore geometry. The pore wall potential is described by 
the Lennard-Jones potential of interaction between a gas molecule and multiple concentric 
graphitic surfaces of infinitely long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported 
pore size range is from 3.5 to 1000 angstroms.

Ar - Zeolites H-Form by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent 
weighting functions and cylindrical pore geometry. The pore wall potential is described by 
the Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an 
infinitely long cylinder.

This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeo-
lites. The reported pore size range is from 3.5 to 300 angstroms.

Ar -  Zeolites Me-Form by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent 
weighting functions and cylindrical pore geometry. The pore wall potential is described by 
the Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an 
infinitely long cylinder.

This model is similar to the model above but it more appropriate is for characterizing alkali 
metal exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87K

Reference:  See above reference.

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77K

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77K
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Models Based on Classical Theories

Both surface energy distribution and pore size distribution may be evaluated using classical 
approaches to model kernel functions for use with equation (1) of the DFT Theory in the cal-
culations appendix. Be aware that the deconvolution method only provides a fitting 
mechanism; it does not overcome any inherent shortcomings in the underlying theory. 

Surface Energy

The use of classical theories to extract adsorptive potential distribution is mostly of historical 
interest. At a minimum, the equation must contain a parameter dependent on adsorption 
energy and another dependent on monolayer capacity, or surface area. This is sufficient to 
permit the calculation of the set of model isotherms that is used to create a library model. The 
Langmuir equation has been used in the past, as have the Hill-de Boer equation and the 
Fowler-Guggenheim equation. All of these suffer from the fact that they only describe mono-
layer adsorption, whereas the data may include contributions from multilayer formation.

Pore Size

It is well established that the pore space of a mesoporous solid fills with condensed adsorbate 
at pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When 
combined with a correlating function that relates pore size with a critical condensation pres-
sure, this knowledge can be used to characterize the mesopore size distribution of the 
adsorbent. The correlating function most commonly used is the Kelvin equation. Refinements 
make allowance for the reduction of the physical pore size by the thickness of the adsorbed 
film existing at the critical condensation pressure. Still further refinements adjust the film 
thickness for the curvature of the pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm 
data using Kelvin-based theories, such as the BJH method, were for the most part developed 
decades ago and were designed for hand computation using relatively few experimental 
points. In general, these methods visualize the incremental decomposition of an experimental 
isotherm, starting at the highest relative pressure or pore size. At each step, the quantity of 
adsorptive involved is divided between pore emptying and film thinning processes and 
exactly is accounted for. This computational algorithm frequently leads to inconsistencies 
when carried to small mesopore sizes. If the thickness curve used is too steep, it finally will 
predict a larger increment of adsorptive for a given pressure increment than is actually 
observed; since a negative pore volume is non-physical, the algorithm must stop. Conversely, 
if the thickness curve used underestimates film thinning, accumulated error results in the cal-
culation of an overly large volume of (possibly nonexistent) small pores. 

The use of equation (1) represents an improvement over the traditional algorithm. Kernel 
functions corresponding to various classical Kelvin-based methods have been calculated for 
differing geometries and included in the list of models.
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Models Included

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

The calculation is the same as above except that cylindrical geometry is assumed.

Kelvin Equation with Harkins and Jura Thickness Curve

N2 -  Harkins and Jura Thickness Curve

The kernel function is calculated using the Harkins and Jura equation with standard 
parameters:

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948)

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

t 3.54
5.00–
P/Po ln

---------------------- 
  1/3

=
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The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Harkins and Jura Thickness Curve

The calculation is the same as above except that cylindrical geometry is assumed.

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

The kernel function is calculated using the Broekhoff-de Boer equation with standard 
parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944)

J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966)

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

Geometry: Cylinder

t
13.99

0.034 P/Po log–
--------------------------------------------- 
  1/2

=

p/p
0  16.11–

t
2

---------------- 0.1682
0.1137

t
–

+=log
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The calculation is similar to the above except that cylindrical geometry is assumed, and the 
film thickness depends on pore size (see reference).

References

The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of 
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, 
Micromeritics Instrument Corp; presented at the International Symposium on the Effects 
of Surface Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland 
(July 1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped 
Geometry,” Perla B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, 
Elsevier Science Publishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density 
Functional Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms 
Calculated by Density Functional Theory,” J.P. Olivier; presented at the Fifth 
International Conference on the Fundamentals of Adsorption, Pacific Grove, CA (1995).

5.

Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

Reference: Specifically, equations 20 and 21 in:  J.C.P. Broekhoff and J.H. de Boer, “The 
Surface Area in Intermediate Pores,” Proceedings of the International Sym-
posium on Surface Area Determination, D.H. Everett, R.H. Ottwill, eds., U.K. 
(1969)
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ETHERNET COMMUNICATION SETTINGS

This section contains instructions for configuring an ethernet port in either Microsoft® 
Windows 7, Windows XP Professional, or Windows Vista. The instructions do not apply to 
any other operating system.

Configuring an Ethernet Port

The computer and analyzer communicate by means of an ethernet connection. This appendix 
contains instructions for ensuring that the ethernet connection operates properly.

Windows 7

1. Select the Windows icon from the Status bar at the bottom of the screen, then select 
Control Panel. 

2. Click Network and Internet then click View network status and tasks.

The windows in this section are Microsoft operating system windows, which may 
be subject to change. The windows are included for reference purposes only.

Methods to access to these windows may vary. Refer to the Windows help system 
for assistance, if necessary. 
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3. Click the Local Area Connection for your analyzer.

4. Click Properties.

5. Highlight Internet Protocol Version 4 then click Properties.
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6. Click Use the following IP address then enter the following in the IP address field: 192 
168 77 100.

7. The following numbers should display in the Subnet mask field: 255.255.255.0. If not, 
enter them. Leave all other fields blank.

8. Click OK until all windows are closed.
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Windows XP Professional

1. Select Start > Settings > Network Connections from the Status bar at the bottom of the 
screen.

2. Double-click the appropriate Local Area Connection (which is the ethernet port). 

3. Click Properties. 

If no Local area connections are displayed, Windows did not detect an ethernet 
port. Contact your system administrator.
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4. Scroll to Internet Protocol (TCP/IP) and ensure a check mark displays in the box to the 
left of the item. If it does not, click the box to insert a check mark.

5. Select Internet Protocol (TCP/IP) to highlight it, then click Properties. 

6. Click Use the following IP address and enter the following in the IP address field: 192 
168 77 100.

7. The following numbers should display in the Subnet mask field: 255.255.255.0. If not, 
enter them. Leave all other fields blank.

Make sure Internet
Protocol (TCP/IP) 
is checked
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8. Click OK until all windows are closed.

Windows Vista

1. Select the Windows icon from the Status bar at the bottom of the screen, then select 
Control Panel. 

2. Double-click Network and Sharing Center.

3. Click Manage network connection from the Tasks list on the left side of the window 
then click Local Area Connection for your analyzer.

Click here
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4. Click Properties.

5. Highlight Internet Protocol Version 4 then click Properties.

6. Click Use the following IP address and enter the following in the IP address field:
192 168 77 100. 

7. The following numbers should display in the Subnet mask field: 255.255.255.0. If not, 
enter them. Leave all other fields blank.

8. Click OK until all windows are closed.
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INDEX

Symbols
$ symbol, 3-6, 5-10, 8-8, 8-11

A
Absolute pressure

See Pressure
Adding

second analyzer, 4-12
Adsorption isotherm, E-3
Adsorptive Properties dialog, 5-32
Adsorptive properties file, 5-32

listing file statistics, 3-54, 5-95
opening, 5-4
printing contents, 3-53

Advanced format, 3-7, 5-6, 5-7, 8-4
creating sample file, 3-9
selecting, 8-4
specifying sample defaults, 3-5, 8-10

Advanced Sample Defaults dialog, 3-5
Alpha-S curve, 5-92
Alpha-S Plot report, 5-54
Alpha-S range, 5-55
Alumina, replacing in oil vapor traps, 9-20
Analysis

bath, 3-32
details, 6-32
Dewar, checking, 9-8
dialog, 3-46, 6-5
gas, 1-6, 3-44
high throughput, 1-6, 3-44, 3-49
Krypton, 1-6, 3-44, 3-47
manifold, 1-8
micropore, 1-6, 3-44, 3-51, 6-16
performing, 3-46
reference, 9-35
sample amount, 3-23
skipping steps, 6-15
standard, 1-6, 3-44
status, 6-31
suspending, 6-15
viewing options, 6-6, 6-10, 6-13, 6-17
See also Analysis port

Analysis conditions
entering, 5-16
for mesoporous materials, 5-20

Analysis Conditions dialog, 5-16

Analysis conditions file, 5-16
listing file statistics, 3-54, 5-95
opening, 5-4
printing contents, 3-53

Analysis port, 2-3
attaching sample tube, 3-36
replacing filter, 9-9

Analysis Preparation dialog, 5-25
Analysis program, 2-11

commands, common, 2-14
exiting, 2-12, 5-100
functions, common, 2-17
installing upgrade, 4-11
uninstalling, 4-20

Analysis system, 1-5
manually controlling, 6-24
schematic, 6-24
specifications, 1-8

Analyzer
adding another, 4-12
cleaning, 9-25
controls, indicators, and connectors, 2-3
depth, 1-11
description, 1-5
front panel, 2-3
height, 1-11
leak testing, D-3
maintaining, 9-7
moving from one computer to another, 4-14
moving to a new computer, 4-14
removing from computer, 4-18
service test, 8-15
side panel, 2-7, 2-9
specifications, 1-8
troubleshooting, 9-3
weight, 1-11
width, 1-11

Application Setup program, 4-9
Ar Carbon Finite Pores, As=12, 2D-NLDFT model, 

E-13
Ar Carbon Finite Pores, As=6, 2D-NLDFT model, E-12
Ar Carbon Slit Pores by NLDFT model, E-12
AR Cylindrical Pores - Oxide Surface model, E-10
AR DFT model, E-9
AR Modified Density Functional Model, E-11
Argon Cylinder, multi-wall nanotube by NLDFT model, 

E-14
Argon Cylinder, single-wall nanotube by NLDFT model, 
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E-13
ASCII text, saving reports, 7-21
Astakhov report, 5-77
Automatic Degas dialog, 3-28, 3-29
Automatically collected data, 5-17, 5-88
Autoscale, 7-25

onscreen reports, 7-23
X- and Y-axes, 7-23

Avogadro's number, C-21
Axis

coordinates, viewing, 7-26
properties, editing, 7-24

Axis Properties dialog, 7-24

B
Backfill

gas, 1-10, 5-30
options, 5-30
port, 2-7
sample tube, 5-15

Balance
weighing the sample, 3-23

Basic format, 3-8, 5-6, 5-9, 8-4
creating a sample file, 3-11
selecting, 8-5
specifying sample defaults, 3-3, 8-6

Bath temperature, 6-7, 6-11, 6-14, 6-18
BET surface area pressure table, 5-17
BET Surface Area report, 5-42

calculations, C-8, C-9
examples, 7-31

BJH
Adsorption (or Desorption) Tabular Report Column 

Options dialog, 5-62
Adsorption or Desorption plot, 5-64
Adsorption or Desorption plot dialog, 5-64
Adsorption or Desorption report, 5-58
Adsorption or Desorption Report Options dialog, 

5-64
Adsorption or Desorption tabular report, 5-62
Adsorptive Options dialog, 5-60
calculations, C-12
correction method, 5-61
pressure table, 5-17
report examples, 7-35

Boltzmann’s constant, E-10
Breaker

valve circuit, 2-8
Broekhoff-de Boer equation, 5-51
Broekhoff-de Boer equation dialog, 5-51

C
Calculated free space, 5-28
Calculations, C-3

differential, smoothing, 5-60
Calibrate Analysis command, 6-42
Calibrate Degas command, 6-42
Calibration Data command, 6-42
Calibration files, reinstalling, 4-19
Calibration, displayed on Unit Configuration dialog, 

6-37
Cancel command, 2-14
Carbon Cylinder, multi-wall nanotube by NLDFT 

model, E-14
Carbon Cylinder, single-wall nanotube by NLDFT 

model, E-13
Cascade windows, 2-23
Cautions, 1-4
Chemical potential, E-5
Cheng/Yang

calculations, C-24
correction, 5-67
Pore Geometry, C-23

Cleaning
analyzer, 9-25
Dewars, 9-8
filler rods, 3-19
sample tubes, 3-19

Close All command, 5-3, 5-93
Close command, 2-14, 5-3, 5-93
Close Reports command, 7-5
CO2 DFT Model, E-11
Cold free space, 5-13
Collected Data dialog, 5-88
Columns, onscreen reports, editing, 7-22
Commands, common, 2-14

Cancel, 2-14
Close, 2-14
Replace, 2-15
Replace All, 2-16
Save, 2-14

Comments, in sample information file, 3-10, 5-8
Control Chart command, 7-11
Control Chart Graph Options dialog, 7-12
Control Chart Options dialog, 7-11
Control Chart report, 7-11

defining the Y-axis, 7-12
recalculating archived results, 7-12

Control Chart Sample Selection dialog, 7-13
Conventions, operator’s manual, 1-4
Convert command, 5-4, 5-98
Copy as metafile command, 7-25
Copy as text command, 7-25
Correction factor, surface area, 5-52
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Cross-hair, axis, 7-26
Curve Properties dialog, 7-24

D
Data

automatically collected, 5-17, 5-88
isotherm, exporting, 5-96
manually entered, 5-88
selecting display options, 8-13
type, 5-8

Dates, selecting range, 2-20
Default Basic Sample Information dialog, 8-6
Defaults, specifying, 3-3
Degas

dialog, 6-20
manifold, 1-8
sample on analysis port, 3-38
sample on degas port, 3-26

Degas conditions
entering, 5-14

Degas Conditions dialog, 3-14, 5-14
Degas conditions file, 5-14

creating, 3-14
listing file statistics, 5-95
opening, 5-4
printing contents, 3-53

Degas port, 1-5, 2-7
attaching sample tube, 3-26, 3-27
connector, 2-5, 3-26
ferrule, 3-26
O-ring, 3-26
removing plug, 3-26
replacing filter, 9-11

Degas system, 1-5
accuracy, 1-10
heating phase, 5-15
indicator lights, 2-4
manually controlling, 6-27
specifications, 1-10

Density conversion factor, 5-33
Density Functional theory, E-5
Destination, of reports, 2-21
Detergent, for cleaning sample tubes, 3-20
Dewar, 1-6

checking, 9-8
cleaning, 9-8
filling, 3-32
placing cover over sample tube, 3-37, 3-42
precautions, 3-31
raising and lowering, 6-25
safety shield, 1-6, 3-37, 3-43

DFT
calculations, C-37

Pore Size report, 5-73
Pore Size Report Options dialog, 5-73
pressure range, 5-74
Surface Energy dialog, 5-76
Surface Energy report, 5-76

DFT models, E-3
See Models

Diagnostics command, 6-38
Dialog box

closing, 2-14
Directory

selecting, 2-18
Dollimore-Heal Adsorption/Desorption report, 5-66
Dose Increment Edit dialog, 5-23
Dose Increments dialog, 5-23
Dosing

amount, 5-22
in Krypton analyses, 3-47
method, 5-33
percent of previous, 5-24

Dosing Options dialog, 5-20
Drying oven

setting temperature, 3-20
Dubinin

Adsorptive Options dialog, 5-78
calculations, C-29
Pore Volume report, 5-80
report, 5-77
Report Options dialog, 5-77, 5-80
report, example, 7-43
tabular report, 5-79
Tabular Report Column Options dialog, 5-79
transformed isotherm, 5-79
Transformed Isotherm Plot Options dialog, 5-79

E
Edit curve command, 7-24
Edit title command, 7-25
Elevator, 1-6, 6-25

lubricating screws, 9-25
raising and lowering, 6-25

Enable Manual Control command, 6-24
Entered Pressures dialog, 5-17
Equilibration

calculations, C-6
delay, 5-30
interval, 5-30

Equilibration delay, 5-22, 5-25
Equilibration dialog, 5-29
Ethernet

configuring port for Vista, F-8
configuring port for Windows 7, F-3
configuring port for Windows XP, F-6
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connection, 2-8
Evacuation, 1-10

fast, 5-25, 6-22
pressure for unrestricted, 5-15
rate, 5-14
time, 5-15, 5-25

Exit command, 5-100
Exiting the analysis program, 2-12, 5-100
Expansion kit, 9-32
Export command, 5-4, 5-96
Export Sample File dialog box, 5-96

F
Fast evacuation, 5-25, 6-22
Ferrule, 3-26
File

close, 5-93
close all open, 5-93
converting for 2420 program, 5-98
exporting, 5-96
listing statistics, 2-12
name, including with file identification, 8-8, 8-11
opening, 2-12, 5-4
printing, 5-93
printing to, 2-21
saving all open, 5-92
saving under a different name, 5-91
selection, 2-17
status, 2-19
See also Analysis conditions file
See also Degas conditions file
See also Sample information file
See also Sample tube file

File menu, 2-22, 5-3
Close All command, 5-93
Close command, 5-93
Convert command, 5-98
Exit command, 5-100
Export command, 5-96
List command, 5-95
Open command, 5-4
Save All command, 5-92
Save As command, 5-91
Save command, 5-91

File name
default extensions, 2-13, 5-5
field, 2-18

Files list, 2-18
Filler rod, 3-19, 5-13

cleaning, 3-19
inserting into sample tube, 3-22

Filter
port, 9-9

vacuum pump exhaust, 9-30
Fixed pore size table

conversion, 5-99
Fixed Pore Size Table dialog, 5-63
Folder, directory, 3-7
f-Ratio report, 5-56
Free space, 6-7, 6-10, 6-14, 6-17

calculated, 5-28
calculations, C-4
cold, 5-27
measured automatically, 5-27
measurement conditions, 5-26
values, 5-27
warm, 5-27

Free Space dialog, 5-26
Frequency, 1-8
Freundlich report, 5-45

calculations, C-36
Frit, seal, for degas port, 3-26
Fume hood, 9-30
Function keys

See Shortcut keys

G
Gas

amount added for each dose cycle, 5-20
analysis, 1-6, 3-44, 5-32
backfill, 1-10, 3-22
changing, 9-32
connecting a regulator, 9-32
connecting to the analyzer, 9-34
guidelines for connecting to analyzer, 9-32
hazardous, 9-34
inlet ports, 1-6, 2-7
leaks, 5-26
mnemonic, 5-32
Non-condensity Adsorptive option, 5-32
outgassing, 5-26
regulator pressure, 3-44
regulators, 1-7
requirements, 1-7
saturation pressure, 1-6, 3-44
used for degas and analysis, 5-8

Gas Configuration dialog, 9-35
Graph

copying as metafile, 7-25
copying report data as text, 7-25
editing onscreen, 7-23
grid lines, 8-14
legend, 7-25
onscreen report, 7-23
overlays, 3-56

Graph Grid Lines command, 8-14
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Graph Grid Lines dialog, 8-14
Graph Overlay Samples dialog, 5-36
Graphic

adding to a report, 5-35
Graphs

editing, 5-75
Grid lines, 8-14

H
Halsey Thickness Equation, 5-50
Halsey Thickness Equation dialog, 5-50, 5-83
Harkins-Jura Thickness equation, 5-51
Harkins-Jura Thickness Equation dialog, 5-51, 5-82
Heat of Adsorption dialog box, 7-14
Heat of Adsorption report, 7-14
Heater Settings dialog, 6-28
Heating mantle

installing, 3-27
power connection, 2-5
power plug, 3-27, 3-40
side-lacing, 3-38
thermocouple connection, 2-5

Heating phase, 5-15
Help menu, 2-22, 2-23
Hide curve command, 7-23
High surface area samples, 3-23
High throughput analysis, 3-49
High Throughput Analysis dialog, 3-49
Histogram, 7-24
Hold pressure, 5-15
Horvath-Kawazoe calculations

Cylinder pore geometry (Saito/Foley), C-22
Slit pore geometry (original HK), C-21
Sphere pore geometry (Cheng/Yang), C-23

Horvath-Kawazoe Physical Properties dialog, 5-68
Horvath-Kawazoe Plot Options dialog, 5-71
Horvath-Kawazoe report, 5-67

calculations, C-21
plot, 5-71
tabular, 5-70

Horvath-Kawazoe Report Options dialog, 5-67
Humidity, 1-8

I
Icons, arrange, 2-23
Indicator lights, 1-5, 2-3, 2-4
Installation Complete dialog, 4-11
Instrument schematic

See Schematic
Interaction parameter, C-24
IP address

entering, Windows 7, F-5

entering, Windows Vista, F-9
entering, Windows XP, F-7

Isosteric heat of adsorption, 7-14
Isotherm, 5-17, E-3

exporting data, 5-96
target pressures, 5-16
type, 5-41

Isotherm report, 5-40
example, 7-28

Isotherm Report Options dialog, 5-40
Isothermal jacket, 1-6, 3-38, 5-13

placing on sample tube, 3-35

K
Kernel function, E-15, E-16
Keys

shortcut, 2-11, 2-20
Kruk Jaroniec Sayari Thickness Equation dialog, 5-50
Kruk-Jaroniec-Sayari thickness equation, 5-50
Krypton

analysis, 1-6, 3-44, 3-47
dosing port, 1-6, 3-44, 5-33
option, 1-6

L
Langmuir surface area pressure table, 5-17
Langmuir Surface Area report, 5-42

calculations, C-9
Leak test, 5-26

data sheet for recording values, D-18
duration, 5-26
performing, D-3
removing differential pressure, D-15

Legend Properties dialog, 7-25
Legend, report, 7-25
Lennard-Jones, E-4, E-10
List command, 5-4, 5-95
Listing file statistics, 5-95
Local area connection, F-6
Low pressure incremental dose mode, 5-21, 5-24

M
Main Menu bar, 2-22
Maintenance, routine, 9-32
Manifold

analysis, 1-8, 1-9
degas, 1-8
maximum pressure, 5-32

Manual control, 6-24
enabling for analysis system, 6-24
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enabling for degas system, 6-27
Manually entered data, 5-88
Mass

calculating, 3-5, 3-6, 3-10, 3-12, 5-8, 5-11, 8-9, 8-12
determining, 3-23
entering, 3-5, 3-6, 3-10, 3-12, 5-8, 5-10, 8-8, 8-12

Maximum volume increment, 5-21
MCM-41 materials, E-10
Menu

File, 5-3
Help, 2-23
Options, 8-3
Reports, 7-3
shortcut, 2-11, 2-12
structure, 2-22
Unit, 6-3
Windows, 2-23

Mesopore volume/area distribution, 5-58
Metafile, copying graph as, 7-25
Micropore

analysis, 3-44, 3-51, 6-16
low pressure incremental dose mode, 5-24
reports, 7-42

Micropore Analysis dialog, 3-51, 6-16
Models, E-3

Ar Carbon finite pores by NLDFT, As=12, E-13
Ar Carbon finite pores by NLDFT, As=6, E-12
Ar Carbon slit pores by NLDFT, E-12
AR Cylindrical Pores - Oxide Surface, E-10
AR DFT model, E-9
AR Modified Density Functional, E-11
Argon Cylinder, multi-wall nanotube by NLDFT, 

E-14
Argon Cylinder, single-wall nanotube by NLDFT 

model, E-13
based on classical theories, E-15
based on statistical thermodynamics, E-3
Carbon Cylinder, multi-wall nanotube by NLDFT, 

E-14
CO2 DFT Model, E-11
N2 Broekhoff-de Boer Model, E-17
N2 Carbon Cylinder, single-walled nanotube by 

NLDFT model, E-13
N2 Carbon finite pores by NLDFT, As=12, E-13
N2 Carbon finite pores by NLDFT, As=6, E-12
N2 Carbon slit pores by NLDFT, E-12
N2 Cylindrical Pores - Oxide Surface, E-10
N2 Cylindrical Pores - Pillared Clay Surface, E-10
N2 DFT model, E-9
N2 Halsey Thickness Curve, E-16
N2 Harkins and Jura Thickness Curve, E-16, E-17
N2 Harkins and Jura Thickness Curve model, E-16
N2 Modified Density Functional, E-9
N2 Tarazona NLDFT, Esf = 30.0K, E-12

Zeolites H-Form by NLDFT, E-14
Molecular cross-sectional area, 5-33
Molecular dynamics, E-4
Molecular simulation methods, E-4
Monte Carlo, E-4
Montmorillionite, E-10
Move analyzer information to this PC dialog, 4-16
Move analyzer operation dialog, 4-14
Moving an analyzer to another computer, 4-14
MP-Method

calculations, C-34
graph, 5-84
report, 5-82
Report Options dialog, 5-82
tabular report, 5-84
Tabular Report Column Options dialog, 5-84

N
N2 Broekhoff-de Boer model, E-17
N2 Broekhoff-de Boer Model model, E-17
N2 Carbon Finite Pores, As=12, 2D-NLDFT model, 

E-13
N2 Carbon Finite Pores, As=6, 2D-NLDFT model, E-12
N2 Carbon Slit Pores by NLDFT model, E-12
N2 Cylindrical Pores - Oxide Surface model, E-10
N2 Cylindrical Pores - Pillared Clay Surface model, 

E-10
N2 DFT model, E-9
N2 Halsey Thickness Curve model, E-16
N2 Harkins and Jura Thickness Curve model, E-17
N2 Modified Density Functional model, E-9
N2 Tarazona NLDFT, Esf = 30.0K model, E-12
Non-ideality factor, 5-13, 5-33
Notes, 1-4

O
Oil vapor traps

replacing alumina, 9-20
On/Off switch, 2-8
Onscreen reports

autoscale, 7-25
axis coordinates, 7-26
graphs, 7-23
legend, editing, 7-25
shortcut menus, 7-22
title, editing, 7-25
zooming in and out, 7-25

Open Adsorptive Properties File dialog, 3-16
Open Analysis Conditions File dialog, 3-15
Open command, 5-3, 5-4
Open dialog, 2-15, 2-17
Open Report command, 7-5
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Open Report Options File dialog, 3-17
Open Sample Information File dialog, 3-9, 3-11
Operator field, omitting or renaming, 5-8
Operator’s manual

conventions, 1-4
organization, 1-3

Option Presentation command, 8-4
Options menu, 2-22, 8-3

Graph Grid Lines command, 8-14
Option Presentation command, 8-4
Parameter Files Directory command, 8-15
Sample Defaults command, 8-6
Service Test Mode command, 8-15
Units command, 8-13

Options report, 5-86
Ordering information, 10-3
Outgas test

duration, 5-27
selecting, 5-27

Outgassing rate
checking, 9-26

Oven, drying samples, 3-20
Overlays

for multiple graphs, 3-60
for multiple samples, 3-56
generating, 3-56

P
Parameter files

degas conditions, creating, 3-14
description, 3-12
directory, 3-12, 8-15
listing file statistics, 3-54, 5-95
predefined, 3-12
printing contents, 3-53, 5-93
report options, creating, 3-17
sample tube, creating, 3-13

Parameters, user, 8-12
Parts, ordering, 10-3
Pass/Fail Options dialog, 5-39
Pass/Fail Selection, 5-39
Password

Restricted format, 8-6
Physical Properties dialog, 5-68
Plot options, 5-41
Plot Options dialog, 5-41
Po and Temperature Options dialog, 5-28
Pore filling pressure, E-6
Pore Geometry, 5-67

cylinder (Saito-Foley), C-22
slit (original Horvath-Kawazoe), C-21
sphere (Cheng/Yang), C-23

Pore size, E-15

Port filter, replacing, 9-10, 9-11
Ports

gas connection, 2-7
gas inlet, 1-6, 2-7
Po, connector, 2-5
sample, connector, 2-5
specifying gas, 9-35
See also Analysis Port
See also Degas Port

Power
connector, 2-8
heating mantle, 2-5, 3-27, 3-40
panel, 2-8
specifications, 1-8
switch, 2-8

Predefined Pressures dialog, 5-19
Pressure

absolute, 5-21
absolute, range, 5-45
absolute, tolerance, 5-21
ending, 5-18
hold value, 5-15
insert predefined, 5-19
maximum manifold, 5-32
measurement specifications, 1-8, 1-9
range, 5-18
relative, 5-21
relative, calculations, C-3, C-4
relative, range, 5-55
relative, tolerance, 5-21
starting, 5-18
surface area minimum and maximum, 5-52
See also Saturation pressure

Pressure points, 5-44
geometrically spaced from low pressure range, 5-18
geometrically spaced from saturation pressure, 5-19
predefined, 5-44

Pressure Range, 5-67
Pressure Range push button, 5-52
Pressure table, 5-17, 5-89

first point, 5-20
Fixed Dose mode, 5-20

Preventive maintenance schedule, 9-7
Print command, 5-3, 5-93
Printer, 2-21
Printing

files, 3-53
Psat tube, 1-6

displayed on schematic, 6-26
Psat vs. Temperature Table for Nitrogen dialog, 5-33
Pump

See Vacuum pump
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R
Radushkevich report, 5-77
Ramp rate, 5-15, 6-28
Redraw command, 7-23, 7-26
Reducer fitting, 9-33
Reference material, 9-35
Regression report, 7-7

recalculating SPC values, 7-8
selecting X- and Y-Axes variables, 7-8

Regression Report command, 7-7
Regression Report Options dialog, 7-7
Regression Report Sample Selection dialog, 7-8
Regulators

attaching to gas supply, 9-32
expansion kit, 9-32
gas, 1-7
purging, 9-33
shut-off/isolation valve, 9-33

Re-install calibration files dialog, 4-19
Relative pressure

See Pressure
Remove an analyzer dialog, 4-18
Replace All command, 2-16
Replace button, 3-8
Replace command, 2-15
Report

Alpha-S Plot, 5-54
BET Surface Area, 5-42
BJH Adsorption, 5-58
BJH Desorption, 5-58
closing, 2-12, 7-5
Control Chart, 7-11
customizing, 1-7, 3-17
deselecting, 5-37
destination, file, 2-21
destination, printer, 2-21
DFT Pore Size, 5-73
DFT Surface Energy, 5-76
displaying company logo above title, 5-35
displaying graphic, 5-35
Dollimore-Heal, 5-66
Dubinin, 5-77
Dubinin Pore Volume, 5-80
Dubinin tabular, 5-79
Dubinin transformed isotherm, 5-79
f-Ratio, 5-56
Freundlich isotherm, 5-45
generated automatically, 3-46, 6-7, 6-11, 6-14, 6-18
generating, 7-4
graphs, editing onscreen, 7-23
header, 7-17
Heat of Adsorption, 7-14
Horvath-Kawazoe, 5-67

Isotherm, 5-40
Langmuir Surface Area, 5-42
number of copies, 2-21
onscreen, shortcut menu, 2-12
opening, 7-5
Options, 5-86
Regression, 7-7
Sample Log, 5-86
saving in other formats, 7-21
selecting, 5-37, 7-5
settings, 2-21
showing title, 5-35
starting, 2-12
Statistical Process Control (SPC), 7-6
system, 1-7
Temkin, 5-46
t-Plot, 5-48
Validation, 5-87, 7-41
zoom feature, 7-25

Report button, 7-10
Report examples, 7-26
Report Options dialog, 3-18, 3-57, 5-34
Report options file, 5-34

creating, 3-17
listing file statistics, 3-54, 5-95
opening, 5-4
printing contents, 3-53

Report Pressure Table dialog, 5-44
Report Relative Pressure Range dialog, 5-52, 5-61, 5-67, 

5-74, 5-83
Report Settings group box, 2-21
Reports menu, 2-22, 7-3

Close Reports command, 7-5
Control Chart command, 7-11
description, 7-3
Open Report command, 7-5
Regression Report command, 7-7
SPC Report Options command, 7-6
Start Report command, 7-4

Reports to Generate dialog, 7-4
Restricted format, 3-8, 5-6, 5-11, 8-4

creating a sample file, 3-11
password, 8-5
selecting, 8-5
specifying sample defaults, 8-6

S
Saito-Foley

calculations, C-22
Pore Geometry, C-22

Sample
degassing, 3-26, 3-38
determining mass, 3-23
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dosing, 5-22, 5-24
high surface area, 3-23
inserting large granules or chunks in a tube, 3-23
inserting powder in a tube, 3-23
outgassing, 5-26
preparing, 3-19
specifying conditions for heating phase, 5-15
weighing, 3-23
weight, recording, A-3

Sample Backfill Options dialog, 5-30
Sample Data Worksheet, 3-23, 3-35, A-3
Sample defaults, 8-6

establishing for Advanced format, 8-10
establishing for Basic format, 8-6

Sample Defaults command, 8-6
Sample Information dialog, 5-7, 5-9, 5-11
Sample information file

Advanced format, 5-7
Basic format, 5-9
converting 2400 or 2405 files to 2420 files, 5-98
creating, 3-7, 5-6
exporting isotherm data, 3-55
listing file statistics, 3-54, 5-95
opening, 5-4
printing contents, 3-53, 5-93
replacing values, 3-10
Restricted format, 5-11
specifying defaults, 3-3

Sample log report, 5-86
Sample tube

allowing to cool, 3-34
assembling, 3-36
attaching to analysis port, 3-36
attaching to degas port, 3-26
choosing, 3-19
cleaning, 3-19
displayed on schematic, 6-26, 6-28
filler rod, 3-19
inside diameter, 5-36
labeling, 3-19
outside diameter, 3-19
rack, 3-21
removing from degas port, 3-35
replacing O-ring, 9-12
rinsing, 3-21
set, 3-19
sizes, 1-5
stopper, 3-19, 3-22
thermal profile, 1-6
weighing, 3-35

Sample Tube dialog, 3-13, 5-12
Sample tube file, 5-12

creating, 3-13
listing file statistics, 5-95

opening, 5-4
printing contents, 5-93

Saturation pressure
calculations, C-3
method for obtaining, 5-28
table, 5-34

Save All command, 5-3, 5-92
Save As command, 5-3, 5-91
Save as Default button, 7-13
Save command, 2-14, 5-3, 5-91
Scale, linear or logarithmic, 5-64
Schematic

analysis system, 6-29
degas system, 6-30
shortcut menu, 2-12

Seal frit, sample tube, 3-19
Select Dates group box, 2-20
Selection Criteria group box, 2-17
Service Test command, 6-42
Service Test Mode command, 8-15
Setup program

adding an analyzer, 4-12
moving an analyzer to another computer, 4-14
reinstalling analysis program, 4-11
reinstalling calibration files, 4-19
starting, 4-9
uninstalling software, 4-20
using for other functions, 4-9

Shield, safety, 3-37, 3-43
Shortcut keys, 2-11, 2-20
Shortcut menu, 2-11, 2-12

for graphs, 7-23
for tabular reports, 7-22

Show Analysis Schematic command, 6-29
Show Analysis Status command, 6-31
Show curve command, 7-23
Show Degas Schematic command, 6-30
Show Degas Status command, 6-32
Show Instrument Log command, 6-34
Smooth differential calculations, 5-60
Software

installing upgrade, 4-11
uninstalling, 4-20
using for other functions, 4-9

SPC report
user parameters, 8-12

SPC Report Options command, 7-6
SPC Report Options dialog, 7-6
Specifications, 1-8
Spreadsheet format

saving reports in, 7-21
Start Analysis command, 3-46, 6-5
Start Micropore Analysis dialog, 3-51
Start Multiple Degas command, 6-21
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Start Report command, 7-4
Start Report dialog box, 7-4
Start Single Degas command, 3-28, 3-29, 6-20
Status

selecting, 2-18
Status drop-down list, 2-19
Stopper

for sample tube, 3-19
inserting in sample tube, 3-22

STSA Thickness Equation, 5-51
STSA Thickness Equation dialog, 5-51
Submitter field, omitting or renaming, 5-8
Subnet mask

entering, Windows 7, F-5
entering, Windows Vista, F-9
entering, Windows XP, F-7

Summary report
calculations, C-39
example, 7-27
Pass/Fail options, 5-39
type of information included, 5-38

Summary Report Options dialog, 5-38
Surface area

correction factor, 5-52
selecting value, 5-52

Surface Area report, 5-42
Surface Area Report Pressure Selection dialog, 5-44
Surface Energy, E-15

T
Tarazona, E-9
Target temperature, 5-14, 6-28
Temkin report, 5-46

calculations, C-36
Temperature, 1-5, 1-8, 5-15

control, 1-10
displayed on schematic, 6-26
ramp rate, 5-14, 5-15
range, 1-10
setting, 6-28
target, 5-14, 6-28
transducer specifications, 1-8

Tests, diagnostic, 6-38
Text, copy graph data as, 7-25
Thermal transpiration correction, 5-36

calculations, C-7
Thermal transpiration hard-sphere diameter, 5-33
Thermocouple

connection, 2-5
plug, 3-27, 3-40

Thermodynamic law, E-4
Thickness curve, 5-48, 5-49

Broekhoff-de Boer, 5-51

Carbon Black STSA, 5-51
Halsey, 5-50
Harkins-Jura, 5-51
Kruk-Jaroniec-Sayari, 5-50
minimum and maximum values, 5-52
t-Plot report, 5-52

Tile windows, 2-23
Title Properties dialog, 7-25
Total pore volume pressure table, 5-17
t-Plot pressure table, 5-17
t-Plot report, 5-48

calculations, C-10
examples, 7-33

Transducer
displayed on schematic, 6-26

TranSeal, 3-36, 5-26
Troubleshooting, 9-3
Tube

See Sample tube

U
Ultrasonic cleaning unit, 3-20
Uninstall dialog, 4-20
Unit command

Start Multiple Degas command, 6-21
Unit Configuration command, 6-36
Unit menu, 2-22, 6-3

Calibrate Analysis command, 6-42
Calibrate Degas command, 6-42
Calibration Data command, 6-42
description, 6-3
Diagnostics, 6-38
Enable Manual Control command, 6-24
Service Test command, 6-42
Show Analysis Schematic command, 6-29
Show Analysis Status command, 6-31
Show Degas Schematic command, 6-30
Show Degas Status command, 6-32
Show Instrument Log command, 6-34
Start Analysis command, 3-46, 6-5
Start Single Degas command, 6-20
Unit Configuration command, 6-36

Units command, 8-13
Units Selections dialog, 8-13
Units, selecting, 8-13
User parameters

specifying, 8-12

V
Vacuum

seal type, 5-13
setpoint, 5-15, 5-25, 6-22, 6-23
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system specifications, 1-10
Vacuum pump

exhaust filter, replacing, 9-30
housing, 2-9
power connectors, 2-9
replacing alumina in oil vapor trap, 9-20
specifications, 1-9

Validation report, 5-87, 7-41
Valve circuit breaker, 2-8
Valves

analysis manifold, D-5
degas manifold, D-3
gas inlet, D-11
location, D-3
opening and closing, 6-25
Po, D-13
regulator, 9-33
repairing or replacing, D-15

Valves, analysis, description, 6-25
Van der Waal force, E-3
Viewing options, 6-6, 6-10, 6-13, 6-17
Voltage

selecting, 2-8
Volume

calibration details, 6-37
Volume adsorbed

calculations, C-5
selecting manner for reporting, 5-42

W
Wall potential, E-12
Warm free space, 5-13
Warnings, 1-4
Weighing sample, 3-23
Welcome screen, 4-9
Wild card characters, 5-5
Windows

arrange icons, 2-23
cascade, 2-23
tile, 2-23

Windows menu, 2-22, 2-23

X
X-axis, autoscale, 5-41

Y
Y-axis autoscale, 5-41

Z
Zeolites H-Form by NLDFT model, E-14
Zeolites Me-Form by NLDFT model, E-14
Zoom feature, 7-25
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